mikroPascal PRO for PIC32" manual

mikroPascal PRO for PIC32 is a full-featured C compiler for PIC32
MCUs from Microchip. It is designed for developing, building and
debugging PIC32-based embedded applications. This development
environment has a wide range of features such as: easy-to-use
IDE, very compact and efficient code, many hardware and software
libraries, comprehensive documentation, software simulator, COFF file
generation, SSA optimization (up to 30% code reduction) and many
more. Numerous ready-to-use and well-explained examples will give a
good start for your embedded project.
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CHAPTER 1

INTRODUCTION

The mikroPascal PRO for PIC32 is a powerful, feature-rich development tool for PIC32 microcontrollers. It is designed
to provide the programmer with the easiest possible solution to developing applications for embedded systems, without
compromising performance or control.
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Introduction to mikroPascal PRO for PIC32

The PIC32 is a 32-bit family of general purpose microcontrollers. This is the Microchip’s first inherent 32-bit (data)
microcontroller family. It builds upon the MIPS M4K 32-bit core, offering high-performance hardware multiply/divide
unit, programmable user and kernel memory partition through an unified 4GB virtual memory space, with powerful
peripherals to address a wide range of applications.

Having a wide range of application, being prized for its efficiency, PIC32 MCUs are a natural choice for developing
embedded systems. mikroPascal PRO for PIC32 provides a successful match featuring highly advanced IDE, ANSI
compliant compiler, broad set of hardware libraries, comprehensive documentation, and plenty of ready-to-run
examples.

Features
mikroPascal PRO for PIC32 allows you to quickly develop and deploy complex applications:

- Write your source code using the built-in Code Editor (Code and Parameter Assistants, Code Folding,
Syntax Highlighting, Auto Correct, Code Templates, and more.)

- Use included mikroPascal PRO for PIC32 libraries to dramatically speed up the development: data
acquisition, memory, displays, conversions, communication etc.

- Monitor your program structure, variables, and functions in the Code Explorer.

- Generate commented, human-readable assembly, and standard HEX compatible with all programmers.

- Use the integrated mikrolCD (In-Circuit Debugger) Real-Time debugging tool to monitor program execution
on the hardware level.

- Inspect program flow and debug executable logic with the integrated Software Simulator.

- Use Single Static Assignment optimization to shrink your code to even smaller size.

- Get detailed reports and graphs: RAM and ROM map, code statistics, assembly listing, calling tree,
and more.

- Active Comments enable you to make your comments alive and interactive.

- mikroPascal PRO for PIC32 provides plenty of examples to expand, develop, and use as building bricks in
your projects. Copy them entirely if you deem fit — that's why we included them with the compiler.

Where to Start

- In case that you're a beginner in programming the PIC32 microcontrollers, read carefully the PIC32
Specifics chapter. It might give you some useful pointers on the PIC32 constraints, code portability, and
good programming practices.

- If you are experienced in Pascal programming, you will probably want to consult mikroPascal PRO
for PIC32 Specifics first. For language issues, you can always refer to the comprehensive Language
Reference. A complete list of included libraries is available at mikroPascal PRO for PIC32 Libraries.

- If you are not very experienced in Pascal programming, don’t panic! mikroPascal PRO for PIC32 provides
plenty of examples making it easy for you to go quickly through it. We suggest that you first consult
Projects and Source Files first, and then start browsing the examples that you're the most interested in.

Copyright (c) 2002-2010 mikroElektronika. All rights reserved.
What do you think about this topic ? Send us feedback!
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Software License Agreement
mikroElektronika Associates License Statement and Limited Warranty

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License Agreement”) between you (either as
an individual or a single entity) and mikroElektronika (“mikroElektronika Associates”) for software product (“Software”)
identified above, including any software, media, and accompanying on-line or printed documentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE TO BE BOUND BY ALL TERMS
AND CONDITIONS OF THE LICENSE AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement, mikroElektronika Associates grants you
the right to use Software in a way provided below.

This Software is owned by mikroElektronika Associates and is protected by copyright law and international copyright
treaty. Therefore, you must treat this Software like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You retain no copies and the recipient
agrees to the terms of the License Agreement. Except as provided in the License Agreement, you may not transfer,
rent, lease, lend, copy, modify, translate, sublicense, time-share or electronically transmit or receive Software, media
or documentation. You acknowledge that Software in the source code form remains a confidential trade secret of
mikroElektronika Associates and therefore you agree not to modify Software or attempt to reverse engineer, decompile,
or disassemble it, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding
this limitation.

If you have purchased an upgrade version of Software, it constitutes a single product with the mikroElektronika
Associates software that you upgraded. You may use the upgrade version of Software only in accordance with the
License Agreement.

LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without warranty of any kind, mikroElektronika
Associates warrants that Software, once updated and properly used, will perform substantially in accordance with the
accompanying documentation, and Software media will be free from defects in materials and workmanship, for a period
of ninety (90) days from the date of receipt. Any implied warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive remedy shall be, at mikroElektronika
Associates’ option, either (a) return of the price paid, or (b) repair or replacement of Software that does not meet
mikroElektronika Associates’ Limited Warranty and which is returned to mikroElektronika Associates with a copy of
your receipt. DO NOT RETURN ANY PRODUCT UNTIL YOU HAVE CALLED MIKROELEKTRONIKA ASSOCIATES
FIRST AND OBTAINED A RETURN AUTHORIZATION NUMBER. This Limited Warranty is void if failure of Software
has resulted from an accident, abuse, or misapplication. Any replacement of Software will be warranted for the rest of
the original warranty period or thirty (30) days, whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MIKROELEKTRONIKA ASSOCIATES AND ITS
SUPPLIERS DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED,
INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FORA PARTICULAR
PURPOSE, TITLE, AND NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION OF OR
FAILURE TO PROVIDE SUPPORT SERVICES.
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IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS INTERRUPTION, OR
ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE PRODUCT
OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF MIKROELEKTRONIKA
ASSOCIATESHASBEENADVISED OF THEPOSSIBILITY OF SUCHDAMAGES. INANY CASE, MIKROELEKTRONIKA
ASSOCIATES’ ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT SHALL BE LIMITED
TO THE AMOUNT ACTUALLY PAID BY YOU FOR SOFTWARE PRODUCT PROVIDED, HOWEVER, IF YOU HAVE
ENTERED INTOAMIKROELEKTRONIKAASSOCIATES SUPPORT SERVICESAGREEMENT, MIKROELEKTRONIKA
ASSOCIATES’ ENTIRE LIABILITY REGARDING SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF
THAT AGREEMENT.

HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control
equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in
which the failure of Software could lead directly to death, personal injury, or severe physical or environmental damage
(“High Risk Activities”). mikroElektronika Associates and its suppliers specifically disclaim any expressed or implied
warranty of fitness for High Risk Activities.

GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised officer of mikroElektronika Associates.
If any provision of this statement is found void or unenforceable, the remainder will remain valid and enforceable
according to its terms. If any remedy provided is determined to have failed for its essential purpose, all limitations of
liability and exclusions of damages set forth in the Limited Warranty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary, from country to country. mikroElektronika
Associates reserves all rights not specifically granted in this statement.

mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com
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Technical Support

The latest software can be downloaded free of charge via Internet (you might want to bookmark the page so you could
check news, patches, and upgrades later on): http://www.pic32compilers.com/ .

In case you encounter any problem, you are welcome to our support forums at www.mikroe.com/forum/. Here, you
may also find helpful information, hardware tips, and practical code snippets. Your comments and suggestions on
future development of the mikroPascal PRO for PIC32 are always appreciated — feel free to drop a note or two on our
Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Frequently Asked Questions and solutions
to known problems. If you can not find the solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more efficiently, which is in our mutual
interest. We respond to every bug report and question in a suitable manner, ever improving our technical support.

How to Register

The latest version of the mikroPascal PRO for PIC32 is always available for downloading from our website. It is a
fully functional software with the mikrolCD(in-circuit Debugger), all the libraries, examples, and comprehensive help
included.

The only limitation of the free version is that it cannot generate hex output over 2K of program words. Although it might
sound restrictive, this margin allows you to develop practical, working applications with no thinking of demo limit. If you

intend to develop really complex projects in the mikroPascal PRO for PIC32, then you should consider the possibility
of purchasing the license key.

Who Gets the License Key
Buyers of the mikroPascal PRO for PIC32 are entitled to the license key. After you have completed the payment

procedure, you have an option of registering your mikroPascal PRO for PIC32. In this way you can generate hex output
without any limitations.

How to Get License Key
After you have completed the payment procedure, start the program. Select Help » How to Register from the drop-
down menu or click the How To Register Icon Jﬁ:] .

You can choose between two registering methods, | work online or | work offline, based on your current internet
connection and click Request license key now button:
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How to register D_(

Choose registration method

(O] T work online. Chaose this option i vou are connected to
Internet, You will be directed to a web page which will help vou
to send the license key request. This is the Fastest way of
ibtaining the license key, it takes minutes to get it in your
mailbax, Recommended,

() I work offline. Choose this option if you are not connected to
Internet, You will be guided to Fill in the registration Form which
wou can e-mail when vou get online. This is & slower way of
getting the license key and it is intended For offline computers,

Request license Cancel
key now

If you choose | work online registering method, following page will be opened in your default browser:

[ ] MikroElektronika g s

DEVELOPMENT TOOLS | COMPILERS | BOOKS Emalli office@mikros, com

Home | Development Tools  Compilers  Accessory B Special Offers | EasyBuy  Publications | Support | Projects | Download

Software Activation

In rder to get activation key please fillin required fields. Upon recaiving and verifying your request, we will send the license key to the e-mall address you spacified in the form.

Product

Mame*: John Smith

Address:
Inviice: Ifyou do O Murniber ar invodce number
then he 1 ssed
200 Mumber mianualty which can take longer ime,

Email*:  |smithi@example.com

Re-enter email*:  |smithi@example.com
Company
Product IDr

Comment

Distributor* : | MikroElektronika -

ooy D4

Type e tws words:
progrant 744

Submit

Related Links:  Producks  Mews Forums  Distributors  About Mi i Legal 1 ation and Privacy Policy  Product Archive  Contact Us

Copyright © 1595-2010. MikroSlektronika, Al rights reserved. Al trace and/or services marks mentioned ane the property of their respective owners.
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Fill out the registration form, select your distributor, and click the Submit button.

If you choose | work offline registering method, following window will be opened:

B How To Register

step 1. Fill in the form below. Please, make sure yvou fill in all required fields.

Step 2. Make sure that you provided a valid email address in the "EMAIL" edit box. This email will be used for
sending vou the activation key.

Step 3. Make sure you select a correct distributor which will malke the registration process faster. If your
distributor is not on the list then select "Other" and type in distributor's email address in the box below.

Step 4. Press the SEND button to send key request. & default ernail client will open with ready-to-send rmessage.
Mote: If erail client does not open, you may copy text of the message and paste it manually into a new email
message before sending it to your distributor's email,

NAME™ John Smith
ADDRESS Enter your address
INVOICE Enter invoice number if available

2C0 Mumber Enter 2Checkout Order Murmber or invaice number if available (10 charackers)

E-MAIL* jsmithi@example.cam

E-MAIL* jsmithi@excample.com

COMPANY Enter comparry name
PRODUCT IO 3F47-546774-FFEATI-6540F

COMMEMTS: Enter comments on your arder

DISTRIBUTOR* | rikrcElektronika kesy@mikroe, com v

* Required fields

Name:
John Smith
Address:

Invoice number:

LQ Copy to clipboard [E4] sEND Cancel

Fill out the registration form, select your distributor, and click the Submit button.

This will start your e-mail client with message ready for sending. Review the information you have entered, and add the
comment if you deem it necessary. Please, do not modify the subject line.

Upon receiving and verifying your request, we will send the license key to the e-mail address you specified in the
form.

After Receving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your computer in order to activate
your copy of compiler and remove the demo limit. You do not need to restart your computer or install any additional
components. Also, there is no need to run the mikroPascal PRO for PIC32 at the time of activation.
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Important:

- The license key is valid until you format your hard disk. In case you need to format the hard disk,
you should request a new activation key.

- Please keep the activation program in a safe place. Every time you upgrade the compiler
you should start this program again in order to reactivate the license.
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Main Menu Options

Available Main Menu options are:

%

rojeck

|me i A e I= | Im
= O
E| \ i| "

I| I3 |22
x| 5|
E | =

Related topics: Keyboard shortcuts, Toolbars
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File

File Menu Options

The File menu is the main entry point for manipulation with the source files.

[ ] Mew Unit Ctrl+h
2 open Cr+o

Recent Files 4
H save Chrl+s
H Save As..
11 Cless Chrl+F4
Jop Close sl Shift+Ch+F4
Brint Preview
&= Print... 4P
B Exit Alk+

File Description

||_'1 Hewi Linit Chrk+ | Open a new editor window.
[ open ko | | Open source file for editing or image file for viewing.
| mecentFies *| | Reopen recently used file.
|8 _save cwi+s | | Save changes for active editor.
|I._—f Save is... | Save the active source file with the different name or change the file type.
Wl Cose a4 | | Close active source file.
|:_[ Close &l Shift+Ctri+F4 | Close all opened files.
| Print Preview | Print Preview.
|& Print. .. Ctrl+P | Print.
[ ea ae+x | | Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files
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Edit

Edit Menu Options

The Edit Menu contains commands for editing the contents of the current document.

Do Yoo XEE &>

Undo Chrl+Z
Redo Shift-+Ckrl+2
Cut Chrl+i
Copy Chrl+C
Paste Chrl+y
Delete

Select all Chrl+a
Find... Chrl+F
Find Mext F3
Find Previous  Shift+F3
Replace... Chrl+R
FindInFiles...  AlL+F3
Gota Line... Chrl+
Advanced

Advanced Code Editor options

Edit Description
(@ o a2z | | Undo last change.
| Rredo  shieculez | | Redo last change.
|3% cut e+ | Cut selected text to clipboard.
B cony ar+c | [ Copy selected text to clipboard.
||E Paste Chr+y | Paste text from clipboard.
[X_peete | | Delete selected text.
| sekcal ar+a | | Select all text in active editor.
[P .. arie | | Find text in active editor.
|)3 Find Next F3 | Find next occurence of text in active editor.
|2 Findprevious shit+73 | | Find previous occurence of text in active editor.
|2 meplcs.. ik | | Replace text in active editor.
|Q Find In Files...  Al+F3 | Find text in current file, in all opened files, or in files from desired folder.
|¢_’] Goto Line... ctrl+a | Go to line to the desired line in active editor.
| advanced ]
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Advanced »

Description

Comment Shift+Ckrl+.

Comment selected code or put single line comment if there is no selection.

Uncomment  Shift+Ctrl+,

Uncomment selected code or remove single line comment if there is no selection.

5

Indent Shift+Ckr+1

Indent selected code.

]

Qukdent Shift+Cerl+U

Outdent selected code.

| Aa| Lowercase Chrl-al+L

Changes selected text case to lowercase.

| aAl Uppercase Chrl+al+1

Changes selected text case to uppercase.

| A Titlecase Chrl+alk+T

Changes selected text case to titlercase.

Find Text

Dialog box for searching the document for the specified text. The search is performed in the direction specified. If the
string is not found a message is displayed.

Find Text

Search for:

Options

=]
-
Direction
Case sensitivity @ Forward
Whole words only
Search from caret Backward
Selected text only
Regular expression QK Cancel

Replace Text

Dialog box for searching for a text string in file and replacing it with another text string.

[ﬂ Replace Text El@
Search for: mikroElektronika -
FReplace with: mik.roE -

Option Direction
] '@ Forward
Wihale words anly
Search from caret @
Selected text anly
Beqular expreszion u] Cancel
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Find In Files
Dialog box for searching for a text string in current file, all opened files, or in files on a disk.

The string to search for is specified in the Text to find field. If Search in directories option is selected, The files to search
are specified in the Files mask and Path fields.

Grep search ==
Text to find: -
—Option here

Case sensitive ) Current file

Al opened files

etz e @ Zearch in directories

—Search directory options

Files rmask: *.* -
Fath: C:WProgram filesy, -
Include subdirectories
oK Cancel
Go To Line

Dialog box that allows the user to specify the line number at which the cursor should be positioned.

Go To Line =]

-

Go To Line Nuber S

oK Cancel

Regular expressions option

By checking this box, you will be able to advance your search, through Regular expressions.

Find Text (=3
Search faor: unsignedsx20int -
Options————— —Direction
Case sensitivity @ Forward

Whole words anly

Search from caret ' Backward

Selected text only

oK Cancel

Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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View
View Menu Options

View Menu contains commands for controlling the on-screen display of the current project.

Debug Windows 3
Toolbars 3
Bookmarks

E Code Explorer
Library Manager
Macro Editor
Messages
Project Manager  Shift+Crl+F11

Project Settings

&

Routine List Chrl+L
Quick Converter Chrl+C

Wiew Image Preview

Assembly.
Listing

Bl @

Skakistics

Windows

[
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View Description
| Debug Windows » | Show/Hide Software Simulator / mikrolCD (In-Circuit Debugger) Debug Windows.
| zookbars » | Show/Hide Toolbars.
| Bockmarks Show/Hide Bookmarks window.
[Ts Code Explorer Show/Hide Code Explorer window.
| Ubrary Manager Show/Hide Library Manager window.
| Marro Edtor Show/Hide Macro Editor window.
| Messages Show/Hide Messages window.

| Posctmsnager  shitecul+eil | Show/Hide Project Manager window.

| Project Settings Show/Hide Project Settings window.

|E Routine List critl | Show/Hide Routine List in active editor.

| Quick Converter ar+q | Show/Hide Quick Converter window.

|E] Yiew Image Preview Show/Hide View Image Preview window.
| @l view asserbly View Assembly.

| 1] viewListing View Listing.

|@ Wiew Statistics View Statistics.

'@ Windows Show Window List window.

The Tools toolbar can easily be customized by adding new tools in Options(F12) window.

Related topics: Keyboard shortcuts, Integrated Tools

13 MikroElektronika



mikoPascal PRO for PIC32

Project

Project Menu Options

Project Menu allows the user to easily manipulate current project.

[ew Project. .. Shift+CEr-+M
Open Project...  Shift+Ctrl4+0
Open Projeck Group...

Recent Projects »
Save Project

Save Project As...

Close Project

Close Project Group

Add File To Project...

Remove File From Project

Edit Search Paths...

Edit Project. . Shift+CtrH-E
Clean Project Folder. ..

Impart Project... Chrl+1

@b IR B T (BGRCHE, B

Expart Project Chrl+-alt+E

3 Impork Project... Chrl+1

Project

Description

|L'%_-, Mew Project...  Shift+Ctrl+N

Open New Project Wizard

|L% Open Project...  Shift+Ctrl+0

Open existing project.

||_% Open Projeck Group...

Open project group.

| Recent Projecks

Open recently used project or project group.

| |_="H Sawve Project

Save current project.

||ﬁ Save Project 4s...

Save active project file with the different name.

| % Close Projeck

Close active project.

||% Close Project Group

Close project group.

|L:_L§f &add Fils Ta Project. .

Add file to project.

|&f Remove File From Projeck

Remove file from project.

| Edit Search Paths. ..

Edit search paths.

|L'% Edit Praject,..  Shift+Ctrl+E

Edit project settings

|i+ Clean Project Folder...

Clean Project Folder

| _&; Import Praoject. ..

Import projects created in previous versions of mikroPascal.

|% Export Project Ctrl+Al+E

Export Project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project Manager, Project Settings

44



mikroPascal PRO for PIC32

Build

Build Menu Options

Build Menu allows the user to easily manage building and compiling process.

A Euid
Rebuild Al Sources

.ﬂ Build all Projects

Chrl+F9
Alt+F9
shift-+F9
Stop Build all Chrl+F12

gz Build + Program  Ctri+F11

Build Description
[% Buid anifs | Build active project.

| Rebuid sl sources — ak+F3 | Rebuild all sources in active project.

| sudalproecs  shiters | Build all projects.

| Stop Build Al cri+F12 | Stop building all projects.

|% Build + Program Cr+F11

Build and program active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project Manager, Project Settings
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Run

Run Menu Options

Run Menu is used to debug and test compiled code on a software or harware level.

I'_%Z; Start Debugger F2
1_5?3 Stop Debugger Ctr+F2
I;E:]J Run/Pause Debugger F&
@01 Step Into F7
@y | Step Over F&
08 Step Out Chrl+F3
&1 | Run To Cursor F4
@ Jurnp To Inkerrupk F2
& Toggle Breakpoint FS
5 Clear Breskpoints  Shift+Clrl+FS

Disassembly mode Alt+0

Run Description

|.'§2} Start Debugger F3 | Start Software Simulator or mikrolCD (In-Circuit Debugger).
|,‘§E] Stop Debugger Ctrl+Fz | Stop Debugger.
|'§J Run/Pase Debugger F& | Run/Pause Debugger.
[0 stentmo 7 | | Step Into.
|d>0 Step Cver Fa | Step Over.
[00 step out s | | Step Out.
[T Run To cursor F | [ Run To Cursor.
|~liI Jurnp To Interrupt F2 | Jump to interrupt in current project.
[=  Toogle Breakpaint Fs | | Toggle Breakpoint.
|Fq‘ Clear Ereakpoints  Shift-+CtrH+FS | Clear Breakpoints.

Disassembly mode Alt+D

Toggle between source and disassembly.

Related topics: Keyboard shortcuts, Debug Toolbar
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Tools

Tools Menu Options

Tools Menu contains a number of applications designed to ease the use of compiler and included library routines.

& mE Programmer F11
' Package Manager
Q Active Comment Editar  Cerl+Al+C
41| Ascil Chart
147 EEPROM Editor
Ll Export Code Ta HTML
() GLCD Bitmap Editor

Interrupt Assistant Chrl+alt+1
JT LoD Custom Character
-“ Sewven Segment Editor
E‘g UDF Terminal
Bl UsART Terminal Chrl+T
&l options F12

Tools Description

|<% mE Programmer Fit | Run mikroElektronika Programmer.
|-‘::r Package Manager Run Package Manager.
|2d active comment Edtor _ crkalteC | Show/Hide Active Comment Editor window.
|_,,l Ascii Chart Run ASCII Chart
4 EEPROM Editer Run EEPROM Editor
|LJ Export Code Ta HTML Generate HTML code suitable for publishing source code on the web.
|@ GLCD Bitmap Editor Run Glcd bitmap editor
[& H Teminal Run HID Terminal
| Interrupt Assistant Chrl-alk+1 | Run Interrupt Assistant
[T LeD custom character Run Lcd custom character
| & seven Ssqment Editor Run Seven Segment Editor
|22 uoP Teminal Run UDP communication terminal
| Bl UsART Terminal Chrl+T Run USART Terminal
| options Fiz [ Open Options window

Related topics: Keyboard shortcuts, Tools Toolbar
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Help

Help Menu Options

@ Help F1

Migration Document

Check For Updates

mikroElektronika Support Forums

mikroElektronika Web Page
.~ How To Register

About

Help Description

|@ telp Fi | | Open Help File.
[ tlioration Document | | Open Code Migration Document.
| Check For Updates | Check if new compiler version is available.
| mikroElektronika Suppart Farums | Open mikroElektronika Support Forums in a default browser.
|| mhooElekroniks web Page | | Open mikroElektronika Web Page in a default browser.
| ?  Haw To Register | Information on how to register
[ abou | | Open About window.

Related topics: Keyboard shortcuts, Help Toolbar
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mikroPascal PRO for PIC32 IDE

IDE Overview
The mikroPascal PRO for PIC32 is an user-friendly and intuitive environment.

For a detailed information on a certain part of IDE, simply click on it (hovering a mouse cursor above a desired IDE part
will pop-up its name):
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- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code Assistant, Parameters Assistant, Spell
Checker, Auto Correct for common typos and Code Templates (Auto Complete).

- The Code Explorer is at your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Messages Window displays all messages during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of mikroPascal PRO for PIC32 to suit
your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this way it helps the programmer to spot
potential problems early, much before the project is compiled.

- Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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Code Editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals. General code editing is the
same as working with any standard text-editor, including familiar Copy, Paste and Undo actions, common for Windows
environment.

Available Code Editor options are: Editor Settings, Editor Colors, Auto Correct, Auto Complete and Style.

Editor Settings
Main Editor Settings Features are:

- Auto Save

- Highlighter

- Spelling

- Comment Style

- Code Folding

- Code Assistant

- Parameter Assistant

- Bookmarks and Go to Line

Options |z|

Editor Settings

Project Files
V' Restare Last Opened Project Restare All Opened Files
Save Breakpoints Save Bookmarks

If ©pened File Is Externally Modified

) Prompt For action @ Reload file, but do not prompt () Ignore externally made changes
Auto Save

¥ Enable Auto Save Tirmeout Interval: minutes

Highlighter

¥ Highlight brackets
¥ Highlight begin. .end pairs

Speling

V' Check Spelling

Comment style

@ {.}

1 (single line)
Advanced Editor Options

3 QOpen options diglog

Code Falding

¥ Enable code folding

' Show Ident Guides

oK. Cancel
MikroElektronika 50
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Auto Save

Auto Save is a function which saves an opened project automatically, helping to reduce the risk of data loss in case of
a crash or freeze. Autosaving is done in time intervals defined by the user.

Highlighter

Highlighting is a convenient feature for spotting brackets which notate begin or end of a routine, by making them
visually distinct.

Spelling

The Spell Checker underlines unknown objects in the code, so they can be easily noticed and corrected before compiling
your project.

Select Tools » Options from the drop-down menu, or click the Show Options Icon g and then select the Spell
Checker Tab.

Comment Style

Code Editor has a feature to change the comment style to either single-line or multi-line. Commenting or uncommenting
the selected code is done by a simple click of a mouse, using the Comment Icon {..} and Uncomment Icon {.} from
the Advanced Edit Toolbar.

Code Folding
Code folding is IDE feature which allows users to selectively hide and display sections of a source file. In this way it is
easier to manage large regions of code within one window, while still viewing only those subsections of the code that

are relevant during a particular editing session.

While typing, the code folding symbols ([=| and [+]) appear automatically. Use the folding symbols to hide/unhide the
code subsections.

%hegin

PORTA :=0;
PORTE :=10:
Led Inici):

LCD_Out{l,1,txc[0]) >
LCD_omt (2, 1,txt[1]) >
delay ms(1000) ;

Led Crd(l):

LCD_Out{1,1,txt[1])>
LCD_out(2,4,txt[2]) 2
delay_ms(500)

end.

begin El
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Another way of folding/unfolding code subsections is by using Alt+« and Alt+—.

If you place a mouse cursor over the tooltip box, the collapsed text will be shown in a tooltip style box.

begin [}
. .
hbegin
PORTA := 0
PORTE := 0
Led Init():

LCD_cut(l,1,txt[0]);
LCD_Cut(2,1,ext[1]):
delay_ms(1000) ;

Led Crdil);

LCD_Cut(1,1,txe[1]];
LCD_Cut (2,4, txc[2]];
delay_ms (500)

end;

Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid identifiers matching the letters you have
typed will be prompted in a floating panel (see the image below). Now you can keep typing to narrow the choice, or you
can select one from the list using the keyboard arrows and Enter.

sp

[wariable sf SPibyte
variable  sfr SPDR: bvte
variable sfr SPSR: byte
wariable  sfr SPCR: byte

Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis “(” or press Shift+Ctrl+Space. If the
name of a valid function precedes the parenthesis, then the expected parameters will be displayed in a floating panel.
As you type the actual parameter, the next expected parameter will become bold.

channel : byte
ADC_Rea

Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use Ctrl+Shift+tnumber. The same
princliple applies to the removal of the bookmarks. To jump to a bookmark, use Ctrl+number.

Go to Line

The Go to Line option makes navigation through a large code easier. Use the shortcut Ctrl+G to activate this option.
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Column Select Mode

This mode changes the operation of the editor for selecting text. When column select mode is used, highlighted text
is based on the character column position of the first character selected to the column of the last character of text
selected.

Text selected in this mode does not automatically include all text between the start and end position, but includes all
text in the columns between the first and last character selected.

Column mode editing is sometimes referred to as block mode editing as the act of selecting text forms a rectangle.

To enter this mode, press Alt + Left mouse button, drag the mouse towards the desired direction thus selecting the
text.

Editor Colors

Options

Editor Colors

Schemes

Current Scheme: |CFfice 2003 Blue - | MNew Scheme Delete

Scheme Setup 1 #DEFINE PWM SEQUENCE 0N ~
Element void Setup ABI () org Ox0041 {
Assembler
Binary X
Character sfr char P2 absolute Oxi0;
Comrment = const code const wvar = 10;
Float ) idata unsigned long long var[10] ;
Hexadecimal -
Identifier Xdata signed long ext_var;
Tllegal Char pdata char pext_wvar:
Nurmber hdata hvar:;
Octal
Preprocessar 1o gbit bit wariasble at P2.EO:
Reserved Word
Spgce float float wvariable;
String =
Symbaol unsigned int hex wvariable:
‘Web link. signed int dec varisble;
= char bin variable = 'a';
signed char octal wvarishle;

Text Attributes

Bold Underline Ttalic Strikeaut fF Inititate ABS controller for new
Foreqground: Background: S session layer
zZ0 PO = OxFO: b
Black hd Black v
_ _ float,_variable = 12.345;
Active Line Calor: hex wvarisble = Ox1234;
| J Custom v| % show Active Line dec_varisble = -12345;
hin varishle = 0h10101010;
Gutker Colors Dct;l varishle = .
Gradient From: Gradient To: — ’
tal ishle += @; /% 3
| sk Elue v| [C—whie ‘] octal varisble += @; /# illegal chara
Font: . 5
|_Blue v| asm nop; S single assembly line
@i
0K Apply Cancel
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Editor Colors option allows user to set, change and save text and color settings organized in schemes. Schemes
represent custom graphical appearance that can be applied to GUI (Graphical User Interface) to satisfy tastes of
different users.

Auto Correct

Auto Correct option facilitates the user in such a fashion that it automatically corrects common typing or spelling errors
as it types.

Options |£ |
¥ Enable Auto Correct = Add Original: Replacement:
¥ Remove | | |

Original | R.eplacement

wahie while

fi if

itn int

cahr char
Advanced

W Correct Case bo Match Declaration W Show Motification
0K Apply Cancel

This option is already set up to automatically correct some words. For example, if you type whiel, it will be corrected
to while when you press the spacebar:

while |

Autocorrect from whiel to while
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The user can easily add its common typos by entering original typo, for example btye, to the Original box, and
replacement, by te, to the Replacement box, and just click "Add" button.
Next time when the typo occurs, it will be automatically corrected.

Auto Complete (Code Templates)

Auto Complete option saves lots of keystrokes for commonly used phrases by automatically completing user's typing.

Options |£|
W Enable Auto Complete
Key word: |dow | o= Add ¥ Remove
Description; |do while |
Key word ’Description ’:
Far for {no { 1)
faors for statement
Ftemplate function header template
furiction ink func declaration
if if {na { 1)
ife if {no begin/end) else {no beginfend)
ifes if else
o |ifs if statement
proc void func declaration
“|| ptemplate header comment for a project
switch switch statement L]
do
{
iwhile (| ) ;
= i} ] |

0K Apply Cancel
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The user can insert the Code Template by typing the name of the template (for instance, dow), then press Ctrl+J and
the Code Editor will automatically generate a code:

dDmI
Auto Complete
do while

You can add your own templates to the list by entering the desired keyword, description and code of your template in
appropriate boxes.
Autocomplete macros can retreive system and project information:

- $DATE% - current system date

- $TIME% - current system time

- $DEVICES® - device (MCU) name as specified in project settings
- $DEVICE CLOCKS - clock as specified in project settings

- $COMPILERS - current compiler version

These macros can be used in template code, see template ptemplate provided with mikroPascal PRO for PIC32
installation.
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Code Explorer

The Code Explorer gives clear view of each item declared inside the source code. You can jump to a declaration of
any item by double clicking it, or pressing the Enter button. Also, besides the list of defined and declared objects, code
explorer displays message about the first error and it's location in code.

Code Explorer 3]
=
= G web links
o hikp e, mikroe, com
G Uses
= B main
% LCD_RS
% LCD_EN
% LCD_D4
% LCD_DS
% LCD_Dé
% LCD_D7

o LCD_RS_Direckion
o LCD_EM_Direckion
o LCD_D4_Direckion
o LCD_DS_Direckion
o LCD_Dé_Direckion
o LD D7 _Direckion
o kxkl

o k2

o kxkS

o kx4

i

[ Move_Delay

The following options are available in the Code Explorer:

Icon Description

E} Expand/Collapse all nodes in tree.

=4 | | Locate declaration in code.
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Routine List

Routine list diplays list of routines, and enables filtering routines by name. Routine list window can be accessed by
pressing Ctrl+L.

You can jump to a desired routine by double clicking on it, or pressing the Enter button. Also, you can sort routines by

size or by address.

Routine List X

Sort By Name Sort By Line

[

e: 74 S _main
Line: 50 GMDVE_DELBY
Line: 54  E#IShift_Text Left
Line: &4 EShift_Text_Right

Project Manager

Project Manager is IDE feature which allows the users to manage multiple projects. Several projects which together
make project group may be open at the same time. Only one of them may be active at the moment.
Setting project in active mode is performed by double clicking the desired project in the Project Manager, which will

result in bolding the project's name.
Also, the name of the currently active project will be diplayed in the Program Manager window title, alongside with the

number of projects in project group.

Project Manager [1/1] - Lcd.mpp32 c:Progr... [X]

L ELENEFEEEYES

= I_% Lcd.mpp32
=107 Sources
Led.mpas
E] Binaries
I Project level defines
[C=) Image Files
IC=) EEFROM Files
T2 Active Comments Files
=07 Output Files
Led.hesx
Led.asm
I Other Files
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Following options are available in the Project Manager:

Icon Description

% Save project Group.

Open project group.

Close the active project.

Close project group.

Add project to the project group.

Remove project from the project group.

Add file to the active project.

Remove selected file from the project.

Build the active project.

P || |G | e |\ | R |(GB | |Gk | o8

Run mikroElektronika’s Flash programmer.

For details about adding and removing files from project see Add/Remove Files from Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project Toolbar, Build Toolbar, Add/Remove
Files from Project
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Project Settings
The following options are available in the Project Settings window:
- Device - select the appropriate device from the device drop-down list.

- MCU Clock - enter the clock frequency value.
- Build/Debugger Type - choose debugger type.

Project Settings 3]
ElgmDevice

Name: | F320<460F512L v
sgvauce |
Frequency: MHz

(=] Buildf Debugger Type

Euild Type
(&) Release () ICD Debug

Debugger

(&) Software ) mikroICD

Related topics: Edit Project, Customizing Projects, Project Manager
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Library Manager

Library Manager enables simple handling libraries being used in a project. Library Manager window lists all libraries
(extension .emc1) which are instantly stored in the compiler Uses folder. The desirable library is added to the project

by selecting check box next to the library name.

In order to have all library functions accessible, simply press the button Check All ,"_1 and all libraries will be selected.

In case none library is needed in a project, press the button Clear All ||| and all libraries will be cleared from the

project.

Only the selected libraries will be linked.

Library Manager 5]

] e | ] fem ] [

= mikroE

ADC

[ EBitReverseComple:x
[ Button

[ can

[ cam_se

|:| Conversions
C_Type

] eerroM

O rFr

[ Firkadix

[ FLASH

1 aled

[ Gled_Fonts
[ 1z¢

[ tirRadix

[ keypaddx4
Lcd
Lcd_Constants
[ manchester
|:| Matrices

M
Mmc_FAT16
[ one_wire

[ Part_Expander
psz

1 pura

BB

122 O 3 O T 3 3 e B

BB

BB -

L 3 O T 3 3 O B

A

183

Icon

Description

“Uses” folder.

2, Refresh Library by scanning files in “Uses” folder. Useful when new libraries are added by copying files to

Rebuild all available libraries. Useful when library sources are available and need refreshing.

Ol |

Include all available libraries in current project.

L&

No libraries from the list will be included in current project.

L&

Restore library to the state just before last project saving.
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Managing libraries using Package Manager

The Package Manager is a tool which enables users to easily install their own libraries in the mikrolDE. Libraries are
distributed in the form of a package, which is an archive composed of one or more files, containing libraries. For more
information on Package Manager, visit our website.

Upon package installation, a new node with the package name will be created in the Library Manager. For example:

= Library Manager a
ke b | [ e e
[ sound =]
O =r

[ sP1_Ethernet

[ sP1_gled

[ =r1_ted

[ sP1_Leda

[ =p1_Tesssc

[ sprintf

[ sprinti

[ sprint!

TE963C

[ Time

[ TouchPanel

Trigonormetry

O mwr

[0 vart

= Conversions

= __Lib_Conversionsz
EybeToBinary Sty
‘WordToBinaryStr
LongWordToBinarySkr

BinaryToGray
GrayToBinary v

From the Library Manager, the user can also uninstall the desired package by right clicking the the appropriate node,
and from the drop-down menu choose Uninstall package:

[ Library Manager a
ek | [ e |

[ sound ~

[ sp1

[ SPI_Fthernet

[ sP1_cled

[] sP1_ted

[] sPI_Lcds

[ sr1_teossc

[ sprintf

[ sprinti

[ sprintl

TRIEIC

[ Time

[ TouchPane!

Trigonometry

[ mwr

[1 uart

2 = 3 = = = 2 =)

Help
Examples
Uninstall package

BinaryToiGray

GrayToBinary ,Z

Related topics: mikroPascal PRO for PIC Libraries, Creating New Library
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Routine List

Routine list diplays list of routines, and enables filtering routines by name. Routine list window can be accessed by
pressing Ctri+L.

You can jump to a desired routine by double clicking on it, or pressing the Enter button. Also, you can sort routines by
size or by address.

Routine List (3]

Sort By Mame Sort By Line

=7 -._t-rnain

Line: 50 GMove_Delav
Line: 54  EdIShift_Tewt Left
Line: &4 Edshift_Text_Right

Statistics

After successful compilation, you can review statistics of your code. Click the Statistics Icon fiL4

Memory Usage Windows

Provides overview of RAM and ROM usage in the various forms.
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Variables

Displays variables sorted by addresses.

Brivk Screen
RAM Memory Usage
o
[ static usea: sabytess 01%
[L] Owavadabie:  32768bvtes 99.9%
Total: 32768 brytes
Functions
Functions Sorted
By Mame Chart
Functions Sorted
By Size Chart
Functions Sorted
By Address Chart
Functions Tree
Summary
Froject Name: €21, |Development Systems L VA2HE VLD (C0G 2ablked mpde Time: 13LF201 1 1:03:40 P4
s R o

Used RAM Locations

Displays used RAM memory locations and their names.

Variables Sorted By Address
Varisbles
v * Chck on colurmn header to soet table by Address, Name, Unigue Assermblar Nate or Size
Address Name Unigue Assembler Name Size In Bytes
0000 RO RO 4
D004 Rl R1 4
D028 R0 R10 4
w002C R11 R11 4
Fnciont 00030 R12 R1z 4
034 R12 R13 4
mg:e‘ i) R4 R14 4
an003c RIS R1S 4
by 0:0040 R16 R16 4
00044 17 17 4
Punctions Sorted 00048 R18 R18 4
Br Addeeis Chort nec r19 R19 4
00008 R2 2 4
TR 00050 R20 R20 4
0054 R21 R2L L)
Summary 0058 R22 R22 4
@i0osc 23 = 4
00060 P24 R24 4
00064 = R2S 4
00068 R26 R26 4
a006C R27 Ra7 4
0x0070 =] ¥ 4
00074 =] =] 4
a0c R3 R3 4 &
MikroElektronika
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SFR Locations

Displays list of used SFR locations.

SFR Locations

No  Address Name Ko Address Name No  Address Name
0 OxBFE0O000 WOTCON 7 OKEFE0ADGS CMSTATCLR 774 (EFEBE0GC LATHIN
1 OxBRE0OEZD0 RTCOON 388 OxEFE0ADSC CMSTATENY 775 OWBFESS0GE LATBSET
2 OxBFEO00ZI0 RTCALRM 309 ONEFEO0ADGE CMSTATSET 776 EFBEG0A0 LATChits
3 O«BRSO0O220 RTCTIME 390 OxeFES5ICO CNCObbits 777 OWEFEBE0A4 LATCCLR
4 O«BFE0O230 RTCOATE 391 DxBFES5ICA CHCONCLR 772 (EFEBE0AC LATCR
S5 OxBFE00Z240 ALRMTIME 392 OwBFEBSICC CHCONIN 79 BFEBG0AR LATCSET
6 OxBREOOZS0 ALRMOATE 393 OeBFESAICE CNCOMSET 780 (wBFESGOED LATDbits
7 O«BFS00G00 T1COM 3% OxBFE6100 ChNEMRits 781 (uBFESEDE4 LATDCLR
& OxBFS00G610 THRL 395 OxBFES6104 CNENCLE: 782 (nEFSBE0EC LATDRY
9 OxBFE00G620 PR1 396 OxBFES610C CHENINY TES  (BFESG0ES LATOSET
10 OxBFE00S00 TaCoH 397 | OxBFES610E CHENSET o4 (BFESS120 LATEDits
11 O«BFE00A10 TR 308 EFBBSI1ED CHPUEDIts TES  (nBFESS124 LATECLR.
12 OeBFE00E20 a2 300 EFEESIES CHPUECLR TEE  EFEE6LIC LATERY
13 O:BFBO0AO0 TICON 400 OxEFEBRIEC CNPUERNY 787 OnBFESSLZE LATESET
14 O:EFBO0AI0 TMRZ 401 O:BFBBSIER CHPLUESET 788 OWBFESSIG0 LATFbits
15 OxEFBO0AZ0 PRI 402 O:EFBOSE00 CVRCONbItS 789 DMEFESG1G4 LATFCLR
16 O:EFBODCOO TACoM 403 ONEFBOSEDA CYROONCLR 70 EFES1EC LATFINY
17| OxEFBODCI0 TMR4 404 OwBFE080C CVRCONDNY 791 CuBFBESLGE LATFSET
18| O«BFBODC20 FR4 405 | OxBFBOSED8 CVRCONSET 792 (EFE8G1AD LATGhits
19 O«BFE0O0EDD TSCON 406 OxBFEEZ060 DCHOCOMbits

20 OxBFE0O0EL0 TMRS 407 OxBFeE3064 DCHIOONCLR.

21 O«BFE0OE20 ms 408 | OnBFEE306C DCHOCTMINY

22 OxBFEIZ000 1C100H 409 OxBFRAS0GA DCHIOONSET

23 (xBFBO2010 IC180F 410 OsBFEas100 DCHOCPTRbits

24 DxBFE0Z200 1C200N 411 O:EFBE3104 DCHOCPTROLE.

ROM Memory Usage

Displays ROM memory space usage

in a pie-like form.

ROM Memory Usage

OM Lsage:

DUM:

[ Free

A5 bytes 06 %

521214 bytes 994 %

524280 bytes

Functions Sorted
By Name Chart

Functions Sortad
By Sire Chart

Functions Sorted
By Address Chart.

Teea: 1{31/2011 1:08:40 P40
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ROM Memory Constants

Displays ROM memory constants and their addresses.

ROM Memory Constants
Address Name
| SO000ATC 7ICS_mtL
| ROM Memery SO000ASD 7ICS_i2
| SO0004TS 7ICS_tt3
0000480 FICS_titd
Functions Sorted
By Name Chart
Functiors Sortad
By Siee Chart
Functions Sarted
By Address Chart
Functions Tree
Summary
Praject Name: C2). . \Development SystemsiLYI2MC weiLCD (COG 2xié)iled mopd2 Time: 1/31{2001 1:03:40 P
F ]

Sorts and displays functions in various ways.

Functions Sorted By Address
e * Clck on colume header to scet table by Address, Mame, Uingue Assembler Name or Size
ROM Memary Address Mame Unigue Assembler Name Size In Bytes
Ox90000034 Move_Delay _Move_Delay 2
ROM Memcry 0¥90000894 mahn _main 488
OxID000CEA _ocaow __ocaow 7]
OXBFCDO320 __BoOTGENEXCEDT __BoomGanExcept 15
UX90000E34 __GenExcept __GenExcept 1
OxBFCO0000 __BooiStartip __PootStarip 04
Sy Name Chart Ox90000000 Delay_tus _Delay_tus ]
OxO000001C Delay_S0us _Delay_S0us ]
f_"';";:"‘ 0x0000007E: Delsy_S500us _Delay_5500u% 2
0xUD000218 Led_Cmd _ted_Cmd 424
Functions Sorted 0x90000040 Lod Che CP _Led Chr CP %
Lobilefelle 0x900003C0 Led_Init _Led_Init 1220
Ox90000004 Lod_out _Led_Out 324
Functions Tree
Summary
Projec: Hame: £11.. \Development Systems{LV-GHIE VLD (COG Bxig)iked mepda Tone: 1f31{2011 103140 FH
s mibio.con
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Functions Sorted By Name Chart

Sorts and displays functions by their name, in the ascending order.

i T S S E. R ......... ........... .

0 100 0 0 a0 S0 s 70 S0 S0 100 1000 120 130

* Bomble ik o Ay Bate can £
Praject Name: €3, . evelopment Systems|LVAZHE vE1LCO (COG 2x16)ked mepde Teee: 13112011 LOSH0FH
T

Functions Sorted By Size Chart

Sorts and displays functions by their sizes in a chart-like form.

Sho ain T e S R .
e e | e
0 100 0 300 a0 ) 500 700 s00 500 10 1400 1200 1M
e ——
Projeck Name: G-, .. evelopment SyRems|LYEHE w10 (C0G Zx16) el mpdz Teme: 13L[Z011 LO3ADFM
T T
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Functions Sorted By Addresses

Sorts and displays functions by their addresses, in the ascending order.

Doy 5D [ ‘ ...................... | U DS -

4 A E] A 4,200,000 000 -1,100,000,000
O L —
Profect Name: £, \Development Systems|LYIZME veILCD (COG 2x18)iked. mepde Teee: 13112011 10340 FM
seomvieRn

Function Tree

Displays Function Tree with the relevant data for each function.

Project Name: €1...|Development SystemellLV3zHe vEILCD (COG 2xigliked.mapde Time: /312011 10340 FH.
st ko, com

MikroElektronika
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Memory Summary

Displays summary of RAM and ROM memory in a pie-like form.

Summary
rDATA:
B static usec: 44bytes 0%
] Oomavsse:  :msbytes ®a%
Tota: 32768 bvtas

By Hame Chart FROM Lisage

Functions Sorted D Wz SldnEs O

By e Chart D Free: 521214 bytes 99,4 %

Punctions Sorted Totd: 524280 bites.

By Addreas Chart

Functions Tree.

:

Froject Name: C:)..j0evelopment SystemsLVAZMGC v6.CO (COG Ex16]ked mepaz Temes: 1312011 BO3A0FM

e mss.con
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Messages Window
Messages Window displays various informations and notifications about the compilation process.

It reports for example, time needed for preprocessing, compilation and linking; used RAM and ROM space, generated
baud rate with error percentage, etc.
The user can filter which notifications will Messages Window display by checking Errors, Warning and Hints box.

In case that errors were encountered during compiling, the compiler will report them and won’t generate a hex file. The
Messages Window will display errros at the bottom of the window by default.

The compiler also reports warnings, but these do not affect the output; only errors can interefere with the generation
of hex.

Errars Warnings Hinks
Line = Message Mo,  Message Text Unit
o 1 mPPIC32, exe -DBG -pP32ME460FS1 2L -MSF -DL -55...
i 133 Carmpilation Started C:\Program Files|Mikroglekkronikal mikroPascal PRO For PTL..
1 1015 Hink: Compiling unit "C:\Program FilesiMikroelektroni...  _ Lib_Delays.mpas
177 1010 Hink: Unit "__Lib_Delays.mpas” has been recompiled _ lib_Delays.mpas
i 134 Campiled SuccessFully C:\Program Files|Mikroglekkronikal mikroPascal PRO For PTL..
i 133 Carmpilation Started C:\Program Files|Mikroglekkronikal mikroPascal PRO For PTL..
1 1015 Hink: Compiling unit "C:\Program FilesiMikroelektroni...  LCD.mpas
] 1010 Hink: Unit "LCD.mpas" has been recompiled LCD.mpas
i 134 Campiled SuccessFully C:\Program Files|Mikroglekkronikal mikroPascal PRO For PTL..
i 139 all files Carpiled in 16 ms
a 1144 Used R¥ (bykes): 32 (100%) Free Rx (bvtes): 0(0... Used R¥ (bytes): 32 (100%) Free Rx (bvtes): 0 (0%:)
a 1144 Static RAM (bykes): 46 Dvnamic RAM (bytes): 32718 Static RAM (bykes): 46 Dyvnamic RAM (bytes): 32718
a 1144 Used ROM (bytes): 3356 (1%) Free ROM (bytes): ... Used ROM (byvtes): 3356 (1%) Free ROM (bytes): 52093...
i 145 Project Linked SuccessFully LCD.mpp3Z2
i} 140 Linked in 203 ms
i 141 Project 'LZD.mpp32' completed: 375 ms
i 103 Finished successfully: 01 Feb 2011, 068:37:28 LCD.mpp3Z2

Double click the message line in the Message Window to highlight the line where the error was encountered.
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Quick Converter

Quick Converter enables the user to easily transform numbers from one base to another.

Quick Converter 3]
Size Sign DECIMAL HEXADECIMAL  BINARY CHARACTER
Qsbits | @unsigned | 77| | oooooo+p| | 00000000 00000000 00000000 01001101 | | M|
() 16 bits
®3zbits (O Signed

FLOAT DECIMAL
136,893
gg’i:t FLOAT 32 bit (IEEE} FLOAT 32 bit (MICROCHIP) RADI% 1.15
& Hex | 4308 E4 9C | B6ORE49C| | |

The user can convert integers of various sizes (8, 16 or 32 bits), signed and unsigned, using different representation
(decimal, hexadecimal, binary and character).

Also, Quick Converter features float point numbers conversion from/to Float Decimal, Float 32bit (IEEE), Float 32bit
(Microchip) and Radix 1.15 for PIC32 family of MCUs.

Macro Editor

A macro is a series of keystrokes that have been 'recorded' in the order performed. A macro allows you to 'record' a
series of keystrokes and then 'playback’, or repeat, the recorded keystrokes.

Macros X

& a2 02|12 R

n
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The Macro offers the following commands:

Icon Description

5}? Starts ‘recording’ keystrokes for later playback.

d;';? Stops capturing keystrokes that was started when the Start Recording command was selected.

p@? Allows a macro that has been recorded to be replayed.

% | | New macro.

Z | Delete macro.

Related topics: Code Editor, Code Templates

Image Preview

There are a lot of occassions in which the user besides the code, must look at the appropriate schematics in order to
succesfully write the desired program.
The mikroPascal PRO for PIC32 provides this possibility through the Image Preview Window.

To add an image to the Image Preview Window, right click the Image Files node in the Project Manager:

Project Manager [1/1] - RS485_Master_Example.mpp32 Z3

B WY
= I_i}, RS485_Master_Example.mpp32
= ) Sources
R5485_Master_Example.mpas
[T Binaries
== Project Level Defines
- [ Image Files
[ EEPROM File
[T Active Comn
= I Cutput Files

| R54a5_

|7 Cther Files

Close Project Chrl+k

Add Project

¢ Lo

Add File To Project...

Remove File From Project

Build Chrl+F9 E

mE Programmer Fi1

MikroElektronika 712
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Now, navigate to the desired image file, and simply add it:

Project Manager [1/1] - R5485_Master_Example.mpp32 EaX]

A ELRTEEEEEY

= % RS5485_Master_Example.mpp32
E} [ sources
R.5485_Master_Example.mpas
- E] Binaries
-T2 Project Level Defines
-[C2) Image Files
- iy RS
-[C>) EEPR.OM Files
-T2 Active Commerts Files
B [ Output Files

Next, right click the added file, and choose Set As Preview Image:

Project Manager [1/1] - R5485_Master_Example.mpp32 23

[BEERIEEEIEY

= |_:="’5_~‘ R5485_Master_Example.mpp32
E| El Saurces
: R.5485_Master_Example.mpas
-[C7) Binaries
-2 Project Level Defines
-T2 Image Files
5
-I=) EEPROM Files
. E] Active Comments F Close Project Chrl+K
-T2 output Files
: RS485_Master |
----- |1 Other Files

‘ Save Project Group

Add Project

Remove Project

Add File Ta Project...

Remave File From Project

Build ChrlFo

o GLOG

mE Praogrammer Fi1

Set As Preview Image  Chri+-alt+P

3
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Once you have added the image, it will appear in the Image Preview Window:

TG LB 8
[T T—r— L]

ii

H
188491214

1

Also, you can add multiple images to the Image Files node, but only the one that is set will be automatically displayed
in the Image Preview Window upon opening the project.

By changing the Image Preview Window size, displayed image will be fit by its height in such a way that its proportions
will remain intact.

Toolbars
This section provides an overview of the toolbars available in mikroPascal PRO for PIC32 Help:

- File Toolbar

- Edit Toolbar

- Advanced Edit Toolbar
- Find Toolbar

- Project Toolbar
- Build Toolbar

- Debug Toolbar
- Styles Toolbar
- Tools Toolbar

- View Toolbar

- Layout Toolbar
- Help Toolbar

MikroElektronika 11
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File Toolbar

& HB B &

File Toolbar is a standard toolbar with the following options:

Icon Description

|j Opens a new editor window.

@ ~ | Open source file for editing or image file for viewing.

[H | Save changes for active window.

D

Save changes in all opened windows.

[T

Print Preview.

A3

Print.

Edit Toolbar

Q@@ | g [3

Edit Toolbar is a standard toolbar with the following options:

Icon Description

£@ | Undo last change.

Redo last change.

o< | |¥

Cut selected text to clipboard.

1
"
[0

Copy selected text to clipboard.

b

Paste text from clipboard.

]
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Advanced Edit Toolbar

A S

I
I

.|

Advanced Edit Toolbar comes with the following options:

Icon

Description

Lo

Comment selected code or put a single line comment if there is no selection

o

Uncomment selected code or remove single line comment if there is no selection.

EE=]
EfD

Select text from starting delimiter to ending delimiter.

EEGI
EHDJ

Go to ending delimiter.

b

Go to line.

E—' Indent selected code lines.

-'E Outdent selected code lines.

..l | Generate HTML code suitable for publishing current source code on the web.
Find/Replace Toolbar

LSRR

Find/Replace Toolbar is a standard toolbar with the following options:

Icon

Description

2

Find text in current editor.

Find next occurence.

Find previous occurence.

0 | %0 |l

Replace text.

)

Find text in files.

16
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Project Toolbar

Ein i AR MBS e RET ST

Project Toolbar comes with the following options:

Icon Description
I'ﬂ-, New project.
I% = | Open Project
I_'i;ff Save Project
| Edit project settings.
I'ig Close current project.
a-l Clean project folder.
7 | Add File To Project
[b’f Remove File From Project
Build Toolbar
T B
Build Toolbar comes with the following options:
Icon Description
‘% | Build current project.
i& Build all opened projects.
% Build and program active project.
% Start programmer and load current HEX file.

n
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Debug Toolbar

@"

Eh Gl |00 #0001 | B [ B | &

Debug Toolbar comes with the following options:

Icon Description

E—b, Start Software Simulator or mikrolCD (In-Circuit Debugger).

I-_EDJ Run/Pause Debugger.

E—E Stop Debugger.

501 | Step Into.

%, | Step Over.

g | Step Out.

2] | Run To Cursor.

= Toggle Breakpoint.

View Breakpoints Window

E@ Clear Breakpoints.

g’ | View Watch Window

o | view Stopwatch Window

Styles Toolbar

Styles toolbar allows you to easily change colors of your workspace.

Office 2003 Blue v

18
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Tools Toolbar
BL4A4A

Tools Toolbar comes with the following default options:

Icon Description

Bl | Run USART Terminal

it |EEPROM

+. | ASCIl Chart

-," Seven Segment Editor.

A@ Open Active Comment editor.

E Options menu

Tip : The Tools toolbar can easily be customized by adding new tools in Options menu window.

View Toolbar

al 1| @

View Toolbar provides access to assembly code, listing file and statistics windows.

Icon Description

ﬂ Open assembly code in editor.

[| | Open listing file in editor.

fil | View statistics for current project.

79 MikroElektronika



mikoPascal PRO for PIC32

Layout Toolbar

Styles toolbar allows you to easily customize workspace through a number of different IDE layouts.

[ efault
Legacy

10244768
[rebug layout

Messages

=l
ol
F=H]

Help Toolbar

@ .0

Help Toolbar provides access to information on using and registering compilers:

Icon

Description

@

Open Help file.

)

How To Register.

Related topics: Keyboard shortcuts, Integrated Tools
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Customizing IDE Layout
Docking Windows

You can increase the viewing and editing space for code, depending on how you arrange the windows in the IDE.

Step 1: Click the window you want to dock, to give it focus.

Project Manager

CS

DE] Sources
-- Led.mpas

El Binaries

7 Project level defines

|71 Image Files

--C=) EEPROM Files

7Y Ackive Comments Files

=07 Output Files

- Led. hes

e Lcd. asm

|7 Other Files

Step 2: Drag the tool window from its current location. A guide diamond appears. The four arrows of the diamond point
towards the four edges of the IDE.

81 MikroElektronika
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Step 3: Move the pointer over the corresponding portion of the guide diamond. An outline of the window appears in the
designated area.

I

Step 4: To dock the window in the position indicated, release the mouse button.

Tip : To move a dockable window without snapping it into place, press CTRL while dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing the name for the layout and pressing
the Save Layout Icon E
To set the layout select the desired layout from the layout drop-down list and click the Set Layout Icon .

To remove the layout from the drop-down list, select the desired layout from the list and click the Delete Layout

Icon lod .

D ebug Layout

<Default Layouts> .
Code Layout

D ebug Layout
lyout L

Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool windows along the edges of the IDE
when not in use.

- Click the window you want to keep visible to give it focus.

- Click the Pushpin Icon 2L on the title bar of the window.

MikroElektronika 82
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Praject Manager a

e — — —
] iz = Project Mana
= % Lcd.mpp32 L I% % §
= Sources = et =1
y = =2 o)
Lecd. mpas %ﬁ Sounl| = =
[T Binaties 1 iadl B3
127 Project Ifa\.-'el defines =) Binar| & ﬂ
[C=) mage Files =) Prajef =
IC=) EEFROM Files 107 Imag|| §
IT7) Bctive Comments Files IT=) EEPR 2
2107 output Files 107 dctiv 3
Led hex = outp
Lcd.asm L
07 Other Files L
I Cthe
[
(2]

When an auto-hidden window loses focus, it automatically slides back to its tab on the edge of the IDE. While a window
is auto-hidden, its name and icon are visible on a tab at the edge of the IDE. To display an auto-hidden window, move
your pointer over the tab. The window slides back into view and is ready for use.

Options

Options menu consists of three tabs: Code Editor, Tools and Output settings.

Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.

Tools

The mikroPascal PRO for PIC32 includes the Tools tab, which enables the use of shortcuts to external programs, like
Calculator or Notepad.
You can set up to 10 different shortcuts, by editing ToolO - Tool9.
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Options

J Editar

Tool Mame: | MHaotepad

File: Marne: | A IND DWW SYHOTERAD . EXE

Pararneters:

Macto: | o2HEX_FILE_Ave Fulpath andname o the au.._ v Inset

S hortzut: | F11 ll']|

9 Clear all fields

d:zFICFlazh Options

[ Cloze when finished
Tools

Tool?

Toold

Tool3

J Output

Output settings

By modifying Output Settings, user can configure the content of the output files.
You can enable or disable, for example, generation of ASM and List file.

Also, user can choose optimization level, and compiler specific settings, which include case sensitivity, dynamic link for
string literals setting (described in mikroPascal PRO for PIC32 specifics).

Build all files as library enables user to use compiled library (* . emc1) on any MCU (when this box is checked), or for a
selected MCU (when this box is left unchecked).

For more information on creating new libraries, see Creating New Library.
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Options

Dutput Settings

Output Settings
W Generate ASM fle
V' Inchade HEX opcodes
V' Includs ROM constants
¥ Include ROM Addresses
W Generake list file
¥ Inchude debug info
¥ Include source ines in output files

Case sensitive:
I Exymamic link For string lerals
¥ Buid al Fles as lbrary

I Ahways buikd ol files in project

X

Cancel




mikoPascal PRO for PIC32

Integrated Tools

Active Comments Editor

Active Comments Editor is a tool, particularly useful when working with Lcd display. You can launch it from the drop-

down menu Tools > Active Comments Editor or by clicking the Active Comment Editor Icon J@ from Tools toolbar.

Active Comments Editor E|
Enter comment narne:

|activeC0mment| |

Active Comment Actions:
New Rename Delete

Froperties:

= Attributes
Lrl
Image
File

=l Events
onLeftClick + Alt
OnRightClick,
onDblClick
OnMousever

Misc:
Add Image To Project

Add File To Project

Save Cancel
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ASCII Chart

The ASCII Chart is a handy tool, particularly useful when working with Lcd display. You can launch it from the drop-

down menu Tools » ASCII chart or by clicking the View ASCII Chart Icon . from Tools toolbar.

NUL SDH|STX ETX EOT ENQ ACK BEL | BS  HT

3z
| | 45

| | 64

112

128

160

176

192

224

o |1 |2 |34 |5 |6 |7 |38
DLE DC1 DC2 DC3 DC4 NAK SYN ETB CAN
16 [ 17 |18 |19 |20 |21 |22 [ 23 | 24

spC !I0" & % % & '
33 | 34 | 35 | 36 | 37 | 38 | 39 | 40
0 1 2 2 4 5 B 7 8
49 | 50 | 51 | 52 | 53 | 54 | 55 | 56
@ A B C D E F G H
65 | 66 | 67 | 68 | 69 | 70 | 71 | 72
P O R S T O v W X
60 | 81 | 82 | 83 | 84 | 85 a8
E a b c d e
96 | 97 | 98 | 99 [ 100 | 101
p | q r s t u
113 | 114 | 115 | 116 | 117 o (EodaE
€ O,  F . T g 01100
120 | 130 [ 131 | 132 | 133 | 134 | 146 | 196
D v i ] w » - — P -
144 | 145 | 146 | 147 | 148 | 149 | 150 | 151 | 152
i ¢ £ | = ¥ |} 8"
161 | 162 | 163 | 164 | 165 | 166 | 167 | 168
e 2 s T p 9
177 | 178 | 179 | 180 | 161 | 162 | 183 | 184
A A|A A A A E C | E
193 [ 194 [ 195 | 196 | 197 | 193 | 199 | 200
P N O 0 O 0O 0| = |@
206 | 200 | 210 | 211 | 212 | 213 | 214 | 215 | 216
alala & a & & ¢ | e
205 | 226 | 227 | 228 | 220 | Z30 | 231 | 232
d A | b |06 O 0 o+ |8
240 | 241 | 242 | 243 | 244 | 245 | 246 | 247 | 248

9
EM

25

)
41
9

a7
I

T3
Y

i)

LF | ¥T
| 11
SUB |ESC
26 | 27
=+
42 | 43
. H
55 | 59
1 K
74 | 75
z2 [
90 | 91
i k
106 | 107
z {
122 | 123
5 «
138 | 139
g »
154 | 155
a "
170 | 171
o »
186 | 187
E E
202 | 203
u u
218 | 219
& B
234 | 235
a i
250 | 251

108
124
140
156
172
14
1?8
204
220

236

252

109
125
141
157
173
12
1?9
295
2?1
237

253

S0
14

RS
a0
46
62
78
24
110
126
142
158
174
34
190

206

SI
15

us
31
47
63
79
95
111
DEL
127
143
159
175
191
207
223

239

255
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can launch it from the drop-down menu

Tools » EEPROM Editor.

When you run mikroElektronika programmer software from mikroPascal PRO for PIC32 IDE - project name.hex

file will be loaded automatically while ihex file must be loaded manually.

MikroElektronika EEPROM Editor

FF
FF
FF
FF
FF
FF
FF
FF

FF
FF
FF
FF
FF
FF
FF
FF

FF
FF
FF
FF
FF
FF
FF
FF

|%

— -
i. EEPROM Editor _
Device: | | EEPROM Size: EEPROMFil EEFROM Fie
PEOF4013 w Eytes Yahe: 0x FF | Eill Load Save
EEPROM Data

FF FF FF FF FF FF FF FF FF FF FF FF FF

FF FF FF FF FF FF FF FF FF FF FF FF FF

EEPROM Address: _ Edit Yalue;
Start Address: O FFFF
: Phri Edit
[ aukatne e .
[rex
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Graphic Lcd Bitmap Editor

The mikroPascal PRO for PIC32 includes the Graphic Lcd Bitmap Editor. Output is the mikroPascal PRO for PIC32
compatible code. You can launch it from the drop-down menu Tools > Glcd Bitmap Editor.

onika GLCD Bitmap Editor

File loaded: banner.brp

Load EMP
Irwert Ficture

GLCD Size | controber
@ 240:126 [TE963C
| 24Dube (TEOE3C)
128128 (TE963C)
") 128354 (b, yet)

"3 128332 (ot imp, yet)

Jf mmmmmmm—————— e — Al
/f GLCD Picture nawe: banner.bnp
A GLCD Model: Toshiba TE9E3C 240m128

Compikar
Jf mmmmmesmeseeneae Semmmmmmsssssmsssssseoes | @ mikroC FRO
unsigned char const benner bmp[3840] = | - '-: mikroPascal PRO
255,255,255, 255,255,265, 255, 255,255 265 255 255,265, 265 255,285, i . mikoBasic PRO:

255,255,288, 255,285, 285, 255, 288, 255,256, 285, 285, 255, 285,128, 0,

o, o, o, o, o, 0, 0, 0, o, 0, 0, O, 0, ©, O, O ’

o, 0, 1,128 ©, 0, O C"””c“"”"d""’ﬂ"
o, o o

.

o, o, o, 0, o, 0, O, 0, O,
o, 0, 6, 0, o, 0, 0, 0, 0,

. a . il : . ‘ :
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HID Terminal

The mikroPascal PRO for PIC32 includes the HID communication terminal for USB communication. You can launch it
from the drop-down menu Tools » HID Terminal.

. mikroElektronika USE (HID) Terminal =] = =]
Terminal | Descriptor
HID Devices: Info
ABBAHOME -
ABBAHOHME i
mikroE HID Library test El
Dell Premium USB Optical House -
Communication

[HID Read/urite Test Send

I~ Append CR ¥ Send as Typing

I~ &Append LF I~ Send as Mumber

armac

& asCI  HEX " DEC Clear
HID Read/Write Test -
4 13

Interrupt Assistant

mikroPascal PRO for PIC32 includes the Interrupt Assistant that assist user in configuring interrupts. Output is the code
for the configured interrupt routine. You can launch it from the drop-down menu Tools » Interrupt Assistant.

Interrupk Assistant

woid |interrupt |iv |.ﬁ.DC v| ilerel |v 4| ics |v SDFT| 0K

Mulki Meckor, SRS Priarity Level = -1, Mector Spacing = 32, EBASE = 9FCO 1000

Change
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Lcd Custom Character

mikroPascal PRO for PIC32 includes the Lcd Custom Character. Output is mikroPascal PRO for PIC32 compatible
code. You can launch it from the drop-down menu Tools > Lcd Custom Character.

MikroElektronika LCD Custom Char Generator ]

T3 LY ] = = ) )

AR e == == | L] L]
5% 10 Save... Load... Fill all clear all Invert

Preview

H+E

Font size
@ 5x7 + cursor line

() 5x10 + cursor line

I I
]
N (N
HEEEE
L]
I IIC ]
I
L

CGRAM address

Char:

Char data row:

mikroC PRO | mikroPascal PRO mikroBasic PRO

const char character[] = {0,4,4,31,4,4,0,0};

woid CustomwChar (char pos row, char pos char) {
char i:
Led Crd(64) ;
for (i = 0; i<=7; i++) Led Chr CFicharacter[i]):
Led Cmd( LCD_RETURN HOME) ;
Led Chr(pos_row, pos_char, 0):

Generate Code i Copy Code To Clipboard

91 MikroElektronika



mikoPascal PRO for PIC32

Seven Segment Editor

The Seven Segment Editor is a convenient visual panel which returns decimal/hex value for any viable combination you
would like to display on seven segment display. Click on the parts of seven segment image to get the requested value

in the edit boxes. You can launch it from the drop-down menu Tools > Seven Segment Editor or by clicking the Seven
=

h from Tools toolbar.

Segment Editor Icon

]

Seven Segment Editor

Cornrnon cathode:

113

Common anode:

142

Decoding Format:
'@ Decimnal

UDP Terminal

The mikroPascal PRO for PIC32 includes the UDP Terminal. You can launch it from the drop-down menu Tools » UDP
Terminal.

MikroElektronika UDP Terminal ]
=Siekting:
IF Address: |192.168.020.025 | Connect
=Send:
mikroElektronika | ;-—— Send —4
Append: [ CR I send as typing
LR " Send as number

mikroElektronika

Clear

~Recei

@ AsCII I HE=® | DEC

mikroElektronika
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USART Terminal

The mikroPascal PRO for PIC32 includes the USART communication terminal for RS232 communication. You can
launch it from the drop-down menu Tools » USART Terminal or by clicking the USART Terminal Icon & from Tools

toolbar.

MikroElektronika Usart Terminal

COM Port Settings
Gom Port: | COMI | : ikroElektronik 1| send Aepoat sending
Bt °900 bes b Support ASCIL © Appand New Line 65/2 |  Send ASCIL alld sending every
Stop Bits: One Stop Bit - Send as typing - - “1000 = | miliseconds
Pegtyt  Gfwens N Send from file
" Chack Parity ] [eitact Seadiag)

Data bits: .!iu'ht 2l Clear " Add Tirme.
Buffer size: 1024 »  |mikroElektronika
Flow contral: Nore
~Data For Hew Line Settings
@ ASCIL 8 CRALF (0200 + 0x0A)
DL L (0x04)
. DEC
) BIN J CR (0x0D)
i

e | oscomac Lot

* Auta Connect | O [ tevsin

[ Cleor | addTime append ta end of fls
) milrEoE Lelcrondka

| Clear |
.Connemd o COML
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Active Comments

The idea of Active Comments is to make comments alive and give old fashioned comments new meaning and look.
From now on, you can assign mouse event on your comments and 'tell' your comments what to do on each one. For
example, on left mouse click, open some web address in your browser, on mouse over show some picture and on
mouse double click open some file.

Suppose we are writing a example for a GSM/GPSR module which is connected to the EasyPIC6 and we would like to
provide a photo of our hardware (jumpers, cables, etc.). within the example.

It would also be nice to put some documentation about chip we are using and a GSM module extra board. Now we can
have all those things defined in one single comment using Active Comment Editor.

New Active Comment

When you start Active Comment Editor for the first time (from the View menu, from editor's pop-up menu, or by pressing
Ctrl + Alt + P) you will get an empty editor:

Active Comments Editor 5]
Select Active Comment: [

Active Comment Actions:
New [Renamty [mmielete

Properties:

Misic:

! Add Image To Project ]

[ Aad File To Project ]

Save Cancel

By clicking the Maw button you are prompted to enter a name for the comment:

MikroElektronika 9]



mikroPascal PRO for PIC32

Active Comments Editor 3]
Enter comment narme:

|activeComment| |

Active Comment Actions:
MNew Rename Delete

Properties:

=l Attributes
Ll
Image
File

=l Events
OnLeftClick + Ale
CnRightClick,
OnDbIClick
OnMousedver

Misc:
Add Image To Project

Add File To Project

Save Cancel

You can notice that when you start typing a name, properties pane is automatically displayed so you can edit properties

if you wish. A Comment will be is created when you click save button.
Properties are consisted of two major categories - Attributes and Events.
Attributes can be:

- URL - Valid web address.
- Image - Image has to be previously added to Project (Project Manager > Images).
- File - File has to be previously added to Project (Project Manager > Other Files).

There are four predefined event types you can apply to an Active Comment:

1. OnLeftClick + Alt
2. OnRightClick

3. OnDoubleClick
4. OnMouseOver




mikoPascal PRO for PIC32

First three event types can have one of the following three actions:

1. OpenUrl - Opens entered URL in default Web browser.

2. OpenFile - Opens a file within a default program associated with the file extension (defined by Windows).
3. None - Does nothing.

The fourth event, OnMouseOver, has only 2 actions:

1. Previewlmage - Shows image when cursor is moved over a comment.
2. None - Does nothing.

Attributes are tightly bounded with events. For example, you can not have OnLeftClick + Alt -> OpenFile if there is no
file attribute set, or if there is no file added to project. The same behavior applies to image attribute.

Let's start editing our Active Comment by entering some valid web address in the URL field:

= Atkributes
Lirl v, mikr e, corm|
Image
File
=l Events
OnLeftClick + Alt
OnRightClick.
OnDblClick.
OnMouseCver

For every Active Comment a XML file will be created, containing all valid information regarding the Active Comment -
attributes, events, etc. and it is automatically added to Project manager after saving it:

Project Manager X
A E S E N
= [, Easy_GSM_GPRS.mpp32
=07 sources
Easy_G5M_GPRS.mpas
|71 Header Files
El Binaries
[T Project Level Defines
= 77 Image Files
Easy_(G5M_GPRS.jpg
[ EEPROM Files
= 07 Active Comments Files
I- 9 activeComment . xml
IC7) Qutbput Files
|~ Cther Files
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You can see the contents of the created XML file by expanding Active Comment Editor:

Active Comments Editor ®

Enter comment name:

|activeC0mment |

Active Comment Actions:

<activeComment:>
<Attributes>

“Url-www.mikroe.com</Url>

<Image></ Image:
New Rename Rels <File></Files>
Properties: </attributes>
=) Attributes <Events:
Url www.mikroe.com| <OnLeftClicks></0nLeftClick>
Imnage <OnRightClick></0nRightClick>
File <0nDb1Click></0nDhlClick>
Y Erents ) < over></ Orer>
OnLéFtChc.k + Alt </Events>
OnRightClick, .
orDbiciick </activeComment
OnMouse Over

Misc:
Add Image To Project

Add File To Project

Save Cancel

As we mentioned above you can add image or file which are already included in project. If the the desired image or file

aren't added, you can do it directly from here by clicking the | Add Image To Project | Or Add File To Project | button.
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Next file dialog will be opened:

Look in: | I3 Images

v| 0 _13‘ e v

by Recent
Documents

File hare:

-

Filez of type:

by Metwork,

|Easy_GSM_GPRS

3

‘_Qpen ]

| Image Files[*.bmp, *jpg. *.pnal

3

[ Cancel ]

[ Open as read-only

There, you should select the desired image to be added. In our example, Easy GSM GPRS.jpg image will be added.

Selected picture is automatically added to the drop down list of the Image field in Active Comment Editor:

Active Comments Editor
Seleck Ackive Comment:

®

| activeCamment

Active Comment Ackions:
New Rename

Properties:

Delete

= Attributes

Image: E
File:

1=l Events
onLeftClick + Al
OnRightclick
onDbiClick
CnMouseCver

Ll iy mikrog, com
G3M_GPRSjpgl B

Misc:
Add Image To Project

Add Filz To Project

Cancel
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Now, when image has been selected, we can assign an event to it. For example, OnMouseOver will be used for

Previewlmage action, and OnLeftClick + Alt will be assigned to OpenUrl action:

=l Attributes
Ul v, ko, com
Image Easy_G5M_GPRS.jpg
File

=l Events

OnLeftClick + At Opentrl
OnRightClick, Mone
OnbDblClick

OnMouseCver  PreviewImage

Now we can save our changes to Active Comment by clicking the Save button.

Note: Setting file attributes is same as for image, so it won't be explained separately.

Once we have finished creating our active comment, we can notice that it has been added to source file on current caret

position with ac: prefix 'telling' IDE that it is active comment:

|7/ ac:activecomment

30

Now let's try it. If you LeftClick+Alt on it, URL in default Web browser will be opened. If you hover the mouse over it,

you will see an Image preview:

|7/ ac:activecomment
"

20

40

50
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There is another way to add an active comment to an active project. You can do it simply by typing a comment in old
fashion way, except with ac: prefix. So it would look like this:

i ac:activec‘omentg Add Comment To Project

30

Notice that when you stop typing, Add Comment To Project button will show. By clicking on it, you will open Active
Comment Editor and comment name will be already set, so you need only to adjust attributes and settings.

After saving you can always edit your active comment by Active Comment Editor, and switch between comments
directly from editor.

If you remove a file from the Project Manager or add an Active Comment File which contains information about the file
which is no longer in project, and hover the mouse over the comment, you will be prompted to either add file to project
or remove event definition from Active Comment for this file:

’E File linked to this active comment is missing!
L

would vou like to add file to a project and make events associated with
in walid , or unlink file From Active Comment?

! V ) Show mare info Yes

If you remove active comment file from the Project Manager, you'll receive this message:

'E Missing a file for this active comment!
.

Would vou like to add file to a project , or delete this Active
Camment?

( \_’ | Show more info Yes

Click on Yes button you'll prompted for an active comment file:
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Look jri | £ Easy_G5M_GPRS

v 0@ E

i ackiveComment
§ 3 activeComment2
My Recent

Documents

(L

Desktop

I,

ty Docurents

==

tdy Computer

File name: |

3

[ Open ]

Files of wpe: |Active Link. Files{*.<ml]

=]

[ Cancel ]

My Netlwork [] Open as read-only

If you click No, comment will be removed from the source code.

Renaming Active Comment

When you click on rename button, you will be prompted to enter new name:

r 3]

Active Comments E:
Select Ackive Comment:

| activeCamment - |

Active Comment Actions:
New Rename Delete

Enter new Active Comment Mame:

Rename Cancel

Properties:
1= Aktributes

Ll v, mikroe, com

Irnage Easy_35M_GPRS.jpg

File
1=l Events

OnLeftClick + Al Opentrl

OnRightClick Mone =

CnDblcClick

OrMouseCver  PreviewImage

Misc:
Add Image To Project

Add File To Project

Save Cancel
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Now click again Rename button. Now you have renamed your Active Comment in such a way that its filename, source
code name are changed:

l«’/ ac:activeCommen tRedame

30

Deleting Active Comment

Deleting active comment works similar like renaming it. By clicking on delete button, you will remove an active comment
from both code and Project Manager.
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Export Project

This option is very convenient and finds its use in relocating your projects from one place to another (e.g. from your
work computer to your home computer).

Often, project contains complicated search paths (files involved within your project could be in a different folders, even
on different hard disks), so it is very likely that some files will be forgotten during manual relocation.
In order to simplify this, Export Project gives you opportunity to do this task automatically.

To open Export Project, from Project menu select Export Project or hit Ctrl + Alt + E. The following window will
appear:

= Export Project g@

Select praject ko export:
| oPascal PRO for PIC32\Examples\Development SystemsiLY32M: waILCD (COG 2x160LC0, mpp32

Select destination Folder:

|D:'|,Pr0ject E]|

Export Project & Cancel

In the empty input boxes, current location and the destination folder of the desired project should be entered.

By default, currently active project will be set for export. You can change it any time by clicking the Open Button

Once you have entered the appropriate data, click Export Project button. After exporting is done, and if everything was
OK, you'll receive a message:

Information

j) Project successfully exported!

‘ou have successfully exported the project. Al files From
the project are now copied ko "D:Project”

Now, Export Project has copied all project files into desired folder and changed project search paths, so you can easily
move the entire folder to another location and run the project.
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Jump To Interrupt

Lets you choose which interrupt you want to jump to.

Requirement: Interrupt routine is included in project.

You can call Jump To Interrupt by selecting Run > Jump To Interrupt from the drop-down menu, or by clicking the Jump

To Interrupt Icon @ , from the Watch Values Window.

Available Interrupts

0x0000 ¢ I¥T_CORE_TIMER_VECTOR

0x0001 @ I¥T_CORE_SOFTWARE_0_VECTOR
0x0002 ¢ IYT_CORE_SOFTWARE_1_VECTOR
0x0003 : IYT_EXTERMAL_O_WECTOR

0x0004 : IYT_TIMER_1 _VECTOR

00005 ¢ IWT_INPUT _CAPTURE_1_WECTOR
00006 @ IWT_OUTPUT_COMPARE_1_VECTOR
00007 : IVT_EXTERMAL_1_WECTOR

00005 @ IWT_TIMER_Z_WECTOR

0x0009 ¢ IVT_INPUT_CAPTURE_Z_WECTOR
0x0004 @ I¥T_OUTPUT_COMPARE_2_YECTOR
0x0006 : I¥T_EXTERMAL _Z_WECTOR

0x000C @ I¥T_TIMER_3_YECTOR

00000 ¢ IVT_INPUT_CAPTURE_3_VECTOR
0x000E : I¥T_OUTPUT_COMPARE_3_VECTOR
0x000F : I¥T_EXTERMAL_3_WECTOR

00010 ¢ IWT_TIMER_4_VECTOR

00011 ¢ IWT_INPUT _CAPTURE_4_WECTOR
00012 ¢ VT _OUTPUT_COMPARE _4_VECTOR
00013 ¢ IVT_EXTERMAL_4_WECTOR

0x0014 : INT_TIMER._S_YECTOR

0x0015 : IVT_INPUT _CAPTURE_S_VECTOR
Ox0016 : IVT_OUTPUT_COMPARE_S_YECTOR
0x0017 ¢ I¥T_SPI_1_VECTOR,

0x0018 @ IYT_UART_L_VECTOR

0x0019 : I¥T_12C_1_VECTOR

0x0014 : IVT_CHAMGE_MNOTICE_WECTOR
00016 @ IVT_ADC_VECTOR

0001 ¢ IVT_PMP_VECTOR

00010 : IVT_COMPARATOR _1_VECTOR
0x001E ¢ IWT_COMPARATOR 2 VECTOR
0x001F ; I¥T_SPI_Z_VECTOR,

Ox0020 ¢ IVT_UART _2_VECTOR.

0x0021 : I¥T_12C_Z_WECTOR

0x0022 ¢ IVT_FAIL_SAFE_MONITOR_YECTOR
0x0023 : IVT_RTCC_WECTOR.

MN024 : VT DA N YFCTOR

[Jonly used K

>

By checking the Only Used box, you can display only the used breakpoints.
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Regular Expressions

Introduction

Regular Expressions are a widely-used method of specifying patterns of text to search for. Special metacharacters
allow you to specify, for instance, that a particular string you are looking for, occurs at the beginning, or end of a line, or
contains n recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special meaning described below. A series
of characters matches that series of characters in the target string, so the pattern “short” would match “short”
in the target string. You can cause characters that normally function as metacharacters or escape sequences to be
interpreted by preceding them with a backslash ™\ .

For instance, metacharacter “~” matches beginning of string, but “\ ~” matches character “~”, and “\\” matches
"\, etc.

Examples:

unsigned matches string 'unsigned’
\“unsigned matches string ' “unsigned’

Escape sequences

Characters may be specified using an escape sequences: “\n” matches a newline, “\t” a tab, etc. More generally,
\xnn, where nn is a string of hexadecimal digits, matches the character whose ASCII value is nn.

If you need wide (Unicode) character code, you can use ‘\x{nnnn}’, where ‘nnnn’ - one or more hexadecimal
digits.

\xnn - char with hex code nn

\x{nnnn) - char with hex code nnnn (one byte for plain text and two bytes for Unicode)
\'t - tab (HT/TAB), same as \x09

\n - newline (NL), same as \x0a

\r - car.return (CR), same as \x0d

\ £ - form feed (FF), same as \x0c

\a - alarm (bell) (BEL), same as \x07

\e - escape (ESC) , same as \x1b

Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\tunsigned matches 'unsigned' (predecessed by tab)

Character classes

You can specify a character class, by enclosing a list of characters in [ ], which will match any of the characters from
the list. If the first character after the “ [ is “~”, the class matches any character not in the list.
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Examples:

count[aeiou]r finds strings 'countar', 'counter', etc. but not 'countbr', 'countcr’, etc.
count[*aeiou]r finds strings 'countbr', 'countecr', etc. but not 'countar', 'counter’', etc.

Within a list, the "-" character is used to specify a range, so that a-z represents all characters between "a" and "z",
inclusive.
If you want "-" itself to be a member of a class, put it at the start or end of the list, or precede it with a backslash.

If you want '] ', you may place it at the start of list or precede it with a backslash.
Examples:

[-az] matches 'a', 'z' and '-'

[az-] matches 'a', 'z' and '-'

[a\-z] matches 'a', 'z' and '-'

[a-z] matches all twenty six small characters from 'a' to 'z’
[\n-\x0D] matches any of #10,#11,#12,#13.

[\d-t] matches any digit, '-' or 't"'.

[1-a] matches any char from "] '.."a".

Metacharacters

Metacharacters are special characters which are the essence of regular expressions. There are different types of
metacharacters, described below.

Metacharacters - Line separators

~ - start of line

$ -end of line

\A - start of text

\Z - end of text

. - any character in line

Examples:

~PORTA - matches string * PORTA ‘ only if it's at the beginning of line
PORTAS - matches string * PORTA * only if it's at the end of line
~PORTAS - matches string * PORTA * only if it's the only string in line
PORT . r - matches strings like ‘PORTZ’, ‘PORTE’, ‘PORT1’ and so on

The “~” metacharacter by default is only guaranteed to match beginning of the input string/text, and the “s”
metacharacter only at the end. Embedded line separators will not be matched by ~ or “s”.

You may, however, wish to treat a string as a multi-line buffer, such that the *~ will match after any line separator within
the string, and “$” will match before any line separator.

Regular expressions works with line separators as recommended at http://www.unicode.org/unicode/reports/tr18/
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Metacharacters - Predefined classes

\w - an alphanumeric character (including "_")
\W - a nonalphanumeric character

\d - a numeric character

\D - a non-numeric character

\'s - any space (same as [\t \n\r\f])

\'S - anon space

You may use \w, \d and \s within custom character classes.
Example:

routi\de - matches strings like 'routile', 'routi6e' and so on, butnot 'routine’, 'routime' and
so on.

Metacharacters - Word boundaries

A word boundary ("\b") is a spot between two characters that has an alphanumeric character ("\w") on one side,
and a nonalphanumeric character (" \W") on the other side (in either order), counting the imaginary characters off the
beginning and end of the string as matching a "\w".

\b - match a word boundary)
\B - match a non-(word boundary)

Metacharacters - lterators

Any item of a regular expression may be followed by another type of metacharacters - iterators. Using this
metacharacters,you can specify number of occurences of previous character, metacharacter or subexpression.

* - zero or more (“greedy”), similar to {0,}

+ - one or more (“greedy”), similar to {1,}

? - zero or one (“greedy”), similar to {0,1}

{n} - exactly n times (“greedy”)

{n,} - atleast n times (“greedy”)

{n,m} - at least n but not more than m times (“greedy”)
*? - zero or more (“non-greedy”), similar to {0,}?

+7? - one or more (“non-greedy”), similar to {1,}?

272 - zero or one (“non-greedy”), similar to {0,1}?

{n}? - exactly n times (“non-greedy”)

{n, }? - atleast n times (“non-greedy”)

{n,m}? - at least n but not more than m times (“non-greedy”)

So, digits in curly brackets of the form, {n,m}, specify the minimum number of times to match the item n and the
maximum m. The form {n} is equivalent to {n,n} and matches exactly n times. The form {n, } matches n or more
times. There is no limit to the size of n or m, but large numbers will chew up more memory and slow down execution.

If a curly bracket occurs in any other context, it is treated as a regular character.
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Examples:

count.*r B-matches strings like 'counter', 'countelkijdflkj9r' and 'countr’

count.+r - matches strings like 'counter', 'countelkijdflkj9r' butnot 'countr’

count. ?r - matches strings like 'counter', 'countar' and 'countr' butnot 'countelkj9r’
counte{2}r - matches string 'counteer'

counte{2, }r - matches strings like 'counteer', 'counteeer', 'counteeer' etc.
counte{2,3}r - matches strings like 'counteer', or 'counteeer' butnot 'counteeeer'

A little explanation about "greediness”. "Greedy" takes as many as possible, "non-greedy" takes as few as possible.
For example, 'b+' and 'b*' applied to string 'abbbbe' return 'bbbb', 'b+?' returns 'b', 'b*? " returns empty
string, 'b{2,3}?"' returns 'bb', 'b{2,3} "' returns 'bbb'.

Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " | " to separate them, so that bit|bat|bot will match
anyof "bit", "bat", or "bot" in the target string as would "b (i |a|o) t) ". The first alternative includes everything
from the last pattern delimiter (" (", " [", or the beginning of the pattern) up to the first " | ", and the last alternative
contains everything from the last " | " to the next pattern delimiter. For this reason, it's common practice to include
alternatives in parentheses, to minimize confusion about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the entire expression matches, is the
one that is chosen. This means that alternatives are not necessarily greedy. For example: when matching rou | rout
against "routine", only the "rou" part will match, as that is the first alternative tried, and it successfully matches the
target string (this might not seem important, but it is important when you are capturing matched text using parentheses.)
Also remember that "|" is interpreted as a literal within square brackets, so if you write [bit|bat|bot], you're really
only matching [biao|].

Examples:

rou(tine|te) - matches strings 'routine' or 'route'.

Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpressions. Subexpressions are numbered
based on the left to right order of their opening parenthesis. The first subexpression has number ‘1’

Examples:

(int) {8,10} matches strings which contain 8, 9 or 10 instances of the ‘int’
routi ([0-9] |a+) e matches ‘routile’, ‘routile’ , ‘routine’, ‘routinne’, ‘routinnne’ efc.

Metacharacters - Backreferences
Metacharacters \1 through \ 9 are interpreted as backreferences. \ matches previously matched subexpression #.
Examples:

(.)\1+ matches ‘aaaa’ and ‘cc’.

(.+)\1+ matches ‘abab’ and ‘123123’
(['71?) (\d+)\1 matches “13” (in double quotes), or ‘4’ (in single quotes) or 77 (without quotes) etc.
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Keyboard Shortcuts

Below is a complete list of keyboard shortcuts available in mikroPascal PRO for PIC32 IDE.

IDE Shortcuts Advanced Editor Shortcuts
F1 Help Ctrl+Space Code Assistant
Ctrl+N New Unit Ctrl+Shift+Space | Parameters Assistant
Ctrl+O Open Ctrl+D Find Declaration
Ctrl+Shift+O Open Project Ctri+E Incremental Search
Ctrl+Shift+N New Project Ctrl+L Routine List
Ctrl+K Close Project Ctrl+G Goto Line
Ctrl+F4 Close unit Ctrl+J Insert Code Template
Ctrl+Shift+E Edit Project Ctrl+Shift+. Comment Code
Ctrl+F9 Build Ctrl+Shift+, Uncomment Code
Shift+F9 Build All Ctrl+number Goto Bookmark
Ctrl+F11 Build And Program Ctrl+Shift+number | Set Bookmark
Shift+F4 View Breakpoints Ctrl+Shift+l Indent Selection
Ctrl+Shift+F5 Clear Breakpoints Ctrl+Shift+U Unindent Selection
F11 Start mE Programmer TAB Indent Selection
Ctrl+Shift+F11 Project Manager Shift+TAB Unindent Selection
F12 Options Alt+Select Select Columns
Alt + X Close mikroPascal PRO for PIC32 Ctrl+Alt+Select Select Columns
Basic Editor Shortcuts Alt + Left Arrow Fold Region (if available)

F3 Find, Find Next Alt + Right Arrow | Unfold Region (if available)
Shift+F3 Find Previous Ctri+Alt+L Convert Selection to Lowercase
Alt+F3 Grep Search, Find In Files Ctrl+Alt+U Convert Selection to Uppercase
Ctrl+A Select All Ctri+Alt+T Convert to Titlecase
CtrlI+C Copy Ctrl+T USART Terminal
Ctrl+F Find Ctrl+Q Quick Converter
Ctrl+R Replace mikrolCD Debugger and Software Simulator
Ctrl+P Print Shortcuts
Ctrl+S Save Unit F2 Jump To Interrupt
Ctrl+Shift+S Save All F4 Run to Cursor
Ctrl+V Paste F5 Toggle Breakpoint
Ctrl+X Cut F6 Run/Pause Debugger
Ctrl+Y Delete Entire Line F7 Step Into
Ctrl+Z Undo F8 Step Over
Ctri+Shift+Z Redo F9 Start Debugger

Ctrl+F2 Stop Debugger
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Ctrl+F5 Add to Watch List

Ctrl+F8 Step Out

Alt+D Disassembly View

Shift+F5 Open Watch Window

Ctrl+Shift+A Show Advanced Breakpoints
MikroElektronika
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CHAPTER 3

mikroPascal PRO for PIC32
Command Line Options

Usage: mPPIC32.exe [-<opts> [-<opts>]] [<infile> [-<opts>]] [-<opts>]]
Infile can be of *.c, *.emcl and *.pld type.

The following parameters are valid:

-P <devicename> : MCU for which compilation will be done.
-FO <oscillator>: Set oscillator [in MHz].

-SP <directory>:Add directory to the search path list.

-N <filename> : Output files generated to file path specified by filename.
-B <directory>: Save compiled binary files (* . emc1) to ‘directory’.
-0 : Miscellaneous output options.

-DBG : Generate debug info.

-MSF : Short message format.

-v : Dynamic link for string literals.

-RA : Rebuild all sources in project.

-1 : Check and rebuild new libraries.

-DL : Build all files as libraries.

-LHF : Generate Long hex format.

-PF : Project file name.

-EH <filename> : Full EEPROM HEX file name with path.
-HEAP <size>:Heap size in bytes.

-GC : Generate COFF file.

-PF : Project file name.

-5ssA : Enable SSA optimization.

-UICD : ICD build type.

-INTDEEF : Interrupt settings.

-EBASE : Exception base address.

m
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Example:

mPPIC32.exe -MSF -DBG -p32MX460F512L -Y -DL -011111114 -£fo80 -N”C:\Lcd\Lcd.mpp32”
-SP”C:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Defs”
-SP”C:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Uses”
-SP”C:\Lcd\” “_ Lib Math.emcl” “_Lib MathDouble.emcl”
“__Lib System.emcl” “_ Lib Delays.emcl” “_Lib LcdConsts.emcl” “_ Lib Lecd.
emcl” “Lcd.mpas”

Parameters used in the example:

-MsE : Short Message Format; used for internal purposes by IDE.

-DBG : Generate debug info.

-p32MxX460F5121 : MCU PIC32MX460F512L selected.

-V : Dynamic link for string literals enabled.

-DL : All files built as libraries.

-011111114 : Miscellaneous output options.

-f080 : Set oscillator frequency [in MHz].

-N”C:\Lcd\Lcd.mpp32” -SP”C:\Program Files\Mikroelektronika\mikroPascal PRO for
PIC32\Defs” : Output files generated to file path specified by filename.

-SP”C:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Defs” :Add directory
to the search path list.

-SP”C:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Uses” :Add directory
to the search path list.

-spP”C:\Lcd\” : Add directory to the search path list.

“Led.mpas” Y Lib Math.emcl” ™ Lib MathDouble.emcl” “ Lib System.emcl” ™ TLib
Delays.emcl” “ TLib LedConsts.emcl” Y Lib Led.emcl” : Specify input files.
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CHAPTER 4

Introduction

The mikrolCD is a highly effective tool for a Real-Time debugging on hardware level. The mikrolCD debugger enables
you to execute the mikroPascal PRO for PIC32 program on a host PIC32 microcontroller and view variable values,
Special Function Registers (SFR), RAM, CODE and EEPROM memory along with the mikrolCD code execution on
hardware.
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If you have appropriate hardware and software for using the mikrolCD select mikrolCD Debug Build Type before
compiling the project.

ProjectSettings @
Name: [P32M4B0F512L v
EHEHMCU Clack |

Flequenc_v: MHz Choose ICD Debug

type if you want
to use mikrolCD

=1 Build) Debugger Type debug.

Euild Type |
) Release () 1CD Debug

Debugger
) Software &) mikroICD

f

Now, compile the project by pressing Ctrl + F9, or by pressing Build Icon “% ' on Build Toolbar.

gy

Run the mikrolCD by selecting Run » Start Debugger from the drop-down menu or by clicking the Start Debugger
Icon Eh . Starting the Debugger makes more options available: Step Into, Step Over, Run to Cursor, etc. Line that is

to be executed is color highlighted (blue by default). There is also notification about the program execution and it can
be found in the Watch Window (yellow status bar). Note that some functions take more time to execute; execution is
indicated with "Running..." message in the Watch Window Status Bar.

°
. Wifatch Walues =
. é:} I-EJJ 1-3?3 DO Wy 0 o = o
50 q‘i add @ Remove <) Properties g AddAll i RemaveAll
] 3 5 5
k] Mmeliz () 8 Select variable from list:
= - Lod Cmd { LCD CLEAR) ; taxt -
. ° Led Cmd( LCD_CURSOR_OFF) ; Search for variable by assembly name:
_ltext !1
- = for i := 1 to 17 do .
Peripherals Freeze
© B begin | e
= - ~ Led Chril, i, text[i-1]);| Name value Address
e o end; PORTE 1} 0x02C8
° ! end. TRISE 0 00206
LATE 1] Ox02CH
ADPCFG 000 00 Ox0Z245
texk {.}r 00500
Running...

Related topics: mikrolCD Debugger Example, mikrolCD Debug Windows, mikrolCD Debugger Options
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mikrolCD Debugger Options

Debugger Options
e Function | Toolbar
Name Description
Key Icon
Start Debugger Starts Debugger. F9 E?}
Stop Debugger Stop Debugger. Ctrl + F2 Eh
Run/Pause Debugger | Run/Pause Debugger. F6 EDJ

Executes the current program line, then halts. If the executed
Step Into program line calls another routine, the debugger steps into the F7 01
routine and halts after executing the first instruction within it.

Executes the current program line, then halts. If the executed
program line calls another routine, the debugger will not step into

fb
Step Over it. The whole routine will be executed and the debugger halts at F8 i
the first instruction following the call.
Executes all remaining program lines within the subroutine. The
Step Out debugger halts immediately upon exiting the subroutine. F8 0w
Run To Cursor Executes the program until reaching the cursor position. Ctrl + F8 £
Toggle Breakpoint Toggle breakpoints option sets new breakpoints or removes those F5 &

already set at the current cursor position.

Related topics: Run Menu, Debug Toolbar
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mikrolCD Debugger Example

Here is a step-by-step mikrolCD Debugger Example.

Step No. 1

First you have to write a program. We will show how the mikrolCD works using this example:
program Lcd Test;

// LCD module connections

var LCD RS : sbit at LATDO bit;
var LCD EN : sbit at LATDl bit;
var LCD D4 : sbit at LATBO bit;
var LCD D5 : sbit at LATBl bit;
var LCD D6 : sbit at LATB2 bit;
var LCD D7 : sbit at LATB3 bit;

var LCD RS Direction : sbit at TRISDO bit;
var LCD EN Direction : sbit at TRISD1 bit;
var LCD D4 Direction : sbit at TRISBO bit;
var LCD D5 Direction : sbit at TRISBI bit;
var LCD D6 Direction : sbit at TRISB2 bit;
var LCD D7 Direction : sbit at TRISB3 bit;
// End LCD module connections

var text : array[l6] of char;
i : byte;

begin
ADPCFG := OXFFFF;
text := ‘mikroElektronika’;

Led Init ()
Led Cmd ( LCD CLEAR) ;
Led Cmd (LCD CURSOR_OFF) ;

for i := 1 to 17 do
Led Chr(l, i, text[i-1]);
end.
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After successful compilation and MCU programming press F9 to start the mikrolCD. After the mikrolCD initialization a

blue active line should appear.

e 47 B hegin

Wiatch Walues =
; ENENE @ m [
® . text := 'mikroElektronika': Eh E) B | 90 @ 0o o1 = -
50 e Add ¥ Remove <0 Properties g Add All Lgi Remove All
3 3 5 .
gl uadliE () 8 Select variable from list:
N - Led Cmd | LCD CLELR) ; cext -
. 9 Led Cmd( LCD CURSOR COFF) ; Seanch for variable by assembly name:
_temt !41
= = for i := 1 to 17 do
Peripherals Freeze
Bl begin
@ Led Chr(l, i, text[i-1]); Mame Walue Address
L end; PORTE 1] 0x02C5
° : end. TRISE o 0026
LATE a Ox02CH
ADPCFG 000 00 Ox02A45
+  kext .. 00500
PiZ= 0x000ZE0 0,00 us

We will debug the program line by line. Pressing [F8] we are executing code line by line. However, it is not recommended

that user does not use Step Into [F7] and Step Over [F8] over Delays routines and routines containing delays. Instead
use Run to cursor [F4] and Breakpoints functions.

All changes are read from MCU and loaded into Watch Window. Note that TRISB changed its value from 255 to 0.

5 Hvoid main(){ Wifatch Walues E
= ADPCFG = OxFFFF;
3 Zh 2} 2 | o0 % o oI i= o
& z7 Led Init(): & Add ¥ Remove < Properties kg AddAll gl Remove Al
@ H . .
WEE el (L Ry £ Select variable from list
Led Cmdi LCD CURSOR_OFF) : text -
a0 Search for variable by azsembly name:
@ H for(i = 1; i < 17; i++] { _text !41
' I LEE,_CRE (1, L, EERE[I=11] 8 Peripherals Freeze
} —
] B Marme Yalus Address
PORTE a 0x02C8
TRISE u] 0x02CE
LATE a Ox02CH
ADPCFG 0xFF FF Ox0248
+ kext {.} 00500
PC= 0x0002E4 0,00 us
111 MikroElektronika



mikoPascal PRO for PIC32

Step Into [F7], Step Over [F8] and Step Out [CtrI+F8] are mikrolCD debugger functions that are used in stepping mode.
There is also a Real-Time mode supported by the mikrolCD. Functions that are used in the Real-Time mode are Run/
Pause Debugger [F6] and Run to cursor [F4]. Pressing F4 executes the code until the program reaches the cursor
position line.

@ 47 B bhegin

Watch Walues =
ADPCFG := OxFFFF:

Bl B\l E [ E=|

e . text := 'mikroElektronika’: ‘;h ‘2:]1 E?E w0 Ay 0w 9T Q “
50 % Add Remove i Properties fwd AddAll il Remove All
N a s
° | i .
g, TAE () 8 Select variable from list:
s . Led Cmd (_LCD_CLERR) ; cext -
53 : Search for vanable by assembly name:
_test |-l
L - for i = 1 to 17 do -
Peripheral: Freeze
- B begin
- 3 © Led Cheii, i, text[i-11):| Name Yalue Address
= 9 end; PORTE 1] Ox02CE
° ) end. TRISE 0 0x02C6
LATE 1 Ox02CH
ADPCFG 0xFF FF Ox0245
+ kext {.} 0x0500

PC= 0x000204 65,55 ms

Run(Pause) Debugger [F6] and Toggle Breakpoints [F5] are mikrolCD debugger functions that are used in the Real-
Time mode. Pressing F5 marks the line selected by the user for breakpoint. F6 executes code until the breakpoint
is reached. After reaching the breakpoint Debugger halts. Here in our example we will use breakpoints for writing
“mikroElektronika” on Lcd char by char. Breakpoint is set on Lcd_Chr and the program will stop everytime this function
is reached. After reaching breakpoint we must press F6 again to continue the program execution.

@ 47 B bhegin

Watch Walues =
0 ADPCFG := OxFFFF:
ENETNE 243 =
2 . | text := 'mikroElektronika’; ‘;h ‘2:]1 ‘;_?3 w0 B 0w 9T L= “
£0 w Add 3@ Remove <U) Properties lg AddAll sl Remave All
e 3 i .
EEL_I0ilE () 8 Select variable from list:
@ a Led Cmd | LCD_CLEAR) 2 Lext -
3 ' Loed Cmd( LCD CURIOR_OFF) : Search for variable by assermbly name:
: _text !}!
= &g i
Peripheral: Freeze
E7 Led Chr(l, i, text[i-1]): Mame Yalue Address
- s . end; PORTE ] 0x02C5
= g end. TRISE 1] 0x02C6
LATE 12 Ox02CH
ADPCFG 0xFF FF Ox0245
+ kext {.} 0x0500

PC= 0x0002E2 71.06 ms
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Breakpoints are divided into two groups: hardware and software breakpoints. The hardware breakpoints are placed
in the MCU and they provide fastest debugging. Number of hardware breakpoints is limited to 8 (6 instruction, 2
data). If all hardware brekpoints are used, then the next breakpoint will be software breakpoint. These breakpoints are
placed inside the mikrolCD and simulate hardware breakpoints. Software breakpoints are much slower than hardware
breakpoints. These differences between hardware and software breakpoints are not visible in the mikrolCD software
but their different timings are quite notable. That's why it is important to know that there are two types of breakpoints.

The picture below demonstrates step-by-step execution of the code used in above mentioned examples.

. YR FERR R EFFERERFE R

Common Errors:

- Trying to program the MCU while the mikrolCD is active.
- Trying to debug Release build version of the program with the mikrolCD debugger.
- Trying to debug program code which has been changed, but has not been compiled and programmed into the MCU.
- Trying to select line that is empty for Run to cursor [F4] and Toggle Breakpoints [F5] functions.
- Trying to debug MCU with mikrolCD while Watch Dog Timer is enabled.
- Trying to debug MCU with mikrolCD while Power Up Timer is enabled.
- Trying to Step Into [F7] the mikroPascal PRO for PIC32 Library routines. Use Step Over [F8] command for
these routines.
- Itis not possible to force Code Protect while trying to debug MCU with mikrolCD.
- Trying to debug MCU with mikrolCD with pull-up resistors set to ON on RB6 and RB7.

Related topics: mikrolCD Debugger, mikrolCD Debug Windows, mikrolCD Debugger Options
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mikrolCD Debugger Windows
Debug Windows

This section provides an overview of available Debug Windows in mikroPascal PRO for PIC32:

- Breakpoints Window

- Watch Values Window

- RAM Window

- Stopwatch Window

- EEPROM Watch Window
- Code Watch Window

Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project. Doubleclicking the desired
breakpoint will cause cursor to navigate to the corresponding location in source code.

In situations when multiple breakpoints are used within the code, it is sometimes handy to enable/disable certain
breakpoints. To do this, just check/uncheck the desired breakpoint using the checkbox in front of the breakpoint’s
name.

Breakpoints 3]
Enable/Line File Mame

27 LedBlirnking.mpas

34 LedBlinking.mpas

36 LedBlinking.mpas

a7 LedBlinking. mpas

39 LedBlinking.mpas

Watch Values Window

Watch Values Window is the main Debugger window which allows you to monitor program execution. To show the
Watch Values Window, select Debug Windows » Watch from the View drop-down menu.

The Watch Values Window displays variables and registers of the MCU, with their addresses and values. Values are
updated along with the code execution. Recently changed items are coloured red.

There are two ways to add variable/register into the watch list:

- by its real name (variable’s name in program code). Just select wanted variable/register from Select
variable from list drop-down menu and click the * Add  button.
- by its name ID (assembly variable name). Simply type name ID of the variable/register you want to

display into Search for variable by assemby name box and click the iﬂi Add button.
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Also, it is possible to add all variables in the Watch Values Window by clicking | 4 AddAll | button.

To remove a variable from the Watch Values Window, just select the variable that you want to remove and then click
the x Remove button, or press the Delete key.

It is possible to remove all variables from the Watch Values Window by clicking & Remove All button.

-

You can also expand/collapse complex variables i.e. struct type variables, strings, etc, by clicking the appropriate
button ([+] or [=]) beside variable name.

Watch Yalues (3]
[z 2} 2y [ oo @ o ol ERETE |
o Add ¥ Remove <U) Properties Iy Add Al el Remove all
Select variable from list:
[wrEGL v
Search for variable by assembly name:
|_WREG1 (&)
Marne Walue Address
ADPCFG 0xFF FF Ox0ZAG
S £} 0%0508
[o] ' %0505
[1] ¥ 0%0509
[z] W 00504
[3] v 00508
[4] o 0%050C
[5] (3 00500
[8] ar 0%050E
i g 00534
WREG 005 34 00000
\WREGD 2100 00000
WREG 1 00002
PC= 0x000Z5E 9655, 99 ms

Double clicking a variable or clicking the ' “!s Froperties button opens the Edit Value window in which you can assign a
new value to the selected variable/register. Also, you can choose the format of variable/register representation between

decimal, hexadecimal, binary, float or character. All representations except float are unsigned by default. For signed
representation click the check box next to the Signed label.

(] Edit Value: PORTB
| ]

Representation

(®)Dec (O Hex CBin ) Float ) Char

[ signed 0K Cancel

An item's value can also be changed by double clicking item's value field and typing the new value directly.
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RAM Window

The RAM Window is available from the drop-down menu, View » Debug Windows > RAM.

The RAM Window displays the map of MCU’s RAM, with recently changed items colored red. The user can edit and
change the values in the RAM window.

mikrolCD Specific: RAM window content will be written to the MCU before the next instruction execution.

FLAM |

uulm|02|03|n4|05|us|o?|ualnglun|nB|nc|nD|DE|uF|ASCH |2

07500 00 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | 00 | ceeaenaaiaeiaaas
07900 00 00 00 00 0D 00 00 00 00 00 00 00 00 00 00 | 00 | caeeaeaeaeiaann
O7A00 00 00 00 0O 0O |00 Q0 0D 00 0O 00 00 00 00 | 00 | 00 ceeeeiieaieaeaaann
07800 0O | OO0 OO0 OO OO 00 OO0 |00 00 00 00 00 00 00 00 | 00 | oeeeeaeeiaann
Oo7C0f 00 00 OO 00 OO | 00 00 00 00 00 00 00 00 | 00 00 | 00 ceaeeaeeeaeaaaen
o70Of 00 00 OO 00 OO | 00 00 00 00 00 00 00 00 | 00 00 | 00 ceaeaeeeaaaaaan
O7E0| 00 00 00 | 0O OO0 OO0 OO0 00 00 00 00 | 00 00 00 00 00 | ceeeeeeeaaeaiaan
O7F0f 00 00 00 | 00O 00 OO0 OO0 00 00 00 00 | 00 00 00 00 00 | ceeeeeeeaaeaiaan
0500 4C 63 64 34 62 5] 74 ] [0 ] BB 7z 6F 45 oo g0 Lcd4bit.mikroE
os10| 69 BB 7z 6F 45 | 6C 65 66 74 7z BF 6E 69 i} 6l oo ikreElektroniks
0520 45 6l T3 79 64 73 50 49 43 34 oo oo o1 uli} o 03 EasydsPIC4. . < 1
0830 00 oo oo ] 0s 0z A 0z ] oo 15 0z ] uli} 36 01

03400 00 00 00 00 0D 00 00 00 00 00 00 00 00 00 00 | 00 | coeeeeaeaeiaann
03500 00 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | 00 | coeeeeeaeiaann
03600 00 00 00 OO0 00 00 OO0 |00 00 00 00 00 00 00 00 | 00 | oeeeeaeeiaann

£

Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu, View > Debug Windows »
Stopwatch.

The Stopwatch Window displays a Current Count of cycles/time since the last Software Simulator action.
Stopwatch measures the execution time (number of cycles) from the moment Software Simulator has started and can
be reset at any time.

Delta represents the number of cycles between the lines where Software Simulator action has started and ended.

atch Clock X
Cyiles: Time:
Current Count: [2,103,943,273 105,205
Delta: 80,881,413 4044, 07 ms
Stopwatch: 2,103,943,273 105197.16 ms
Reset To Zero
Clock: 20 MHz

MikroElektronika 122



mikroPascal PRO for PIC32

Notes:
- The user can change the clock in the Stopwatch Window, which will recalculate values for the latest specified
frequency.

- Changing the clock in the Stopwatch Window does not affect actual project settings — it only provides a simulation.
- Stopwatch is available only when Software Simulator is selected as a debugger.

EEPROM Watch Window

Note: EEPROM Watch Window is available only when mikrolCD is selected as a debugger.

To show the EEPROM Watch Window, select Debug Windows » EEPROM from the View drop-down menu.
The EEPROM Watch Window shows current content of the MCU's internal EEPROM memory.

There are two action buttons concerning the EEPROM Watch Window:

read EEPROM = - Reads data from MCU's internal EEPROM memory and loads it up into the EEPROM window.

write EEPROM | - Writes data from the EEPROM window into MCU's internal EEPROM memory.

EEPROM Watch 3]
Read EEFROM Write EEFROM
Dnlm|Dz|na|u4|n5|nﬁ|n?|us|n9|DA|DB|DC|DD|DE|DF|ASCII |ﬁ

os20| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

o330| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

0340| FF | FF | FF FF | FF | FF | FF  FF | FF | FF | FF FF | FF | FF | FF | FF

oss0| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

00| FF | FF | FF FF | FF | FF | FF  FF | FF | FF | FF  FF | FF | FF | FF | FF

o370| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

oss0| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

meo| FF | FF | FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF | FF | FF | FF

wsa0| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF  FF

00| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

oaco| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF  FF

wepo| FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF  FF

mE0| FF | FF | FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF | FF | FF | FF

osFo| FE | FF | FF FF | FF | FF | FF FF | FF | FF | FF FF | FF | FF | FF | FF

04000 00 00 00 00 00 00 | 00 00 00 | 00 | 00 00 00 | 00 | 00 00 e

0410 00 00 | 00 00 00 OO0 00 00 | 00 | 00 00 00 00 00 00 00 | eeeeeiiaean

04200 00 00 00 00 00 00 | 00 00 00 | 00 | 00 00 00 | 00 | 00 00 e

0430 00 oo oo oo oo oo oo oo oo oo oo oo oo oo oo L I

0440 00 00 | 00 00 OO0 OO 00 00 | 00 | 00 | 00 00 00 00 00 00 | aeeeeniiaean

04500 00 00 00 00 00 00 | 00 00 00 | 00 | 00 00 00 | 00 | 00 00 e

0460 00 oo oo oo oo oo oo oo oo oo oo oo o oo oo [

04700 00 00 00 00 00 00 | 00 00 00 00 | 00 00 00 | 00 | 00 00 e

0480 | 00 oo oo oo oo oo oo oo oo oo oo oo oo oo oo oo

0400 00 00 0D 0O OO0 OO0 OO0 00 | 00 0O 0D 0O OD 00 00 a0

O4A0| OO 00 00 00 | 00 | 0O | 0O 0O 0D 00 00 00 |00 |00 | 00 00

narnd_nn nn nn nn nn nn nn nn nn nn nn nn nn nn nn N0 i b
STATUS: Idle
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Code Watch Window

Note: Code Watch Window is available only when mikrolCD is selected as a debugger.

To show the Code Watch Window, select Debug Windows » Code from the View drop-down menu.

The Code Watch Window shows code (hex format) written into the MCU.

There is one action button concerning the Code Watch Window:

consuming operation so the user should wait until the reading is over.

Also, you can set an address scope in which hex code will be read.

CODE Watch =

- Reads code from the MCU and loads it up into the Code Window. Code reading is resources

Address Scope
ooooon | | oogaao| | ]
0o | 02 | 04 06 08 04 0c 0E | ASCIT ~
0200 | A7SOI0 | ABZECA | 470060 | AG4010 | A9OZCA | AT4010 | AGO2CA | z08eco | <DLE=PSE" .G <DLES
0210 | 460010 | ASOZDE | A70010 | AS02D6 | OFFF96 | 470060 | AG3010 | A9e2cA | <DLE> | O <STH=" <DL
0220 | 473010 | ABGZCA | 470060 | AG2010 | A942CA | AT2010 | AG42CA | 470060 | <DLE=05EbLT .G <DL
0230 | 461010 | ASZ2CA | A7IOND | AGZ2CA | 470060 | AGODI0 | A902CA | A70010 | <DLE> <DLE:| E'© <DI
0240 | AG02CA | 2088C0 | AGOOI0 | ABOZDE | AFODI0 | ASOZDE | OFFFFC | z08sco | E <STHET A T<SRCH <D
0250 | A0010 | 370002 | O7FFe4 | 370001 | OFFFE6 | FASDOD | 060000 | FAODDZ | <DLE | <5TR: Fd§<
0260 | 37000F | zoosoo | SFEF4D | 370019 | 200C00 | 9FEF40 | 370016 | 200840 | <50x 7. <BS»<SPC: €
0270 | 9FEF40 | 370013 | 200040 | 9FEF40 | 370010 | 200800 | 9FEF40 | 370000 | @ ¥ <DC3: 7@ <R
0280 | 97B@4E | E10061 | G2FFEE | 97BB4E | E10062 | G2FFEE | 97BE4E | E10063 | M .—a AT9ZN —b.5
0290 | 32FFEE | 97BE4E | E10064 | 3EFFEE | 37FFF0 | 97B3E | SO0DEL | S7006E | 1Y2ZM —d.ATp2ayTs
0za0 | 402010 | SFEF40 | 7EiFe0 | OFFF9E | BI00ZF | 2088C0 | A10010 | EFzo00 | <DLE>€@ @€ <05
0260 | 980700 | 97EGAE | 470060 | 408010 | EOO410 | 32000C | 97BGAE | 470060 | . <BELL="® .— .Gl
ozco | 408010 | 7e4010 | FEEOO0 | 7EAFE0 | OFFF3Z | BI00ZF | 200011 | 470060 | <DLE>€@ <DLE> @x .1
0200 | 408810 | SFFFEF | 2088CO | AOOD10 | FASO00 | 060000 | FAOOOZ | EFzo00 | <DLE> "@T97 A "=SPC
0260 | 984700 | S0400E | E10468 | 310009 | 20001C0 | 7EIFE0 | OFFF7E | BI00ZF | . G7 <30= @O h <EOT:
02F0 | 07FF31 | B3CO11 | 470060 | 40CB10 | 37FFF4 | FASO00 | 060000 | FAOO0Z | 1 §<BELL: <DC1=A®®
0300 | EFz000 | 984700 | SO400E | E10468 | 310009 | 200180 | 7EIFE0 | OFFFE7 | . <SPCH, GT <50>@C
0310 | B100ZF | O7FF20 | B3CO11 | 470060 | 40CB10 | 37FFF4 | FASOO0 | 060000 | f . <SPC> §<BELL: <T
0320 | 2088EF | ZOFFFO | B7AOZ0 | 200000 | BFAD34 | 200040 | B72044 | FAODOD | §7<SPC: 8 §<SPC <SF
0330 | 02030% | 000000 | ZFFFFO | BFAZAR | OFFFID | 200000 | FAIFGD | OFFF4F | @ <ETR=<STR>. . 39/
0340 | B100ZF | zosein | 7eiFe0 | 200060 | 7EIFE0 | 200010 | 7FEIFE0 | OFFFE7 | [ . <DLE: teSPC:E£ <
0350 | B100GF | zomesn | 7EiFe0 | 200060 | FEAFE0 | 200020 | 7FEIFE0 | OFFFFF | 0. O T<SPCH€ <US:
0360 | BIOOSF | 200CCE | 273987 | EDZO0E | 3AFFFE | ED2010 | 3AFFFC | 200010 | 0.+ E <FR=<SpCs+9
0370 | 781FE0 | O7FF3S | B1002F | 208700 | 7EAFE0 | 200010 | 7EIFE0 | 200010 | € <USEx 5 §<BELL= [ .
0380 | 781FE0 | O7FFED | B1006F | 208810 | 7EIFE0 | 200050 | 7EIFE0 | 200020 | € <USmxm§<BELL0 v
o)) 3
STATLS: Idle
MikroElektronika
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mikoPascal PRO for PIC32

Software Simulator

The Source-level Software Simulator is an integral component of the mikroPascal PRO for PIC32 environment. It is

designed to simulate operations of the Microchip PIC32 MCUs and assist the users in debugging code written for these
devices.

Upon completion of writing your program, choose Release build Type in the Project Settings window:

Projeck Settings
Sl Device

Name: | P32mM+<460F5120 -

=4 MCU Clack

IIE

Choose Release type 5 _
if you want to use 'e““e"':”' HH=

software simulator

(=) Buildf Debugger Type

EBuild Type
*) Relea () 10D Debug

Debugger
(%) Software ) mikrolCD

After you have successfuly compiled your project, you can run the Software Simulator by selecting Run > Start
Debugger from the drop-down menu, or by clicking the Start Debugger Icon E?} from the Debugger Toolbar.

Starting the Software Simulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor, etc. Line
that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruction lines, but it cannot fully emulate
PIC32 device behavior, i.e. it doesn’t update timers, interrupt flags, etc.

Related topics: Software Simulator Debug Windows, Software Simulator Debugger Options
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Software Simulator Debug Windows

Debug Windows
This section provides an overview of available Debug Windows in mikroPascal PRO for PIC32:

- Breakpoints Window

- Watch Values Window

- RAM Window

- Stopwatch Window

- EEPROM Watch Window
- Code Watch Window

Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project. Doubleclicking the desired
breakpoint will cause cursor to navigate to the corresponding location in source code.

In situations when multiple breakpoints are used within the code, it is sometimes handy to enable/disable certain
breakpoints. To do this, just check/uncheck the desired breakpoint using the checkbox in front of the breakpoint’s
name.

Breakpoints 3]
Enable/Line File Name
27 LedBlinking.mpas
34 LedBlinking. mpas
36 LedBlinking.mpas
a7 LedElinking. mpas
39 LedBlinking.mpas

Watch Values Window

Watch Values Window is the main Debugger window which allows you to monitor program execution. To show the
Watch Values Window, select Debug Windows > Watch from the View drop-down menu.

The Watch Values Window displays variables and registers of the MCU, with their addresses and values. Values are
updated along with the code execution. Recently changed items are coloured red.

There are two ways to add variable/register into the watch list:

- by its real name (variable's name in program code). Just select wanted variable/register from Select
variable from list drop-down menu and click the # Add  button.
- by its name ID (assembly variable name). Simply type name ID of the variable/register you want to

display into Search for variable by assemby name box and click the Iﬂi Add button.

121 MikroElektronika



mikoPascal PRO for PIC32

Also, it is possible to add all variables in the Watch Values Window by clicking = g Add All  button.

To remove a variable from the Watch Values Window, just select the variable that you want to remove and then click
the x Remove  button, or press the Delete key.

It is possible to remove all variables from the Watch Values Window by clicking . Remaowe All button.

You can also expand/collapse complex variables i.e. struct type variables, strings, etc, by clicking the appropriate
button ([#] or[=]) beside variable name.

Watch Yalues 3]
E?], EDJ |'§?3 S0 o8 ] | @ F@ o O
w Add 3¢ Remove <U) Properties Iy AddAll kel Remove All
Select variable from list:
WEEGL v|
Search for variable by assembly name:
|_WREGT &
Mame Walue Address
ADPCFG 0xFF FF Ox02 45
= bxid £} 0x0308
[ w' Dx0E0G
[1] i 0x%0809
2] i Dx0E04
[3] ¥ %0308
[4] o' D080
[5] e %0300
[&] o 0x0E0E
i 3 0x0834
WREG 005 34 00000
WREGD 2100 00000
WREGT 1 Ox0002
PC= 0x00025E 9655, 99 ms

Double clicking a variable or clicking the 3 Propertiez button opens the Edit Value window in which you can assign a

new value to the selected variable/register. Also, you can choose the format of variable/register representation between
decimal, hexadecimal, binary, float or character. All representations except float are unsigned by default. For signed
representation click the check box next to the Signed label.

(] Edit Value: PORTB
| ]

Representakion

() Dec (O Hex BN ) Float ) char

[] signed 0K Cancel

An item's value can also be changed by double clicking item's value field and typing the new value directly.
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RAM Window

The RAM Window is available from the drop-down menu, View » Debug Windows > RAM.

The RAM Window displays the map of MCU’s RAM, with recently changed items colored red. The user can edit and
change the values in the RAM window.

mikrolCD Specific: RAM window content will be written to the MCU before the next instruction execution.

oulm|02|03|04|05|06|0?|oalng|0A|DB|DC|UD|DE|0F|ASCII

o700y 0o 00 i} o0 o1 0o oo i} ol | 0o oo ili} oo oo oo O0 | v
o7a0) 0o o0 i} o0 o1 0o oo i} ol | 0o oo ili} oo oo oo O0 | v
O7FA0| OO | OO0 00 0O 0O 0O 00 00 00 00 00 00 00 00 | 00 | OO0 cceeeeaeaeeiaean
0700 0O 00 00 00 00 00 00 |00 00 00 00 00 00 00 00 | 00 | caeeeiaaiaaiaans
070 00 | 00 00 0O OO 0O OO0 OO0 00 0O 00 00 00 00 00 | 00 eoeeriaaaaniaaas
o700 00 | 00 00 0O 00 0O 00 00 00 00 00 00 00 00 | 00 | 00 ceeeeaieaeenaans
O7EQ| 0O 00 00 00 00 00 00 |00 00 00 00 00 00 00 00 | 00 | caeeeeeaeaaiaann
O7F0| 0O 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | coeeeeeaeaeiaann
0500 4C 53 &4 34 62 69 74 i) 1) 69 5B 72 &F 45 uln] &0 Lcd4bit.mikroE
0810| 69 BB 72  6F | 45 | 6C | 65 6B 74 72  6F 6E | 69 68 61 00 | ikroElektronike
mazn| 45 el 73 | 79 64 73 S0 49 | 43 3 00 00 01 | 00 | OC | 03 EasydsPIC4..s
0830 000 00 00 00 05 02 A6 |02 00 OO0 15 |02 00 OO0 36 | O1

0340| 00 00 00 OO0 0D 0O OO0 |00 00 00 00 00 00 00 00 | @0 | ceeeeeaeaeiaenns
0350| 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | 00 | ceeeeeaeaeieenn
0sE0| 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | 00 | cieeenaaiaiiaans

Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu, View > Debug Windows >
Stopwatch.

The Stopwatch Window displays a Current Count of cycles/time since the last Software Simulator action.
Stopwatch measures the execution time (number of cycles) from the moment Software Simulator has started and can
be reset at any time.

Delta represents the number of cycles between the lines where Software Simulator action has started and ended.

watchclock ______ ®
Cyiles: Time:
Current Count: |2,103,943,273 105,20 5
Delta; §0,561,413 4044.07 ms
Stopwatch: 2,103,943,273 10519716 ms
Clock: a0 MHz
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Notes:
- The user can change the clock in the Stopwatch Window, which will recalculate values for the latest specified
frequency.

- Changing the clock in the Stopwatch Window does not affect actual project settings — it only provides a simulation.
- Stopwatch is available only when Software Simulator is selected as a debugger.

EEPROM Watch Window

Note: EEPROM Watch Window is available only when mikrolCD is selected as a debugger.

To show the EEPROM Watch Window, select Debug Windows » EEPROM from the View drop-down menu.
The EEPROM Watch Window shows current content of the MCU's internal EEPROM memory.

There are two action buttons concerning the EEPROM Watch Window:

Read EEFROM | - Reads data from MCU's internal EEPROM memory and loads it up into the EEPROM window.

write EEPROM | - Writes data from the EEPROM window into MCU's internal EEPROM memory.

EEPROM Watch =
Read EEPROM Write EEPROM
Dnlm||32||33|D4|Ds|ns|n7|nﬁ|m9|na|na|DC|DD|DE|DFlASCII |ﬁ

nszo| FF | FF | FF | FF FF FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF

n3a0| FF | FF | FF | FF FF FF | FF | FF | FF | FF  FF | FF | FF | FF | FF | FF

0340| FF | FF | FF | FF FF FF | FF | FF FF | FF FF | FF | FF | FF | FF  FF

00| FF | FF | FF | FF  FF FF | FF | FF FF | FF FF | FF | FF | FF | FF  FF

00| FF | FF | FF | FF FF FF | FF | FF FF | FF FF | FF | FF | FF | FF  FF

o370| FF | FF | FF | FF FF FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

o30| FF | FF FF | FF FF FF | FF | FF | FF FF FF | FF | FF | FF | FF  FF

o3| FF | FF FF | FF FF FF | FF | FF | FF FF FF | FF | FF | FF | FF  FF

osa0| FF | FF | FF (FF FF FF FF | FF | FF | FF | FF FF | FF | FF | FF | FF

00| FF | FF FF | FF FF FF | FF | FF | FF FF FF | FF | FF | FF | FF FF

osco| FF | FF | FF (FF  FF FF FF | FF | FF | FF | FF FF | FF | FF | FF | FF

ospo| FF | FF | FF (FF  FF  FF FF | FF | FF | FF | FF FF | FF | FF | FF | FF

00| FF | FF FF | FF FF FF | FF | FF | FF FF FF | FF | FF | FF | FF  FF

ool FF | FF  FF | FF FF FF | FF | FF | FF FF FF | FF | FF | FF | FF  FF

o400 00 | 00 00 00 00 00 00 | 00 00 00 00 | 00 00 00 00 00 e

0410 00 | 00 00 00 00 00 00 | 00 00 00 00 | 00 00 00 00 00 e

04204 00 00 | 00 00 00 00 0D OO0 00 OO0 00 | 00 00 | 00 00 00 eeeeeaeaeeniniin

04304 00 00 | 00 00 00 00 0D 00 00 00 00 | 00 00 | 00 00 00 eeeeeaeaeeniniin

04404 00 00 | 00 O0 00 00 0D OO0 0D 00 00 | 00 00 | 00 00 00 eeeeeaeaeeniaiin

04504 00 00 | 00 00 00 00 0D 00 00 00 00 | 00 00 | 00 00 00 eeeeeaeaeeninian

04604 00 00 | 00 Q0 00 00 0D 00 00 00 00 | 00 00 | 00 00 00 eeeeaeeaeeniniin

04704 00 00 | 00 00 00 00 0D OO0 00 00 00 | 00 00 | 00 00 00 eeeeeaeaeeniaiin

04804 00 00 | 00 00 00 00 0D OO0 0D 00 00 | 00 00 | 00 00 00 eeeeeaeaeeniniin

0490f 00 00 | 00 00 00 00 00 00 00 00 00 | 00 00 | 00 00 00 eeeeeeeaeeaainn

04A0| 00 | 00 00 | 00 00 00 00 00 a0 | 00 00 00 | 00 00 00 00 ceeeeeeeaaniia

naenl on | on  on L on non an non oo o on . on 00l an o0 nn 00 —
STATUS: Idle
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Code Watch Window

Note: Code Watch Window is available only when mikrolCD is selected as a debugger.

To show the Code Watch Window, select Debug Windows > Code from the View drop-down menu.

The Code Watch Window shows code (hex format) written into the MCU.

There is one action button concerning the Code Watch Window:

consuming operation so the user should wait until the reading is over.

Also, you can set an address scope in which hex code will be read.

CODE Watch

Address Scope
| oooaon | | oog00| | ]
oo | 0z | 04 06 03 04 oC 0E | ASCIT b
0200 | ATSOLD | ASZECA 470060 AE40L0 A302CA A74010 A302CA 20830 | <DLE=PSE" " .G <DLE=
0210 | AB00L0 | ASOZDE A7O0L0 A3020E 07FF95 470060 AE3010 agezca | <DLE= |0 <5TH=" <DL
0220 | ATI0L0 | ASEZCA 470060 AE2010 A342CH A72010 A34ZCA 470060 | <DLE=DFEL" " .G <DLl
0230 | ABL010 | A9ZECA A71010 AZZCA 470050 AE0010 AI0ZCA a70010 | <DLE> <DLE>] E"@ <D
0240 | As0zCA | 208800 AE0010 A8020E ATO0L0 A0206 07FF7C zogaco | E <5TR=" A "<SPC> <D
0250 | As00L0 | 370002 O7FFE4 370001 07FFaE FAS000 060000 Fagooz | <DLE> . <5Ta= Fd i
0260 | 37000F | 200800 SFEF40 370019 200000 IFEF4D 370016 200940 | <50= .7, <BIE<SPCH E
0270 | 9FBF4D | 3FO0L3 200040 GFEF40 370010 200500 9FEF40 7oo0n | @& <DC3E T @ <R
0280 | 97BS4E | E10061 32FFEE I7BS4E E10062 32FFEE 97BE4E E10063 | M .—a.4i¥2M —b.a
0290 32FFEE | 97BS4E E10064 32FFEE 3TFFFO 97B53E SO00EL s7ones | TVEM —d.AT¥2a47 s
0za0 | 408010 | 9FEF40 FalFa0 07FFIE B1002F 208300 A10010 EFz000 | <DLE= €@ @ i £ US>
0260 | 980700 | 97BSAE 470060 403010 EQ0410 320000 I7BSAE 470060 | . <BELL®"@® —" .G <[
02c0 | 408010 | 7E4010 FES000 781F30 07FF32 B1002F 200011 470060 | <DLE= €@ <DLE> @x .1
0200 | 408810 | 3FFFEF 208300 A00010 FAS000 060000 FADO0Z EFzO00 | <DLE= “@i§7 & "<SPC
0ZE0 | 984700 | 90400E El0463 310009 2001C0 7B1FE0 07FF7a El00ZF | - G" <50% @0 h <E0T:
0zF0 | 0FFF31 | B3COLL 470060 40CE10 37FFF4 FAS000 060000 Fanonz | 1 <BELL® <DC1= A3
0300 | EFZ000 | 984700 90400E E10465 310009 200150 751FE0 O7FFE7 | . <3PCHTL G7 <505 @C
0310 | BlOOZF | OFFFZ0 B3C011 470060 400510 37FFF4 FAS000 060000 | f . <SPCH §<BELL= <C
0320 | 2083EF | 20FFFD BFADZD 200000 B7AD34 200040 B72044 FAOO0D | §7<SPCH 8 §<5PCs <5F
0330 | 020303 | 000000 ZFFFFO B7AZAS 07FFLD 200000 781Fa0 O7FF4F | @ <ETH><STH= . . 8%/
0340 B100ZF | 208610 FE1FE0 200060 7E1FE0 200010 751FE0 07FFg7 | f & <DLE=T<5SPC=€ <
0350 | BLOOSF | 208890 FalFa0 200060 7a1Fa0 200020 781Fa0 O7FF7F | 0% O T=3PC= € <U5=
0360 | BLODEF | 200CCE 273957 EDZ00E 3AFFFE EDZ010 3AFFFC 200010 | 0 £E <FFr<SPC» 9
0370 | 7siFS0 | O7FF3S E1002F 208700 7a1Fa0 200010 781Fa0 200010 | € <US=x 5 §<BELL> [ .+
0380 | 7BIFS0 | OFFFED E1005F 208510 7a1Fa0 200050 781Fa0 200020 | € <US=xm $<BELL= 0. %
M >
STATUS: Idle

- Reads code from the MCU and loads it up into the Code Window. Code reading is resources
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Software Simulator Debugger Options

Debugger Options
_— Function | Toolbar
Name Description
Key Icon
Start Debugger Starts Debugger. F9 E?}
Stop Debugger Stop Debugger. Ctrl + F2 IE—E
Run/Pause Debugger | Run/Pause Debugger. F6 EDJ

Executes the current program line, then halts. If the executed
Step Into program line calls another routine, the debugger steps into the F7 18
routine and halts after executing the first instruction within it.

Executes the current program line, then halts. If the executed
program line calls another routine, the debugger will not step into

Pt
Step Over it. The whole routine will be executed and the debugger halts at F8 e
the first instruction following the call.
Executes all remaining program lines within the subroutine. The
5
Step Out debugger halts immediately upon exiting the subroutine. F8 @
Run To Cursor Executes the program until reaching the cursor position. Ctrl + F8 g
Toggle Breakpoint Toggle breakpoints option sets new breakpoints or removes those F5 =

already set at the current cursor position.

Related topics: Run Menu, Debug Toolbar
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CHAPTER 6

mikroPascal PRO for PIC32
Specifics

The following topics cover the specifics of mikroPascal PRO for PIC32 compiler:

- ANSI Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- Linker Directives

- Built-in Routines

- Code Optimization
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Predefined Globals and Constants

To facilitate PIC32 programming, the mikroPascal PRO for PIC32 implements a number of predefined globals and
constants.

All PIC32 SFRs are implicitly declared as global variables of volatile word. These identifiers have an external linkage,
and are visible in the entire project. When creating a project, the mikroPascal PRO for PIC32 will include an appropriate
(*.mpas) file from defs folder, containing declarations of available SFRs and constants (such as PORTB, ADPCFG, etc).
All identifiers are in upper case, identical to nomenclature in the Microchip datasheets.

For a complete set of predefined globals and constants, look for “Defs” in the mikroPascal PRO for PIC32 installation
folder, or probe the Code Assistant for specific letters (Ctrl+Space in the Code Editor).

Predefined project level defines

mikroPascal PRO for PIC32 provides predefined project level defines that you can use in your project :
First one is equal to the name of selected device for the project. For example:

{SIFDEF P32MX460F512L}

%éﬁNDIF}

Second one is equal to the family name :

{SIFDEF PIC32}

%éﬁNDIF}

Related topics: Project Level Defines
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Accessing Individual Bits

The mikroPascal PRO for PIC32 allows you to access individual bits of 32-bit variables. It also supports sbit and bit
data types.

Lets use the Zero bit as an example. This bit is defined in the definition file of the particular MCU as :

const Z = 1;
var 7Z bit : sbit at SR.BI;

To access this bit in your code by its name, you can write something like this:

// Clear Zero Bit
SR.Z := 0;

In this way, if Zero bit changes its position in the register, you are sure that the appropriate bit will be affected.
But, if Zero bit is not located in the designated register, you may get errors.

Another way of accesing bits is by using the direct member selector (.) with a variable, followed by a primary expression.
Primary expression can be variable, constant, function call or an expression enclosed by parentheses. For individual bit
access there are predefined global constants 20, B1, .. , B31, 0r0, 1, .. 31, with 31 being the most significant bit

// predefined globals as bit designators
// Clear bit 0 in STATUS register
SR.BO := 0;

// literal constant as bit designator
// Set bit 5 in STATUS register
SR.5 := 1;

// expression as bit designator

// Set bit 6 in STATUS register

i =5

SR. (i+1) := 1;

In this way, if the target bit changes its position in the register, you cannot be sure that you are invoking the appropriate bit.

When using literal constants as bit designators instead of predefined ones, make sure not to exceed the appropriate
type size.

This kind of selective access is an intrinsic feature of mikroPascal PRO for PIC32 and can be used anywhere in the
code. Identifiers BO—B31 are not case sensitive and have a specific namespace. You may override them with your own
members B0-B31 within any given structure.

Also, you can access the desired bit by using its alias name, in this case z bit:

// Set Zero Bit
Z bit :=1;

In this way, if the Zero bit changes its register or position in the register, you are sure that the appropriate bit will be
affected.

See Predefined Globals and Constants for more information on register/bit names.
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sbit type

The mikroPascal PRO for PIC32 compiler has sbit data type which provides access to bit-addressable SFRs.
You can declare a sbit varible in a unit in such way that it points to a specific bit in SFR register:

unit MyUnit;

var Abit: sbit; sfr; external; // Abit is precisely defined in some external file, for
example in the main program unit

implementation

end.

In the main program you have to specify to which register this sbit points to, for example:

program MyProgram;

var Abit: sbit at PORTB.O; // this is where Abit is fully defined

begin

end.

In this way the variable 2bi t will actually point to PORTB.0. Please note that we used the keyword sfr for declaration
of Abit, because we are pointing it to PORTB which is defined as a sfr variable.

In case we want to declare a bit over a variable which is not defined as st r, then the keyword s r is not necessary,
for example:

unit MyUnit;

var AnotherBit: sbit; external; // Abit is precisely defined in some external file, for
example in the main program unit

implementation
end.
program MyProgram;

var MyVar: byte;
var Abit: sbit at MyVar.0; // this is where Abit is fully defined

begin

end.
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at keyword

You can use the keyword “at” to make an alias to a variable, for example, you can write a library without using register
names, and later in the main program to define those registers, for example:

unit MyUnit;

var PORTAlias: byte; external; // here in the library we can use its symbolic name
iﬁélementation

end.

program MyProgram;

;g; PORTAlias: byte at PORTB; // this is where PORTAlias is fully defined

gééin

end.

Note : Bear in mind that when using a t operator in your code over a variable defined through a external modifier,
appropriate memory specifer must be appended also.

bit type

The mikroPascal PRO for PIC32 compiler provides a bit data type that may be used for variable declarations. It can not
be used for argument lists, and function-return values.

var bf : bit; // bit variable
There are no pointers to bit variables:
varptr———bit; // invalid
An array of type bit is not valid:
var—arr{s5+—bit; // invalid
Note :

- Bit variables can not be initialized.

- Bit variables can not be members of records.
- Bit variables do not have addresses, therefore unary operator @ (address of) is not applicable to these variables.

Related topics: Predefined globals and constants, External modifier
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Interrupts

The PIC32MX generates interrupt requests in response to interrupt events from peripheral modules. The Interrupt
module exists external to the CPU logic and prioritizes the interrupt events before presenting them to the CPU.
The PIC32MX Interrupts module includes the following features:

- Up to 96 interrupt sources.

- Up to 64 interrupt vectors.

- Single and Multi-Vector mode operations.

- Five external interrupts with edge polarity control.

- Interrupt proximity timer.

- Module freeze in Debug mode.

- Seven user-selectable priority levels for each vector.

- Four user-selectable subpriority levels within each priority.

- User-configurable shadow set based on priority level (this feature is not available on all devices; refer to
the specific device data sheet for availability).

- Software can generate any interrupt.

- User-configurable interrupt vector table location.

ISRs are organized in IVT. ISR is defined as a standard function but with the i v directive afterwards which connects the
function with specific interrupt vector. For more information on IVT refer to the PIC32 Family Reference Manual.

Configuring Interrupts
The PIC32MX interrupt controller can be configured to operate in one of two modes:

- Single Vector mode - all interrupt requests will be serviced at one vector address (mode out of reset).
- Multi-Vector mode - interrupt requests will be serviced at the calculated vector address.

Single Vector Mode

In this mode, the CPU always vectors to the same address. This means that only one ISR can be defined.
The Single Vector mode address is calculated by using the Exception Base (EBase) address (its address
default is 0X9FC01000E). The exact formula for Single Vector mode is as follows: Single Vector Address =
EBase + 0x200.

Multi Vector Mode

In this mode, the CPU vectors to the unique address for each vector number. Each vector is located at a
specific offset, with respect to a base address specified by the EBase register in the CPU.

The individual vector address offset is determined by the following equation: EBase + (Vector_Number x
Vector_Space) + 0x200.

By default, the compiler configures interrupts in the Multi Vector mode, with the EBase address set to
0x9FC01000 and vector spacing of 32.
Configuring the Interrupt operating mode is performed in the Edit Project window.
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Interrupt Priorities

In the Multi Vector Mode, the user is able to assign a group priority and group subpriority level to each of the
interrupt vectors. The user-selectable priority levels range from 1 (the lowest priority) to 7 (the highest).

If an interrupt priority is set to zero, the interrupt vector is disabled for both interrupt and wake-up purposes. Interrupt
vectors with a higher priority level preempt lower priority interrupts.

The subpriority will cause that when two interrupts with the same priority are pending, the interrupt with the highest

subpriority will be handled first. The user-selectable subpriority levels range from 0 (the lowest subpriority) to 3 (the
highest).

Interrupts and Register Sets

The PIC32MX family of devices employs two register sets, a primary register set for normal program execution and a
shadow register set for highest priority interrupt processing.

Register Set Selection in Single Vector Mode

In Single Vector mode, you can select which register set will be used. By default, the interrupt controller will
instruct the CPU to use the first register set. This can be changed later in the code.

Interrupts and Register Sets
When a priority level interrupt matches a shadow set priority, the interrupt controller instructs the CPU to use

the shadow set. For all other interrupt priorities, the interrupt controller instructs the CPU to use the primary
register set.

Interrupt Coding Requirements

In order to correctly utilize interrupts and correctly write the ISR code, the user will need to take care of these things:
1. Write the Interrupt Service Routine. You may use Interrupt Assistant to easily write this routine.
2. Initialize the module which will generate an interrupt.
3. Set the correct priority and subpriority for the used module according to the priorities set in the Interrupt

Service Routine.
4. Enable Interrupts.

Interrupt Service Routine

Interrupt service routine is defined in this way:

procedure interrupt(); iv IVT ADC; ilevel 7; ics ICS SOFT;
begin

// Interrupt service routine code
end;
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where:

- iv - reserved word that inform the compiler that it is an interrupt service routine.

- IVT_ADC - appropriate Interrupt Vector.

-ilevel 7 - Interrupt priority level 7.

- ics Interrupt Context Saving; Interrupt Context Saving can be performed in several ways:

1. 1Cs sSOFT - Context saving is carried out by the software.

2. 1CS SRS - Shadow Register set is use for context saving.

3. 1CSs OFF - No context saving

4, 1Cs AUTO - Compiler chooses whether the 1cs sOFT or 1Cs SRS will be used.

User can explicitly declare starting interrupt routine address using org directive:

procedure interrupt(); org 0x9D000000; iwv IVT ADC; ilevel 7; ics ICS SOFT;
begin

// Interrupt service routine code
end;

Function Calls from Interrupt

Calling functions from within the interrupt routine is possible. The compiler takes care about the registers being used,
both in “interrupt” and in “main” thread, and performs “smart” context-switching between two of them, saving only the
registers that have been used in both threads. It is not recommended to use a function call from interrupt. In case of
doing that take care of stack depth.

Use the DisableContextSaving to instruct the compiler not to automatically perform context-switching. This means that
no register will be saved/restored by the compiler on entrance/exit from interrupt service routine.

This enables the user to manually write code for saving registers upon entrance and to restore them before exit from
interrupt.
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Interrupt Example

Here is a simple example of handling the interrupts from Timer1 (if no other interrupts are allowed):

program Timerl interrupt;

procedure TimerlInt(); iv IVT TIMER 1; ilevel 7; ics ICS SRS;

begin
T1IF bit := 0;
LATB := not PORTB;

end;

begin
AD1PCFG := OxFFFF;
TRISB = 0;
LATB = OxAAAA;
TMR1 := 0;
PR1 := 65000;
T1IPO bit := 1;
T1IP1 bit := 1;
T1IP2 bit := 1;
TCKPSO bit := 1;
TCKPSl_bit = 1;

EnableInterrupts();

T1IE bit := 1;
ON__TICON bit :=
end.

//
//

Clear TI1IF
Invert PORTB

Initialize AN pins as digital
initialize PORTB as output
Initialize PORTB value

reset timer value to zero
Load period register

set interrupt
priority
to 7

Set Timer Input Clock
Prescale value to 1:256

Enable Timerl Interrupt
Enable Timerl
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Linker Directives

mikroPascal PRO for PIC32 uses an internal algorithm to distribute objects within memory. If you need to have a
variable, constant or a routine at the specific predefined address, use the linker directives absolute and org.

When using these directives, be sure to use them in proper memory segments, i.e. for functions it is the KSEGO and
for variables it is the KSEG1. Linker directives are used with the virtual addresses.

Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the variable is multi-byte, higher bytes will be
stored at the consecutive locations.

Directive absolute is appended to declaration of a variable:

// Variable x will occupy 1 word (16 bits) at address 0xA0000000
var x : word; absolute 0xA0000000;

// Variable y will occupy 2 words at addresses 0xA0000000 and 0xA0000002
var y : longint; absolute 0xA0000000;

Be careful when using the absolute directive, as you may overlap two variables by accident. For example:

// Variable i will occupy 1 word at address 0xA0000002;
var 1 : word; absolute 0xA0000002;

// Variable will occupy 2 words at 0xA0000000 and O0xA0000002; thus,

// changing i changes jj at the same time and vice versa
var jj : longint; absolute 0xA0000000;

Directive org

Directive org specifies the starting address of a constant or a routine in ROM. It is appended to the constant or a routine
declaration.

To place a constant array in Flash memory, write the following :

// Constant array MONTHS will be placed starting from the address 0x9D000000

const MONTHS : array[l..l12] of byte = (31,28,31,30,31,30,31,31,30,31,30,31); org
0x800;

If you want to place simple type constant into Flash memory, instead of following declaration:

const SimpleConstant : byte = 0xAA; org 0x9D000000;

use an array consisting of single element :

const SimpleConstant : array[l] of byte = (0xAA); org 0x9D000000;
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In first case, compiler will recognize your attempt, but in order to save Flash space, and boost performance, it will automatically
replace all instances of this constant in code with it’s literal value.

In the second case your constant will be placed in Flash in the exact location specified.

To place a routine on a specific address in Flash memory you should write the following :

procedure proc (par : byte); org 0x9D000000;

begin

// Procedure will start at address 0x9D000000;

end;

org directive can be used with main routine too. For example:

program Led Blinking;

begin org 0x9D000000; // main procedure starts at 0x9D000000

end.

Directive orgall
Use the orgall directive to specify the address above which all routines and constants will be placed. Example:
begin
orgall (0x9D000000); // All the routines, constants in main program will be above the

address 0x9D000000

end.
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Built-in Routines

mikroPascal PRO for PIC32 compiler provides a set of useful built-in utility functions. Built-in functions do not have any
special requirements. You can use them in any part of your project.

The Delay us and Delay ms routines are implemented as “inline”; i.e. code is generated in the place of a call, so the
call doesn’t count against the nested call limit.

The Vdelay ms, Vdelay advanced ms, Delay Cyc, Delay Cyc Long, Get Fosc kHz and Get Fosc Per
Cyc are actual Pascal routines. Their sources can be found in the delays.mpas file located in the uses folder of the
compiler.

-Lo

- Hi

- Higher

- Highest
- LoWord
- HiWord

-Inc
- Dec

- Chr
-Ord

- SetBit
- ClearBit
- TestBit

- Delay_us

- Delay_ms

- Vdelay_ms

- Vdelay_Advanced_ms
- Delay_Cyc

- Delay_Cyc_Long

- Clock_kHz

- Clock_MHz

- Get_Fosc_kHz

- Get_Fosc_Per_Cyc

- Reset
- Clrwdt

- DisableContextSaving

- SetFuncCall
- SetOrg

- GetDateTime
- GetVersion
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- KVAO_TO_KVA1
- KVA1_TO_KVAO
-KVA_TO_PA

- PA_TO_KVAO

- PA_TO_KVA1

- CP0O_Get

- CPO_Set

- Enablelnterrupts
- Disablelnterrupts

Lo

Prototype function Lo (number: longint): byte;

Description | Function returns the lowest byte of numbe r. Function does not interpret bit patterns of number — it
merely returns 8 bits as found in register.
This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.

Parameters | - number: input number

Returns Lowest 8 bits (byte) of number, bits 7..0.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

Example d := 0x12345678;
tmp := Lo(d); // Equals 0x78
Lo(d) := 0xAA; // d equals 0x123456AA

Notes None.

Hi

Prototype function Hi (number: longint): byte;

Description | Function returns next to the lowest byte of numbe r. Function does not interpret bit patterns of numbe r
— it merely returns 8 bits as found in register.
This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.

Parameters |- number: input value

Returns Returns next to the lowest byte of number, bits 8..15.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

Example d := 0x12345678;
tmp := Hi(d); // Equals 0x56
Hi(d) := OxAA; // d equals 0x1234AA78

Notes None.
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Higher
Prototype function Higher (number: longint): byte;
Description | Function returns next to the highest byte of number. Function does not interpret bit patterns of number
— it merely returns 8 bits as found in register.
This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.
Parameters | - number: input number
Returns Returns next to the highest byte of number, bits 16..23.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
Example d := 0x12345678;
tmp := Higher(d); // Equals 0x34
Higher (d) := 0xAA; // d equals 0x12AA5678
Notes None.
Highest
Prototype function Highest (number: longint): byte;
Description | Function returns the highest byte of number. Function does not interpret bit patterns of number — it
merely returns 8 bits as found in register.
This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.
Parameters | - number: input number
Returns Returns the highest byte of number, bits 24..31.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
Example d := 0x12345678;
tmp := Highest(d); // Equals 0x12
Highest (d) := 0OxAA; // d equals 0xAA345678
Notes None.
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LoWord
Prototype function LoWord (val longint) : word;
Description | The function returns low word of val. The function does not interpret bit patterns of val — it merely
returns 16 bits as found in register.
Parameters :
- val:input value
Parameters | number
Returns Low word of val, bits 15. . 0.
Requires Nothing.
Example d := 0x12345678;
tmp := LoWord(d),; // Equals 0x5678
LoWord (d) := 0xAAAA; // d equals 0x1234AAAA
Notes None.
HiWord
Prototype function HiWord (val longint) : word;
Description | The function returns high word of va 1. The function does not interpret bit patterns of va1 — it merely
returns 16 bits as found in register.
Parameters :
- val:input value
Parameters | number
Returns High word of va 1, bits 31. .16.
Requires Nothing.
Example d := 0x12345678;
tmp := HiWord(d),; // Equals 0x1234
HiWord(d) := 0xAAAA; // d equals 0OxAAAA5678
Notes None.
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Inc
Prototype procedure Inc (var par longint) ;
Description | Increases parameter par by 1.
Parameters |- par: value which will be incremented by 1
Returns Nothing.
Requires Nothing.
Example p :=4;
Inc(p); // p is now 5
Notes None.
Dec
Prototype procedure Dec (var par longint) ;
Description | Decreases parameter par by 1.
Parameters |- par: value which will be decremented by 1
Returns Nothing.
Requires Nothing.
Example p = 4;
Dec(p); // p is now 3
Notes None.
Chr
Prototype function Chr (code : byte) char;
Description | Function returns a character associated with the specified character code . Numbers from 0 to 31
are the standard non-printable ASCII codes.
This is an “inline” routine; the code is generated in the place of the call.
Parameters |- code :inputcharacter
Returns Nothing.
Requires Nothing.
Example ¢ := Chr(10); // returns the linefeed character
Notes None.
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Ord
Prototype function Ord(const character char) : byte;
Description | Function returns ASCII code of the character.
This is an “inline” routine; the code is generated in the place of the call.
Parameters |- character:input character
Returns ASCII code of the character.
Requires Nothing.
Example c := Ord(‘'A’); // returns 65
Notes None.
SetBit
Prototype procedure SetBit (var register : word; rbit : byte);
Description | Function sets the bit rbit of register . Parameter rbit needs to be a variable or literal with value
0..15. For more information on register identifiers see Predefined Globals and Constants .
This is an “inline” routine; the code is generated in the place of the call.
Parameters |- register : desired register
- rbit: desired bit
Returns Nothing.
Requires Nothing.
Example SetBit (PORTB, 2); // Set RBZ2
Notes None.
ClearBit
Prototype procedure ClearBit (var register : byte; rbit : byte);
Description | Function clears the bit rbit of register. Parameter rbit needs to be a variable or literal with value
0..7. See Predefined globals and constants for more information on register identifiers.
This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.
Parameters |- register :desired register
- rbit: desired bit
Returns Nothing.
Requires Nothing.
Example ClearBit (PORTC, 7),; // Clear RC7
Notes None.
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TestBit

Prototype function TestBit (register , rbit : byte) : byte;

Description | Function tests if the bit rbit of register is set. If set, function returns 1, otherwise returns 0.
Parameter rbi t needs to be a variable or literal with value 0..7. See Predefined globals and constants
for more information on register identifiers.

This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against
the nested call limit.

Parameters |- register :desired register
- rbit: desired bit

Returns If the bit is set, returns 1, otherwise returns 0.

Requires Nothing.

Example flag := TestBit (PORTE, 2); // 1 if RE2 is set, otherwise 0

Notes None.

Delay _us

Prototype procedure Delay us(Time In us: dword);

Description | Creates a software delay in duration of Time In us microseconds.

This is an “inline” routine; the code is generated in the place of the call, so the call doesn’t count
against the nested call limit.

Parameters |- Time In us: delay time in microseconds. Valid values: constant values, range of applicable
constants depends on the oscillator frequency

Returns Nothing.

Requires Nothing.

Example Delay us(10); // Ten microseconds pause

Notes None.

Delay_ms

Prototype procedure Delay ms (Time In ms: dword);

Description | Creates a software delay in duration of Time_In_ms milliseconds.

This is an “inline” routine; the code is generated in the place of the call, so the call doesn’t count
against the nested call limit.

Parameters |- Time In ms: delay time in milliseconds. Valid values: constant values, range of applicable
constants depends on the oscillator frequency

Returns Nothing.

Requires Nothing.

Example Delay ms (1000); // One second pause

Notes For generating delays with variable as input parameter use the Vdelay_ms routine.
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VDelay_ms

Prototype

procedure VDelay ms (Time ms : word);

Description

Creates a software delay in duration of Time_ms milliseconds. Generated delay is not as precise as
the delay created by Delay_ms.

Parameters |- Time ms: delay time in milliseconds
Returns Nothing.
Requires Nothing.
Example var pause : word;
VDelay ms (pause); // ~ one second pause

Notes

None.

VDelay advanced_ms

Prototype procedure VDelay advanced ms(time ms, Current Fosc kHz: word);

Description | Creates a software delay in duration of time_in_ms milliseconds (a variable), for a given oscillator
frequency. Generated delay is not as precise as the delay created by Delay_ms.
Note that Vdelay_ms is library function rather than a built-in routine; it is presented in this topic for
the sake of convenience.

Parameters |- time ms: delay time in milliseconds
-Current Fosc kHz:frequency in kHz

Returns Nothing.

Requires Nothing.

Example pause := 1000;
fosc 10000;
VDelay advanced ms (pause, fosc); // Generates approximately one second
pause, for a oscillator frequency of 10 MHz

Notes None.

Delay Cyc

Prototype procedure Delay Cyc(x: word; y: word);

Description | Creates a delay based on MCU clock. Delay lasts for x*16384 + y MCU clock cycles.

Parameters |- x: NumberOfCycles divided by 16384
- y: remainder of the NumberOfCycles/16384 division

Returns Nothing.

Requires Nothing.

Example Delay Cyc(l, 10); // 1x16384 + 10 = 16394 cycles pause

Notes Delay Cyc is a library function rather than a built-in routine; it is presented in this topic for the sake

of convenience.
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Delay Cyc Long
Prototype procedure Delay Cyc Long(CycNo : word);
Description | Creates a delay based on MCU clock. Delay lasts for CycNo MCU clock cycles.
Parameters |- Cyclo: number of MCU cycles
Returns Nothing.
Requires Nothing.
Example Delay Cyc Long(16384); // 16384 cycles pause
Notes Delay Cyc Long is a library function rather than a built-in routine; it is presented in this topic for
the sake of convenience.
Clock_kHz
Prototype function Clock kHz () : longint;
Description | Returns device clock in kHz, rounded to the nearest integer.
This is an “inline” routine; the code is generated in the place of the call.
Parameters | None.
Returns Device clock in kHz, rounded to the nearest integer.
Requires Nothing.
Example clk := Clock kHz();
Notes None.
Clock_MHz
Prototype function Clock MHz () : word;
Description | Returns device clock in MHz, rounded to the nearest integer.
This is an “inline” routine; the code is generated in the place of the call.
Parameters | None.
Returns Device clock in MHz, rounded to the nearest integer.
Requires Nothing.
Example clk := Clock MHz();
Notes None.
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Get_Fosc _kHz

Prototype function Get Fosc kHz () longint;

Description | Function returns device clock in kHz, rounded to the nearest integer.

Parameters | None.

Returns Device clock in kHz.

Requires Nothing.

Example clk := Get Fosc kHz();

Notes -Get Fosc kHz is a library function rather than a built-in routine; it is presented in this topic for the
sake of convenience.

Get_Fosc_Per_Cyc

Prototype function Get Fosc Per Cyc() : word;

Description | Function returns device’s clock per cycle, rounded to the nearest integer.
Note that Get Fosc Per Cyc is library function rather than a built-in routine; it is presented in this
topic for the sake of convenience.

Parameters | None.

Returns Device clock in kHz.

Requires Nothing.

Example var clk per cyc : word;
clk per cyc := Get Fosc Per Cyc();

Notes None.

Reset

Prototype procedure Reset () ;

Description | This procedure is equal to assembler instruction reset.

Parameters | None.

Returns Nothing.

Requires Nothing.

Example Reset (); // Resets the MCU

Notes None.
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Clrwdt

Prototype procedure ClrWdt () ;

Description | This procedure is equal to assembler instruction c1 rwdt.
Parameters | None.

Returns Nothing.

Requires Nothing.

Example Clrwdt (); // Clears WDT

Notes None.

DisableContextSaving

Prototype procedure DisableContextSaving () ;

Description | Use the DisableContextSaving() to instruct the compiler not to automatically perform context-
switching. This means that no register will be saved/restored by the compiler on entrance/exit from
interrupt service routine. This enables the user to manually write code for saving registers upon
entrance and to restore them before exit from interrupt.

Parameters | None.

Returns Nothing.

Requires This routine must be called from main.

Example DisableContextSaving(); // instruct the compiler not to automatically
perform context-switching

Notes None.
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SetFuncCall

Prototype procedure SetFuncCall (FuncName: string);

Description | If the linker encounters an indirect function call (by a pointer to function), it assumes that any routine
whose address was taken anywhere in the program can be called at that point if it's prototype matches
the pointer declaration.

Use the SetFuncCall directive within routine body to instruct the linker which routines can be called
indirectly from that routine :

SetFunCCall (called funcl[, ,...])

Routines specified in the setrFunccall argument list will be linked if the routine containing
SetFunCCall directive is called in the code no matter whether any of them was explicitly called or
not.

Thus, placing setFuncCall directive in main will make compiler link specified routines always.

Parameters |- FuncName: function name

Returns Nothing.

Requires Nothing.

Example procedure first (p, g: byte);
begin

SetFuncCall (second); // let linker know that we will call the routine
‘second’
end

Notes The setFunccall directive can help the linker to optimize function frame allocation in the compiled

stack.
SetOrg

Prototype procedure SetOrg(RoutineName: string; address: longint);

Description | Use the setOrg (); routine to specify the starting address of a routine in ROM.

Parameters |- RoutineName: routine name
- address: starting address

Returns Nothing.

Requires This routine must be called from main.

Exan"ﬂe SetOrg (UART1 Write, 0x1234);

Notes None.
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DoGetDateTime
Prototype function DoGetDateTime () : string;
Description | Use the GetDateTime () to get date and time of compilation as string in your code.
Parameters | None.
Returns String with date and time when this routine is compiled.
Requires Nothing.
Example str := GetDateTime () ;
Notes None.
GetVersion
Prototype function GetVersion() : string;
Description | Use the GetvVersion ();to get the current version of compiler.
Parameters | None.
Returns String with current compiler version.
Requires Nothing.
Example str := GetVersion(); // for example, str will take the value of
‘8.2.1.6"7
Notes None.

KVAO_TO_KVAT

Prototype function KVAO TO KVAl (Address: dword) : dword;
Description | Function converts virtual address from KSEGO to the virtual address in the KSEG1.
Parameters | Desired Virtual address in the KSEGO.
Returns Virtual address in the KSEG1.
Requires Nothing.
Example address := KVAO TO KVAI (0x9FC00000) ;
Notes None.
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KVA1_TO_ KVAO

Prototype function KVAl TO KVAO (Address: dword) dword;
Description | Function converts virtual address from KSEG1 to the virtual address in the KSEGO.
Parameters | Desired Virtual address in the KSEG1.
Returns Virtual address in the KSEGO.
Requires Nothing.
Example address := KVAl TO KVAQ (0xBFC00000) ;
Notes None.
KVA_TO_PA
Prototype function KVA TO PA (Address: dword) : dword;
Description | Function converts virtual address from any Kernel segment to the appropriate physical address.
Parameters | Desired Virtual Address.
Returns Appropriate physical address.
Requires Nothing.
Example address := KVA TO PA(0xBFC00000) ;
Notes None.
PA_TO_KVAO
Prototype function PA TO KVAOQ (Address: dword) dword;
Description | Function converts physical address to the virtual address in the KSEGO.
Parameters | Desired physical address.
Returns Appropriate virtual address in the KSEGO.
Requires Nothing.
Example address := PA TO KVAO (0x1D000000) ;
Notes None.
PA_TO_KVA1
Prototype function PA TO KVAIL (Address: dword) dword;
Description | Function converts physical address to the virtual address in the KSEG1.
Parameters | Appropriate virtual address in the KSEG1.
Returns Virtual address in the KSEG1.
Requires Nothing.
Example address := PA TO KVAIL (0x1D000000) ;
Notes None.
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CPO_GET

Prototype function CP0 GET (const register: TCPOREG): dword;

Description | Function returns the value of the coprocessor register or part of the register, based upon the argument
entered.

Parameters | Parameter must be a constant from the enumerated built-in constants list, which can be found at the
bottom of this page.

Returns Value of the coprocessor register or part of the register.

Requires Nothing.

Example var register value : dword;
register value := CPO_GET (CPO_CONFIG) ;

Notes None.

CPO_SET

Prototype procedure CPO SET (const register: TCPOREG; value: dword);

Description | Function sets the value of the coprocessor register or part of the register, based upon the register
argument.

Parameters | Function sets the value of the coprocessor register or part of the register, based upon the register
argument.

Returns Nothing.

Requires Nothing.

Example CPO_SET (CPO_CONFIG, 0x1A2C0000);

Notes None.

Enablelnterrupts

Prototype procedure EnableInterrupts();
Description | Function enables interrupts.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example EnableInterrupts () ;
Notes None.
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Disablelnterrupts

199

Prototype procedure DisablelInterrupts();
Description | Function disables interrupts.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example EnableInterrupts () ;
Notes None.
Coprocessor Registers
CPO_HWRENA CPO_BADVADDR CPO_COUNT CPO_COMPARE CPO_STATUS
CPO_INTCTL CPO_SRSCTL CPO_SRSMAP CPO_CAUSE CPO_EPC
CPO_PRID CP0_EBASE CPO_CONFIG CPO_CONFIG1 CP0O_CONFIG2
CPO_CONFIG3 CPO_DEBUG CPO_TRACECONTROL CPO_TRACECONTROL2 CPO_USERTRACEDATA
CPO_TRACEBPC | CP0O_DEBUG2 CPO_DEPC CP0_ERROREPC CPO_DESAVE
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Copressor Register Fields

CPO_HWRENA_MASK

CPO_STATUS_IE

CPO_STATUS_EXL

CPO_STATUS_ERL

CP0O_STATUS_UM

CPO_STATUS_IMO

CPO_STATUS_IM1

CPO_STATUS_IPL

CPO_STATUS_IM2

CPO_STATUS_IM3

CPO_STATUS_IM4

CPO_STATUS_IM5

CPO_STATUS_IM6

CPO_STATUS_IM7

CP0O_STATUS_CEE

CPO_STATUS_NMI

_CPO_STATUS_SR

CPO_STATUS_TS

CPO_STATUS_BEV

CPO_STATUS_RE

CP0O_STATUS FR

CP0O_STATUS RP

CPO_STATUS_CUO

CPO_STATUS_CU1

CP0O_STATUS_CU2

CPO_STATUS_CU3

CPO_INTCTL_VS

CPO_INTCTL_IPPCI

CPO_INTCTL_IPTI

CPO_SRSCTL_CSS

CPO_SRSCTL_PSS

CPO_SRSCTL_ESS

CPO_SRSCTL_EICSS

CP0O_SRSCTL_HSS

CP0O_SRSMAP_SSV0

CPO_SRSMAP_SSV1

CPO_SRSMAP_SSV2

CPO_SRSMAP_SSV3

CP0_SRSMAP_SSV4

CP0_SRSMAP_SSV5

CP0_SRSMAP_SSV6

CP0O_SRSMAP_SSV7

CPO_CAUSE_EXCCODE

CPO_CAUSE_IPO

CPO_CAUSE_IP1

CPO_CAUSE_RIPL

CPO_CAUSE_IP2

CPO_CAUSE_IP3

CPO_CAUSE_IP4

CP0_CAUSE._IP5

CPO_CAUSE_IP6

CPO_CAUSE_IP7

CPO_CAUSE_WP

CPO_CAUSE_IV

CPO_CAUSE_PCI

CPO_CAUSE_DC

CPO_CAUSE_CE

CPO_CAUSE_TI

CPO_CAUSE_BD

CPO_PRID_REVISION

CP0O_PRID_PATCHREV

CPO_PRID_MINORREV

CP0O_PRID_MAJORREV

CP0O_PRID_PROCESSORID

CPO_PRID_COMPANYID

CPO_EBASE_CPUNUM

CPO_EBASE_EBASE

CPO_CONFIG_KO

CPO_CONFIG_MT

CP0_CONFIG_AR

CPO_CONFIG_AT

CPO_CONFIG_BE

CPO_CONFIG_DS

CP0_CONFIG_MDU

CPO_CONFIG_SB

CPO_CONFIG_UDI

CPO_CONFIG_KU

CPO_CONFIG1_M

CPO_CONFIG1_FP

CPO_CONFIG1_EP

CPO_CONFIG1_CA

CPO_CONFIG1_WR

CPO_CONFIG1_PC

CPO_CONFIG1_MD

CPO_CONFIG1_C2

CPO_CONFIG1_DA

CPO_CONFIG1_DL

CPO_CONFIG1_DS

CPO_CONFIG1_IA

CPO_CONFIG1_IL

CPO_CONFIG1_IS

CP0O_CONFIG1_MMUSIZE

CPO_CONFIG1_M

CPO_CONFIG2_M

CPO_CONFIG3_TL

CPO_CONFIG3_SM

CPO_CONFIG3_SP

CPO_CONFIG3_VINT

CPO_CONFIG3_VEIC

CPO_CONFIG3_ITL

CPO_CONFIG3 M

CPO_DEBUG_DSS

CPO_DEBUG_DBP

CP0_DEBUG_DDBL

CP0_DEBUG_DDBS

CPO_DEBUG_DIB

CPO_DEBUG_DINT

CP0_DEBUG_DIBIMPR

CP0_DEBUG_R

CPO_DEBUG_SST

CPO_DEBUG_NOSST

CP0_DEBUG_DEXCCODE

CPO_DEBUG_VER

CPO_DEBUG_DDBLIMPR

CP0_DEBUG_DDBSIMPR

CP0_DEBUG_IEXI

CPO_DEBUG_DBUSEP

CPO_DEBUG_CACHEEP

CPO_DEBUG_MCHECKP

CP0_DEBUG_IBUSEP

CP0_DEBUG_COUNTDM

CPO_DEBUG_HALT

CPO_DEBUG_DOZE

CPO_DEBUG_LSNM

CPO_DEBUG_NODCR

CP0_DEBUG_DM

CPO_DEBUG_DBD

CP0_TRACECONTROL ON

CPO_TRACECONTROL_MODE

CPO_TRACECONTROL_G

CPO_TRACECONTROL_ASD

CPO_TRACECONTROL U

CP0_TRACECONTROL 0

CPO_TRACECONTROL_K

CPO_TRACECONTROL _E

CPO_TRACECONTROL_D

CPO_TRACECONTROL_IO

CP0_TRACECONTROL TB

CPO_TRACECONTROL_UT

CPO_TRACECONTROL_TS

CPO_TRACECONTROL2 SYP

CP0O_TRACECONTROL2 TBU

CPO_TRACECONTROL2 TBI

(OP0 TRACECONTROL2 \ALDVIODES

CPO_USERTRACEDATA DATA

CPO_TRACEBPC_IBPON

CPO_TRACEBPC_IE

CPO_TRACEBPC_DBPON

CPO_TRACEBPC_DE

CP0_DEBUG2_PACO

CP0_DEBUG2_TUP

CPO_DEBUG2_DQ

CPO_DEBUG2_PRM
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Code Optimization

Optimizer has been added to extend the compiler usability, cut down the amount of code generated and speed-up its
execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. constant) are being replaced by their results. (3 + 5 ->
8);

Constant propagation

When a constant value is being assigned to a certain variable, the compiler recognizes this and replaces the use of the
variable by constant in the code that follows, as long as the value of a variable remains unchanged.

Copy propagation
The compiler recognizes that two variables have the same value and eliminates one of them further in the code.

Value numbering

The compiler "recognizes" if two expressions yield the same result and can therefore eliminate the entire computation
for one of them.

"Dead code" ellimination

The code snippets that are not being used elsewhere in the programme do not affect the final result of the application.
They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY complex expressions to be evaluated
with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement specific solutions for the code "building
bricks" that further reduce output code size.

Related topics: SSA Optimization, PIC32 specifics, mikroPascal PRO for PIC32 specifics, Memory type specifiers
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Single Static Assignment Optimization

Introduction

In compiler design, static single assignment form (often abbreviated as SSA form or SSA) is an intermediate
representation (IR) in which every variable is assigned exactly once.

An SSA-based compiler modifies the program representation so that every time a variable is assigned in the original
program, a new version of the variable is created.

A new version of the variable is distinguished (renamed) by subscripting the variable name with its version number or
an index, so that every definition of each variable in a program becomes unique.

At a joining point of the control flow graph where two or more different definitions of a variable meet, a hypothetical
function called a phi-function is inserted so that these multiple definitions are merged.

In mikroPascal PRO for PIC32, SSA's main goal is in allocating local variables into the RX space (instead onto the
frame).
To do that, SSA has to make an alias and data flow analysis of the Control Flow Graph.

Besides these savings, there are a number of compiler optimization algorithms enhanced by the use of SSA, like :

- Constant Propagation

- Dead Code Elimination
- Global Value Numbering
- Register Allocation

Changes that SSA brings is also in the way in which routine parameters are passed. When the SSA is enabled,
parameters are passed through a part of the RX space which is reserved exclusively for this purpose.

Allocating local variables and parameters in RX space has its true meaning for those architectures with hardware
frame.

Enabling SSA optimization in compiler is done by checking ¥ Enable 354 aptimization ; box from the Output Settings Menu.

Lets consider a trivial case :
program Example;
procedure SSA Test(y : integer; k : integer);

begin
if (ytk) then
asm
nop;
end
end;

begin
SSA Test (5,5);

end.

With SSA enabled, procedure ss2 Test is consisted of 3 asm instructions :
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;Example.mpas, 29 :: if (yt+k) then
0x9D000000 0x033A1021 ADDU R2, R25, R26
0x9D000004 0x10400002 BEQ R2, RO, L SSA Test2

0x9D000008 0x70000000 NOP

Without SSA enabled, procedure SSA_Test is consisted of 5 asm instructions :

;Example.mpas, 29 :: if (y+k) then
0x9D000000 0x87A30002 LH R3, 2(SP)

0x9D000004 0x87A20000 LH R2, 0(SP)

0x9D000008 0x00431021 ADDU R2, R2, R3
0x9D00000C 0x10400002 BEQ R2, RO, L SSA Test2

0x9D000010 0x70000000 NOP

Proper Coding Recommendations
To get the maximum out of the SSA, user should regard the following rules during the coding process :
- Routines should not contain too many parameters (not more than 4 words).

- Don’t change the value of the parameter in the function body (it is better to use a new local variable).
- If the function1 parameters are passed as function2 parameters, then parameter order should remain

the same :

procedure f2(a: integer; b: integer;) { }

procedure fl (x: integer; y: integer;) {
// routine call
f2(x,y); // x->a and y->b (1 to 1 and 2 to 2) is far more efficient than
2 (y,x); // y->a and x->b (1 to 2 and 2 to 1)

}

- Large amount of nested loops and complex structures as its members should be avoided.

- When writing a code in assembly, keep in mind that there are registers reserved exclusively for
routine parameters.

- Using goto and 1abel statements in nested loops should be avoided.

- Obtaining address of the local variable with the global pointer and using it to alter the variable’s address
should be avoided.

Notes :

- emc1 files compiled with or without SSA enabled are fully compatible and can be used and mixed without
any restrictions, except function pointers.

- All function prototypes and function pointers have to be built using the same optimizer because of different
calling conventions in different optimizers. In SSA, function parameters are passed via working registers,
and without SSA they end up on the function frame.

- This means that you cannot have a function implementation which is optimized using SSA optimizer, and to
call this function via function pointer in another module which is optimized using NON-SSA.

When using pointers to functions, compiler must know exactly how to pass function parameters and how to
execute function call.
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Asm code and SSA optimization

If converting code from an earlier version of the compiler, which consists of mixed asm code with the Pascal
code, keep in mind that the generated code can substantially differ when SSA optimization option is enabled
or disabled.

This is due to the fact that SSA optimization uses certain working registers to store routine parameters
(W10-W13), rather than storing them onto the function frame.

Because of this, user must be very careful when writing asm code as existing values in the working registers
used by SSA optimization can be overwritten.
To avoid this, it is recommended that user includes desired asm code in a separate routine.

Debugging Notes

SSA also influences the code debugging in such a way that the local variables will be available in the Watch Window
only in those parts of the procedure where they have useful value (eg. on entering the procedure, variable isn’t available
until its definition).

Variables can be allocated in one part of the procedure in register W4, and in another part of the procedure in register
W2, if the optimizer estimates that it is better that way. That means that the local variable has no static address.

Warning Messages Enhancement

Besides the smaller code, SSA also deals with the intensive code analysis, which in turn has the consequence in
enhancing the warning messages.
For example, compiler will warn the user that the uninitialized variable is used:

void main () {
int vy;
if (vy) // Variable y might not have been initialized
PORTD = 0;

}

Related topics: Code Optimization, PIC32 Specifics, mikroPascal PRO for PIC32 specifics, Memory type specifiers
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CHAPTER 1

PIC32 Specifics

In order to get the most from the mikroPascal PRO for PIC32 compiler, the user should be familiar with certain aspects
of PIC32 MCU. This knowledge is not essential, but it can provide a better understanding of the PIC32’s capabilities

and limitations, and their impact on the code writing as well.
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Types Efficiency

First of all, the user should know that PIC32’s ALU, which performs arithmetic operations, is optimized for working with
32-bit types. Also, it performs hardware multiplication and division on the integer level,

so the floating multiplication and division is slower and consumes more memory comparing it to the integer.

The PIC32 supports 64-bit data types, but they are less efficient. They provide higher precision, but lack the code size
and the execution.

Nested Calls Limitations

There are no Nested Calls Limitations, except by RAM size. A Nested call represents a function call within the function
body, either to itself (recursive calls) or to another function.

Recursive calls, as a form of cross-calling, are supported by mikroPascal PRO for PIC32, but they should be used very
carefully. Also calling functions from interrupt is allowed.

Calling function from both interrupt and main thread is allowed. Be careful because this programming technique may
cause unpredictable results if common resources are used in both main and interrupt.

Variable, constant and routine alignment

Simple type variables whose size exceeds 2 byte (int, long, float, double, long double) and those
exceeding 4 bytes are always set to alignment 4.
Routines are always set to aligment 4.

Boot Start-up Initialization
Upon reset, MCU positions at the address 0xBFC00000 on which the BootstartUp function is located.
BootStartUp function configures:

- CPO (coprocessor registers),
- SFR registers associated with the interrupt,
- Stack pointer (R29) and global pointer (R1).

By default the MCU is configured as follows:

- Cache Enabled,

- Prefetch enabled (for executable code and constants),
- Flash waitstates set for specified oscillator frequency,
- Executable code allocated in the KSEGO,

- Data allocated in the KSEG1,

After this start-up function has been executed, MCU will jump into the main routine. Interupts will be set accordingly to
the settings in the Edit Project.
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PIC32 Memory Organization

The PIC32MX microcontrollers provide 4 GB of unified virtual memory address space. All memory regions, including
program memory, data memory, SFRs and Configuration registers reside in this address space at their respective
unique addresses.

The program and data memories can be optionally partitioned into user and kernel memories. In addition, the data
memory can be made executable, allowing the PIC32MX to execute from data memory.

Key features of PIC32MX memory organization include the following:

- 32-bit native data width

- Separate User and Kernel mode address spaces.

- Flexible program Flash memory partitioning.

- Flexible data RAM partitioning for data and program space.

- Separate boot Flash memory for protected code.

- Robust bus-exception handling to intercept runaway code.

- Simple memory mapping with Fixed Mapping Translation (FMT) unit.
- Cacheable and non-cacheable address regions.
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PIC32MX Memory Layout

The PIC32MX microcontrollers implement two address spaces: virtual and physical.

All hardware resources, such as program memory, data memory and peripherals, are located at their respective
physical addresses. Peripherals, such as DMA and Flash controllers, use physical addresses and access memory
independently of the CPU.
Virtual addresses are exclusively used by the CPU to fetch and execute instructions. Virtual address space can be
thought as CPU’s logical view and use of its physical resources.

A graphical representation of the PIC32MX virtual and physical memory is shown in picture below:
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As it can be seem, the entire 4 GB virtual address space is divided into two primary regions: User and Kernel space.
The lower 2 GB of space called USEG/KUSEG, and the upper 2 GB are divided into KSEG0, KSEG1, KSEG2 and
KSEG3.

Virtual vs Physical Addresses

The PIC32MX’s CPU uses virtual addresses to address the peripherals, which means that to access the PIC32MX’s
peripherals we (and the CPU) must be operating within the virtual boundaries of KSEG1.
The PIC32MX's CPU also uses virtual addressing to fetch and execute program memory instructions.

If you look closely, you'll see that the physical address region between the INTERNAL RAM (at physical address
0x00000000) and the INTERNAL BOOT FLASH (beginning at physical address 0x1FC00000)
is matched up with the virtual memory schemes of KSEGO and KSEGH1.

The PIC32MX CPU maps the virtual areas of KSEGO0 and KSEG1 against the same physical memory area beginning
at physical address 0x00000000.

Because both the KSEG0 and KSEG1 virtual segments point to the same physical memory area, the PIC32MX CPU
can execute instructions from either the KSEGO or KSEG1 virtual memory segment, depending on the cacheable
status of the application (KSEGO0 and USEG-KSEG are cacheable while KSEG1 is not cacheable).

Related topics: Accessing individual bits, SFRs, Memory type specifiers
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Memory Type Specifiers

The mikroPascal PRO for PIC32 supports usage of all memory areas.
Each variable may be explicitly assigned to a specific memory space by including a memory type specifier in the
declaration, or implicitly assigned.

The following memory type specifiers can be used:

- code

- data

- rx (reserved for compiler purposes only)

- sfr

code

Description | The code memory type may be used for allocating constants in program memory.

Example // puts txt in program memory
const txt = 'ENTER PARAMETER:’; code;

data

Description | This memory specifier is used when storing variable to the Data RAM.

Example // puts data buffer in data ram
var data buffer : char; data;

X

Description | This memory specifier allows variable to be stored in the working registers space (reserved for compiler
purposes only).

Example // puts y in Rx space
var y : char; rx;

sfr

Description | This memory specifier allows user to access special function registers. It also instructs compiler to
maintain same identifier in source and assembly.

Example var y : char; sfr; // puts y in SFR space

Note : If none of the memory specifiers are used when declaring a variable, data specifier will be set as default by the

compiler.

Related topics: PIC32 Memory Organization, Accessing individual bits, SFRs, Constants, Functions
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Read Modify Write Problem

The Microchip microcontrollers use a sequence known as Read-Modify-Write (RMW) when changing an output state
(1 or 0) on a pin. This can cause unexpected behavior under certain circumstances.

When your program changes the state on a specific pin, for example RBO in PORTB, the microcontroller first READs
all 8 bits of the PORTB register which represents the states of all 8 pins in PORTB (RB7-RB0).

The microcontroller then stores this data in the MCU. The bit associated with RB that you've commanded to MODIFY
is changed, and then the microcontroller WRITEs all 8 bits (RB7-RB0) back to the PORTB register.

During the first reading of the PORT register, you will be reading the actual state of the physical pin.
The problem arises when an output pin is loaded in such a way that its logic state is affected by the load. Instances of
such loads are LEDs without current-limiting resistors or loads with high capacitance or inductance.

For example, if a capacitor is attached between pin and ground, it will take a short while to charge when the pin is set
to 1.

On the other hand, if the capacitor is discharged, it acts like a short circuit, forcing the pin to ‘0’ state, and, therefore, a
read of the PORT register will return 0, even though we wrote a 1 to it.

Lets analyze the following example:

PORTB.BO = 1;
PORTB.B1 = 1;

Assume that the PORTB is initially set to zero, and that all pins are set to output. Let's say we connect a discharged
capacitor to RBO pin.

The first line, PORTB. B0 = 1; will be decoded like in this way:

READ PORTB is read: STORE Data is stored inside a temporary internal
register in the MCU:

] INTERMAL | — Store read value
— | 00000 s v

_
= |oooemn = lNeToTalela) e
ﬂil'ls II" o o e o |_||_|_||_I||_|E:: i

FORTE
. 00000000 Discharged LIS LN eesiren

I ke capacitor

-

e s s i e s ff s ) e |

Discharged

00000000 =C capacitor
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Actual voltage levels on MCU pins are relevant.

MODIFY Data is modified to set the RBO bit: WRITE PORTB is written with the modified data.
The output driver for RBO turns on, and the

Modify value capacitor starts to charge:
Write olloflolloflofo]o][1] rZszves
C modified
lllllll PORTE value -
REGISTER
Discharged
0O0DO0O0ODO0CODOOOD C Charging
I capacitor 0000 O0DO0OO0OD IC capacitor
The second line, PORTB.B1 = 1; will be decoded like in this way:
READ PORTB is read: STORE Because the capacitor is still charging, the

voltage at RBO is still low and reads as a ‘0’
(since we are reading from the pins directly,
not from the PORTB register) :

Store

read Value we didn't expect here

value  (but physically still correct one)

A ojjofjojofo]a]ofl Fesser
Read 1 (
from | | — 5
pins T—zjf:'::::": (00000000
Charging
0O0O0O0O0ODOOD C
capacitor Charging
T unnunnnnl_c oo i
Actual voltage levels on MCU pins are relevant.
MODIFY Data is modified to set the bit: WRITE PORTB is written with the new data. The

output driver for RB1 turns on, but the

Modify value driver for RB0 turns back off:

Write Hlmln ﬂﬂ ﬂmm IHNEGIETE!H._
d modified 'l
| value =
"'\-\.,_'
T o L e ST T = o e e e e i
unnuunnuTlc 5::;‘5:;‘3_ unnunn1ui i‘-mscharglng

—_|_wI capacitor
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To correct the problem in the code, insert a delay after each PORTE.Bx = 1 line, or modify the entire PORTB register
in a single line PORTB = 000000011,

This problem can be avoided by using LATx register when writing to ports, rather than using PORTX registers.
Writing to a LATX register is equivalent to writing to a PORTX register, but readings from LATx registers return the
data value held in the port latch, regardless of the state of the actual pin.

For example, lets analyze the following example:

LATB.BO = 1;
LATB.B1 = 1;

The first line, LATE. B0 = 1; will be decoded like in this way:

READ LATB is read: STORE Data is stored inside a temporary internal
register in the MCU:

Read ‘L//i

from il .
LATE N
I - o - - -  —  — m— ) m—  co— — — m— r-'-
Discharged
I ke capacitor
Discharged
I capaciter

Actual voltage levels on MCU pins are no longer relevant when using LATx for output

MODIFY Data is modified to set the RBO bit: WRITE LATB is written with the modified data.
The output driver for RBO turns on, and the
Modify value capacitor starts to charge:

Write oflojojjojlofololl1) Aeres

modified | |
value

"

fan Y

| s s i s o s s s

0 Discharged
I s capacitor
= I capacitor
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The second line, LATB.B1 = 1; will be decoded like in this way:

READ LATB is read:
Read
from
LATB =

Charging
capacitor

STORE Since the voltage levels on MCU pins are no
longer relevant, we get the expected value:

Store
read
value

|

Expected
value

INTERMAL
0 In Iu lulnlnlu ﬂ TERNAL

l

L

| o ) s ff s § o s ff e

e
Charging

I ¢ capacitor

Actual voltage levels on MCU pins are no longer relevant when using LATx for output
MODIFY Data is modified to set the bit:
Modify value

T

[t

IC

s ) o | o e s

Charging
capacitor

When to use LATx instead of PORTx

WRITE LATB is written with the new data. The

output driver for RB1 turns on, and the output
driver for RBO remains turned on:

Write
maodified
value

C'

7y

|
] ]
Sy
_i_ Charging

1 I capaciter

Depending on your hardware, one may experience unpredictable behavior when using PORTX bits for driving output.

Displays (GLCD, LCD), chip select pins in SPI interfaces and other cases when you need fast and reliable output, LATx
should be used instead of PORTx.
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CHAPTER 8

mikroPascal PRO for PIG32
Language Reference

- Lexical Elements

- Whitespace
- Comments
- Tokens

- Literals

- Keywords

- Identifiers

- Punctuators

- Program Organization

- Program Organization
- Scope and Visibility
- Units

- Variables

- Constants

- Labels

- Functions and Procedures

- Functions
- Procedures

- Types

- Simple Types
- Arrays

- Strings

- Pointers
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- Introduction to Pointers
- Function Pointers
- Pointer Arithmetic

- Records
- Types Conversions

- Implicit Conversion
- Explicit Conversion

- Operators
- Introduction to Operators
- Operators Precedence and Associativity
- Arithmetic Operators
- Relational Operators
- Bitwise Operators
- Boolean Operators
- Expressions
- Expressions
- Statements
- Introduction to Statements
- Assignment Statements
- Compound Statements (Blocks)
- Conditional Statements

- If Statement
- Case Statement

- Iteration Statements (Loops)
- For Statement
- While Statement
- Repeat Statement
- Jump Statements
- Break and Continue Statements
- Exit Statement
- Goto Statement
- asm Statement

- Directives

- Compiler Directives
- Linker Directives
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Lexical Elements Overview

The following topics provide a formal definition of the mikroPascal PRO for PIC32 lexical elements. They describe
different categories of word-like units (tokens) recognized by the language.

In the tokenizing phase of compilation, the source code file is parsed (i.e. broken down) into tokens and whitespace.

The tokens in mikroPascal PRO for PIC32 are derived from a series of operations performed on your programs by the
compiler.

Whitespace
Whitespace is a collective name given to spaces (blanks), horizontal and vertical tabs, newline characters and comments.
Whitespace can serve to indicate where tokens start and end, but beyond this function, any surplus whitespace is

discarded.

For example, the two sequences

var i : char;
J : word;
and
var
i : char;
J : word;

are lexically equivalent and parse identically to give nine tokens:

var
i

char

word

Newline Character
Newline character (CR/LF) is not a whitespace in BASIC, and serves as a statement terminator/separator. In mikroPascal

PRO for PIC32, however, you may use newline to break long statements into several lines. Parser will first try to get the
longest possible expression (across lines if necessary), and then check for statement terminators.

Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals, in which case they are protected from
the normal parsing process (they remain a part of the string). For example,
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some string := 'mikro foo';
parses into four tokens, including a single string literal token:

some string

'mikro foo'

’

Comments

Comments are pieces of a text used to annotate a program, and are technically another form of whitespace. Comments
are for the programmer’s use only. They are stripped from the source text before parsing.

There are two ways to create comments in mikroPascal. You can use multi-line comments which are enclosed with
braces or (* and *):

{ All text between left and right brace
constitutes a comment. May span multiple lines. }

(* Comment can be
written in this way too. *)
or single-line comments:

// Any text between a double-slash and the end of the
// line constitutes a comment spanning one line only.

Nested comments

mikroPascal PRO for PIC32 doesn’t allow nested comments. The attempt to nest a comment like this

{ 1 { identifier } : word; }

fails, because the scope of the first open brace “{” ends at the first closed brace “}”. This gives us
word; }

which would generate a syntax error.
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Tokens

Token is the smallest element of a mikroPascal PRO for PIC32 program, meaningful to the compiler. The parser
separates tokens from the input stream by creating the longest token possible using the input characters in a left—to—
right scan.
mikroPascal PRO for PIC32 recognizes the following kinds of tokens:

- keywords

- identifiers

- constants

- operators
- punctuators (also known as separators)

Token Extraction Example
Here is an example of token extraction. Take a look at the following example code sequence:
end flag := 0;

First, note that end flag would be parsed as a single identifier, rather than as the keyword end followed by the identifier
_flag.

The compiler would parse it as the following four tokens:

end flag // variable identifier
1= // assignment operator
0 // literal

; // statement terminator

Note that : = parses as one token (the longest token possible), not as token : followed by token .
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Literals
Literals are tokens representing fixed numeric or character values.

The data type of a constant is deduced by the compiler using such clues as numeric value and format used in the
source code.

Integer Literals
Integral values can be represented in decimal, hexadecimal or binary notation.

In decimal notation, numerals are represented as a sequence of digits (without commas, spaces or dots), with optional
prefix + or - operator to indicate the sign. Values default to positive (6258 is equivalent to +6258).

The dollar-sign prefix ($) or the prefix 0x indicates a hexadecimal numeral (for example, $8F or 0x8F).
The percent-sign prefix (%) indicates a binary numeral (for example, 301010000).

Here are some examples:

11 // decimal literal

$11 // hex literal, equals decimal 17
Ox11 // hex literal, equals decimal 17
$11 // binary literal, equals decimal 3

The allowed range of values is imposed by the largest data type in mikroPascal PRO for PIC32 — 1ongint. Compiler
will report an error if the literal exceeds 2147483647 (STFFFFFFE).

Floating Point Literals
A floating-point value consists of:
- Decimal integer
- Decimal point
- Decimal fraction
- e or I; and a signed integer exponent (optional)
You can omit either the decimal integer or decimal fraction (but not both).

Negative floating constants are taken as positive constants with the unary operator minus (-) prefixed.

mikroPascal PRO for PIC32 limits floating-point constants to range +1.17549435082 * 10-38 .. +6.80564774407 *
1038.

0. // = 0.0

-1.23 // = -1.23
23.45e6 // = 23.45 * 1076
2e-5 // = 2.0 * 10"-5
3E+10 // = 3.0 * 10710

.09E34 // = 0.09 * 10734
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Character Literals
Character literal is one character from the extended ASCII character set, enclosed with apostrophes.

Character literal can be assigned to variables of the byte and char type (variable of by te will be assigned the ASCII
value of the character). Also, you can assign character literal to a string variable.

Note : Quotes (" ") have no special meaning in mikroPascal PRO for PIC32.

String Literals

String literal is a sequence of characters from the extended ASCII character set, written in one line and enclosed with
apostrophes. Whitespace is preserved in string literals, i.e. parser does not “go into” strings but treats them as single
tokens.

Length of string literal is a number of characters it consists of. String is stored internally as the given sequence of
characters plus a final null character. This null character is introduced to terminate the string, it does not count against
the string’s total length.

String literal with nothing in between the apostrophes (null string) is stored as a single null character.
You can assign string literal to a string variable or to an array of char.

Here are several string literals:

'Hello world!' // message, 12 chars long

'Temperature is stable' // message, 21 chars long

v // two spaces, 2 chars long

c! // letter, 1 char long

v // null string, 0 chars long

The apostrophe itself cannot be a part of the string literal, i.e. there is no escape sequence. You can use the built-in
function Chr to print an apostrophe: chr (39) . Also, see String Splicing.
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Keywords

Keywords are words reserved for special purposes and must not be used as normal identifier names.

Beside standard Pascal keywords, all relevant SFRs are defined as global variables and represent reserved words that
cannot be redefined (for example: w0, TMR1, T1CON, etc). Probe the Code Assistant for specific letters (Ctrl+Space in

Editor) or refer to Predefined Globals and Constants.

Here is the alphabetical listing of keywords in mikroPascal PRO for PIC32:

- absolute

- abstract

- and

- array

- as

- asm

- assembler
- at

- automated
- bdata

- begin

- bit

- case

- cdecl

- class

- code

- compact

- const

- constructor
- contains

- data

- default

- deprecated
- destructor
- dispid

- dispinterface
- div

- dma

- do

- downto

- dynamic

- end

- except

- export

- exports

- external

far

file

final
finalization
finally

for
forward
goto
helper
idata

if

ilevel
implementation
implements
in

index
inherited
initialization
inline
interface
io

is

label
library
message
mod

name

near

nil
nodefault
not

object

of

on
operator
or

org
out
overload
override
package
packed
pascal
pdata
platform
private
procedure
program
property
protected
public
published
raise
read
readonly
record
register
reintroduce
repeat
requires
rx
safecall
sbit
sealed
set

sfr

shl

shr

small
stdcall
stored
string

threadvar
to

try

type

unit
until
uses

var
virtual
volatile
while
with
write
writeonly
xdata

XOr

ydata

Also, mikroPascal PRO for PIC32 includes a number of predefined identifiers used in libraries. You can replace them by
your own definitions, if you plan to develop your own libraries. For more information, see mikroPascal PRO for PIC32

Libraries.
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Identifiers

Identifiers are arbitrary names of any length given to functions, variables, symbolic constants, user-defined data types
and labels. All these program elements will be referred to as objects throughout the help (don't get confused about the
meaning of object in object-oriented programming).

Identifiers can contain the letters a to z and A to Z, underscore character “ ”
is that the first character must be a letter or an underscore.

, and digits from 0 to 9. The only restriction

Case Sensitivity

mikroPascal PRO for PIC32 is not case sensitive, so Sum, sum, and suM are equivalent identifiers.

Uniqueness and Scope

Although identifier names are arbitrary (according to the stated rules), if the same name is used for more than one
identifier within the same scope then error arises. Duplicated names are illegal within same scope. For more information,
refer to Scope and Visibility.

Identifier Examples
Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext

... and here are some invalid identifiers:

Ttemp // NO -- cannot begin with a numeral

$higher // NO -- cannot contain special characters

XOor // NO -- cannot match reserved word

323.07.04 // NO -- cannot contain special characters (dot)
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Punctuators

The mikroPascal PRO for PIC32 punctuators (also known as separators) are:

[1- Brackets

() — Parentheses
,—Comma

; — Semicolon
:—Colon

. — Dot

Brackets

Brackets [ ] indicate single and multidimensional array subscripts:
var alphabet : array[l..30] of byte;

/7

alphabet[3] := 'c';

For more information, refer to Arrays.

Parentheses

Parentheses () are used to group expressions, isolate conditional expressions and indicate function calls and function
declarations:

d :=c * (a + b); // Override normal precedence

if (d = z) then ... // Useful with conditional statements

func () ; // Function call, no arguments

function func2(n : word); // Function declaration with parameters

For more information, refer to Operators Precedence and Associativity, Expressions and Functions and Procedures.

Comma

Comma (, ) separates the arguments in function calls:

LCD Out (1, 1, txt);

Furthermore, the comma separates identifiers in declarations:
var i, j, k : byte;

The comma also separates elements of array in initialization lists:

const MONTHS : array[l..l12] of byte = (31,28,31,30,31,30,31,31,30,31,30,31);

185



mikoPascal PRO for PIC32

Semicolon

Semicolon (; ) is a statement terminator. Every statement in Pascal must be terminated with a semicolon. The exceptions
are: the last (outer most) end statement in the program which is terminated with a dot and the last statement before end
which doesn't need to be terminated with a semicolon.

For more information, see Statements.

Colon

Colon (:) is used in declarations to separate identifier list from type identifier. For example:

var
i, j : byte;
k : word;

In the program, use the colon to indicate a labeled statement:
start: nop;
goto start;

For more information, refer to Labels.

Dot

Dot (.) indicates an access to a field of a record. For example:
person.surname := 'Smith';

For more information, refer to Records.

Dot is a necessary part of floating point literals. Also, dot can be used for accessing individual bits of registers in
mikroPascal.
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Program Organization

mikroPascal PRO for PIC32 imposes strict program organization. Below you can find models for writing legible and
organized source files. For more information on file inclusion and scope, refer to Units and Scope and Visibility.

Organization of Main Unit

Basically, the main source file has two sections: declaration and program body. Declarations should be in their proper
place in the code, organized in an orderly manner. Otherwise, the compiler may not be able to comprehend the program
correctly.

When writing code, follow the model presented below. The main unit should look like this:

program { program name }
uses { include other units }

//********************************************************

//* Declarations (globals):
//********************************************************

{ constants declarations }
const

{ types declarations }

type

{ variables declarations }

var Name[, Name2...] : ["]type; [absolute 0x123;] [external;] [volatile;] [register;]
[sfr;]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name (parameter list);
{ local declarations }
begin

end;

{ functions declarations }

function function name (parameter list) : return type;
{ local declarations }
begin
end;

//********************************************************

//* Program body:

//********************************************************

begin
{ write your code here }
end.
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Organization of Other Units

Units other than main start with the keyword unit. Implementation section starts with the keyword implementation.
Follow the model presented below:

unit { unit name }
uses { include other units }

//********************************************************

//* Interface (globals):

//********************************************************

{ constants declarations }
const

{ types declarations }

type

{ variables declarations }

var Name[, Name2...] : ["]type; [absolute 0x123;] [external;] [volatile;] [register;]
[sfr; ]

{ procedures prototypes }
procedure procedure name ([var] [const] ParamName : ["]type; [var] [const] ParamName2,
ParamName3 : [“]type);

{ functions prototypes }
function function name ([var] [const] ParamName : [“]type; [var] [const] ParamNameZ2,
ParamName3 : [“]type) : ["]type;

//********************************************************

//* Implementation:
//********************************************************

implementation

{ constants declarations }
const

{ types declarations }

type

{ variables declarations }

var Name[, Name2...] : ["]type; [absolute 0x123;] [external;] [volatile;] [register;]
[sfr; ]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name ([var] [const] ParamName : ["]type; [var] [const] ParamName2,
ParamName3 : ["]type); [ilevel 0x123;] [overload;] [forward;]

{ local declarations }

begin

end;
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{ functions declarations }
function function name([var] [const] ParamName : ["]type; [var] [const] ParamName2,
ParamName3 : ["]type) : ["]type; [ilevel 0x123;] [overload;] [forward;]

{ local declarations }

begin

end;

end.

Note :
- Constants, types and variables used in the implementation section are inaccessible to other units. This feature is not
applied to the procedures and functions in the current version, but it will be added to the future ones.

- Functions and procedures must have the same declarations in the interface and implementation section. Otherwise,
compiler will report an error.

Scope and Visibility

Scope

The scope of an identifier is a part of the program in which the identifier can be used to access its object. There are
different categories of scope, which depends on how and where identifiers are declared:

Place of declaration Scope

Identifier is declared in the declaration of a | Scope extends from the point where it is declared to the end of the
program, function, or procedure current block, including all blocks enclosed within that scope. Identifiers
in the outermost scope (file scope) of the main unit are referred to as
globals, while other identifiers are locals.

Identifier is declared in the interface section | Scope extends the interface section of a unit from the point where it is
of a unit declared to the end of the unit, and to any other unit or program that
uses that unit.

Identifier is declared in the implementation | Scope extends from the point where it is declared to the end of the unit.
section of a unit, but not within the block of | The identifier is available to any function or procedure in the unit.
any function or procedure

Visibility

The visibility of an identifier is that region of the program source code from which legal access to the identifier’s
associated object can be made.

Scope and visibility usually coincide, though there are circumstances under which an object becomes temporarily
hidden by the appearance of a duplicate identifier, i.e. the object still exists but the original identifier cannot be used to
access it until the scope of the duplicate identifier is ended.

Technically, visibility cannot exceed scope, but scope can exceed visibility
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Name Spaces

Name space is a scope within which an identifier must be unique. The mikroPascal PRO for PIC32 uses two distinct
categories of identifiers:

1. Global variables are visible throughout the whole unit, from the place of declaration. Also. they can be seen in

other units, if they are declared above the Implementation section.
2. Local variables, parameters, types, function results - must be unique within the block in which they are declared.

For example:

var level : byte;

procedure control (sens : byte);
var location : byte;
begin
location := 1;
sens := location;
level := 123;
end;

procedure temperature;

begin
location := 0; // ILLEGAL
sens := 23; // ILLEGAL: redefinition of sens
level := 95;

end;
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Units

In mikroPascal PRO for PIC32, each project consists of a single project file and one or more unit files. Project file, with
extension .mpp32 contains information about the project, while unit files, with extension .mpas, contain the actual
source code.

Units allow you to:

- break large programs into encapsulated parts that can be edited separately,
- create libraries that can be used in different projects,
- distribute libraries to other developers without disclosing the source code.

Each unit is stored in its own file and compiled separately. Compiled units are linked to create an application. In order
to build a project, the compiler needs either a source file or a compiled unit file (. emc 1 file) for each unit.

Uses Clause

mikroPascal PRO for PIC32 includes units by means of the uses clause. It consists of the reserved word uses, followed
by one or more comma-delimited unit names, followed by a semicolon. Extension of the file should not be included.
There can be at most one uses clause in each source file, and it must appear immediately after the program (or unit)
name.

Here’s an example:
uses utils, strings, Unit2, MyUnit;

For the given unit name, the compiler will check for the presence of .emc1 and .mpas files, in order specified by the
search paths.

- If both .mpas and .emc1 files are found, the compiler will check their dates and include the newer one in the
project. If the .mpas file is newer than .emc1, a new library will be written over the old one;

- Ifonly .mpas file is found, the compiler will create the . emc1 file and include it in the project;

- Ifonly .emc1 file is present, i.e. no source code is available, the compiler will include it as it is found;

- If none found, the compiler will issue a “File not found” warning.

Main Unit

Every project in mikroPascal PRO for PIC32 requires a single main unit file. The main unit file is identified by the
keyword program at the beginning; it instructs the compiler where to “start”.

After you have successfully created an empty project with the Project Wizard, the Code Editor will display a new main
unit. It contains the bare-bones of the Pascal program:

program MyProject;

{ main procedure }
begin

{ Place program code here }
end.
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Nothing should precede the keyword program except comments. After the program name, you can optionally place the
uses clause.

Place all global declarations (constants, variables, types, labels, routines) before the keyword begin.

Other Units

Units other than main start with the keyword unit. Newly created blank unit contains the bare-bones:
unit MyUnit;

implementation

end.

Other than comments, nothing should precede the keyword uni t. After the unit name, you can optionally place the
uses clause.

Interface Section

Part of the unit above the keyword implementation is referred to as interface section. Here, you can place global
declarations (constants, variables, labels and types) for the project.

You do not define routines in the interface section. Instead, state the prototypes of routines (from implementation
section) that you want to be visible outside the unit. Prototypes must match the declarations exactly.

Implementation Section

Implementation section hides all irrelevant innards from other units, allowing encapsulation of code.

Everything declared below the keyword implementation is private, i.e. has its scope limited to the file. When you
declare an identifier in the implementation section of a unit, you cannot use it outside the unit, but you can use it in any

block or routine defined within the unit.

By placing the prototype in the interface section of the unit (above the implementation) you can make the routine
public, i.e. visible outside of unit. Prototypes must match the declarations exactly.
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Variables

Variable is an object whose value can be changed during the runtime. Every variable is declared under unique name
which must be a valid identifier. This name is used for accessing the memory location occupied by a variable.

Variables are declared in the declaration part of the file or routine — each variable needs to be declared before being
used. Global variables (those that do not belong to any enclosing block) are declared below the uses statement, above
the keyword begin.

Specifying a data type for each variable is mandatory. Syntax for variable declaration is:

var identifier list : type;

Here, identifier list is a comma-delimited list of valid identifiers and type can be any data type.

For more details refer to Types and Types Conversions. For more information on variables’ scope refer to the chapter
Scope and Visibility.

Pascal allows shortened syntax with only one keyword var followed by multiple variable declarations. For example:

var i, j, k : byte;
counter, temp : word;
samples : array[l100] of word;

External Modifier

Use the external modifier to indicate that the actual place and initial value of the variable, function or procedure body,
is defined in a separate source code unit.

For example, lets create a project which will calculate circle area and will have function and procedure definition in two
different units, and a call to these routines in the third, separate unit.

So, the project will be consisted of the main unit, Main Unit.mpas and First Unit.mpas and Second Unit.
mpas units.

In the Main Unit we will define routine called r squared (calculates radius squared). Also, both units must be
included in the Main_Unit :

program Main Unit;
uses First Unit, Second Unit; // Include both used units

function r squared(r : real) : real; // Definition of the r squared routine
begin

result := r*r;
end;

begin
CircleArea(); // CircleArea routine call
end.
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In the First_Unit we will define and declare routine called pi_r_squared (calculates pi multiplied by the radius
squared):

unit First Unit;

procedure pi r squared(rr : real); // Declaration of the pi r squared routine
implementation
procedure pi r squared(rr : real); // Definition of the pi r squared routine
var res : real;
begin
res := rr*3.14;
end;
end.

In the Second_Unit we will make a call to the routines defined externally (r squaredandpi r sguared). Firstofall,
we must declare their prototypes followed with a external modifier. Then, we can proceed to the routine call :

unit Second Unit;

procedure CircleArea();

function r squared(r : real) : real; external; // Declaration of the r squared routine
(defined in Main Unit) followed with a external modifier
procedure pi r squared(rr : real); external; // Declaration of the pi r squared

routine (defined in First_Unit) followed with a external modifier
implementation

procedure CircleArea(); // Definition of the CircleArea routine

var res : real;
begin
res := r squared(5); // r squared routine call
pi r squared(res); // pi r squared routine call
end;
end.

Variables and PIC32

Every declared variable consumes part of RAM memory. Data type of variable determines not only the allowed range
of values, but also the space a variable occupies in RAM memory. Bear in mind that operations using different types of
variables take different time to be completed. mikroPascal PRO for PIC32 recycles local variable memory space — local
variables declared in different functions and procedures share the same memory space, if possible.

There is no need to declare SFRs explicitly, as mikroPascal PRO for PIC32 automatically declares relevant registers
as global variables of volatile word see SFR for details.
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Constants

Constant is a data whose value cannot be changed during the runtime. Using a constant in a program consumes no
RAM memory. Constants can be used in any expression, but cannot be assigned a new value.

Constants are declared in the declaration part of a program or routine. You can declare any number of constants after
the keyword const:

const constant name [: type] = value;

Every constant is declared under unique constant name which must be a valid identifier. It is a tradition to write
constant names in uppercase. Constant requires you to specify va1ue, which is a literal appropriate for the given type.
type is optional and in the absence of t ype, the compiler assumes the “smallest” of all types that can accommodate
value.

Note : You cannot omit t ype when declaring a constant array.

Pascal allows shorthand syntax with only one keyword const followed by multiple constant declarations. Here’s an
example:

const
MAX : longint = 10000;
MIN = 1000; // compiler will assume word type
SWITCH = 'n'; // compiler will assume char type
MSG = 'Hello'; // compiler will assume string type
MONTHS : array[l..12] of byte = (31,28,31,30,31,30,31,31,30,31,30,31);

195 MikroElektronika



mikoPascal PRO for PIC32

Labels

Labels serve as targets for goto statements. Mark the desired statement with a label and colon like this:
label identifier : statement

Before marking a statement, you must declare a label. Labels are declared in declaration part of unit or routine, similar
to variables and constants. Declare labels using the keyword 1abel:

label labell, ..., labeln;
Name of the label needs to be a valid identifier. The label declaration, marked statement, and goto statement must
belong to the same block. Hence it is not possible to jump into or out of a procedure or function. Do not mark more than
one statement in a block with the same label.
Here is an example of an infinite loop that calls the Beep procedure repeatedly:
label loop;
loop:
Beep;
goto loop;
Note : Label should be followed by end of line (CR) otherwise compiler will report an error.

label loop;

loop: Beep; // compiler will report an error
loop: // compiler will report an error
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Functions and Procedures

Functions and procedures, collectively referred to as routines, are subprograms (self-contained statement blocks)
which perform a certain task based on a number of input parameters. When executed, a function returns a value while
procedure does not.

Functions
A function is declared like this:

function function name (parameter list) : return type;
{ local declarations }

begin
{ function body }

end;

function name represents a function’s name and can be any valid identifier. return type is a type of return
value and can be any simple type or complex type. Within parentheses, parameter 1list is a formal parameter list
very similar to variable declaration. In Pascal, parameters are always passed to a function by the value. To pass an
argument by address, add the keyword var ahead of identifier.

Local declarations are optional declarations of variables and/or constants, local for the given function. Function
body is a sequence of statements to be executed upon calling the function.

Calling a function

Afunctionis called by its name, with actual arguments placed in the same sequence as their matching formal parameters.
The compiler is able to coerce mismatching arguments to the proper type according to implicit conversion rules. Upon
a function call, all formal parameters are created as local objects initialized by values of actual arguments. Upon return
from a function, a temporary object is created in the place of the call and it is initialized by the value of the function
result. This means that function call as an operand in complex expression is treated as the function result.

In standard Pascal, a function name is automatically created local variable that can be used for returning a value of
a function. mikroPascal PRO for PIC32 also allows you to use the automatically created local variable result to assign
the return value of a function if you find function name to be too ponderous. If the return value of a function is not defined
the compiler will report an error.

Function calls are considered to be primary expressions and can be used in situations where expression is expected.
A function call can also be a self-contained statement and in that case the return value is discarded.

Example
Here’s a simple function which calculates x" based on input parameters x and n (n > 0):

function power (x, n : byte) : longint;
var i : byte;
begin
i := 0; result := 1;
if n > 0 then
for i := 1 to n do result := result*x;
end;
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Now we could call it to calculate, say, 312:

tmp := power (3, 12);

Procedures
Procedure is declared like this:
procedure procedure_name(parameter_list);
{ local declarations }
begin
{ procedure body }
end;
procedure name represents a procedure’s name and can be any valid identifier. Within parentheses, parameter
list is a formal parameter list very similar to variable declaration. In Pascal, parameters are always passed to a
procedure by the value — to pass an argument by address, add the keyword var ahead of identifier.

Local declarations are optional declaration of variables and/or constants, local for the given procedure. Procedure
body is a sequence of statements to be executed upon calling the procedure.

Calling a procedure

A procedure is called by its name, with actual arguments placed in the same sequence as their matching formal
parameters. The compiler is able to coerce mismatching arguments to the proper type according to implicit conversion
rules. Upon procedure call, all formal parameters are created as local objects initialized by the values of actual
arguments.

Procedure call is a self-contained statement.

Example
Here’s an example procedure which transforms its input time parameters, preparing them for output on Lcd:

procedure time prep(var sec, min, hr : byte);

begin
sec := ((sec and $F0) shr 4)*10 + (sec and $O0F);
min = ((min and S$FO0) shr 4)*10 + (min and S$OF);
hr := ((hr and S$FO0) shr 4)*10 + (hr and S$O0F);
end;

A function can return a complex type. Follow the example bellow to learn how to declare and use a function which
returns a complex type.
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Example:

This example shows how to declare a function which returns a complex type.

program Example;

type TCircle = record // Record
CenterX, CenterY: word;
Radius: byte;

end;

var MyCircle: TCircle; // Global variable

function DefineCircle(x, y: word; r: byte): TCircle; // DefineCircle function returns a
Record

begin
result.CenterX := x;
result.CenterY Vi
result.Radius := r;
end;

begin

MyCircle := DefineCircle (100, 200, 30); // Get a Record via function
call

MyCircle.CenterX := DefineCircle (100, 200, 30).CenterX + 20; // Access a Record field
via function call

// |- \ [ ===~ |

// | |

// Function returns TCircle Access to one field of TCircle
end.

Forward declaration

A function can be declared without having it followed by it's implementation, by having it followed by the forward
procedure. The effective implementation of that function must follow later in the unit. The function can be used after a
forward declaration as if it had been implemented already. The following is an example of a forward declaration:

program Volume;
var Volume : word;
function First(a, b : word) : word; forward;

function Second(c : word) : word;
var tmp : word;
begin
tmp := First (2, 3);
result := tmp * c;
end;
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function First(a, b : word) : word;
begin

result := a * Db;
end;

begin

Volume := Second (4);
end.

Functions reentrancy

Functions reentrancy is allowed. Remember that the PIC32 have memory limitations that can vary between MCUs.

Types

Pascal is strictly typed language, which means that every variable and constant need to have a strictly defined type,
known at the time of compilation.

The type serves:

- to determine the correct memory allocation required,
- to interpret the bit patterns found in the object during subsequent accesses,
- in many type-checking situations, to ensure that illegal assignments are trapped.

mikroPascal PRO for PIC32 supports many standard (predefined) and user-defined data types, including signed and
unsigned integers of various sizes, arrays, strings, pointers and records.

Type Categories
Types can be divided into:

- simple types
- arrays

- strings

- pointers

- records
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Simple Types

Simple types represent types that cannot be divided into more basic elements and are the model for representing
elementary data on machine level. Basic memory unit in mikroPascal PRO for PIC32 has 32 bits.

Here is an overview of simple types in mikroPascal PRO for PIC32:

Type Size Range

bit 1-bit Oor1

sbhit 1-bit Oor1

byte, char 8—bit 0..255

short 8—bit -127 ..128

word 16-bit 0 ..65535

integer 16-bit -32768 .. 32767

dword 32-hit 0 .. 4294967295

longint 32—hit -2147483648 .. 2147483647

real 32-bit +1.17549435082 *  10-38
16.80564774407 * 1038

int64 64—bit -9223372036854775808
9223372036854775807

uint64 64—bit 0 .. 18446744073709551615

You can assign signed to unsigned or vice versa only using the explicit conversion. Refer to Types Conversions for
more information.

Derived Types

The derived types are also known as structured types. They are used as elements in creating more complex user-
defined types.

The derived types include:
- arrays

- pointers
- records
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Arrays

An array represents an indexed collection of elements of the same type (called the base type). Because each element
has a unique index, arrays, unlike sets, can meaningfully contain the same value more than once.

Array Declaration
Array types are denoted by constructions in the following form:
array[index start .. index end] of type

Each of the elements of an array is numbered from index start through index end. The specifier index start
can be omitted along with dots, in which case it defaults to zero.

Every element of an array is of type and can be accessed by specifying array name followed by element’s index within
brackets.

Here are a few examples of array declaration:

var
weekdays : array[l..7] of byte;
samples : array[50] of word;

begin
// Now we can access elements of array variables, for example:
samples[0] := 1;
if samples[37] = 0 then

Constant Arrays

Constant array is initialized by assigning it a comma-delimited sequence of values within parentheses. For example:

// Declare a constant array which holds number of days in each month:
const MONTHS : array[l..l12] of byte = (31,28,31,30,31,30,31,31,30,31,30,31);

The number of assigned values must not exceed the specified length. The opposite is possible, when the trailing
“excess” elements are assigned zeroes.

For more information on arrays of char, refer to Strings.

Multi-dimensional Arrays

Multidimensional arrays are constructed by declaring arrays of array type. These arrays are stored in memory in such
way that the right most subscript changes fastest, i.e. arrays are stored “in rows”. Here is a sample 2-dimensional
array:

m : array([5] of array[l10] of byte; // 2-dimensional array of size 5x10

Avariable mis an array of 5 elements, which in turn are arrays of 10 byte each. Thus, we have a matrix of 5x10 elements
where the first elementis m[0] [0] and lastoneis m[4] [ 9]. The first element of the 4th row would be m [3] [0].
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Strings

A string represents a sequence of characters equivalent to an array of char. It is declared like this:

string name : string[length]

The specifier 1ength is a number of characters the string consists of. The string is stored internally as the given
sequence of characters plus a final nu1 1 character (zero) which is introduced to terminate the string. It does not count
against the string’s total length.

A null string (' ") is stored as a single null character.

You can assign string literals or other strings to string variables. String on the right side of an assignment operator has
to be shorter or of equal length than the one on the right side. For example:

var
msgl : string[20];
msg2 : string[l19];

begin
msgl := 'This is some message';
msg2 := 'Yet another message';
msgl := msg2; // this is ok, but vice versa would be illegal

Alternately, you can handle strings element—by—element. For example:

var s : string[5];

'mik';

is char literal 'm'
is char literal
is char literal 'k'

i
is zero

is undefined

is undefined

g w N O

~— n 0 O n n n ~n -

Be careful when handling strings in this way, since overwriting the end of a string will cause an unpredictable
behavior.

String Concatenating

mikroPascal PRO for PIC32 allows you to concatenate strings by means of plus operator. This kind of concatenation is
applicable to string variables/literals, character variables/literals. For control characters, use the non-quoted hash sign
and a numeral (e.g. #13 for CR).
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var msg : string[20];

res _txt : string[5];
res, channel : word;
begin
/] ...

// Get result of ADC
res := Adc Read(channel);

// Create string out of numeric result
WordToStr (res, res txt);

// Prepare message for output

msg := 'Result is ' + // Text "Result is"
res_txt ; // Result of ADC
/).
Notes :

- In current version plus operator for concatenating strings will accept at most two operands.
- mikroPascal PRO for PIC32 includes a String Library which automatizes string related tasks.

Pointers

A pointer is a data type which holds a memory address. While a variable accesses that memory address directly, a
pointer can be thought of as a reference to that memory address.

To declare a pointer data type, add a carat prefix (*) before type. For example, in order to create a pointer to an
integer, write:

“integer;

In order to access data at the pointer’s memory location, add a carat after the variable name. For example, let’s declare
variable p which points to a word, and then assign value 5 to the pointed memory location:

var p : “word;

A pointer can be assigned to another pointer. However, note that only the address, not the value, is copied. Once you
modify the data located at one pointer, the other pointer, when dereferenced, also yields modified data.

Pointers and memory spaces

Pointers can point to data in any available memory space.
Pointers can reside in any available memory space except in program (code) memory space.
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var ptrl: “const byte; // ptrl pointer in data space pointing to a
byte in code space

var ptr2: “const “volatile sfr byte; rx; // ptr2 is pointer in rx space pointing to a
pointer in code space pointing to volatile byte in sfr space

var ptr3: “data byte; code; // error, pointers can not be placed in code
space

Due to backward compatibility, pointers to program memory space can also be declared within constant declaration
block (using keyword const):

program const ptr;

// constant array will be stored in program memory

const b array: array([5] of byte = (1,2,3,4,5);
const ptr: "“byte; // ptr is pointer to program memory space
begin
ptr := @b_array; // ptr now points to b _arrayl[0]
PORTA := ptr”*;
ptr := ptr + 3; // ptr now points to b _array[3]
PORTA := ptr”*;
end.

This leads to equality of the following declarations:

var ptrl : “const byte; // ptrl pointer in data space pointing to a byte in code
space
const ptr2 : "“byte; // ptr2 pointer in data space pointing to a byte in code
space

Therefore, when declaring a pointer within constant declaration block, const qualifier refers to pointed object, not to
pointer itself.

Notes :
- Pointer to constant space (Flash memory) is allocated in RAM.

- Constants of a simple type are not allocated in the Flash memory nor in RAM, but changed in the compile time, and
therefore address of a such constant can not be obtained.

Function Pointers

Function pointers are allowed in mikroPascal PRO for PIC32. The example shows how to define and use a function
pointer:

Example:

Example demonstrates the usage of function pointers. It is shown how to declare a procedural type, a pointer to
function and finally how to call a function via pointer.
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program Example;

type TMyFunctionType = function (paraml, param2: byte; param3: word) word; // First,
define the procedural type
var MyPtr: "TMyFunctionType; // This is a pointer to previously defined type
Sample: word;
function Funcl (pl, p2: byte; p3: word): word; // Now, define few functions
which will be pointed to. Make sure that parameters match the type definition
begin
result := pl and p2 or p3; // return something
end;
function Func2 (abc: byte; def: byte; ghi: word): word; // Another function of the
same kind. Make sure that parameters match the type definition
begin
result := abc * def + ghi; // return something
end;
function Func3 (first, yellow: byte; monday: word): word; // Yet another function. Make
sure that parameters match the type definition
begin
result := monday - yellow - first; // return something
end;
// main program:
begin
MyPtr = @Funcl; // MyPtr now points to Funcl
Sample := MyPtr”~ (1, 2, 3); // Perform function call via pointer, call Funcl,
the return value is 3
MyPtr = @Func2; // MyPtr now points to Func2
Sample := MyPtr”~ (1, 2, 3); // Perform function call via pointer, call Func2,
the return value is 5
MyPtr = @Func3; // MyPtr now points to Func3
Sample := MyPtr”~ (1, 2, 3); // Perform function call via pointer, call Func3,

the return

end.

value is 0

Therefore, when declaring a pointer within constant declaration block, const qualifier refers to pointed object, not to

pointer itself.
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@ Operator

The @ operator constructs a pointer to its operand. The following rules are applied to @:
- If X is a variable, @x returns a pointer to x.
Note : If variable i is of array type, the @ operator will return pointer to it's first basic element, except when the left side
of the statement in which x is used is an array pointer.

In this case, the @ operator will return pointer to array, not to it's first basic element.

program example;

var w 1 word;
ptr b : “byte;
ptr arr : “array[10] of byte;
arr : array|[l10] of byte;
begin
ptr b := Qarr; // @ operator will return "“byte
w := Qarr; // @ operator will return "“byte
ptr arr := Qarr; // @ operator will return “array[l0] of byte
end.

- If F is a routine (a function or procedure), ¢F returns a pointer to F.

Related topics: Pointer Arithmetic

Pointer Arithmetic

Pointer arithmetic in the mikroPascal PRO for PIC32 is limited to:
- assigning one pointer to another,
- comparing two pointers,
- comparing pointer to zero,

- adding/subtracting pointer and an integer value,
- subtracting two pointers.

Assignment and Comparison

The simple assignment operator (=) can be used to assign value of one pointer to another if they are of the same
type.

Assigning the integer constant 0 to a pointer assigns a null pointer value to it.

Two pointers pointing to the same array may be compared by using relational operators =, <>, <, <=, >, and >=.
Results of these operations are the same as if they were used on subscript values of array elements in question:
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var ptrl : “byte;
ptr2 : "“byte;

a : array[1l0] of byte; // array a containing 10 elements of type byte

begin

ptrl := Qal4];

ptr2 := Qal2];

if (ptrl = ptr2) then ... // won't be executed as 4 is not equal to 2

if (ptrl > ptr2) then ... // will be executed as 4 is greater than 2

if (ptrl”® = ptr2”) then ... // if the value pointed to by ptrl is equal to the value
pointed to by ptr2

if (ptrl” > ptr2”) then ... // if the value pointed to by ptrl is greater to the value
pointed to by ptr2

end.

Note : Comparing pointers pointing to different objects/arrays can be performed at programmer’s own responsibility —
a precise overview of data’s physical storage is required.

Pointer Addition

You can use Inc to add an integral value to a pointer. The result of addition is defined only if the pointer points to an
element of an array and if the result is a pointer pointing to the same array (or one element beyond it).

If a pointer is declared to point to type, adding an integral value n to the pointer increments the pointer value by n *
sizeof (type) as long as the pointer remains within the legal range (first element to one beyond the last element). If
type has a size of 10 bytes, then adding 5 to a pointer to type advances the pointer 50 bytes in memory.

For example:
var
a : array[1l0] of byte; // array a containing 10 elements of type byte
ptr : “byte; // pointer to byte
begin
ptr := Qa[0]; // ptr is pointer to byte, pointing to al0]
ptr := ptr + 3; // ptr+3 is a pointer pointing to al[3]
ptr” = 6; // al[3] now equals 6
Inc (ptr); // ptr now points to the next element of array a: al[4]
end.

Also, you may sum values pointed to by pointers.
For example:

var
i, j, x : Dbyte; // variables
ptrl : “byte; // pointers to byte
ptr2 : "“byte;
begin
i := 10; // assign value 10 to variable; i is at the address 0x0038
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j = 5; // assign value 10 to variable; J is at the address 0x003A

ptrl := @1i; // ptrl is pointer to byte, pointing to i

ptr2 := @j; // ptr2 is a pointer pointing to j

X = ptrl”® + ptr2®; // result is equal to the sum of the values pointed to; x = 5
end.

Pointer Subtraction
Similar to addition, you can use Dec to subtract an integral value from a pointer.

If a pointer is declared to point to type, subtracting an integral value n from the the pointer decrements the pointer value
by n * sizeof (type) as long as the pointer remains within the legal range (first element to one beyond the last
element). If type has a size of 10 bytes, then subtracting 5 from a pointer to type pushes back the pointer 50 bytes in
memory.

For example:
var
a : array[l1l0] of byte; // array a containing 10 elements of type byte
ptr : “byte; // pointer to byte
begin
ptr := Qal6]; // ptr is pointer to byte, pointing to al[6]
ptr := ptr - 3; // ptr-3 is a pointer pointing to al[3]
ptr® := 6; // al[3] now equals 6
Dec (ptr) ; // ptr now points to the previous element of array a: al[2]
end.

Also, you may subtract two pointers. The difference will be equal to the distance between two pointed addresses, and
is calculated regarding to the type which the pointer points to.

For example:
var
i, j, x : Dbyte; // variables
ptrl : "“byte; // pointers to byte

ptr2 : "“byte;

begin

i := 10; // assign value 10 to variable; i is at the address 0x0039

j = 5; // assign value 5 to variable; J is at the address 0x003A
ptrl := @i; // ptrl is a pointer to byte, pointing to i

ptr2 := @j; // ptr2 is a pointer pointing to j

x = ptr2 - ptrl; // result is equal to the distance between the two pointed ad-
dresses; x = 1 (1 byte)

x = ptrl” - ptr2”; // result is equal to the difference of the values pointed to;
x =5
end
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Records

A record (analogous to a structure in some languages) represents a heterogeneous set of elements. Each element is
called a field. The declaration of the record type specifies a name and type for each field. The syntax of a record type
declaration is

type recordTypeName = record
fieldListl : typel;

fieldListn : typen;
end;
where recordTypeName is a valid identifier, each type denotes a type, and each fie1dList is a valid identifier or a
comma-delimited list of identifiers. The scope of a field identifier is limited to the record in which it occurs, so you don’t
have to worry about naming conflicts between field identifiers and other variables.

Note : In mikroPascal PRO for PIC32, you cannot use the record construction directly in variable declarations, i.e.
without type.

For example, the following declaration creates a record type called TDot:

type
TDot = record
X, y @ real;

end;

Each Thot contains two fields: x and y coordinates. Memory is allocated when you declare the record, like this:
var m, n: TDot;

This variable declaration creates two instances of Thot, called m and n.

A field can be of previously defined record type. For example:

// Structure defining a circle:

type
TCircle = record
radius : real;
center : TDot;

end;

Accessing Fields

You can access the fields of a record by means of dot (.) as a direct field selector. If we have declared variables
circlel and circle? of previously defined type TCircle:

var circlel, circle2 : TCircle;

we could access their individual fields like this:
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circlel.radius := 3.7;
circlel.center.x := 0;
circlel.center.y := 0;

Accessing the fields is possible via the with statement as well.
You can also commit assignments between complex variables, if they are of the same type:

circle2 := circlel; // This will copy values of all fields

Types Conversions

Conversion of variable of one type to a variable of another type is typecasting. mikroPascal PRO for PIC32 supports
both implicit and explicit conversions for built-in types.

Implicit Conversion
Compiler will provide an automatic implicit conversion in the following situations:

- statement requires an expression of particular type (according to language definition), and we use an expression of
different type,

- operator requires an operand of particular type, and we use an operand of different type,

- function requires a formal parameter of particular type, and we pass it an object of different type,

- result does not match the declared function return type.

Promotion

When operands are of different types, implicit conversion promotes the less complex type to more complex type taking
the following steps:

bit , byte/char
byte/char - word
short > integer
short > longint
integer > longint
integer »  real

Higher bytes of extended unsigned operand are filled with zeroes. Higher bytes of extended signed operand are filled
with bit sign (if number is negative, fill higher bytes with one, otherwise with zeroes). For example:

var a : byte; b : word;

a := SFF;
b :=a; // a is promoted to word, b becomes SO00FF
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Clipping

In assignments and statements that require an expression of particular type, destination will store the correct value only
if it can properly represent the result of expression, i.e. if the result fits in destination range.

If expression evaluates to a more complex type than expected, excess of data will be simply clipped (higher bytes are
lost).

var i : byte; J : word;

/).

j := SFFOF;

i =73 // 1 becomes $0F, higher byte $FF is lost

Explicit Conversion
Explicit conversion can be executed at any point by inserting type keyword (byte, word, short, integer, longint or real)
ahead of an expression to be converted. The expression must be enclosed in parentheses. Explicit conversion can be

performed only on the operand right of the assignment operator.

Special case is conversion between signed and unsigned types. Explicit conversion between signed and unsigned data
does not change binary representation of data — it merely allows copying of source to destination.

For example:
var a : byte; b : short;

b = -1;
a byte(b); // a is 255, not 1

// This is because binary representation remains
// 11111111; it's just interpreted differently now

You can’t execute explicit conversion on the operand left of the assignment operator:

word(b) := a; // Compiler will report an error

Conversions Examples
Here is an example of conversion:
program test;

type TBytePtr = "byte;

var arr: array[l0] of word;
ptr : TBytePtr;

var a, b, cc : byte;
dd : word;
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begin
a := 241;
b := 128;
cc :=a + b; // equals 113
cc := word(a + b); // equals 113
dd := a + b; // equals 369
ptr := TBytePtr (Qarr);
ptr := “byte (Qarr);

end.

Type Specifier

The specifier type introduces a synonym for a specified type. The type declarations are used to construct shorter or
more convenient names for types already defined by the language or declared by the user.

The specifier type stands first in the declaration:

type synonym = <type definition>;

The type keyword assigns synonymto <type definition>. The synonym needs to be a valid identifier.

A declaration starting with the type specifier does not introduce an object or a function of a given type, but rather a
new name for a given type. In other words, the type declaration is identical to a “normal” declaration, but instead of
objects, it declares types. It is a common practice to name custom type identifiers with starting capital letter — this is
not required by the mikroPascal PRO for PIC32.

For example:

// Let’s declare a synonym for “byte”
type Distance = byte;

// Now, synonym “Distance” can be used as type identifier:
var i : Distance; // declare variable i of byte
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Type Qualifiers

The type qualifiers const and volatile are optional in declarations and do not actually affect the type of declared
object.

Qualifier const

The qualifier const implies that a declared object will not change its value during runtime. In declarations with the
const qualifier all objects need to be initialized.

The mikroPascal PRO for PIC32 treats objects declared with the const qualifier the same as literals or preprocessor
constants. If the user tries to change an object declared with the const qualifier compiler will report an error.

For example:

const PI : byte := 3.14159;

Qualifier volatile

The qualifier volatile implies that a variable may change its value during runtime independently from the program. Use
the volatile modifier to indicate that a variable can be changed by a background routine, an interrupt routine, or I/O port.
Declaring an object to be volatile warns the compiler not to make assumptions concerning the value of an object while
evaluating expressions in which it occurs because the value could be changed at any moment.

Operators

Operators are tokens that trigger some computation when being applied to variables and other objects in an
expression.

There are four types of operators in mikroPascal PRO for PIC32:

- Arithmetic Operators
- Bitwise Operators

- Boolean Operators

- Relational Operators
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Operators Precedence and Associativity

There are 4 precedence categories in mikroPascal PRO for PIC32. Operators in the same category have equal
precedence with each other.

Each category has an associativity rule: left-to-right (—), or right-to-left (<). In the absence of parentheses, these rules
resolve the grouping of expressions with operators of equal precedence.

Precedence Operands Operators Associativity
4 1 @ not + - —
3 2 * / div mod and shl shr N
2 2 + - or xor N
1 2" = <> < > <= >= -

Arithmetic Operators

Arithmetic operators are used to perform mathematical computations. They have numerical operands and return
numerical results. Since the char operators are technically bytes, they can be also used as unsigned operands in
arithmetic operations.

All arithmetic operators associate from left to right.

Operator | Operation Operands Result
+ addition byte, short, word, integer, |byte, short, word,
longint, dword, real integer, longint, dword,
real
- subtraction byte, short, word, integer, |byte, short, word, integer,
longint, dword, real longint, dword, real
* multiplication byte, short, word, integer, |word, integer, longint,
longint, dword, real dword, real
/ division, floating-point byte, short, word, integer, | real
longint, dword, real
div division, rounds down to|byte, short, word, integer, |byte, short, word,
nearest integer longint, dword integer, longint, dword
mod modulus,returnstheremainder | byte, short, word, integer, |byte, short, word,
of integer division (cannot be | longint, dword integer, longint, dword
used with floating points)

Division by Zero

If O (zero) is used explicitly as the second operand (i.e. x div 0), the compiler will report an error and will not generate

code.

But in case of implicit division by zero: x div vy, where y is 0 (zero), the result will be the maximum integer (i.e 255, if
the result is byte type; 65536, if the result is word type, etc.).
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Unary Arithmetic Operators

Operator - can be used as a prefix unary operator to change sign of a signed value. Unary prefix operator + can be
used, but it doesn’t affect data.

For example:

b := -a;

Relational Operators
Use relational operators to test equality or inequality of expressions. All relational operators return TRUE or FATSE.
All relational operators associate from left to right.

Relational Operators Overview

Operator Operation

= equal

<> not equal

> greater than

< less than

>= greater than or equal
<= less than or equal

Relational Operators in Expressions

Precedence of arithmetic and relational operators is designated in such a way to allow complex expressions without
parentheses to have expected meaning:

a+ 5> c¢c-1.0/ e // - (a + 5) > (c - (1.0 / e))
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Bitwise Operators
Use bitwise operators to modify individual bits of numerical operands.

Bitwise operators associate from left to right. The only exception is the bitwise complement operator not which associates
from right to left.

Bitwise Operators Overview

Operator | Operation

and bitwise AND; compares pairs of bits and returns 1 if both bits are 1, otherwise it returns 0

or bitwise (inclusive) OR; compares pairs of bits and generates a 1 result if either or both bits are 1,
otherwise it returns 0

xor bitwise exclusive OR (XOR); compares pairs of bits and generates a 1 resultif the bits are complementary,
otherwise it returns 0

not bitwise complement (unary); inverts each bit

shl bitwise shift left; moves the bits to the left, discards the far left bit and assigns 0 to the right most bit.

shr bitwise shift right; moves the bits to the right, discards the far right bit and if unsigned assigns 0 to the

left most bit, otherwise sign extends

Logical Operations on Bit Level

and |0 1 or 0 1 xor 0 1 not 0 1
0 0 0 0 1 0 0 1 0
1 0 1 1 1 1 0

Bitwise operators and, or, and xor perform logical operations on the appropriate pairs of bits of their operands. The
operator not complements each bit of its operand. For example:

$1234 and $5678 // equals $1230
{ because

$1234 : 0001 0010 0011 0100
$5678 : 0101 0110 0111 1000

and : 0001 0010 0011 0000

that is, $1230 }

// Similarly:

$1234 or $5678 // equals $567C
$1234 xor $5678 // equals $444C
not $1234 // equals SEDCB
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Unsigned and Conversions

If a number is converted from less complex to more complex data type, the upper bytes are filled with zeroes. If a
number is converted from more complex to less complex data type, the data is simply truncated (the upper bytes are
lost).

For example:

var a : byte; b : word;
1= SAA;

SFOFO;

:= b and a;
a 1s extended with zeroes; b becomes $00A0 }

a
b
b
{

Signed and Conversions

If number is converted from less complex to more complex data type, the upper bytes are filled with ones if sign bit is
1 (number is negative); the upper bytes are filled with zeroes if sign bit is 0 (number is positive). If number is converted
from more complex to less complex data type, the data is simply truncated (the upper bytes are lost).

For example:

var a : byte; b : word;

a = -12;

b := S$T0FF;
b := b and a;

{ a is sign extended, with the upper byte equal to S$FF;
b becomes $70F4 }

Bitwise Shift Operators

Binary operators sh1 and shr move the bits of the left operand by a number of positions specified by the right operand,
to the left or right, respectively. Right operand has to be positive and less than 255.

With shift left (sh1), left most bits are discarded, and “new” bits on the right are assigned zeroes. Thus, shifting
unsigned operand to the left by n positions is equivalent to multiplying it by 2n if all discarded bits are zero. This is also
true for signed operands if all discarded bits are equal to the sign bit.

With shift right (shr), right most bits are discarded, and the “freed” bits on the left are assigned zeroes (in case of
unsigned operand) or the value of the sign bit (in case of signed operand). Shifting operand to the right by n positions
is equivalent to dividing it by 2.
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Boolean Operators

Although mikroPascal PRO for PIC32 does not support boolean type, you have Boolean operators at your disposal for
building complex conditional expressions. These operators conform to standard Boolean logic and return either TRUE
(all ones) or FALSE (zero):

Operator Operation

and logical AND

or logical OR

xXor logical exclusive OR (XOR)
not logical negation

Boolean operators associate from left to right. Negation operator not associates from right to left.

Unary Operators

Unary operators are operators that take exactly one argument.

Unary Arithmetic Operator

Operator - can be used as a prefix unary operator to change sign of a signed value. Unary prefix operator + can be
used also, but it doesn’t affect data.

For example:

b := -a;

Unary Bitwise Operator

The result of the not (bitwise negation) operator is the bitwise complement of the operand. In the binary representation
of the result, every bit has the opposite value of the same bit in the binary representation of the operand.

Operator Operation

not bitwise complement (unary); inverts each bit
Example:
not 0x1234 ' equals OxEDCB

Address and Indirection Operator

In the mikroPascal PRO for PIC32, address of an object in memory can be obtained by means of an unary operator @.
To reach the pointed object, we use an indirection operator ~ on a pointer. See Pointers section for more details.
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Operator | Operation

A

accesses a value indirectly, through a pointer; result is
the value at the address to which operand points

@ constructs a pointer to its operand

See Pointers for more details on this subject

Note : Besides these, sizeof and explicit conversion unary operators are supported also.

Sizeof Operator

The prefix unary operator sizeof returns an integer constant that represents the size of memory space (in bytes) used
by its operand (determined by its type, with some exceptions).

The operator sizeof can take either a type identifier or an unary expression as an operand. You cannot use sizeof with

expressions of function type, incomplete types, parenthesized names of such types, or with Ivalue that designates a
bit field object.

Sizeof Applied to Expression

If applied to expression, the size of an operand is determined without evaluating the expression (and therefore without
side effects). The result of the operation will be the size of the type of the expression’s result.

Sizeof Applied to Type

If applied to a type identifier, sizeof returns the size of the specified type. The unit for type size is sizeof(byte) which is
equivalent to one byte.

Thus:

sizeof (byte) // returns 1
sizeof (integer) // returns 2
sizeof (dword) // returns 4
sizeof (real) // returns 4

When the operand is a non-parameter of array type, the result is the total number of bytes in the array (in other words,
an array name is not converted to a pointer type):

var 1, J : integer;
samples : array[l0] of integer;
j := sizeof (samples[1l]); // j = sizeof (integer) = 2
i := sizeof (samples); // 1 = 10*sizeof (integer) = 20

If the operand is a parameter declared as array type or function type, sizeof gives the size of the pointer. When
applied to records, sizeof gives the total number of bytes, including any padding. The operator sizeof cannot be
applied to a function.
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Expressions

An expression is a sequence of operators, operands and punctuators that returns a value.

The primary expressions include: literals, constants, variables and function calls. More complex expressions can be
created from primary expressions by using operators. Formally, expressions are defined recursively: subexpressions
can be nested up to the limits of memory.

Expressions are evaluated according to certain conversion, grouping, associativity and precedence rules which depend
on the operators in use, presence of parentheses and data types of the operands. The precedence and associativity

of the operators are summarized in Operator Precedence and Associativity. The way operands and subexpressions
are grouped does not necessarily specify the actual order in which they are evaluated by mikroPascal PRO for PIC.

Expression Evaluation

General Rule

Expression are evaluated according to the right side operands. Operations are done at higher operand level, with
signed operands taking precedence.

Example :
a : byte;
: word;
c : integer;

* b // word level
* ¢ // integer level
b * ¢ // integer level

o o

Left side exception

In arithmetic expression left side is considered in the following manner : If the left side size in bytes is greater than
higher operand size, then evaluation is done at one level above higher operand level (to get correct calculations).

Example :

a: dword;
b: byte;

a := b * 5; // this is done at word level
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Conditional expressions
Conditional expressions may differ from the same code in assignment expressions (due to left side exception).
Example :

a: dword;

b: byte

if b*5 then... // byte level - general rule will not give same result as
a :=b * 5 // word level - general rule + left side exception

if a then...

if b*5 exceeds byte range.
Explicit Typecasting

Any expression can be evaluated at specific level by using explicit typecasting. Having in mind previous example, in
order to get same calculation in conditional and assignment expression, the following should be done :

if word(b*5) then... // word level

Statements

Statements define algorithmic actions within a program. Each statement needs to be terminated with a semicolon
(;)- In the absence of specific jump and selection statements, statements are executed sequentially in the order of
appearance in the source code.

The most simple statements are assignments, procedure calls and jump statements. These can be combined to form
loops, branches and other structured statements.

Refer to:

- Assignment Statements

- Compound Statements (Blocks)
- Conditional Statements

- Iteration Statements (Loops)

- Jump Statements

- asm Statement
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Assignment Statements
Assignment statements have the following form:
variable := expression;

The statement evaluates expression and assigns its value to variable. All the rules of implicit conversion are applied.
Variable can be any declared variable or array element, and expression can be any expression.

Do not confuse the assignment with relational operator = which tests for equality. Also note that, although similar, the
construction is not related to the declaration of constants.

Compound Statements (Blocks)
Compound statement, or block, is a list of statements enclosed by keywords begin and end:
begin

statements

end;

Syntactically, a block is considered to be a single statement which is allowed to be used when Pascal syntax requires
a single statement. Blocks can be nested up to the limits of memory.

For example, the while loop expects one statement in its body, so we can pass it a compound statement:

while i < n do

begin
temp := al[il;
ali] := b[i];
b[i] := temp;
i =1+ 1;
end;

Conditional Statements

Conditional or selection statements select one of alternative courses of action by testing certain values. There are two
types of selection statements:

- if

- case
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If Statement
Use the keyword if to implement a conditional statement. The syntax of the if statement has the following form:
if expression then statementl [else statement2]

If expression evaluates to true then statement1 executes. If expression is false then statement2 executes. The
expression must convert to a boolean type; otherwise, the condition is ill-formed. The else keyword with an alternate
statement (statement?) is optional.

There should never be a semicolon before the keyword e 1 se.

Nested if statements

Nested if statements require additional attention. A general rule is that the nested conditionals are parsed starting from
the innermost conditional, with each <1 se bound to the nearest available i £ on its left:

if expressionl then
if expression2 then statementl
else statement?

The compiler treats the construction in this way:

if expressionl then

begin
if expression2 then statementl
else statement?

end

In order to force the compiler to interpret our example the other way around, we have to write it explicitly:

if expressionl then
begin
if expression2 then statementl
end
else statement?
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Case Statement

Use the case statement to pass control to a specific program branch, based on a certain condition. The case statement
consists of a selector expression (a condition) and a list of possible values. The syntax of the case statement is:

case selector of

value 1 : statement 1

value n : statement n

[else default statement]
end;

selector is an expression which should evaluate as integral value. values can be literals, constants, or expressions,
and statements can be any statements.

The e1se clause is optional. If using the else branch, note that there should never be a semicolon before the keyword
else.

First, the selector expression (condition) is evaluated. Afterwards the case statement compares it against all available
values. If the match is found, the statement following the match evaluates, and the case statement terminates. In
case there are multiple matches, the first matching statement will be executed. If none of values matches selector, then
default statement inthe else clause (if there is some) is executed.

Here’s a simple example of the case statement:

case operator of

'*' : result := nl * n2;
'/' : result := nl / n2;
'+' : result := nl + n2;
'-'" : result := nl - n2
else result := 0;
end;

Also, you can group values together for a match. Simply separate the items by commas:

case reg of

0: opmode := 0;

1,2,3,4: opmode := 1;

5,6,7: opmode := 2;
end;

In mikroPascal PRO for PIC32, values in the case statement can be variables too:
case byte variable of
byte varl: opmode := 0; // this will be compiled correctly
byte var2:

opmode := 1; // avoid this case, compiler will parse
// a variable followed by colon sign as label

byte var3: // adding a comment solves the parsing problem
opmode := 2;

end;

Nested Case statement

Note that the case statements can be nested — values are then assigned to the innermost enclosing case statement.
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Iteration Statements

Iteration statements let you loop a set of statements. There are three forms of iteration statements in mikroPascal PRO
for PIC32:

- for
- while...do
- repeat

You can use the statements break and continue to control the flow of a loop statement. break terminates the statement
in which it occurs, while continue begins executing the next iteration of the sequence.

For Statement

The for statement implements an iterative loop and requires you to specify the number of iterations. The syntax of the
for statement is:

for counter := initial value to final value do statement list
// or
for counter := initial value downto final value do statement list

counter is a variable which increments (or decrements if you use downto) with each iteration of the loop. Before
the first iteration, counterissetto initial value and will increment (or decrement) until it reaches final value.
final value will be recalculated each time the loop is reentered.

This way number of loop iterations can be changed inside the loop by changing final_value. With each iteration,
statement 1list will be executed.

initial value andfinal value should be expressions compatible with counter.

If final value is a complex expression whose value can not be calculated in compile time and number of loop
iterations is not to be changed inside the loop by the means of final value, it should be calculated outside the for
statement and result should be passed as for statement’s final value. statement list is a list of statements
that do not change the value of counter. If statement 1ist contains more than one statement, statements must be
enclosed within begin-end block.

Here is an example of calculating scalar product of two vectors, a and b, of length 10, using the for statement:

Endless Loop
The for statement results in an endless loop if final value equals or exceeds the range of the counter’s type.

More legible way to create an endless loop in Pascal is to use the statement while TRUE do.
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While Statement

Use the while keyword to conditionally iterate a statement. The syntax of the while statement is:
while expression do statement

statement is executed repeatedly aslong as expression evaluates true. The test takes place before the statement
is executed. Thus, if expression evaluates false on the first pass, the loop does not execute.

Here is an example of calculating scalar product of two vectors, using the whi 1 e statement:

s = 0; 1 := 0;
while i < n do
begin
s :=s + a[i] * bli]l:
i+ 1;

i
end;

Probably the easiest way to create an endless loop is to use the statement:

while TRUE do ...;

Repeat Statement
The repeat statement executes until the condition becomes true. The syntax of the repeat statement is:
repeat statement until expression

statement is executed repeatedly as long as expression evaluates false. The expression is evaluated after each
iteration, so the loop will execute statement at least once.

Here is an example of calculating scalar product of two vectors, using the repeat statement:

s = 0; 1 := 0;
repeat
begin
s :=s + al[i] * bli]:
i =1+ 1;
end;
until i = n;
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Jump Statements

The jump statement, when executed, transfers control unconditionally. There are four such statements in mikroPascal
PRO for PIC32:

- break

- continue
- exit

- goto

asm Statement

mikroPascal PRO for PIC32 allows embedding assembly in the source code by means of the asm statement. Note that
you cannot use numerals as absolute addresses for register variables in assembly instructions. You may use symbolic
names instead (listing will display these names as well as addresses).

You can group assembly instructions with the 2 sm keyword:

asm
block of assembly instructions
end;

The only types whose name remains the same in asm as it is in the mikroPascal PRO for PIC32 are registers, e.g.
INTCON, PORTB, WREG, GIE, etc.

mikroPascal PRO for PIC32 comments are allowed in embedded assembly code.

Accessing variables
Depending on the place of declaration, accessing a variable can be done in several ways :

- Accessing global variable :

1. If declared under implementation section (visible only in the file where it was declared) : <source file
name> <variable name>.

2. If declared in the interface section (visible throughout the whole project) : <variable name>.

3. If accessing registers (declared through register, rx or sfr specifiers, visible throughout the whole project) :
<variable name>.

- Accessing local variable : <routine name> <variable name>.

- Accessing routine parameter : FARG <routine name> <variable name>.
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Here is an example of using asm instructions :
program asm example;

var myvar : word; absolute 0x2678;
const msg = 'Hello'; org 0x3678;

var myvarl : dword;

procedure proc(); org 0x1234;

begin
asm
nop
end;
end;
begin
myvar := 5;
myvarl := O0xABCD1234;
asm
MOV myvar, w0 ; move myvar to WO
nop
MOV #6, WO ; move literal 6 to WO
MOV W0, myvar ; move contents of WO to myvar
MOV #lo addr ( myvar), wl ; retrieve low address word of myvar and move
it to Wl (0x2678 -> W1l)
MOV #hi addr( myvar), Wl ; retrieve high address word of myvar and
move it to W1 (0x0000 -> W1)
MOV #lo addr( proc), WO ; retrieve hi address byte of routine proc and
move it to WO (0x0001 -> W1)
MOV #lo addr( msg), WO ; retrieve low address word of constant msg
and move it to WO (0x3652 -> W1l)
MOV myvarl+2, wO ; accessing hi word of myvarl variable and
move it to Wl (OxABCD -> Wl)
end;
end.

Asm code and SSA optimization

If asm code is mixed with the Pascal code, keep in mind that the generated code can substantially differ when SSA
optimization option is enabled or disabled.

This is due to the fact that SSA optimization uses certain working registers to store routine parameters (W10-W13),
rather than storing them onto the function frame.

Because of this, user must be very careful when writing asm code as existing values in the working registers used by
SSA optimization can be overwritten.
To avoid this, it is recommended that user includes desired asm code in a separate routine.
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With Statement

The With statement is a convenient method for referencing elements of a complex variable, such as a record.

It simplifies the code by removing the need to prefix each referenced element with the complex variable name; i.e.
accessing all of the record's fields with only one reference.

Example:

program With Test;

type Circle Parameters =

Record
x center : integer;
y_center : integer;
radius : integer;
end;
var Circle : Circle Parameters;
begin
With Circle do
begin
x center := 50;
y _center := 60;
radius = 10;
end;
end.
Directives

Directives are words of special significance which provide additional functionality regarding compilation and output.
The following directives are at your disposal:

- Compiler directives for conditional compilation,
- Linker directives for object distribution in memory.

Compiler Directives

mikroPascal PRO for PIC32 treats comments beginning with a “S” immediately following an opening brace as a compiler
directive; for example, {SE1.5E}. The compiler directives are not case sensitive.

You can use a conditional compilation to select particular sections of code to compile, while excluding other sections.
All compiler directives must be completed in the source file in which they have begun.
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Directives SDEFINE and $UNDEFINE

Use directive sDEFINE to define a conditional compiler constant (“flag”). You can use any identifier for a flag, with no
limitations. No conflicts with program identifiers are possible because the flags have a separate name space. Only one
flag can be set per directive.

For example:
{SDEFINE Extended format}
Use sUNDEFTINE to undefine (“clear”) previously defined flag.

Note : Pascal does not support macros; directives SDEFTNE and SUNDEFINE do not create/destroy macros. They only
provide flags for directive sTFDEF to check against.

Directives $IFDEF, $IFNDEF, $ELSE and $ENDIF

Conditional compilation is carried out by the sTFDEF and $TENDEF directives. STFDEF tests whether a flag is currently
defined, and s TFNDEF if the flag is not defined, i.e. whether a previous SDEFINE directive has been processed for that
flag and is still in force.

Directives sTFDEF and STFNDEF are terminated with the SENDTF directive and can have an optional SEL.SE clause:

{SIFDEF flag}

<block of code>
{SELSE}

<alternate block of code>
{SENDIF}

First, sT7DEF checks if flag is defined by means of sDEFINE. If so, only <block of code> will be compiled.
Otherwise, <alternate block of code> will be compiled. sENDTFE ends the conditional sequence. The result of
the preceding scenario is that only one section of code (possibly empty) is passed on for further processing.

The processed section can contain further conditional clauses, nested to any depth; each $17DEF must be matched
with a closing SENDTE.

Here is an example:

// Uncomment the appropriate flag for your application:
//{SDEFINE resolutionlO}
//{SDEFINE resolutionl2}

{SIFDEF resolutionlO}
// <code specific to 10-bit resolution>
{SELSE}
{SIFDEF resolutionl2}
// <code specific to 12-bit resolution>
{SELSE}
// <default code>
{SENDIF}
{SENDIF}
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Unlike sTFDEF, STFNDEF checks if flag is not defined by means of $DEFTNE, thus producing the opposite results.

Include Directive $I

The $I parameter directive instructs mikroPascal PRO for PIC32 to include the named text file in the compilation. In
effect, the file is inserted in the compiled text right after the {$T filename} directive. If filename does not specify a
directory path, then, in addition to searching for the file in the same directory as the current unit, mikroPascal PRO for
PI1C32 will search for file in order specified by the search paths.

To specify a filename that includes a space, surround the file name with quotation marks: {1 "My file'}.

There is one restriction to the use of include files: An include file can't be specified in the middle of a statement part. In
fact, all statements between the begin and end of a statement part must exist in the same source file.

See also Predefined Project Level Defines.

Linker Directives

mikroPascal PRO for PIC32 uses an internal algorithm to distribute objects within memory. If you need to have a
variable, constant or a routine at the specific predefined address, use the linker directives absolute and org.

When using these directives, be sure to use them in proper memory segments, i.e. for functions it is the KSEGO and
for variables it is the KSEG1. Linker directives are used with the virtual addresses.

Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the variable is multi-byte, higher bytes will be
stored at the consecutive locations.

Directive absolute is appended to declaration of a variable:

// Variable x will occupy 1 word (16 bits) at address 0xA0000000
var x : word; absolute 0xA0000000;

// Variable y will occupy 2 words at addresses 0xA0000000 and 0xA0000002
var y : longint; absolute 0xA0000000;

Be careful when using the absolute directive, as you may overlap two variables by accident. For example:

// Variable i will occupy 1 word at address 0xA0000002;
var 1 : word; absolute 0xA0000002;

// Variable will occupy 2 words at 0xA0000000 and OxA0000002; thus,
// changing i changes jj at the same time and vice versa
var jj : longint; absolute 0xA0000000;
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Directive org

Directive org specifies the starting address of a constant or a routine in ROM. It is appended to the constant or a routine
declaration.

To place a constant array in Flash memory, write the following :

// Constant array MONTHS will be placed starting from the address 0x9D000000

const MONTHS : array[l..l12] of byte = (31,28,31,30,31,30,31,31,30,31,30,31); org
0x800;

If you want to place simple type constant into Flash memory, instead of following declaration:

const SimpleConstant : byte = 0xAA; org 0x9D000000;

use an array consisting of single element :

const SimpleConstant : array[l] of byte = (0xAA); org 0x9D000000;

In first case, compiler will recognize your attempt, but in order to save Flash space, and boost performance, it will
automatically replace all instances of this constant in code with it's literal value.

In the second case your constant will be placed in Flash in the exact location specified.

To place a routine on a specific address in Flash memory you should write the following :

procedure proc (par : byte); org 0x9D000000;

begin

// Procedure will start at address 0x9D000000;

end;

org directive can be used with ma in routine too. For example:

program Led Blinking;

begin org 0x9D000000; // main procedure starts at 0x9D000000

end.

Directive orgall
Use the orga 11 directive to specify the address above which all routines and constants will be placed. Example:
begin

orgall (0x9D000000); // All the routines, constants in main program will be above the

address 0x9D000000

end.
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CHAPTER 9

mikroPascal PRO for PIC32
Libraries

mikroPascal PRO for PIC32 provides a set of libraries which simplify the initialization and use of PIC32 and their
modules:

Use Library manager to include mikroPascal PRO for PIC32 Libraries in you project.
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Hardware Libraries

- ADC Library

- CANSPI Library

- Compact Flash Library

- Epson S1D13700 Graphic Lcd Library
- Flash Memory Library

- Graphic Lcd Library

- I2C Library

- Keypad Library

- Lcd Library

- Manchester Code Library

- Memory Manager Library

- Multi Media Card Library

- OneWire Library

- Port Expander Library

- PS/2 Library

- PWM Library

- RS-485 Library

- Software I?C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Ethernet ENC24J600 Library
- SPI Graphic Lcd Library

- SPI Lcd Library

- SPI Lcd8 Library

- SPI T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- TFT Display Library

- Touch Panel Library

- Touch Panel TFT Library

- UART Library

- USB Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- PrintOut Library

- Setjmp Library

- Sprint Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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Hardware Libraries

- ADC Library
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ADC Library

ADC (Analog to Digital Converter) module is available with a number of PIC32 MCU modules. ADC is an electronic
circuit that converts continuous signals to discrete digital numbers. ADC Library provides you a comfortable work with
the module.

Library Routines

- ADC1_Init
-ADC1_Init_Advanced
-ADC1_Get_Sample
-ADC1_Read

ADC1_lInit

Prototype |procedure ADCI Init();

Description | This routines configures ADC module to work with default settings.
The internal ADC module is set to:

- single channel conversion

- 10-bit conversion resolution
- unsigned integer data format
- auto-convert

- VRef+ : Avdd, VRef- : AVss
- instruction cycle clock

- conversion clock : 32*Tcy

- auto-sample time : 31TAD

Parameters | None.

Returns Nothing.
Requires - MCU with built-in ADC module.
Example ADC1l Init(); // Initialize ADC module with default settings

Notes None.
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ADC1_Init_Advanced

Prototype procedure ADCl Init Advanced (Reference : word);
Description | This routine configures the internal ADC module to work with user defined settings.
Parameters | - Reference: voltage reference used in ADC process.
Description Predefined library const
Voltage reference:

Internal voltage reference _ADC_INTERNAL REF

External voltage reference _ADC_EXTERNAL REF
Returns Nothing.
Requires - The MCU with built-in ADC module.
Example ADC1l Init Advanced( ADC_INTERNAL REF); // set internal reference used
Notes - Not all MCUs support advanced configuration. Please, read the appropriate datasheet before utilizing

this library.

ADC1_Get_Sample

Prototype function ADCl Get Sample (channel : word) : word;

Description | The function enables ADC module and reads the specified analog channel input.

Parameters | - channel represents the channel from which the analog value is to be acquired.

Returns 10-bit unsigned value from the specified channe.

Requires - The MCU with built-in ADC module.
- Prior to using this routine, ADC module needs to be initialized. See ADCx_Init and ADCx_Init_
Advanced.
- Before using the function, be sure to configure the appropriate TRISx bits to designate pins as
inputs.

Example var adc value : word;
adc_value = ADCl Get Sample (10); // read analog value from ADC module
channel 10

Notes - The function sets the appropriate bit in the AD1PCFG registers to enable analog function of the
chosen pin.
- Refer to the appropriate Datasheet for channel-to-pin mapping.
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ADC1_Read

Prototype

function ADC1 Read(channel : word) : word;

Description

The function initializes, enables ADC module and reads the specified analog channel input.

Parameters

- channel represents the channel from which the analog value is to be acquired.

Returns

10-bit unsigned value from the specified channel.

Requires - The MCU with built-in ADC module.
- Before using the function, be sure to configure the appropriate TRISx bits to designate pins as
inputs.
Example var adc_value : word;
adc_value = ADC1l Read(10); // read analog value from ADC module channel 10
Notes - This is a standalone routine, so there is no need for a previous initialization of ADC module.

- The function sets the appropriate bit in the ADPCFG registers to enable analog function of the
chosen pin.
- Refer to the appropriate Datasheet for channel-to-pin mapping.
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Library Example
This code snippet reads analog value from the channel 1 and sends readings as a text over UART1.
Copy Code To Clipboard

program Temperature Sensor;

// LCD module connections

var LCD RS : sbit at LATB2Z bit;
var LCD EN : sbit at LATB3 bit;
var LCD D4 : sbit at LATB4 bit;
var LCD D5 : sbit at LATBS5 bit;
var LCD D6 : sbit at LATB6 bit;
var LCD D7 : sbit at LATB7 bit;

var LCD RS Direction : sbit at TRISB2 bit;
var LCD EN Direction : sbit at TRISB3 bit;
var LCD D4 Direction : sbit at TRISB4 bit;
var LCD D5 Direction : sbit at TRISBS bit;
var LCD D6 Direction : sbit at TRISB6 bit;
var LCD D7 Direction : sbit at TRISB7 bit;
// End LCD module connections

var temp : real;
txt : array[20] of char;,

// Convert ADC value to Celsius degrees format
function ADC to degC() : real;

begin
result := ADC1 Get Sample(8); // Read ADC value from AN8 pin
result := (((3.25/1024) * result - 0.5) * 100);,;

end;

begin

CHECON := 0x32;

ADIPCFG := OxFFF7; // Configure AN8 pin as analog I/0

ADC1 Init(); // Initialize ADC

Delay 100ms () ;

Led Init(); // Initialize LCD

Lcd Cmd(_LCD CLEAR) ; // Clear LCD

Lcd Cmd( LCD CURSOR OFF) ; // Turn cursor off

Led Out (1, 1, ' Temperature: ‘),

while (TRUE) do

begin
temp := ADC to degC(); // Convert ADC value to Celsius degrees format
FloatToStr (temp, txt);
Led Chr(2,13,223) ; // Print degree character, 'C’ for Centigrades
// Different LCD displays have different char code for degree
Led Chr(2,14,7C7); // If you see greek alpha letter try typing
178 instead of 223
Led Out (2, 5, txt); // Display value on the LCD
Delay 1sec(); // 1 second delay
end;
end.
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CANSPI Library

The SPI module is available with a number of the PIC32 MCUs. The mikroPascal PRO for PIC32 provides a library
(driver) for working with mikroElektronika’s CANSPI Add-on boards (with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization, self’Ichecking and fault confinement.
Faulty CAN data and remote frames are re-transmitted automatically, similar to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at network lengths below 40m while
250 Kbit/s can be achieved at network lengths below 250m. The greater distance the lower maximum bitrate that can
be achieved. The lowest bitrate defined by the standard is 200Kbit/s. Cables used are shielded twisted pairs.

CAN supports two message formats:

- Standard format, with 11 identifier bits and
- Extended format, with 29 identifier bits

Important :

- Consult the CAN standard about CAN bus termination resistance.

- An effective CANSPI communication speed depends on SPI and certainly is slower than “real” CAN.

- The library uses the SPI module for communication. User must initialize appropriate SPI module before
using the SPI Graphic Lcd Library.

- For MCUs with multiple SPI modules it is possible to initialize both of them and then switch by using the
SPI_Set_Active routine.

- Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet before
utilizing this library.

Library Dependency Tree
]—’tSPI ]

LCANSW

External dependencies of CANSPI Library

The following variables must be

defined in all projects using CANSPI
Library:

Description:

Example:

sbit; sfr; external;

Direction of the Chip Select pin.

var CanSpi CS sbit; sfr; . . var CansSpi CS sbit at

external; Chip Select line. LATFO bit;

var CanSpi Rst sbit; sfr; . var CanSpi Rst sbit at
Reset line. I

external; LATF1 bit;

var CanSpi CS Direction var CanSpi CS Direction

sbit at TRISFO bit;

var
sbit; sfr; external;

CanSpi Rst Direction

Direction of the Reset pin.

var CanSpi Rst Direction :
sbit at TRISF1 bit;
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Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode
- CANSPIInit

- CANSPISetBaudRate

- CANSPISetMask

- CANSPISetFilter

- CANSPIRead

- CANSPIWrite

CANSPISetOperationMode

Prototype

procedure CANSPISetOperationMode (mode : byte; WAIT: byte);

Description

Sets the CANSPI module to requested mode.

Parameters

- mode: CANSPI module operation mode. Valid values: CANSPT OP MODE constants. See CANSPT
OP MODE constants.

- WwATT: CANSPI mode switching verification request. If wATT == 0, the call is non-blocking. The
function does not verify if the CANSPI module is switched to requested mode or not. Caller must
use CANSPIGetOperationMode to verify correct operation mode before performing mode specific

operation. If wATT = 0, the call is blocking — the function won’t “return” until the requested mode is
set.

Returns

Nothing.

Requires

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example

//  set the CANSPI module into  configuration mode (wait inside
CANSPISetOperationMode until this mode 1is set)
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF);

Notes

None.
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CANSPIGetOperationMode

Prototype

function CANSPIGetOperationMode() : byte;

Description

The function returns current operation mode of the CANSPI module. Check CANSPI_OP_MODE
constants or device datasheet for operation mode codes.

Parameters

None.

Returns

Current operation mode.

Requires

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example

// check whether the CANSPI module
something.

if (CANSPIGetOperationMode ()
begin

is in Normal mode and 1if it 1is do

_CANSPI MODE NORMAL) then

end;,

Notes

None.

CANSPIInit

Prototype

procedure CANSPIInit (SJW, BRP,
char) ;

PHSEG1, PHSEG2, PROPSEG, CANSPI CONFIG FLAGS

Description

Initializes the CANSPI module.
Stand-Alone CAN controller in the CANSPI module is set to:

- Disable CAN capture

- Continue CAN operation in Idle mode

- Do not abort pending transmissions

- Fcan clock : 4*Tey (Fosc)

- Baud rate is set according to given parameters

- CAN mode : Normal

- Filter and mask registers |IDs are set to zero

- Filter and mask message frame type is set according to CANSPT CONFIG FLAGS value

SAM, SEG2PHTS, WAKFIL and DBEN bits are set according to CANSPT CONFIG FLAGS value.

Parameters

- sJu as defined in MCU’s datasheet (CAN Module)

- BRP as defined in MCU’s datasheet (CAN Module)

- PHSEG1 as defined in MCU’s datasheet (CAN Module)

- PHSEG2 as defined in MCU’s datasheet (CAN Module)

- PROPSEG as defined in MCU’s datasheet (CAN Module)

- CANSPI CONFIG FLAGS is formed from predefined constants. See CANSPI CONFIG FLAGS
constants.

Returns

Nothing.
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Requires

Global variables:

- CanSpi Cs: Chip Select line

- CanSpi Rst: Reset line

- CanSpi CS Direction: Direction of the Chip Select pin

- CanSpi Rst Direction: Direction of the Reset pin

must be defined before using this function.

The CANSPI routines are supported only by MCUs with the SPI module.

The SPI module needs to be initialized. See the SPTx Init and SPIx Init Advanced routines.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example

// CANSPI module connections

var CanSpi CS : sbit at LATFO bit;
CanSpi CS Direction : sbit at TRISFO bit;
CanSpi Rst : sbit at LATF1 bit;
CanSpi Rst Direction : sbit at TRISFI1 bit;

// End CANSPI module connections

var CANSPI Init Flags: word;

CANSPI Init Flags := CANSPI CONFIG SAMPLE THRICE and
_CANSPI CONFIG PHSEG2 PRG ON and
__CANSPI CONFIG STD MSG and
_CANSPI CONFIG DBIL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG and
_CANSPI CONFIG LINE FILTER OFF;

SPI1 Init(); // initialize
SPI1 module
CANSPITnit(1,3,3,3,1,CANSPI Init Flags); // initialize CANSPI

Notes

- CANSPI mode NORMAL will be set on exit.
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CANSPISetBaudRate

Prototype procedure CANSPISetBaudRate (SJW, BRP, PHSEGl, PHSEG2, PROPSEG, CANSPI
CONFIG FLAGS : char);
Returns Nothing.
Description | Sets the CANSPI module baud rate. Due to complexity of the CAN protocol, you can not simply force
a bps value. Instead, use this function when the CANSPI module is in Config mode.
SAM, SEG2PHTS and WAKFIL bits are set according to CANSPI_CONFIG_FLAGS value. Refer to
datasheet for details.
Parameters | - sJi7 as defined in MCU’s datasheet (CAN Module)
- BRP as defined in MCU'’s datasheet (CAN Module)
- PHSEG] as defined in MCU’s datasheet (CAN Module)
- PHSEG2 as defined in MCU’s datasheet (CAN Module)
- PROPSEG as defined in MCU’s datasheet (CAN Module)
- CANSPI CONFIG FLAGS is formed from predefined constants. See CANSPI_CONFIG_FLAGS
constants.
Returns Nothing.
Requires The CANSPI module must be in Config mode, otherwise the function will be ignored. See
CANSPISetOperationMode.
The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.
Example // set required baud rate and sampling rules
var CANSPI CONFIG FLAGS : byte;
CANSPISetOperationMode ( CANSPI MODE CONFIG,O0xFF) ; // set CONFIGURATION
mode (CANSPI module must be in config mode for baud rate settings)
CANSPI CONFIG FLAGS := CANSPI CONFIG SAMPLE THRICE and
__CANSPI CONFIG PHSEG2 PRG ON and
__CANSPI CONFIG STD MSG and
_ CANSPI CONFIG DBL BUFFER ON and
_ CANSPI CONFIG VALID XTD MSG and
__CANSPI CONFIG LINE FILTER OFF;
CANSPISetBaudRate (1, 1, 3, 3, 1, CANSPI CONFIG FLAGS);
Notes None.
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CANSPISetMask

Prototype

procedure CANSPISetMask (CANSPI MASK : byte; val : longint; CANSPI CONFIG
FLAGS : byte);

Description

Configures mask for advanced filtering of messages. The parameter value is bit-adjusted to the
appropriate mask registers.

Parameters

- caNsPI MASK: CAN module mask number. Valid values: CANSPT MASK constants. See CANSPI_
MASK constants.
- val: mask register value. This value is bit-adjusted to appropriate buffer mask registers
- CANSPI CONFIG FLAGS: selects type of message to filter. Valid values:
- CANSPI CONFIG ALL VALID MSG,
- CANSPI CONFIG MATCH MSG TYPE & CANSPI CONFIG STD MSG,
- CANSPI CONFIG MATCH MSG TYPE & CANSPI CONFIG XTD MSG.
See CANSPI_CONFIG_FLAGS constants.

Returns

Nothing.

Requires

The CANSPI module must be in Config mode, otherwise the function will be ignored. See
CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example

// set the appropriate filter mask and message type value
CANSPISetOperationMode ( CANSPI MODE CONFIG,0xFF); // set
CONFIGURATION mode (CANSPI1 module must be 1in config mode for mask
settings)

// Set all Bl mask bits to 1 (all filtered bits are relevant):

// Note that -1 is just a cheaper way to write OXFFFFFFFF.

// Complement will do the trick and fill it up with ones.

CANSPISetMask ( CANSPI MASK Bl1, -1, _ CANSPI CONFIG MATCH MSG TYPE and
CANSPI CONFIG XTD MSG) ;

Notes

None.
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CANSPISetFilter

Prototype

procedure CANSPISetFilter (CAN FILTER : as byte, wval : longint, CANSPI
CONFIG FLAGS : as byte);

Description

Configures message filter. The parameter vz 1 ue is bit-adjusted to the appropriate filter registers.

Parameters

- CaNsPI FILTER: CAN module filter number. Valid values: CANSPI FILTER constants. See
CANSPI_FILTER constants.

- val: filter register value. This value is bit-adjusted to appropriate filter registers

- CANSPI CONFIG FLAGS: selects type of message to filter. Valid values: CANSPI CONFIG STD
MSGand CANSPI CONEFIG XTD MSG. See CANSPI_CONFIG_FLAGS constants.

Returns

Nothing.

Requires

The CANSPI module must be in Config mode, otherwise the function will be ignored. See
CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example

// set the appropriate filter value and message type
CANSPISetOperationMode(_CANSPI_MODE_CONFIG,OXFF); // set CONFIGURATION
mode (CANSPI module must be in config mode for filter settings)

// Set id of filter B1 F1 to 3 :
CANSPISetFilter ( CANSPI FILTER Bl F1, 3, CANSPI CONFIG XTD MSG);

Notes

None.
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CANSPIRead

Prototype function CANSPIRead(var id : longint; wvar Data : array([8] of byte; var
DatalLen: byte; war CAN RX MSG FLAGS : byte) : byte;

Description | If at least one full Receive Buffer is found, it will be processed in the following way:

- Message ID is retrieved and stored to location provided by the i d parameter

- Message data is retrieved and stored to a buffer provided by the data parameter

- Message length is retrieved and stored to location provided by the datal.en parameter

- Message flags are retrieved and stored to location provided by the CANSPI RX MSG FLAGS
parameter

Parameters | - id: message identifier address
- data: an array of bytes up to 8 bytes in length
- datalLen: data length address
- CANSPI RX MSG FLAGS: message flags address. For message receive flags format refer to
CANSPI RX MSG FLAGS constants. See CANSPI_RX_MSG_FLAGS constants.
Returns - 0 if nothing is received
- 0xFFET if one of the Receive Buffers is full (message received)
Requires The CANSPI module must be in a mode in which receiving is possible. See
CANSPISetOperationMode.
The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.
Exmnpm // check the CANSPI1 module for received messages. If any was received do
something.
var msg rcvd, rx flags, data len : byte;
data : array[8] of byte;
msg id : longint;
CANSPISetOperationMode (_CANSPI MODE NORMAL,OxFF) ; // set NORMAL
mode (CANSPI1 module must be in mode in which receive 1s possible)
rx flags := 0; // clear message
flags
if (msg rcvd = CANSPIRead(msg id, data, data len, rx flags)) then
begin
end;
Notes None.
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CANSPIWrite
Prototype function CANSPIWrite(id : longint; var Data : array([8] of byte; Datalen,
CANSPI TX MSG FLAGS : byte) : byte;

Description | If at least one empty Transmit Buffer is found, the function sends message in the queue for
transmission.

Parameters | - i d: CAN message identifier. Valid values: 11 or 29 bit values, depending on message type (standard
or extended)

- Data: data to be sent

- DataLen: data length. Valid values: 0..8

- CANSPI TX MSG FLAGS: message flags. Valid values: CANSPT TX MSG FLAGS constants. See
CANSPI_TX_MSG_FLAGS constants.

Returns - 0 if all Transmit Buffers are busy
- 0xFEFE if at least one Transmit Buffer is available

Requires The CANSPlI module must be in mode in which transmission is possible. See
CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika’s CANSPI Extra Board or similar hardware.
See connection example at the bottom of this page.

Example // send message extended CAN message with the appropriate ID and data
var tx flags : byte;

data : array[8] of byte;

msg _id : longint;

CANSPISetOperationMode (CANSPI MODE NORMAL,OxFF) ; // set
NORMAL mode (CANSPI must be in mode in which transmission is possible)

tx flags := CANSPI TX PRIORITY 0 and CANSPI TX XTD FRAME; // set message
flags
CANSPIWrite (msg id, data, 2, tx flags);

Notes None.

CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be familiar with them in order to be able
to use the library effectively. Check the example at the end of the chapter.

CANSPI_OP_MODE Constants

The canspI op MODE constants define CANSPI operation mode. Function CANSPISetOperationMode expects one
of these as it's argument:
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Copy Code To Clipboard

const
_CANSPI MODE BITS
_CANSPI MODE NORMAL
_CANSPI MODE SLEEP
_CANSPI MODE LOOP
_CANSPI MODE LISTEN
_CANSPI MODE CONFIG

byte

byte =
byte =
byte =
byte =
byte =

SEO
0;

$20;
$40;
$60;
$80;

; // Use this

’

’

’

’

CANSPI_CONFIG_FLAGS Constants

to access opmode Dbits

The CANSPI CONFIG FLAGS constants define flags related to the CANSPI module configuration. The functions
CANSPIInit, CANSPISetBaudRate, CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise

combination) as their argument:
Copy Code To Clipboard

const
~CANSPI CONFIG DEFAULT

_CANSPI CONFIG PHSEG2 PRG BIT
_CANSPI CONFIG PHSEG2 PRG ON
_CANSPI CONFIG PHSEG2 PRG OFF

_CANSPI CONFIG LINE FILTER BIT

_CANSPI CONFIG LINE FILTER ON

_CANSPI CONFIG LINE FILTER OFF

~CANSPI CONFIG SAMPLE
~CANSPI CONFIG SAMPLE

_CANSPI CONFIG SAMPLE THRICE

_CANSPI CONFIG MSG TYPE BIT

_CANSPI CONFIG_STD MSG
_CANSPI CONFIG XTD MSG

_CANSPI CONFIG DBL BUFFER BIT
_CANSPI CONFIG DBL BUFFER ON
~CANSPI CONFIG DBL BUFFER OFF

_CANSPI CONFIG MSG BIT
~CANSPI CONFIG ALL MSG

_CANSPI CONFIG VALID XTD MSG
_CANSPI CONFIG VALID STD MSG
_CANSPI CONFIG ALL VALID MSG

BIT
ONCE

S

byte

byte
byte
byte

byte
byte
byte

byte
byte
byte

byte
byte
byte

byte
byte
byte

byte
byte
byte
byte
byte

SFFE;

$01;
SFFE;
SFE;

$02;
SFFE;
SED;

$04;
SFFE;
SFB;

$08;
SFFE;
SE7;

$10;
SFFE;
SEF;

$60;
SFFE;
SDF;
SBE;
SOF;

11111111

):0:0:0:0:0.041
KXKXXKXXX0

KXKXKXXX1X
KXXXXX0X

KXKXKXX1XX
KXXXXOXX

KXKXX1XXX
KXKXXOXXX

):0:0:49:0:0:0:¢
KXXOXXXX

K11XXXXX
X10XXXXX
KO1XXXXX
XO0OXXXXX
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You may use bitwise AND (&) to form config byte out of these values. For example:
Copy Code To Clipboard
init := CANSPI CONFIG SAMPLE THRICE and

_CANSPI CONFIG PHSEG2 PRG ON and

_CANSPI CONFIG STD MSG and

_CANSPI CONFIG DBL BUFFER ON and

_CANSPI CONFIG VALID XTD MSG and

_CANSPI CONFIG LINE FILTER OFF;

CANSPIInit(1, 1, 3, 3, 1, init); // initialize CANSPI

CANSPI_TX_MSG_FLAGS Constants

CANSPI TX MSG FLAGS are flags related to transmission of a CANSPI message:

Copy Code To Clipboard

const
_CANSPI TX PRIORITY BITS : byte = $03;
_CANSPI TX PRIORITY 0 : byte = SFC; // XXXXXX00
_CANSPI TX PRIORITY 1 : byte = SFD; // XXXXXX01
_CANSPI TX PRIORITY 2 : byte = SFE; // XXXXXX10
_CANSPI TX PRIORITY 3 : byte = SFF; // XXXXXX11l
_CANSPI TX FRAME BIT : byte = $08;
_CANSPI TX STD FRAME : byte = $FF; // XXXXX1XX
_CANSPI TX XTD FRAME : byte = $F7; // XXXXX0XX
_CANSPI TX RTR BIT : byte = $40;
_CANSPI TX NO RTR FRAME : byte = $FF; // XIXXXXXX
_CANSPI TX RTR FRAME : byte = $BF; // XOXXXXXX

You may use bitwise AND (and) to adjust the appropriate flags. For example:
Copy Code To Clipboard
// form value to be used as sending message flag
send config := CANSPI TX PRIORITY 0 and
__CANSPI TX XTD FRAME and
__CANSPI TX NO RTR FRAME;

CANSPIWrite (id, data, 1, send config);

CANSPI_RX_MSG_FLAGS Constants

CANSPI RX MSG FLAGS are flags related to reception of CANSPI message. If a particular bit is set then corresponding
meaning is TRUE or else it will be FALSE.
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Copy Code To Clipboard

const
_CANSPI RX FILTER BITS byte = $07; // Use this to access filter bits
_CANSPI RX FILTER 1 byte = $00;
_CANSPI RX FILTER 2 byte = $01;
_CANSPI RX FILTER 3 byte = $02;
_CANSPI RX FILTER 4 byte = $03;
_CANSPI RX FILTER 5 byte = $04;
_CANSPI RX FILTER 6 byte = $05;
_CANSPI _RX OVERFLOW byte = $08; // Set if Overflowed else cleared
_CANSPI RX INVALID MSG byte = $10; // Set if invalid else cleared
_CANSPI RX XTD FRAME byte = $20; // Set if XTD message else cleared
_CANSPI_RX RTR_FRAME byte = $40; // Set if RTR message else cleared

CANSPI RX DBL BUFFERED byte = $80; // Set if this message was hardware double-

buffered

You may use bitwise AND (and) to adjust the appropriate flags. For example:

Copy Code To Clipboard

if
begin

(MsgFlag and CANSPI RX OVERFLOW)

<> 0 then

// Receiver overflow has occurred.
// We have lost our previous message.
end;

CANSPI_MASK Constants

The caNSPI MASK constants define mask codes. Function CANSPISetMask expects one of these as it's argument:
Copy Code To Clipboard

const

_CANSPI_MASK Bl
_CANSPI_MASK B2

byte = 0;
byte =

|
=

CANSPI_FILTER Constants

The caANSPI FILTER constants define
argument:

filter codes. Functions CANSPISetFilter expects one of these as it's

Copy Code To Clipboard

const
_CANSPI FILTER Bl F1 byte = 0;
_CANSPI FILTER Bl F2 byte = 1;
_CANSPI FILTER B2 F1 byte = 2;
_CANSPI FILTER B2 F2 byte = 3;
_CANSPI FILTER B2 F3 byte = 4;
_CANSPI FILTER B2 F4 byte = 5;
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Library Example

The code is a simple demonstration of CANSPI protocol. This node initiates the communication with the 2nd node by
sending some data to its address. The 2nd node responds by sending back the data incremented by 1. This (1st) node
then does the same and sends incremented data back to the 2nd node, etc.

Code for the first CANSPI node:

Copy Code To Clipboard

program Can Spi 1st;

const ID 1st : longint = 12111;

const ID 2nd : longint = 3;

var Can Init Flags, Can Send Flags, Can Rcv Flags : word; // can flags
Rx Data Len : word; // received data length in bytes
RxTx Data : array([8] of byte; // can rx/tx data buffer
Msg Rcvd : byte; // reception flag
Tx _ID, Rx ID : dword; // can rx and tx ID

// CANSPI module connections

var CanSpi CS : sbit at LATFO bit;
CanSpi CS Direction : sbit at TRISFO bit;
CanSpi Rst : sbit at LATF1 bit;

CanSpi Rst Direction : sbit at TRISF1 bit;
// End CANSPI module connections

begin
CHECON := 0x32;
ADIPCFG := OxFFFF; // configure AN pins as digital I/O
PORTB := 0; // clear PORTB
TRISB := 0; // set PORTB as output
Can Init Flags := 0; //
Can_Send Flags := 0; // clear flags
Can _Rcv Flags := 0; //
Can_Send Flags := CANSPI TX PRIORITY 0 and // form value to be used
_CANSPI TX XTD FRAME and // with CANSPIWrite

_CANSPI_TX NO RTR FRAME;

Can Init Flags _CANSPI CONFIG_SAMPLE THRICE and // form value to be used
_CANSPI CONFIG PHSEG2 PRG ON and // with CANSPIInit
_CANSPT_CONFIG_XTD MSG and

_CANSPI CONFIG DBL BUFFER ON and

_CANSPI_CONFIG VALID XTD MSG;

// Initialize SPI2 module

SPI2 Init();
CANSPIInitialize(l,3,3,3,1,Can Init Flags); // initialize external CANSPI module
CANSPISetOperationMode(_CANSPI_MODE_CONFIG,OXFF); // set CONFIGURATION mode

CANSPISetMask ( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG); // set all maskl bits to ones
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CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG);

bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F4,ID 2nd, CANSPI CONFIG XTD MSG);

filter B2 F4 to 2nd node ID

CANSPISetOperationMode(7CANSP17MODE7NORMAL,OxFF);

// Set initial data to be sent
RxTx Datal0] := 9;

CANSPIWrite (ID 1st, RxTx Data, 1, Can Send Flags);
while (TRUE) do
begin
Msg Rcvd
message
if ((Rx ID = ID 2nd) and Msg Rcvd) then
begin
PORTB := RxTx Datal[O];
Inc (RxTx DatalO0]);
Delay ms (10);
CANSPIWrite (ID 1st, RxTx Data, 1,

incremented data back
end;
end;
end.

Code for the second CANSPI node:
Copy Code To Clipboard
program Can Spi 2nd;

const ID 1st
const ID 2nd

= 12111;
3;

longint
longint

var Can Init Flags, Can Send Flags, Can Rcv Flags

Rx Data Len word;

RxTx Data array([8] of byte;
Msg Rcvd byte;

Tx ID, Rx ID dword;

// CANSPI module connections

var CanSpi CS sbit
CanSpi CS Direction sbit
CanSpi Rst sbit
CanSpi Rst Direction sbit

// End CANSPI module connections

at LATFO bit;
at TRISFO bit;
at LATF1 bit;
at TRISF1 bit;

:= CANSPIRead (Rx ID , RxTx Data , Rx Data Len, Can Rcv Flags);

// id correct,
// increment received data

Can_Send Flags);

// set all mask2

// set id of

// set NORMAL mode

// send initial message

// endless loop
// receive

// 1f message received check id

output data at PORTD

// send

word; // can flags
received data length in bytes
// can rx/tx data buffer
// reception flag
// can rx and tx ID

//

begin

CHECON := 0x32;

AD1PCFG := OxFFFE; // configure AN pins as digital I/O
MikroElektronika
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PORTB := 0; // clear PORTB

TRISB := 0; // set PORTB as output

Can Init Flags := 0; //

Can_Send Flags := 0; // clear flags

Can Rcv Flags := 0; //

Can Send Flags := CANSPI TX PRIORITY 0 and // form value to be used
_CANSPI_TX XTD FRAME and // with CANSPIWrite

_CANSPI TX NO RTR FRAME;

Can Init Flags _CANSPI CONFIG SAMPLE THRICE and // form value to be used
_CANSPI CONFIG PHSEG2 PRG ON and // with CANSPITnit
_CANSPI CONFIG XTD MSG and

_CANSPI CONFIG DBL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG and

_CANSPI CONFIG LINE FILTER OFF;

// Initialize SPI1 module

SPI2 Init();

CANSPIInitialize(1,3,3,3,1,Can Init Flags); // initialize
external CANSPI module

CANSPISetOperationMode (  CANSPI MODE CONFIG, OxFF) ; // set CONFIGURATION mode

CANSPISetMask( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG); // set all
maskl bits to ones

CANSPISetMask( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG); // set all
mask2 bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F3,ID 1lst, CANSPI CONFIG XTD MSG); // set id of

filter B2 F3 to 1st node ID

CANSPISetOperationMode ( CANSPI MODE NORMAL, O0xFF) ; // set NORMAL mode
while (TRUE) do // endless loop
begin
Msg Rcvd := CANSPIRead(Rx ID , RxTx Data , Rx Data Len, Can Rcv_Flags); // receive
message
if ((Rx_ID = ID 1lst) and Msg Rcvd) then // 1f message received check id
begin
PORTB := RxTx Datal[0]; // 1id correct, output data at PORTB
Inc (RxTx Datal[0]); // increment received data
CANSPIWrite (ID 2nd, RxTx Data, 1, Can Send Flags); // send
incremented data back
end;
end;
end.

299 MikroElektronika



mikoPascal PRO for PIC32

HW Connection

100K |:|

vcC
Ly P u\"dd u
|8
R T :
T[ cLKO G5 ]157 =
) e
i <
¢ f5a  sex [J12 Ao B JROCRLAIGR
" fosc2 v ]i o B
SRR bl P = PIC32MX460F512L &=
1 2 (lvee s - 3
— BMHz =
=— MCP2510 =
— -]
T 5
10R w
—1[ m-gxu)ns s
IH—i[ GND CANH ]:—
§b-—[ VEC CANL
—‘[ RXD  Wref ]5—
MCP2551
Shielded =~ |
twisted pair h

Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface
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Compact Flash Library

The Compact Flash Library provides routines for accessing data on Compact Flash card (abbr. CF further in text). CF
cards are widely used memory elements, commonly used with digital cameras. Great capacity and excellent access
time of only a few microseconds make them very attractive for microcontroller applications.

In CF card, data is divided into sectors. One sector usually comprises 512 bytes. Routines for file handling, the Cf_Fat
routines, are not performed directly but successively through 512B buffer.

Important :

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only.

- Library functions populate both FAT1 and FAT2 tables when writing to files, but the file data is being read from the
FAT1 table only; i.e. there is no recovery if the FAT1 table gets corrupted.

- If MMC/SD card has Master Boot Record (MBR), the library will work with the first available primary (logical)
partition that has non-zero size. If MMC/SD card has Volume Boot Record (i.e. there is only one logical partition and
no MBRs), the library works with entire card as a single partition. For more information on MBR, physical and logical
drives, primary/secondary partitions and partition tables, please consult other resources, e.g. Wikipedia and similar.

- Before writing operation, make sure not to overwrite boot or FAT sector as it could make your card on PC or digital
camera unreadable. Drive mapping tools, such as Winhex, can be of great assistance.

Library Dependency Tree

—_—
—» Compact Flash

-

—» C_Type

( compact Flash FAT16 | —
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External dependencies of Compact Flash Library

The following variables must

be defined in all projects | Description: Example:
using Compact Flash Library:
var CF Data Port byte; |
- = 7 Compact Flash Data Port. var CF Data Port : byte at PORTD;
sfr; external; - -
CF RDY bit; sfr; . . . .
var bh_ SPrEr SR Ready signal line. var CF RDY : sbit at RB7 bit;
external; - -
ar CF WE sbit; sfr; . . . N . .
v - * Write Enable signal line. var CF WE sbit at LATB6 bit;
external; — .
var CF OE sbit; sfr; . . . .
- Output Enable signal line. var CF OE sbit at LATBS5 bit;
external; - -
ar CF CD1 sbit; sfr; . . . . .
v - * Chip Detect signal line. var CF CD1 sbit at RB4 bit;
external; — -
CF CE1l bit; sfr; . . . . .
ver - sot she Chip Enable signal line. var CF CEl sbit at LATB3 bit;
external; - -
CF A2 it; fr; . L. L.
var - sbit; sfr Address pin 2. var CF_A2 sbit at LATB2 bit;
external; — _
CF Al bit; fr; . . .
ver - =or S5 | Address pin 1. var CF Al sbit at LATBl bit;
external; - -
CF A0 bit; fr; . . .
var Lo SorEs SR Address pin 0. var CF A0 : sbit at LATBO bit;
external; - -
var CF RDY direction . . . var CEF RDY direction sbit at TRISB7
. . Direction of the Ready pin. L - = -
sbit; sfr; external; bit;
var CF WE direction . . . . var CF WE direction sbit at TRISBG6
. - Direction of the Write Enable pin. . - = -
sbit; sfr; external; bit;
var CF OE direction . . . var CF OE direction sbit at TRISBS
. _ et R Direction of the Output Enable pin. | - —eat * R
sbit; sfr; external; bit;
var CF CD1 direction . . . . var CF CD1 direction sbit at TRISB4
. — = Direction of the Chip Detect pin. o - = -
sbit; sfr; external; bit;
var CF CEl direction . . ’ . var CF CEl direction sbit at TRISB3
. . = Direction of the Chip Enable pin. . - = B
sbit; sfr; external; bit;
var CF A2 direction . . . var CF A2 direction sbit at TRISB2
. - Direction of the Address 2 pin. . - = -
sbit; sfr; external; bit;
var CF Al direction . . . var CF Al direction sbit at TRISB1
. - Direction of the Address 1 pin. . - - -
sbit; sfr; external; bit;
var CF A0 direction . . . var CF A0 direction sbit at TRISBO
. - Direction of the Address 0 pin. . - = -
sbit; sfr; external; bit;
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Library Routines

- Cf_Init

- Cf_Detect

- Cf_Enable

- Cf_Disable

- Cf_Read_lInit

- Cf_Read_Byte

- Cf_Write_Init

- Cf_Write_Byte

- Cf_Read_Sector
- Cf_Write_Sector

Routines for file handling:

- Cf_Fat_Init

- Cf_Fat_QuickFormat

- Cf_Fat_Assign

- Cf_Fat_Reset

- Cf_Fat_Read

- Cf_Fat_Rewrite

- Cf_Fat_Append

- Cf_Fat_Delete

- Cf_Fat_Write

- Cf_Fat_Set_File_Date
- Cf_Fat_Get_File_Date
- Cf_Fat_Get_File_Date_Modified
- Cf_Fat_Get_File_Size
- Cf_Fat_Get_Swap_File

The following routine is for the internal use by compiler only:

- Cf_lIssue_ID_Command
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Cf_Init

Prototype procedure Cf Init();

Description | Initializes ports appropriately for communication with CF card.

Parameters | None.

Returns Nothing.

Requires Global variables:

-CF Data Port :Compact Flash data port

- CF_RDY : Ready signal line

- CF WE : Write enable signal line

- CE OE : Output enable signal line

- CF CD1 : Chip detect signal line

- CF CE1 : Enable signal line

- CE A2 :Address pin 2

- CF Al :Address pin 1

- CF A0 :Address pin 0

-CEF RDY direction : Direction of the Ready pin

-CF WE direction : Direction of the Write enable pin
-CF OE direction : Direction of the Output enable pin
-CF CD1 direction : Direction of the Chip detect pin
-CF CEl direction : Direction of the Chip enable pin
-CF A2 direction : Direction of the Address 2 pin

-CF Al direction : Direction of the Address 1 pin

-CF A0 direction : Direction of the Address 0 pin

must be defined before using this function.

Example // set compact flash pinout
var
Cf Data Port : byte at PORTD;

CF RDY : sbit at RB7 bit;
CF WE : sbit at LATB6 bit; // for writing to output pin always use latch
CF OE : sbit at LATB5 bit; // for writing to output pin always use latch
CF CD1 : sbit at RB4 bit;
CF CE1 : sbit at LATB3 bit; // for writing to output pin always use latch

CEiA2 : sbit at LATB2 bit; // for writing to output pin always use latch
CF Al : sbit at LATBI1 bit; // for writing to output pin always use latch
CF A0 : sbit at LATB0 bit; // for writing to output pin always use latch

CF RDY direction : sbit at TRISB7 bit;
CF WE direction : sbit at TRISB6 bit;
CF OE direction : sbit at TRISBS bit;
CF CD1 direction : sbit at TRISB4 bit;
CF CE1 direction : sbit at TRISB3 bit;

CF A2 direction : sbit at TRISBZ bit;
CF Al direction : sbit at TRISBI bit;
CF A0 direction : sbit at TRISBO bit;

// end of compact flash pinout

Cf Init(); // initialize CF

Notes None.
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Cf_Detect

Prototype function CF Detect () : word ;

Description | Checks for presence of CF card by reading the chip detect pin.

Parameters | None.

Returns - 1 - if CF card was detected
- 0 - otherwise

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf Init.

Example // Wait until CF card is inserted:
while (Cf Detect() = 0) do

nop;

Notes PIC32 family MCU and CF card voltage levels are different. The user must ensure that MCU’s pin

connected to CD line can read CF card Logical One correctly.
Cf_Enable

Prototype |procedure Cf Enable();

Description | Enables the device. Routine needs to be called only if you have disabled the device by means of the
Cf_Disable routine. These two routines in conjunction allow you to free/occupy data line when working
with multiple devices.

Parameters | None.

Returns Nothing.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.

Example // enable compact flash
Cf Enable();

Notes None.

Cf_Disable

Prototype procedure Cf Disable();

Description | Routine disables the device and frees the data lines for other devices. To enable the device again, call
Cf_Enable. These two routines in conjunction allow you to free/occupy data line when working with
multiple devices.

Parameters | None.

Returns Nothing.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.

Example // disable compact flash
Cf Disable();

Notes None.
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Cf Read_Init
Prototype procedure Cf Read Init (address dword; sectcnt : byte);
Description | Initializes CF card for reading.
Parameters | - address: the first sector to be prepared for reading operation.
- sector count: number of sectors to be prepared for reading operation.
Returns Nothing.
Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.
Example // initialize compact flash for reading from sector 590
Cf Read Init (590, 1);
Notes None.

Cf Read_Byte

Prototype function CF Read Byte() : byte;

Description | Reads one byte from Compact Flash sector buffer location currently pointed to by internal read
pointers. These pointers will be autoicremented upon reading.

Parameters | None.

Returns Returns a byte read from Compact Flash sector buffer.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.
CF card must be initialized for reading operation. See Cf_Read_Init.

Example // Read a byte from compact flash:
var data as byte;
dataﬁ := Cf Read Byte();

Notes Higher byte of the unsigned return value is cleared.

Cf_Write_Init

Prototype procedure Cf Write Init (address dword; sectcnt : word);

Description | Initializes CF card for writing.

Parameters | - address: the first sector to be prepared for writing operation.
- sectent: number of sectors to be prepared for writing operation.

Returns Nothing.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.

Example // initialize compact flash for writing to sector 590
Cf Write Init (590, 1);

Notes None.
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Cf_Write_Byte

Prototype procedure Cf Write Byte(data : byte) ;

Description | Writes a byte to Compact Flash sector buffer location currently pointed to by writing pointers. These
pointers will be autoicremented upon reading. When sector buffer is full, its contents will be transfered
to appropriate flash memory sector.

Parameters | - data : byte to be written.

Returns Nothing.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.

CF card must be initialized for writing operation. See Cf_Write_Init.

Example var data : byte;
data := OxAA;

Cf Write Byte(data );

Notes None.

Cf Read_Sector

Prototype procedure Cf Read Sector (sector number dword; wvar buffer array[512] of
byte);
Description | Reads one sector (512 bytes). Read data is stored into buffer provided by the buf fer parameter.
Parameters | - sector number: sector to be read.
- buf fer: data buffer of at least 512 bytes in length.
Returns Nothing.
Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.
Example // read sector 22
var data : array[512] of byte;
Cf Read Sector (22, data );
Notes None.

Cf_Write_Sector

Prototype procedure Cf Write Sector (sector number : dword; var buffer : array[512] of
byte) ;

Description | Writes 512 bytes of data provided by the buffer parameter to one CF sector.

Parameters | - sector number: sector to be written to.
- buf fer: data buffer of 512 bytes in length.

Returns Nothing.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.

Example // write to sector 22
var data : array[512] of byte;
Cf Write Sector (22, data );

Notes None.
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Cf_Fat_Init
Prototype function Cf Fat Init(): word;
Description | Initializes CF card, reads CF FAT16 boot sector and extracts necessary data needed by the library.
Parameters | None.
Returns - 0 - if CF card was detected and successfully initialized
- 1 - if FAT16 boot sector was not found
- 255 - if card was not detected
Requires Nothing.
Example // init the FAT library
if (Cf Fat Init() = 0) then
begin
end
Notes None.

Cf_Fat_QuickFormat

Prototype function Cf Fat QuickFormat (var cf fat label string([11]) : word;
Description | Formats to FAT16 and initializes CF card.
Parameters |- c£ fat label:volume label (11 characters in length). If less than 11 characters are provided, the
label will be padded with spaces. If null string is passed, the volume will not be labeled.
Returns - 0 - if CF card was detected, successfully formated and initialized
- 1 - if FAT16 format was unsuccessful
- 255 - if card was not detected
Requires Nothing.
Example // format and initialize the FAT library
if (Cf Fat QuickFormat ('mikroE’) = 0) then
begin
end;,
Notes - This routine can be used instead or in conjunction with Cf_Fat_|Init routine.
- If CF card already contains a valid boot sector, it will remain unchanged (except volume label field)
and only FAT and ROOT tables will be erased. Also, the new volume label will be set.
MikroElektronika
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Cf_Fat_Assign

Prototype function Cf Fat Assign(var filename: array[l12] of char; file cre attr: byte):
word;

Description | Assigns file for file operations (read, write, delete...). All subsequent file operations will be applied over
the assigned file.

Parameters | - filename: name of the file that should be assigned for file operations. The file name should be in
DOS 8.3 (file_name.extension) format. The file name and extension will be automatically padded with
spaces by the library if they have less than length required (i.e. “mikro.tx” -> “mikro .tx “), so the user
does not have to take care of that. The file name and extension are case insensitive. The library will
convert them to proper case automatically, so the user does not have to take care of that.

Also, in order to keep backward compatibility with the first version of this library, file names can be
entered as UPPERCASE string of 11 bytes in length with no dot character between the file name and
extension (i.e. “MIKROELETXT” -> MIKROELE.TXT). In this case the last 3 characters of the string
are considered to be file extension.
- file cre attr: file creation and attributes flags. Each bit corresponds to the appropriate file
attribute:

Bit | Mask Description

0 0x01 Read Only

1 0x02 Hidden

2 0x04 System

3 0x08 Volume Label

4 0x10 Subdirectory

5 0x20 Archive

6 0x40 Device (internal use only, never found on disk)

7 0x80 File creation flag. If the file does not exist and this flag is

set, a new file with specified name will be created.
Returns - 0 if file does not exist and no new file is created.

- 1 if file already exists or file does not exist but a new file is created.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

Example // create file with archive attributes if it does not already exist
Cf Fat Assign (“MIKRO007.TXT”,0xAQ);

Notes Long File Names (LFN) are not supported.
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Cf _Fat_Reset

Prototype procedure Cf Fat Reset (var size: dword);

Description | Opens currently assigned file for reading.

Parameters | - size: buffer to store file size to. After file has been open for reading its size is returned through this
parameter.

Returns Nothing.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.

Example var size dword;
(.Zf;FatiReset (size) ;

Notes None.

Cf Fat Read

Prototype procedure Cf Fat Read(var bdata: byte);

Description | Reads a byte from currently assigned file opened for reading. Upon function execution file pointers will
be set to the next character in the file.

Parameters | - bdata: buffer to store read byte to. Upon this function execution read byte is returned through this
parameter.

Returns Nothing.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.
File must be open for reading. See Cf_Fat_Reset.

Example var bdata : byte;
é%;FatiRoad (bdata) ;

Notes None.
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Cf_Fat_Rewrite

Prototype procedure Cf Fat Rewrite();
Description | Opens currently assigned file for writing. If the file is not empty its content will be erased.
Parameters | None.
Returns Nothing.
Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
The file must be previously assigned. See Cf_Fat_Assign.
Example // open file for writing
Cf Fat Rewrite();
Notes None.

Cf _Fat_Append

Prototype procedure Cf Fat Append();
Description | Opens currently assigned file for appending. Upon this function execution file pointers will be positioned
after the last byte in the file, so any subsequent file writing operation will start from there.
Parameters | None.
Returns Nothing.
Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.
Example // open file for appending
Cf Fat Append();
Notes None.

Cf_Fat_Delete

Prototype |procedure Cf Fat Delete();

Description | Deletes currently assigned file from CF card.

Parameters | None.

Returns Nothing.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.

Example // delete current file
Cf Fat Delete();

Notes None.
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Cf_Fat_Write
Prototype procedure Cf Fat Write(var fdata: array([512] of byte; data len: word);
Description | Writes requested number of bytes to currently assigned file opened for writing.
Parameters | - fdata: data to be written.
- data len: number of bytes to be written.
Returns Nothing.
Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.
File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.
Example var file contents : array[42] of byte;
é%;FatiYNrite (file contents, 42); // write data to the assigned file
Notes None.

Cf _Fat_Set File Date

Prototype procedure Cf Fat Set File Date(year: word; month: byte; day: byte; hours:
byte; mins: byte; seconds: byte);

Description | Sets the date/time stamp. Any subsequent file writing operation will write this stamp to currently
assigned file’s time/date attributes.

Parameters | - year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12
- day: day attribute. Valid values: 1-31
- hours: hours attribute. Valid values: 0-23
- mins: minutes attribute. Valid values: 0-59
- seconds: seconds attribute. Valid values: 0-59

Returns Nothing.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.
File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

Example Cf Fat Set File Date(2005,9,30,17,41,0);

Notes None.
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Cf Fat _Get File Date

Prototype procedure Cf Fat Get File Date(var year: word; wvar month: byte; wvar day:
byte; war hours: byte; wvar mins: byte);

Description | Reads time/date attributes of currently assigned file.

Parameters | - year: buffer to store year attribute to. Upon function execution year attribute is returned through this
parameter.
- month: buffer to store month attribute to. Upon function execution month attribute is returned through
this parameter.
- day: buffer to store day attribute to. Upon function execution day attribute is returned through this
parameter.
- hours: buffer to store hours attribute to. Upon function execution hours attribute is returned through
this parameter.
- mins: buffer to store minutes attribute to. Upon function execution minutes attribute is returned
through this parameter.

Returns Nothing.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.

Example var year : word;

month, day, hours, mins : byte;

Cf Fat Get File Date(year, month, day, hours, mins);

Notes None.

Cf _Fat_Get_File _Date Modified

Prototype

procedure Cf Fat Get File Date Modified(var year: word; var month: byte; wvar
day: byte; wvar hours: byte; var mins: byte);

Description

Retrieves the last modification date/time of the currently assigned file.

Parameters

- year: buffer to store year of modification attribute to. Upon function execution year of modification
attribute is returned through this parameter.

-month: buffer to store month of modification attribute to. Upon function execution month of modification
attribute is returned through this parameter.

- day: buffer to store day of modification attribute to. Upon function execution day of modification
attribute is returned through this parameter.

- hour s: buffer to store hours of modification attribute to. Upon function execution hours of modification
attribute is returned through this parameter.

- mins: buffer to store minutes of modification attribute to. Upon function execution minutes of
modification attribute is returned through this parameter.

Returns

Nothing.

Requires

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

File must be previously assigned. See Cf_Fat_Assign.

Example

var year : word;

month, day, hours, mins : byte;

Cf Fat Get File Date Modified(year, month, day, hours, mins);

Notes

None.
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Cf _Fat_Get_File_Size

Prototype function Cf Fat Get File Size(): dword;

Description | This function reads size of currently assigned file in bytes.

Parameters | None.

Returns Size of the currently assigned file in bytes.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.

Example var my file size : dword;
ﬁ&;ﬁleisize := Cf Fat Get File Size();

Notes None.

Cf _Fat_Get Swap_ File

Prototype

function Cf Fat Get Swap File(sectors cnt: dword; wvar filename : string[1l1l];
file_ attr : byte): dword;

Description

This function is used to create a swap file of predefined name and size on the CF media. If a file
with specified name already exists on the media, search for consecutive sectors will ignore sectors
occupied by this file. Therefore, it is recommended to erase such file if it exists before calling this
function. If it is not erased and there is still enough space for a new swap file, this function will delete
it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to CF media as fast as possible, by using
the Cf_Read_Sector() and Cf_Write_Sector() functions directly, without potentially damaging the FAT
system. Swap file can be considered as a “window” on the media where the user can freely write/read
data. It's main purpose in the this library is to be used for fast data acquisition; when the time-critical
acquisition has finished, the data can be re-written into a “normal” file, and formatted in the most
suitable way.

Parameters

- sectors cnt:number of consecutive sectors that user wants the swap file to have.

- filename: name of the file that should be assigned for file operations. The file name should be in
DOS 8.3 (file_name.extension) format. The file name and extension will be automatically padded with
spaces by the library if they have less than length required (i.e. “mikro.tx” -> “mikro .tx “), so the user
does not have to take care of that. The file name and extension are case insensitive. The library will
convert them to proper case automatically, so the user does not have to take care of that.

Also, in order to keep backward compatibility with the first version of this library, file names can be
entered as UPPERCASE string of 11 bytes in length with no dot character between the file name and
extension (i.e. “MIKROELETXT” -> MIKROELE.TXT). In this case the last 3 characters of the string
are considered to be file extension.

-file attr:file creation and attributes flags. Each bit corresponds to the appropriate file attribute:
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Parameters - -
Bit | Mask Description
0 0x01 Read Only
1 0x02 Hidden
2 0x04 System
3 0x08 Volume Label
4 0x10 Subdirectory
5 0x20 Archive
6 0x40 Device (internal use only, never found on disk)
7 0x80 Not used
Returns - Number of the start sector for the newly created swap file, if there was enough free space on CF
card to create file of required size.
- 0 - otherwise.
Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Example // Try to create a swap file with archive atribute, whose size will be at
least 1000 sectors.
// If it succeeds, it sends the No. of start sector over
UART
var size dword;
size := Cf Fat Get Swap File (1000, '‘mikroE.txt’, 0x20);
if (size <> 0) then
begin
UART1 Write (0xAA);
UARTI Write (Lo (size));
UART1 Write (Hi(size));
UART1 Write (Higher (size));
UART1 Write (Highest (size));
UART1 Write (OxAA) ;
end;
Notes Long File Names (LFN) are not supported.
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Library Example

This project consists of several blocks that demonstrate various aspects of usage of the Cf_Fat16 library. These are :

- Creation of new file and writing down to it;

- Opening existing file and re-writing it (writing from start-of-file);

- Opening existing file and appending data to it (writing from end-of-file);
- Opening a file and reading data from it (sending it to USART terminal);
- Creating and modifying several files at once;

- Reading file contents;

- Deleting file(s);

- Creating the swap file (see Help for details);

Copy Code To Clipboard

program CF Fatl6 Test;

// set compact flash pinout

var

Cf Data Port

: byte at PORTE;

CF RDY : sbit at RD7 bit;

CF WE sbit at LATDGibit;
CF OE sbit at LATD5 bit;
CF CD1 sbit at RD4 bit;

CF CEI sbit at LATD3 bit;
CF A2 sbit at LATD2 bit;
CF_Al sbit at LATDl_bi t;
CEﬁAO sbit at LATDQibit;

CF RDY direction
CF WE direction
CF OE direction
CF CD1 direction
CF CEl direction
CF A2 direction
CF Al direction
CF AO direction

sbit at TRISD7 bit;
sbit at TRISD6 bit;
sbit at TRISD5 bit;
sbit at TRISD4 bit;
sbit at TRISD3 bit;
sbit at TRISD2 bit;
sbit at TRISD1 bit;
sbit at TRISDO bit;

// end of compact ﬂash pinout

const LINE LEN = 39;

var

err txt
file contents

string[20];
string[LINE LEN];

filename string[14]; // File names
character : byte;

loop, loopZ2 : byte;

i, size longint;

Buffer array[512] of byte;,

// UART write text and new line (carriage return + line feed)

procedure UARTI Write Line( var uart text

string ),
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begin
UART1 Write Text (uart text);
UART1 Write (13);
UART1 Write(10);

end;
[/ =—mmm———————— Creates new file and writes some data to it
procedure M Create New File();
begin
filename[7] := ‘A’;
Cf Fat Set File Date(2005,6,21,10,35,0); // Set file date & time info
Cf Fat Assign(filename, O0xA0); // Will not find file and then create file
Cf Fat Rewrite(); // To clear file and start with new data
for loop:=1 to 99 do // We want 5 files on the MMC card
begin
UART1 Write('.’);
file contents[0] := loop div 10 + 48;
file contents[1] := loop mod 10 + 48;
Cf Fat Write(file contents, LINE LEN-1); // write data to the assigned file
end;
end;
// = Creates many new files and writes data to them
procedure M Create Multiple Files();
begin
for loop2 := ‘B’ to ‘'Z’ do
begin
UART1 Write (loop2); // this line can slow down the performance
filename[7] := loop2; // set filename
Cf Fat Set File Date(2005,6,21,10,35,0); // Set file date & time info
Cf Fat Assign(filename, 0xAO); // find existing file or create a new one
Cf Fat Rewrite(); // To clear file and start with new data
for loop := 1 to 44 do
begin
file contents[0] := loop div 10 + 48;
file contents[1] := loop mod 10 + 48;
Cf Fat Write(file contents, LINE LEN-1); // write data to the assigned file
end;
end;
end;
// = Opens an existing file and rewrites it
procedure M Open File Rewrite();
begin
filename[7] := ‘C’; // Set filename for single-file tests

Cf Fat Assign (filename, O0);
Cf Fat Rewrite();

for loop := 1 to 55 do
begin
file contents[0] := byte(loop div 10 + 48);
file contents[1] := byte(loop mod 10 + 48);
Cf Fat Write (file contents, LINE LEN-1); // write data to the assigned file
end;
end;
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/) mmm e Opens an existing file and appends data to it
// (and alters the date/time stamp)
procedure M Open File Append();
begin
filename[7] := 'B’;

Cf Fat Assign (filename, 0);
Cf Fat Set File Date (2009, 1, 23, 17, 22, 0);
Cf Fat Append;

file contents := ' for mikroElektronika 2009’; // Prepare file for append
file contents[26] := 13; // CR
file contents[27] := 10; // LF
Cf Fat Write(file contents, 27); // Write data to assigned file
end;
) Opens an existing file, reads data from it and puts it to USART
procedure M Open File Read();
begin
filename[7] := '‘B’;
Cf Fat Assign (filename, 0);
Cf Fat Reset (size); // To read file, procedure returns size of file
while size > 0 do
begin
Cf Fat Read (character) ;
UART1 Write (character); // Write data to USART
Dec (size) ;
end;
end;
S/ Deletes a file. If file doesn’t exist, it will first be created
/7 and then deleted.
procedure M Delete File();
begin
filename[7] := ‘F’;

Cf Fat Assign (filename, 0);
Cf Fat Delete();

end;,

) Tests whether file exists, and i1f so sends its creation date
/7 and file size via USART

procedure M Test File Exist();

var

fsize : longint;

year : word;

month, day, hour, minute : byte;,
outstr : array[l1”2] of char;

begin
filename[7] := 'B’; // uncomment this line to search for file that DOES exists
// filename[7] := ‘F’; // uncomment this line to search for file that DOES NOT exist
if Cf Fat Assign(filename, 0) <> 0 then
begin

//--— file has been found - get its date

Cf Fat Get File Date(year,month,day,hour,minute);
UART1 Write Text (' created: ');

WordToStr (year, outstr);

UART1 Write Text (outstr);

ByteToStr (month, outstr);
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UART1 Write Text (outstr);
WordToStr (day, outstr);

UART1 Write Text (outstr);
WordToStr (hour, outstr);

UART1 Write Text (outstr);
WordToStr (minute, outstr);
UART1 Write Text (outstr);

//--- file has been found - get its modified date
Cf Fat Get File Date Modified(year, month, day, hour, minute);
UART1 Write Text (' modified: Y);

WordToStr (year, outstr);
UART1 Write Text (outstr);
ByteToStr (month, outstr);
UART1 Write Text (outstr);
WordToStr (day, outstr);
UART1 Write Text (outstr);
WordToStr (hour, outstr);
UART1 Write Text (outstr);
WordToStr (minute, outstr);
UART1 Write Text (outstr);

//--- get file size

fsize := Cf Fat Get File Size;
LongIntToStr (fsize, outstr);
UART1 Write Line (outstr);

end
else begin
//--- file was not found - signal it

UART1 Write (0x55);
Delay ms (1000);
UART1 Write (0x55);

end;
end;
/)= ——— Tries to create a swap file, whose size will be at least 100
// sectors (see Help for details)
procedure M Create Swap File();
var 1 : word;
begin
for i:=0 to 511 do
Buffer([i] := 1i;
size := Cf Fat Get Swap File (5000, ‘mikroE.txt’, 0x20); // see help on this

function for details

if (size <> 0) then
begin
LongIntToStr (size, err txt);
UART1 Write Line(err txt);
for i:=0 to 4999 do
begin
Cf Write Sector(size, Buffer);
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Inc (size);
UART1 Write(‘.’);
end;
end;

end;

begin
err
file
file
file
file
file

{sd
CHE
AD1
//
UAR
Del
UAR
//
//
if
be

el

more
last

end.

——————————— Main. Uncomment the function(s) to test the desired operation(s)

_txt := ‘FAT16 not found’;

~contents := ‘XX CF FAT16 library by Anton Rieckert’;
~_contents [LINE LEN-2] := 13;

~contents [LINE LEN-1] = 10;
~contents[LINE LEN] := 0;
name := ‘MIKROOOxXTXT';

efine COMPLETE EXAMPLE} // comment this line to make simpler/smaller example
CON := 0x32;
PCFG := OxFFFF; // disable A/D inputs

Initialize UART1 module
Tl Init(56000);
ay ms(10);

Tl Write Line (‘MCU-Started’); // MCU present report

--- Init the FAT library

--- use Cf Fat QuickFormat instead of init routine if a format is needed

Cf Fat Init() = 0 then

gin

Delay ms (2000); // wait for a while until the card is stabilized
// period depends on used CF card

//--- Test start

UART1 Write Line(‘Test Start.’);

M Create New File();

{SIFDEF COMPLETE EXAMPLE}

M Create Multiple Files();

M Open File Rewrite();

M Open_ File Append();

M Open File Read();

M Delete File();

M Test File Exist();

M Create Swap File();

{SENDIF}

UART1 Write Line(‘Test End.’);

end

se

begin

UART1 Write Line(err txt); // Note: Cf Fat Init tries to initialize a card

than once.
// If card is not present, initialization may

longer (depending on clock speed)

end;
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HW Connection
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Pin diagram of CF memory card
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Epson S1D13700 Graphic Lcd Library

The mikroPascal PRO for PIC32 provides a library for working with Glcds based on Epson S1D13700 controller.

The S1D13700 Glcd is capable of displaying both text and graphics on an LCD panel. The S1D13700 Glcd allows
layered text and graphics, scrolling of the display in any direction, and partitioning of the display into multiple screens.
Itincludes 32K bytes of embedded SRAM display memory which is used to store text, character codes, and bit-mapped
graphics.

The S1D13700 Glcd handles display controller functions including :
- Transferring data from the controlling microprocessor to the buffer memory
- Reading memory data, converting data to display pixels
- Generating timing signals for the LCD panel
The S1D13700 Glcd is designed with an internal character generator which supports 160, 5x7 pixel characters in

internal mask ROM (CGROM) and 64, 8x8 pixel characters incharacter generator RAM (CGRAM).
When the CGROM is not used, up to 256, 8x16 pixel characters are supported in CGRAM.

External dependencies of the Epson S1D13700 Graphic Lcd Library

The following variables must be defined

in all projects using S1D13700 Graphic | Description: Example:
Lcd library:
S1D13700 DATA : ; sfr;

var S1bia/io. byte; sfr System data bus. var S1D13700 DATA at PORTD;

external; -

var S1D13700 WR : sbit; sfr; . . var S1D13700 WR : sbit at LATC2
- Write signal. L - -

external; bit;

var S1D13700 RD : sbit; sfr; . var S1D13700 RD : sbit at LATC1

Read signal. L

external; bit;

var S1D13700 A0 : sbit; sfr; . var S1D13700_A0 : sbit at LATCO
- System Address pin. . - -

external; bit;

var S1D13700 RES : sbit; sfr; . var S1D13700 RES : sbit at LATC3
- Reset signal. - - -

external; bit;

var S1D13700 CS : sbit; sfr; . var S1D13700 CS : sbit at LATC4
- Chip select. - - -

external; bit;

var S1D13700 DATA Direction : | Direction of the system data bus | var S1D13700 DATA Direction sbit at

byte; sfr; external; pins. PORTD;

var S1D13700 WR Direction var S1D13700 WR Direction : sbit at

Direction of the Write pin.

sbit; sfr; external; TRISC2 bit;
var S1D13700_RD Direction Direction of the Read pin var S1D13700 RD Direction : sbit at
sbit; sfr; external; rectt pin. TRISC1 bit;
var S1D13700 A0 Direction : | Direction of the System Address | var S1D13700 A0 Direction : sbit at
sbit; sfr; external; pin. TRISCO bit;

var S1D13700 RES Direction var S1D13700_ RES Direction : sbit at

Direction of the Reset pin.

sbit; sfr; external; TRISC3 bit;
var S1D13700_Cs Direction Direction of the Chin select pin var S1D13700 CS Direction : sbit at
sbit; sfr; external; P pin. TRISC4 bit;
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Library Routines

- S1D13700_lInit

- $S1D13700_Write_Command
- S1D13700_Write_Parameter
- S1D13700_Read_Parameter
- S1D13700_Fill

- S1D13700_GrkFill

- S1D13700_TxtFill

- S1D13700_Display_GrlLayer
- S1D13700_Display_TxtLayer
- S1D13700_Set_Cursor

- S1D13700_Display_Cursor

- S1D13700_Write_Char

- S1D13700_Write_Text

- S1D13700_Dot

- S1D13700_Line
-S1D13700_H_Line
-S1D13700_V_Line

- S1D13700_Rectangle

- S1D13700_Box

- S1D13700_Rectangle_Round_Edges
- S1D13700_Rectangle_Round_Edges_Fill
- S1D13700_Circle

- S1D13700_Circle_Fill

- S1D13700_Image

- S1D13700_Partiallmage
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S1D13700_Init

Prototype procedure S1D13700 Init (width : word; height : word);

Returns Nothing.

Description | Initializes S1D13700 Graphic Lcd controller.
Parameters:

- width: width of the Glcd panel.
- height: height of the Glcd panel.

Requires Global variables:

-S1D13700 Data Port:Data Bus Port.

- 51D13700 wRr: Write signal pin.

- 51D13700 RD: Read signal pin.
-S1D13700 A0: Command/Data signal pin.
- 51D13700 RES: Reset signal pin.

- S1D13700 cs: Chip Select signal pin.

-51D13700 Data Port Direction:Data Bus Port Direction.
-S1D13700 WR Direction: Direction of Write signal pin.
-51D13700 RD Direction: Direction of Read signal pin.
-S1D13700 A0 Direction: Direction of Command/Data signal pin.
-S1D13700 RES Direction: Direction of Reset signal pin.
-S1D13700 Cs Direction: Direction of Chip Select signal pin.

must be defined before using this function.

Example // S1D13700 module connections

var SI1D13700 Data Port : byte at PORTD;
var SI1D13700 WR : sbit at LATCZ bit;
var SID13700 RD : sbit at LATCI bit;
var S1D13700 A0 : sbit at LATCO bit;
var SI1D13700 RES : sbit at LATC3 bit;
var SID13700 CS : sbit at LATC4 bit;

var S1D13700 Data Port Direction : byte at PORTD;
var SI1D13700 WR Direction : sbit at TRISCZ bit;
var SI1D13700 RD Direction : sbit at TRISCI1 bit;
var S1D13700 A0 Direction : sbit at TRISCO bit;
var S1D13700 RES Direction : sbit at TRISC3 bit;
var S1D13700 CS Direction : sbit at TRISC4 bit;
// End of S1D13700 module connections

// init display for 320 pixel width, 240 pixel height
S1D13700 Init (320, 240);
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S1D13700_Write_ Command

Prototype procedure S1D13700 Write Command (command byte) ;
Returns Nothing.
Description | Writes a command to S1D13700 controller.
Parameters:
- command: command to be issued:
Value Description
S1D13700 SYSTEM SET General system settings.
S1D13700 POWER SAVE Enter into power saving mode.
S1D13700 DISP ON Turn the display on.
S1D13700 DISP OFF Turn the display off.
S1D13700 SCROLL Setup text and graphics address regions.
S1D13700 CS RIGHT Cursor moves right after write to display
- = memory.
S1D13700 CS LEFT Cursor moves left after write to display
- = memory.
s1D13700 CS UP Cursor moves up after write to display
- = memory.
S1D13700 CS DOWN Cursor moves down after write to display
- = memory.
S1D13700 OVLAY Configure how layers overlay.
S1D13700 CGRAM ADR Configure character generator RAM address.
S1D13700 HDOT SCR Set horizontal scroll rate.
S1D13700 CSRW Set the cursor address.
S1D13700 CSRR Read the cursor address.
S1D13700 GRAYSCALE Selects the gray scale depth, in bits-per-pixel
- (bpp).
S1D13700 MEMWRITE Write to display memory.
S1D13700 MEMREAD Read from display memory.
Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Example // Turn the display on
S1D13700 Write Command (S1D13700 DISP ON) ;
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S1D13700_ Write Parameter

Prototype procedure S1D13700 Write Parameter (parameter : byte);
Returns Nothing.
Description | Writes a parameter to S1D13700 controller.
Parameters:
- parameter: parameter to be written.
Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Previously, a command must be sent through S1D13700_Write_Command routine.
Example S1D13700 Write Command(S1D13700 CSRW); // set cursor address

SlD137007WriteiParameter(Lo(start));
S1D13700 Write Parameter (Hi(start));

// send lower byte of cursor address
// send higher byte cursor address

S1D13700_Read_Parameter

Prototype function S1D13700 Read Parameter () : byte;
Returns Nothing.
Description | Reads a parameter from GLCD port.
Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example parameter = S1D13700 Read Parameter();
S1D13700 _Fill
Prototype |procedure S1D13700_Fill(d : byte; start : word; len : word);
Returns Nothing.
Description | Fills Glcd memory block with given byte.
Parameters:
- d: byte to be written.
- start: starting address of the memory block.
- len: length of the memory block in bytes.
Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example // from the starting address of 0x3000, fill the memory block size of O0x7FFF
with 0x20
S1D13700 Fill(0x20, 0x3000, Ox7FFF);
MikroElektronika
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S1D13700_GrFill

Prototype procedure S1D13700 GrFill(d : byte);
Returns Nothing.
Description | Fill graphic layer with appropriate value (0 to clear).
Parameters:
- d: value to fill graphic layer with.
Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Example // clear current graphic panel
S1D13700 GrFill (0);

S1D13700_TxtFill

Prototype |procedure S1D13700 TxtFill(d : byte);
Returns Nothing.
Description | Fill current text panel with appropriate value (0 to clear).
Parameters:
- d: this value will be used to fill text panel.
Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example // clear current text panel
S1D13700 TxtFill(0);

S1D13700_Display_GrLayer

Prototype procedure S1D13700 Display GrLayer (mode : byte);
Returns Nothing.
Description | Display selected graphic layer.
Parameters:
- mode: graphic layer mode. Valid values:
Value Description
S1D13700 LAYER OFF Turn off graphic layer.
S1D13700 LAYER ON Turn on graphic layer.
S1D13700 LAYER FLASH 2Hz Turn on graphic layer and flash it at the rate of 2 Hz.
S1D13700 LAYER FLASH 16Hz Turn on graphic layer and flash it at the rate of 16 Hz.
Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example // Turn on graphic layer
S1D13700 Display GrLayer (S1D13700 LAYER ON);

283



mikoPascal PRO for PIC32

S1D13700_Display_TxtLayer

Prototype procedure S1D13700 Display TxtLayer (mode : byte);

Returns Nothing.

Description | Display selected text layer.
Parameters:

- mode: text layer mode. Valid values:

Value Description
S1D13700 LAYER OFF Turn off graphic layer.
S1D13700 LAYER ON Turn on graphic layer.
S1D13700 LAYER FLASH 2Hz Turn on graphic layer and flash it at the rate of 2 Hz.
S1D13700 LAYER FLASH 16Hz Turn on graphic layer and flash it at the rate of 16 Hz.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.

Example // Display on text layer
S1D13700 Display TxtLayer (S1D13700 LAYER ON);

S1D13700_Set Cursor

Prototype procedure S1D13700 Set Cursor (width : byte; height : byte; mode : byte);

Returns Nothing.

Description | Sets cursor properties.
Parameters:
- width: in pixels-1 (must be less than or equal to the horizontal char size).

-height:inlines-1 (must be less than or equal to the vertical char size).
- mode: cursor mode. Valid values:

Value Description
S1D13700 CURSOR_UNDERSCORE Set cursor shape - underscore.
S1D13700 CURSOR_BLOCK Set cursor shape - block.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.

Example // set cursor with the following properties : width 5px, height 10px, cursor
shape - block
S1D13700_Set Cursor (5, 10, S1D13700 CURSOR BLOCK) ;
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S1D13700_Display_Cursor

Prototype procedure S1D13700 Display Cursor (mode : byte);

Returns Nothing.

Description | Displays cursor.
Parameters:

- mode: mode parameter. Valid values:

Value Description
S1D13700 CURSOR OFF Turn off graphic layer.
S1D13700 CURSOR_ON Turn on graphic layer.
S1D13700 CURSOR_FLASH 2Hz Turn on graphic layer and flash it at the rate of 2 Hz.
S1D13700 CURSOR_FLASH 16Hz Turn on graphic layer and flash it at the rate of 16 Hz.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.

Example // set cursor on
S1D13700 Display Cursor (S1D13700 CURSOR ON) ;

S1D13700_Write Char

Prototype procedure S1D13700 Write Char(c : char; x : word; y : word; mode: byte);

Returns Nothing.
Description | Writes a char in the current text layer of Glcd at coordinates (=<, v).

Parameters:

- c: char to be written.

- x: char position on x-axis (column).

- v: char position on y-axis (row).

- mode: mode parameter. Valid values :

Value Description

In the OR-Mode, text and graphics can be displayed and the data is
logically “OR-ed”.
This is the most common way of combining text and graphics, for
example labels on buttons.

S1D13700 OVERLAY OR

In this mode, the text and graphics data are combined via the logical

S1D13700 OVERLAY XOR . : »
- - exclusive OR”.

The text and graphic data shown on display are combined via the logical
“AND function”.

S1D13700 OVERLAY AND

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Write Char (‘A’,22,23,S1D13700 OVERLAY OR);
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S1D13700_ Write Text

Prototype procedure S1D13700 Write Text (var str : string; x, y : word; mode : byte);

Returns Nothing.
Description | Writes text in the current text panel of Glcd at coordinates (x, v).

Parameters:

- str: text to be written.

- x: text position on x-axis (column).

- v: text position on y-axis (row).

- mode: mode parameter. Valid values :

Value Description

In the OR-Mode, text and graphics can be displayed and the data is
logically “OR-ed”.
This is the most common way of combining text and graphics, for
example labels on buttons.

S1D13700 OVERLAY OR

In this mode, the text and graphics data are combined via the logical

S1D13700 OVERLAY XOR « ) »
? - - exclusive OR”.

The text and graphic data shown on display are combined via the logical

S1D13700 OVERLAY AND . N
2 - — AND function”.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.

Example S1D13700 Write Text (‘EPSON LIBRARY DEMO, WELCOME !/, 0, 0, S1D13700 OVERLAY
OR) ;

S1D13700_Dot

Prototype procedure S1D13700 Dot(x : word; y : word; color : byte);

Returns Nothing.

Description | Draws a dot in the current graphic panel of Glcd at coordinates (x, y).
Parameters:
- x: dot position on x-axis.

- v: dot position on y-axis.
- color: color parameter. Valid values :

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Dot (50, 50, S1D13700 WHITE) ;
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S1D13700_Line

Prototype procedure S1D13700 Line(x0, yO, x1, yl : word; pcolor : byte);

Returns Nothing.

Description | Draws a line from (x0, y0) to (x1, y1).
Parameters:

- x0: x coordinate of the line start.
- y0: y coordinate of the line end.
- x1: x coordinate of the line start.
- y1:y coordinate of the line end.
- pcolor: color parameter. Valid values:

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Example S1D13700 Line (0, 0, 239, 127, sS1D13700 WHITE);

S1D13700_H_Line

Prototype procedure S1D13700 H Line(x start, x end, y pos : word; color : byte);

Returns Nothing.

Description | Draws a horizontal line.
Parameters:

- x_start: x coordinate of the line start.
- x_end: x coordinate of the line end.

- v_pos: line position on the y axis.

- pcolor: color parameter. Valid values :

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Line (0, O, 239, 127, S1D13700 WHITE);
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S1D13700_V_Line

Prototype |procedure S1D13700_V_Line(y_start, y end, x pos : word; color : byte);

Returns Nothing.

Description | Draws a horizontal line.
Parameters:

-y _start:y coordinate of the line start.
-y _end:y coordinate of the line end.

- x_pos: line position on the x axis.

- pcolor: color parameter. Valid values:

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Line (0, O, 239, 127, S1D13700 WHITE);

S1D13700_Rectangle

Prototype procedure S1D13700 Rectangle (x0, yO0, x1, yl : word; pcolor : byte);

Returns Nothing.

Description | Draws a rectangle on Glcd.
Parameters:

- x0: x coordinate of the upper left rectangle corner.
- v0: y coordinate of the upper left rectangle corner.
- x1: x coordinate of the lower right rectangle corner.
- y1:y coordinate of the lower right rectangle corner.
- pcolor: color parameter. Valid values :

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 rectangle (20, 20, 219, 107, S1D13700 WHITE);
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S1D13700_Box

Prototype procedure S1D13700 Box(x0, y0, x1, yl : word; pcolor : byte);

Returns Nothing.

Description | Draws a rectangle on Glcd.
Parameters:

- x0: x coordinate of the upper left rectangle corner.
- v0:y coordinate of the upper left rectangle corner.
- x1: x coordinate of the lower right rectangle corner.
- y1:y coordinate of the lower right rectangle corner.
- pcolor: color parameter. Valid values :

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Box (0, 119, 239, 127, S1D13700 WHITE);

S1D13700_Rectangle_Round_Edges

Prototype procedure S1D13700 Rectangle Round Edges (x upper left : word; y upper left
word; x bottom right : word; y bottom right : word; round radius : word;
color : byte);

Returns Nothing.

Description | Draws a rounded edge rectangle on Glcd.
Parameters:

-x upper left:x coordinate of the upper left rectangle corner.

-y upper left:y coordinate of the upper left rectangle corner.

-x bottom right:x coordinate of the lower right rectangle corner.
-y bottom right:y coordinate of the lower right rectangle corner.
- round_radius: radius of the rounded edge.

- pcolor: color parameter. Valid values:

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Rectangle Round Edges (20, 20, 219, 107, 12, S1D13700 WHITE);
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S1D13700_Rectangle_Round_Edges_Fill

Prototype |procedure S1D13700 Rectangle Round Edges Fill (x_upper_left : word; y upper_
left word; x bottom right word; y bottom right word; round radius
word; color byte) ;

Returns Nothing.

Description | Draws a filled rounded edge rectangle on Glcd.

Parameters:
-x upper left:x coordinate of the upper left rectangle corner.
-y upper left:y coordinate of the upper left rectangle corner.
- x_bottom right:x coordinate of the lower right rectangle corner.
-y bottom right:y coordinate of the lower right rectangle corner.
- round radius: radius of the rounded edge.
- pcolor: color parameter. Valid values :
Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.
Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Example S1D13700 Rectangle Round Edges Fill (20, 20, 219, 107, 12, S1D13700 WHITE);

S1D13700_Circle

Prototype procedure SlD137007Circle (x_center word; y center word; radius word;
color byte) ;
Returns Nothing.
Description | Draws a circle on Glcd.
Parameters:
- x_center: x coordinate of the circle center.
-y _center:y coordinate of the circle center.
- radius: radius size.
- color: color parameter. Valid values :
Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.
Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Circle(120, 64, 110, S1D13700 WHITE);
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S1D13700_Circle_Fill

Prototype procedure S1D13700 Circle Fill(x center: word; vy center: word; radius:
word; color : byte);

Returns Nothing.

Description | Draws a filled circle on Glcd.
Parameters:

- x_center: x coordinate of the circle center.
-y center:y coordinate of the circle center.
- radius: radius size.

- color: color parameter. Valid values :

Value Description
S1D13700 BLACK Black color.
S1D13700 WHITE White color.

Requires Glcd module needs to be initialized. See the S1D13700_1Init routine.
Example S1D13700 Circle Fill (120, 64, 110, S1D13700 WHITE);

S1D13700_Image

Prototype procedure S1D13700 Image (const image : "“byte);

Returns Nothing.

Description | Displays bitmap on Glcd.
Parameters:
- image: image to be displayed. Bitmap array is located in code memory.

Note: Image dimension must match the display dimension.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.
Example S1D13700 Image (image) ;
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S1D13700_Partiallmage

Prototype procedure S1D13700 PartialImage(x left, vy top, width, height, picture
width, picture height : word; const image : “byte);

Returns Nothing.

Description | Displays a partial area of the image on a desired location.
Parameters:

- x_left: x coordinate of the desired location (upper left coordinate).

- yv_top:y coordinate of the desired location (upper left coordinate).

- width: desired image width.

- height: desired image height.

- picture width: width of the original image.

-picture height: height of the original image.

- image: image to be displayed. Bitmap array is located in code memory.

Note : Image dimension must match the display dimension.

Requires Glcd module needs to be initialized. See the S1D13700_Init routine.

Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12). Original image size is 16x32.
S1D13700 PartialImage (10, 12, 10, 15, 16, 32, image);

Flash Memory Library
This library provides routines for accessing microcontroller’s (internal) Flash memory.

The program Flash array for the PIC32MX device is built up of a series of rows. A row contains 128 32-bit instruction
words or 512 bytes. A group of 8 rows compose a page; which, therefore, contains 8 1512 = 4096 bytes or 1024
instruction words.

A page of Flash is the smallest unit of memory that can be erased at a single time. The program Flash array can be
programmed in one of two ways:

- Row programming, with 128 instruction words at a time.
- Word programming, with 1 instruction word at a time.

The CPU stalls (waits) until the programming operation is finished. The CPU will not execute any instruction, or respond
to interrupts, during this time. If any interrupts occur during the programming cycle, they remain pending until the cycle
completes.

Library Routines

- Flash_Write_Word
- Flash_Write_Row
- Flash_Erase_Page
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Flash_Write_Word

Prototype procedure FLASH Erase32 (flash address longint) ;
Description | Writes one 32-bit word in the program Flash memory on the designated address.
Parameters | - address: address of the FLASH memory word
- wdata: data to be written
Returns Nothing.
Requires Nothing.
Example
Notes None.

Flash_Write_ Row

Prototype procedure FLASH Write Block(flash address longint; data address : word);

Description | Writes one row in the program Flash memory (128 32-bit words or 512 bytes) on the designated
address.

Parameters | - address: address of the FLASH memory word
- rdata: data to be written

Returns Nothing.

Requires Nothing.

Example

Notes None.

Flash_Erase Page

Prototype procedure FLASH Write Init (flash address longint; data address : word);
Description | Erases one page (8 rows, 1024 32-bit word, 4096 bytes) from the program Flash memory.
Parameters | - address: starting address of the FLASH memory block

Returns Nothing.

Requires Nothing.

Example

Notes None.
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Graphic Lcd Library

mikroPascal PRO for PIC32 provides a library for operating Graphic Lcd 128x64 (with commonly used Samsung
KS108/KS107 controller).

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Library Dependency Tree
| Gled ]—DL Glcd_Fonts )
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External dependencies of Graphic Lcd Library

The following variables must be defined in all

295

. : . . Description: Example:
projects using Graphic Lcd Library: P p
var GLCD DO sbit; sfr; external; Data 0 line. var GLCD DO sbit at RBO bit;
var GLCD D1 sbit; sfr; external; Data 1 line. var GLCD D1 sbit at RB1 bit;
var GLCD D2 sbit; sfr; external; Data 2 line. var GLCD D2 sbit at RB2 bit;
var GLCD D3 sbit; sfr; external; Data 3 line. var GLCD D3 : sbit at RB3 bit;
var GLCD_D4 sbit; sfr; external; Data 4 line. var GLCD_D4 sbit at RDO bit;
var GLCD D5 sbit; sfr; external; Data 5 line. var GLCD D5 sbit at RD1 bit;
var GLCD D6 : sbit; sfr; external; Data 6 line. var GLCD D6 : sbit at RD2 bit;
var GLCD D7 sbit; sfr; external; Data 7 line. var GLCD D7 sbit at RD3 bit;
var GLCD CsSl sbit; sfr; external; | Chip Select1 line. var GLCD CS1 : sbit at LATB4 bit;
var GLCD CS2 : sbit; sfr; external; | Chip Select2 line. var GLCD_CS2 : sbit at LATB5 bit;
var GLCD_RS : sbit; sfr; external; Register select line. var GLCD RS : sbit at LATFO0 bit;
var GLCD RW : sbit; sfr; external; Read/Write line. var GLCD RW : sbit at LATF1 bit;
var GLCD EN : sbit; sfr; external; Enable line. var GLCD EN : sbit at LATF4 bit;
var GLCD RST sbit; sfr; external; Reset line. var GLCD RST sbit at LATF5 bit;
var GLCD_DO Direction sbit; sfr; Direction of the Data 0 pin var GLCD_DO Direction sbit at
external; pin. TRISBO bit;
var GLCD D1 Direction sbit; sfr; Direction of the Data 1 pin var GLCD D1 Direction sbit at
external; pin. TRISB1 bit;
var GLCD D2 Direction sbit; . . . var GLCD D2 Direction sbit at
- Direction of the Data 2 pin. T

sfr; external; TRISB2 bit;
var GLCD D3 Direction sbit; sfr; Direction of the Data 3 pin var GLCD D3 Direction sbit at
external; pin. TRISB3 bit;
var GLCD D4 Direction sbit; sfr; Direction of the Data 4 pin var GLCD D4 Direction sbit at
external; : : pin. TRISDO bit;
var GLCD D5 Direction sbit; sfr; Direction of the Data 5 pin var GLCD D5 Direction sbit at
external; pin. TRISD1 bit;
var GLCD D6 Direction sbit; sfr; Direction of the Data 6 pin var GLCD D6 Direction sbit at
external; ection of the Lata © pin. TRISD2 bit;
var GLCD D7 Direction sbit; sfr; Direction of the Data 7 pin var GLCD D7 Direction sbit at
external; ectionotfhe Lata 7 pin. TRISD3 bit;
var GLCD CS1 Direction sbit; sfr; | Direction of the Chip Select | var GLCD CS1 Direction sbit at
external; 1 pin. TRISB4 bit;
var GLCD CS2 Direction sbit; sfr; | Direction of the Chip Select | var GLCD_CS2 Direction sbit at
external; 2 pin. TRISB5 bit;
var GLCD RS Direction sbit; sfr; | Direction of the Register [ var GLCD RS Direction sbit at
external; select pin. TRISFO bit;
var GLCD RW Direction sbit; sfr; | Direction of the Read/Write | var GLCD RW Direction sbit at
external; pin. TRISF1 bit;
var GLCD EN Direction sbit; sfr; Direction of the Enable pin var GLCD EN Direction sbit at
external; pin. TRISF4 bit;
var GLCD RST Direction sbit; sfr; Direction of the Reset pin var GLCD RST Direction sbit at
external; pin. TRISF5 bit;
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Library Routines

Basic routines:

- Gled_Init

- Glcd_Set_Side
- Gled_Set_ X

- Glcd_Set_Page

- Glcd_Read_Data
- Glcd_Write_Data

Advanced routines:

- Gled_Fill

- Gled_Dot

- Gled_Line

- Gled_V_Line
- Gled_H_Line

- Glcd_Rectangle
- Glcd_Rectangle_Round_Edges
- Glcd_Rectangle_Round_Edges_Fill

- Gled_Box

- Gled_Circle

- Glcd_Circle_Fill
- Glcd_Set_Font

- Glcd_Write_Char
- Gled_Write_Text

- Glcd_Image
- Gled_Partiallmage

Gled_Init

Prototype

procedure Glcd Init();

Description

Initializes the Glcd module. Each of the control lines are both port and pin configurable, while data
lines must be on a single port (pins <0:7>).

Parameters

None.

Returns

Nothing.

Requires

Global variables:

- GLCD_DO

- GLCD_D3

:Datapin 0
- GLCD_D1:
- GLCD D2:
: Data pin 3
- GLCD_D4:
- GLCD_D5:
- GLCD_D6:
- GLCD_D7:
- GLCD Cs1 : Chip select 1 signal pin
- GLCD Cs2 : Chip select 2 signal pin
- GLCD_ RS : Register select signal pin
- GLCD RW : Read/Write Signal pin

Data pin 1
Data pin 2

Data pin 4
Data pin 5
Data pin 6
Data pin 7
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Requires - GLCD EN : Enable signal pin
- GLCD_RST : Reset signal pin
- GLCD DO Direction : Direction of the Data pin 0
-GLCD D1 Direction : Direction of the Data pin 1
- GLCD D2 Direction : Direction of the Data pin 2
- GLCD D3 Direction : Direction of the Data pin 3
- GLCD D4 Direction : Direction of the Data pin 4
- GLCD D5 Direction : Direction of the Data pin 5
-GLCD D6 Direction : Direction of the Data pin 6
-GLCD D7 Direction : Direction of the Data pin 7
-GLCD CS1 Direction : Direction of the Chip select 1 pin
- GLCD Cs2 Direction : Direction of the Chip select 2 pin
- GLCD RS Direction : Direction of the Register select signal pin
- GLCD RW Direction : Direction of the Read/Write signal pin
- GLCD EN Direction : Direction of the Enable signal pin
-GLCD RST Direction : Direction of the Reset signal pin
must be defined before using this function.
Example // Glcd module connections
var GLCD D7 : sbit at RD3 bit;
GLCD D6 : sbit at RD2 bit;
GLCD D5 : sbit at RDI bit;
GLCD D4 : sbit at RDO bit;
GLCD D3 : sbit at RB3 bit;
GLCD D2 : sbit at RB2 bit;
GLCD D1 : sbit at RBI bit;
GLCD DO : sbit at RBO bit;
GLCD D7 Dlrectlon : sbit at TRISD3 bit;
GLCD_D&_Dlrectlon : sbit at TRISDZ bit;
GLCD D5 Direction : sbit at TRISDI bit;
GLCD D4 Direction : sbit at TRISDO bit;
GLCD D3 Direction : sbit at TRISB3 bit;
GLCD D2 Direction : sbit at TRISBZ bit;
GLCD D1 Direction : sbit at TRISBI1 bit;
GLCD DO Direction : sbit at TRISBO bit;
GLCD CS2 : shit at LATB5 bit;
GLCD RS : sbit at LATFO bit;
GLCD RW : sbit at LATF1 bit;
GLCD EN : sbit at LATF4 bit;
GLCD RST : sbit at LATF5 bit;
var GLCD CS1 Direction : sbit at TRISB4 bit;
GLCD _ CSZ Direction : sbit at TRISB5 bit;
GLCD RS Direction : sbit at TRISFO bit;
GLCDiRwiDlrectlon : sbit at TRISFI1 bit;
GLCD EN Direction : sbit at TRISF4 bit;
GLCD RST Direction : sbit at TRISF5 bit;
// End Glcd module connections
Gled Init();
Notes None.
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Glcd_Set_Side
Prototype procedure Glcd Set Side(x pos: byte);
Description | Selects Glcd side. Refer to the Glcd datasheet for detailed explanation.
Parameters | - x pos: Specifies position on x-axis of the Glcd. Valid values: 0..127. Values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side of the Glcd.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example The following two lines are equivalent, and both of them select the left side of Glcd:
Glcd Select Side (0);
Glcd Select Side(10);
Notes For side, x axis and page layout explanation see schematic at the bottom of this page.
Glcd_Set X
Prototype procedure Glcd Set X (x pos: byte);
Description | Sets x-axis position to x pos dots from the left border of Glcd within the selected side.
Parameters | - x pos: position on x-axis. Valid values: 0..63
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_lInit routine.
Example Glcd Set X (25);
Notes For side, x axis and page layout explanation see schematic at the bottom of this page.

Glcd_Set_Page

Prototype procedure Glcd Set Page(page: byte);

Description | Selects page of the Glcd.

Parameters | - page: page number. Valid values: 0..7

Returns Nothing.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set Page(5);

Notes For side, x axis and page layout explanation see schematic at the bottom of this page.
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Glcd_Read Data

Prototype function Glcd Read Data () : byte;
Description | Reads data from from the current location of Glcd memory and moves to the next location.
Parameters | None.
Returns One byte from Glcd memory, formatted as a word (16-bit).
Requires Glcd needs to be initialized, see Glcd_Init routine.
Glcd side, x-axis position and page should be set first. See functions Glcd_Set_Side, Glcd_Set_X,
and Glcd_Set_Page.
Example var data : byte;
(.JiédiReadiData O);
data := Glcd Read Data();
Notes This routine needs to be called twice; After the first call, data is placed in the buffer register. After the

second call, data is passed from the buffer register to data lines.

Glcd_Write_Data

Prototype procedure Glcd Write Data(data : byte);
Returns Nothing.
Description | Writes one byte to the current location in Glcd memory and moves to the next location.
Parameters:
- data :datato be written
Requires Glcd needs to be initialized, see Glcd_Init routine.
Glcd side, x-axis position and page should be set first. See functions Glcd_Set_Side, Glcd_Set_X,
and Glcd_Set_Page.
Example var data_ : byte;

Glcd Write Data(data );
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Gled_Fill
Prototype procedure Glcd Fill (pattern: byte);
Description | Fills Glcd memory with the byte pattern.
To clear the Gled screen, use Glcd Fill (0).
To fill the screen completely, use Glcd Fill (0xFF).
Parameters | - pattern: byte to fill Gled memory with.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_lInit routine.
Example // Clear screen
Glcd Fill (0);
Notes None.
Glcd_Dot
Prototype procedure Glcd Dot (x pos, y pos, color: byte);
Description | Draws a dot on Glcd at coordinates (x _pos, vy pos).
Parameters | - x pos: x position. Valid values: 0..127
- y_pos:y position. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines a dot state: O clears dot, 1 puts a dot, and 2 inverts dot state.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Invert the dot in the upper left corner
Glcd Dot (0, 0, 2);
Notes For x and y axis layout explanation see schematic at the bottom of this page.
Glcd_Line
Prototype procedure Glcd Line(x start, y start, x end, y end: integer; color: byte);
Description | Draws a line on Glcd.
Parameters | - x start: x coordinate of the line start. Valid values: 0..127
-y _start:y coordinate of the line start. Valid values: 0..63
- x_end: x coordinate of the line end. Valid values: 0..127
- v _end:y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: O white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a line between dots (0,0) and (20,30)
Glcd Line(0, 0, 20, 30, 1);
Notes None.
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Gled _V Line

Prototype

procedure Glcd V Line(y start, y end, x pos, color: byte);

Description

Draws a vertical line on Glcd.

Parameters

-y _start:y coordinate of the line start. Valid values: 0..63
- y_end:y coordinate of the line end. Valid values: 0..63

- x_pos: X coordinate of vertical line. Valid values: 0..127

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.

Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a vertical line between dots (10,5) and (10,25)
Gled V Line(5, 25, 10, 1);
Notes None.
Glcd_H Line
Prototype procedure Glcd H Line(x start, x end, y pos, color: byte);
Description | Draws a horizontal line on Glcd.
Parameters | - x start: x coordinate of the line start. Valid values: 0..127
- x_end: x coordinate of the line end. Valid values: 0..127
- v _pos:y coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a horizontal line between dots (10,20) and (50,20)
Gled H Line (10, 50, 20, 1);
Notes None.
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Glcd_Rectangle

Prototype procedure Glcd Rectangle(x upper left, vy upper left, x bottom right, vy
bottom right, color: byte);
Description | Draws a rectangle on Glcd.
Parameters | - x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
-x bottom right:x coordinate of the lower right rectangle corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts
each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a rectangle between dots (5,5) and (40,40)
Glcd Rectangle(5, 5, 40, 40, 1);
Notes None.

Glcd_Rectangle _Round_Edges

Prototype procedure Glcd Rectangle Round Edges (x upper left: byte; y upper left: byte;
x bottom right: byte; y bottom right: byte; radius: byte; color: byte);
Description | Draws a rounded edge rectangle on Glcd.
Parameters | - x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
- x _bottom right:x coordinate of the lower right rectangle corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63
- round_radius: radius of the rounded edge.
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts
each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Exmnpm // Draw a rounded edge rectangle between dots (5,5) and (40,40) with the
radius of 12
Glcd Rectangle Round Edges(5, 5, 40, 40, 12, 1);
Notes None.
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Glcd_Rectangle_Round_Edges_Fill

Prototype procedure Glcd Rectangle Round Edges Fill (x upper left: byte; y upper left:
byte; x bottom right: byte; y bottom right: byte; radius: byte; color:
byte);

Description | Draws a filled rounded edge rectangle on Glcd with color.

Parameters | - x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
-x bottom right: X coordinate of the lower right rectangle corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63
- round radius: radius of the rounded edge
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts
each dot.

Returns Nothing.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example // Draws a filled rounded edge rectangle between dots (5,5) and (40,40) with
the radius of 12
Glcd Rectangle Round Edges Fill(5, 5, 40, 40, 12, 1);

Notes None.

Glcd_Box

Prototype |procedure Glcd Box(x upper_ left, vy upper left, x bottom right, y bottom
right, color: byte);

Description | Draws a box on Glcd.

Parameters:

Parameters |- x upper left:x coordinate of the upper left box corner. Valid values: 0..127
-y upper left:y coordinate of the upper left box corner. Valid values: 0..63
-x bottom right: X coordinate of the lower right box corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2 inverts each dot.

Returns Nothing.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example // Draw a box between dots (5,15) and (20,40)

Glcd Box (5, 15, 20, 40, 1);

Notes None.
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Glcd_Circle
Prototype procedure Glcd Circle(x center, y center, radius: integer; color: byte);
Description | Draws a circle on Glcd.
Parameters | - x center: x coordinate of the circle center. Valid values: 0..127
-y _center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the circle line: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a circle with center in (50,50) and radius=10
Glcd Circle (50, 50, 10, 1);
Notes None.
Glcd_Circle_Fill
Prototype procedure Glcd Circle Fill(x center: integer; y center: integer; radius:
integer; color: byte);
Description | Draws a filled circle on Glcd.
Parameters | - x _center: x coordinate of the circle center. Valid values: 0..127
-y _center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size
- color: color parameter. Valid values: 0..2
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_lInit routine.
Example // Draws a filled circle with center in (50,50) and radius=10
Glcd Circle Fill (50, 50, 10, 1);
Notes None.
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Glcd_Set Font

Prototype procedure Glcd Set Font (const activeFont: “byte; aFontWidth, aFontHeight
byte; aFontOffs : byte);

Description | Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines.

Parameters | - activeFont: font to be set. Needs to be formatted as an array of char

- aFontWidth: width of the font characters in dots.

- aFontHeight: height of the font characters in dots.

- aFontOf fs: number that represents difference between the mikroPascal PRO for PIC32 character
set and regular ASCII set (eg. if ‘A’ is 65 in ASCII character, and ‘A’ is 45 in the mikroPascal PRO for
PIC32 character set, aFontOffs is 20). Demo fonts supplied with the library have an offset of 32, which
means that they start with space.

The user can use fonts given in the file “__Lib_ GLCDFonts” file located in the Uses folder or create
his own fonts.

List of supported fonts:

-Font Glcd System3x5

-Font Glcd Systemb5x7
-Font Glcd 5x7

-Font Glcd Character8x7

For the sake of the backward compatibility, these fonts are supported also:

- System3x5 (equivalentto Font Glcd System3x5)
-FontSystemb5x7 v2 (equivalentto Font Glcd System5x7)
- font5x7 (equivalentto Font Glcd 5x7)

- Character8x7 (equivalentto Font Glcd Character8x7)

Returns Nothing.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example // Use the custom 5x7 font “myfont” which starts with space (32):
Glcd Set Font (&myfont, 5, 7, 32);

Notes None.
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Glcd_Write_Char

Prototype procedure Glcd Write Char (character, x pos, page num, color : byte);
Description | Prints character on the Glcd.
Parameters | - character: character to be written
- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid values: 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the character: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to specify the font for display; if
no font is specified, then default Font Glcd System5x7 font supplied with the library will be used.
Example // Write character 'C’ on the position 10 inside the page 2:
Glcd Write Char(‘C’, 10, 2, 1);
Notes For x axis and page layout explanation see schematic at the bottom of this page.

Glcd_Write_Text

Prototype procedure Glcd Write Text(var text: string; x pos, page num, color
byte);
Description | Prints text on Glcd.
Parameters | - text: text to be written
- x_pos: text starting position on x-axis.
- page num: the number of the page on which text will be written. Valid values: 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to specify the font for display; if
no font is specified, then default Font Glcd Systemb5x7 font supplied with the library will be used.
Example // Write text “Hello world!” on the position 10 inside the page 2:
Glcd Write Text (“Hello world!”, 10, 2, 1);
Notes For x axis and page layout explanation see schematic at the bottom of this page.
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Glcd_Image

Prototype

procedure Glcd Image (const image: "“byte);

Description

Displays bitmap on Glcd.

Parameters

- image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC32 pointer to const and pointer to RAM equivalency).

Returns Nothing.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw image my image on Glcd
Glcd Image (my image);
Notes Use the mikroPascal PRO for PIC32 integrated Glcd Bitmap Editor, Tools > Glcd Bitmap Editor, to

convert image to a constant array suitable for displaying on Glcd.

Glcd_Partiallmage

Prototype procedure Glcd Partiallmage (x left, y top, width, height, picture width,
picture height word; const image “byte);

Description | Displays a partial area of the image on a desired location.

Parameters | - x left: x coordinate of the desired location (upper left coordinate).
- yv_top:y coordinate of the desired location (upper left coordinate).
- width: desired image width.
- height: desired image height.
- picture width: width of the original image.
-picture height: height of the original image.
- image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12). Original image size 1is 16x32.
Glcd PartialImage (10, 12, 10, 15, 16, 32, image);

Notes Use the mikroPascal PRO for PIC32 integrated Glcd Bitmap Editor, Tools > Glcd Bitmap Editor, to
convert image to a constant array suitable for displaying on Glcd.

307




mikoPascal PRO for PIC32

I?C Library

The I2C full master I?C module is available with a number of the PIC32 MCU models. The mikroPascal PRO for PIC32
provides a library which supports the master I?°C mode.

Important :

- I2C library routines require you to specify the module you want to use. To select the desired 12C module, simply
change the letter x in the routine prototype for a number from 1 to 3.
- Number of 12C modules per MCU differs from chip to chip. Please, read the appropriate datasheet before utilizing

this library.

Library Routines

- 12Cx_Init

- 12Cx_Init_Advanced
- 12Cx_Start

- 12Cx_Restart
-12Cx_lIs_lIdle

- 12Cx_Read

- 12Cx_Write

- 12Cx_Stop

[2Cx_Init

Prototype

procedure I2Cx Init(scl : longint);

Description

This function configures and initializes the desired 1°C module with default settings.

This function enables the I?C module by setting the I2CEN bit. The rest of the bits in I?C control register
remains unchanged. Default initialization (after reset) of I°C module is:

- Continue operation in IDLE mode.

- 7-bit slave address.

- Slew rate control enabled for High Speed mode (400 kHz).
- General call address disabled.

- SCL clock stretching disabled.

As per the I2C standard, SCL clock may be 100 kHz or 400 kHz. However, the user can specify any
clock rate up to 1 MHz.

Parameters | - sc1: requested serial clock rate.

Returns Nothing.

Requires MCU with the I2C module.

Example // Initialize the I2C1 module with clock rate of 100000
I2C1 Init(100000);

Notes Refer to the MCU’s datasheet for correct values of the scl in respect with Fosc.

I2C library routines require you to specify the module you want to use. To select the desired I?C
module, simply change the letter x in the routine prototype for a number from 1 to 3.

Number of I2C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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[2Cx_Init_Advanced

Prototype procedure I2Cx Init Advanced(Fclk Khz, scl : dword);

Description | This function configures and initializes the desired I12C module using Peripheral Bus Clock and default
initialization settings.
As per the I°C standard, SCL clock may be 100 kHz or 400 kHz. However, the user can specify any
clock rate up to 1 MHz.

Parameters | - Fc1k Khz: Peripheral Bus Clock frequency in kHz.
- sc1: requested serial clock rate.

Returns Nothing.

Requires MCU with the I2C module.

Example

Notes - I12C library routines require you to specify the module you want to use. To select the desired I°C
module, simply change the letter x in the routine prototype for a number from 1 to 5.
- Number of I?C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

[2Cx_Start

Prototype procedure I2Cx Start();

Description | Determines if the IC bus is free and issues START signal.

Parameters | None.

Returns Nothing.

Requires MCU with at least one I12C module.
Used I*C module must be initialized before using this function. See 12Cx_lInit routine.

Example // Issue START signal
I2C1 Start();

Notes - I2C library routines require you to specify the module you want to use. To select the desired I12)C

module, simply change the letter x in the routine prototype for a number from 1 to 5.

- Number of 12C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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I2Cx_Restart

Prototype |procedure I2Cx Restart();

Description | Issues repeated START signal.

Parameters | None.

Returns Nothing.

Requires MCU with at least one I?C module.
Used I°C module must be initialized before using this function. See 12Cx_lInit routine.

Example // Issue RESTART signal
I2C1 Restart();

Notes - I2C library routines require you to specify the module you want to use. To select the desired I1°C
module, simply change the letter x in the routine prototype for a number from 1 to 5.
- Number of I12C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

12Cx_Is_Idle

Prototype function I2Cx Is Idle() : word;

Description | Waits for the I?C bus to become free. This is a blocking function.

Parameters | None.

Returns - 0 if I’C bus is free.
- 1 if I*C bus is not free.

Requires MCU with at least one I?C module.
Used I12C module must be initialized before using this function. See 12Cx_Init routine.

Example var data : byte;
if (I2C1 Is Idle)

I2C1l Write(data );

Notes - I2C library routines require you to specify the module you want to use. To select the desired I’C
module, simply change the letter x in the routine prototype for a number from 1 to 5.
- Number of I?C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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I2Cx_Read

Prototype function I2Cx Read(ack : word) : byte;

Description | Reads a byte from the 12C bus.

Parameters | - ack: acknowledge signal parameter. If the ack = 0, acknowledge signal will be sent after reading,
otherwise the not acknowledge signal will be sent.

Returns Received data.

Requires MCU with at least one I12C module.
Used I?C module must be initialized before using this function. See 12Cx_lInit routine.
Also, START signal needs to be issued in order to use this function. See 12Cx_Start.

Example var take : byte;
// ‘Read data and send the not acknowledge signal
take := I2Cl Read(1l);

Notes - I12C library routines require you to specify the module you want to use. To select the desired I?C
module, simply change the letter x in the routine prototype for a number from 1 to 5.
- Number of I?C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

12Cx_Write

Prototype function I2Cx Write(data : byte) : word;

Description | Sends data byte via the I°C bus.

Parameters | - data :data to be sent

Returns - 0 if there were no errors.
- 1 if write collision was detected on the I?C bus.

Requires MCU with at least one 12C module.
Used I?C module must be initialized before using this function. See 12Cx_lInit routine.
Also, START signal needs to be issued in order to use this function. See 12Cx_Start.

Example var data : byte;

error : word;

é]‘f]‘for = I2Cl Write(data );
error := I2Cl Write (0xA3);

Notes - I2C library routines require you to specify the module you want to use. To select the desired I12C
module, simply change the letter x in the routine prototype for a number from 1 to 5.
- Number of I?C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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I2Cx_Stop

Prototype |procedure I2Cx Stop();

Description | Issues STOP signal.

Parameters | None.

Returns Nothing.

Requires MCU with at least one I?C module.

Used I2C module must be initialized before using this function. See 12Cx_lInit routine.

Example // Issue STOP signal
I2C1 Stop();
Notes - I2C library routines require you to specify the module you want to use. To select the desired I1°C

module, simply change the letter x in the routine prototype for a number from 1 to 5.

- Number of I12C modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

Library Example

This code demonstrates working with the I12C library. Program sends data to EEPROM (data is written at the address
2). After that, program reads data from the same EEPROM address and displays it on PORTB for visual check. See the
figure below how to interface the 24C02 to PIC32.

Copy Code To Clipboard

program I2C Simple;

var i, b : char;

procedure EEPROM 24C02 Init();

begin
I2C2_Init(100000);
end;
[/ == mm Writes data to 24C02 EEPROM - signle location
procedure EEPROM 24C02 WrSingle (wAddr : byte; wData : byte);
begin
I2C2 _Start(); // issue I2C start signal
I2C2 _Write (0xA0); // send byte via I2C (command to 24c02)
I2C2 Write (wAddr); // send byte (address of EEPROM location)
I2C2_Write (wData); // send data (data to be written)
I2C2 _Stop();
end;
[/ =—mm——————————— Reads data from 24C02 EEPROM - single location (random)
function EEPROM 24C02 RdSingle(rAddr : byte) : byte;
begin
I2C2 _Start(); // issue I2C start signal
I2C2 Write (0xA0); // send byte via I2C (device address + W)
I2C2 Write (rAddr); // send byte (data address)
I2C2 Restart(); // issue I2C signal repeated start
I2C2 Write (OxAl); // send byte (device address + R)
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result := I2C2 Read(l); // Read the data (NO acknowledge)
I2C2 Stop();
end;

begin
CHECON := 0x30;
AD1IPCFG := OxFFFFFFFE;

LATB := 0; // Set PORTB value to zero
TRISB := 0; // Configure PORTB as output
TRISA := 0;

TRISD := 0

LATD ;

LATF 0;

TRISF := 0;

’

|
o

EEPROM 24C02 Init(); // performs I2C initialization
b := 0x00;
for i := 0x00 to 0x80 do
begin
EEPROM 24C02 WrSingle(i,b);
Inc(b);
Delay ms(5); //max vrednost za upis u eeprom
end;

for i := 0x00 to 0x80 do
begin
LATD := 1;
LATB := EEPROM_24C02_RdSingle(i);
Delay ms (100);
end;
end.
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Keypad Library

mikroPascal PRO for PIC32 provides a library for working with 4x4 keypad. The library routines can also be used with
4x1, 4x2, or 4x3 keypad. For connections explanation see schematic at the bottom of this page.

External dependencies of Keypad Library

The following variable must be defined _
. . . . Description: Example:
in all projects using Keypad Library:
var keypadPort : word; sfr;
ke Port : byte PORTB;
external ; Keypad Port. var keypadPor yte at PO
var keypadPort Direction : word; var keypadPort Direction : byte at
sfr; external; Keypad Port. TRISB;

Library Routines
- Keypad_Init

- Keypad_Key_Press
- Keypad_Key_Click

Keypad_ Init

Prototype procedure Keypad Init();

Description | Initializes given port for working with keypad.

Parameters | None.

Returns Nothing.

Requires Global variable:
- keypadPort - Keypad port

must be defined before using this function.

Example // Keypad module connections

var keypadPort : byte at PORTB;

var keypadPort Direction : byte at TRISB;
// End of keypad module connections

Keypad Init();

Notes The Keypad library uses lower byte (bits <7..0>) of keypadPort.
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Keypad_Key Press

Prototype function Keypad Key Press(): word;
Description | Reads the key from keypad when key gets pressed.
Parameters | None.
Returns The code of a pressed key (1..16).
If no key is pressed, returns 0.
Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.
Example var kp : word;
kp := Keypad Key Press();
Notes None

Keypad_Key_Click

Prototype function Keypad Key Click(): word;

Description | Call to Keypad Key Click is a blocking call: the function waits until some key is pressed and
released. When released, the function returns 1 to 16, depending on the key. If more than one key is
pressed simultaneously the function will wait until all pressed keys are released. After that the function
will return the code of the first pressed key.

Parameters | None.

Returns The code of a clicked key (1..16).

If no key is clicked, returns 0.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

Example kp = Keypad Key Click();

Notes None
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Library Example

The following code can be used for testing the keypad. It is written for keypad_4x3 or _4x4. The code returned by the

keypad functions (1..16) is transformed into ASCII codes [0..9,A..F], and then sent via UART1.

Copy Code To Clipboard

program Keypad Test;
var kp, oldstate : byte;
txt : array[6] of char;

// Keypad module connections

var keypadPort : dword at PORTD;

var keypadPort Direction : dword at TRISD;
// End Keypad module connections

begin
oldstate := 0;
AD1PCFG := OxFFFE;
CHECON := 0x32;
UART1 Init(19200); // Initialize UART module at 9600 bps
Delay ms (10);
Keypad Init(); // Initialize Keypad

UART1 Write Text (‘Press any key on your keypad...’);
UART1 Write (10);
UART1 Write (13);

while TRUE do
begin
kp := 0; // Reset key code variable

// Wait for key to be pressed and released
while ( kp = 0 ) do
kp := Keypad Key Click(); // Store key code in kp variable

LATB := kp;
// Prepare value for output, transform key to it’s ASCII value
case kp of

//case 10: kp = 42; VA // Uncomment this block for keypaddx3
//case 11: kp = 48; // 07
//case 12: kp = 35; /] M

//default: kp += 48;

1: kp := 49; // 1 // Uncomment this block for keypad4x4
2: kp := 50; // 2
3: kp := 51; // 3
4: kp := 65; // A
5: kp := 52; // 4
6: kp := 53; // 5
7: kp := 54; // 6
8: kp := 66; // B
9: kp := 55; // 7
10: kp := 56; // 8
11: kp := 57; // 9
12: kp := 67; // C
MikroElektronika
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13: kp := 42; // *

14: kp := 48; // O

15: kp := 35; // #

16: kp := 68; // D
end;

UART1 Write Text (‘Key pressed: ');
UART1 Write (kp); // Send value of pressed button to UART
UART1 Write (10);
UART1 Write(13);
end;
end.

HW Connection

DECILLATOR.

GMD

PIC32MX460F512L o

- — —

WVCC3
MO

WCC3

LIIJIJLII.IIJLII.IIJLIIJIllLILI gooooorod

4x4 Keypad connection scheme
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Lcd Library

mikroPascal PRO for PIC32 provides a library for communication with Lcds (with HD44780 compliant controllers)
through the 4-bit interface. An example of Lcd connections is given on the schematic at the bottom of this page.

For creating a set of custom Lcd characters use Lcd Custom Character Tool.

Library Dependency Tree

| Led ]—>L Lcd_Constants )

Keypad_Key_ Click

The following variables must be defined

. . ] : Description: Example:

in all projects using Lcd Library: P P

var LCD RS : sbit; sfr; external; | Register Select line. var LCD_RS : sbit at LATDO bit;

var LCD EN : sbit; sfr; external; | Enable line. var LCD EN : sbit at LATD1 bit;

var LCD D7 : sbit; sfr; external; | Data7 line. var LCD D7 : sbit at LATB3 bit;

var LCD D6 : sbit; sfr; external; | Data6 line. var LCD D6 : sbit at LATB2 bit;

var LCD D5 : sbit; sfr; external; | Data5 line. var LCD D5 : sbit at LATB1 bit;

var LCD D4 : sbit; sfr; external; | Data4 line. var LCD D4 : sbit at LATBO bit;

var LCD RS Direction : sbit; sfr; Reaqister Select direction pin var LCD RS Direction : sbit at
external; 9 pin. TRISDO bit;

var LCD_EN Direction : sbit; sfr; Enable direction pin var LCD_EN Direction : sbit at
external; pin. TRISD1 bit;

var LCD D7 Direction : sbit; sfr; Data 7 direction pin var LCD D7 Direction : sbit at
external; pin. TRISB3 bit;

var LCD D6 Direction : sbit; sfr; Data 6 direction bin var LCD D6 Direction : sbit at
external; pin. TRISB2 bit;

var LCD D5 Direction : sbit; sfr; Data 5 direction pin var LCD D5 Direction : sbit at
external; ata ection pin. TRISB1 bit;

var LCD D4 Direction : sbit; sfr; Data 4 direction bin var LCD D4 Direction : sbit at
external; pin. TRISBO bit;

Library Routines

- Led_Init

- Led_Out
-Lecd_Out Cp
-Led_Chr
-Led_Chr_Cp
-Led_Cmd
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Led Init

Prototype |procedure Lcd Init();

Description | Initializes Lcd module.

Parameters | None.

Returns Nothing.

Requires Global variables:

- LCD D7: Data bit 7

- LCD Dé6: Data bit 6

- LCD_D5: Data bit 5

- LCD D4: Data bit 4

- LCD Rs: Register Select (data/instruction) signal pin
- LCD_EN: Enable signal pin

-LCD D7 Direction: Direction of the Data 7 pin

-LCD D6 Direction: Direction of the Data 6 pin

-LCD D5 Direction: Direction of the Data 5 pin

-LCD D4 Direction: Direction of the Data 4 pin

-LCD RS Direction: Direction of the Register Select pin
-LCD EN Direction: Direction of the Enable signal pin

must be defined before using this function.

Example // LCD module connections

var LCD RS : sbit at LATDO bit;
var LCD EN : sbit at LATDI bit;
var LCD D4 : sbit at LATBO bit;
var LCD D5 : sbit at LATB1 bit;
var LCD D6 : sbit at LATBZ bit;
var LCD D7 : sbit at LATB3 bit;

var LCD RS Direction : sbit at TRISDO bit;
var LCD EN Direction : sbit at TRISDI1 bit;
var LCD D4 Direction : sbit at TRISBO bit;
var LCD D5 Direction : sbit at TRISBI bit;
var LCD Dé Direction : sbit at TRISBZ bit;
var LCD D7 Direction : sbit at TRISB3 bit;
// End LCD module connections

Lcd_Init(};

Notes None
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Lcd Out
Prototype procedure Lcd Out (row, column: word; var text: string);
Description | Prints text on Lcd starting from specified position. Both string variables and literals can be passed as
a text.
Parameters | - row: starting position row number
- column: starting position column number
- text: text to be written
Returns Nothing.
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write text “Hello!” on Lcd starting from row 1, column 3:
Lcd Out (1, 3, “Hello!”);
Notes None
Lcd Out Cp
Prototype |procedure Lcd Out Cp(var text: string);
Returns Nothing.
Description | Prints text on Lcd at current cursor position. Both string variables and literals can be passed as a
text.
Parameters | - text: text to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write text “Here!” at current cursor position:
Lcd Out Cp (“Here!”);
Notes None
Led_Chr
Prototype procedure Lcd Chr (row, column: word, out char: byte);
Description | Prints character on Lcd at specified position. Both variables and literals can be passed as a
character.
Parameters | - row: writing position row number
- column: writing position column number
- out char: character to be written
Returns Nothing.
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write character “i” at row 2, column 3:
Led Chr(2, 3, ‘i');
Notes None
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Led Chr_Cp
Prototype procedure Lcd Chr Cp(out char: byte);
Description | Prints character on Lcd at current cursor position. Both variables and literals can be passed as a
character.
Parameters | - out char: character to be written
Returns Nothing.
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write character “e” at current cursor position:
Lcd Chr Cp(te’);
Notes None
Lcd_Cmd
Prototype procedure Lcd Cmd(out char: byte);
Description | Sends command to Lcd.
Parameters | - out char: command to be sent
Returns Nothing.
Requires The Lcd module needs to be initialized. See Lcd_Init table.
Example // Clear Lcd display:
Lcd Cmd ( _LCD CLEAR) ;
Notes Predefined constants can be passed to the function, see Available Lcd Commands.

Available Lcd Commands

Lcd Command

Purpose

_ICD FIRST ROW

Move cursor to the 1st row

_LCD_SECOND_ROW

Move cursor to the 2nd row

_ICD_THIRD ROW

Move cursor to the 3rd row

_LCD FOURTH ROW

Move cursor to the 4th row

_LCD_CLEAR

Clear display

_1CD RETURN HOME

Return cursor to home position, returns a shifted display to its
original position. Display data RAM is unaffected.

_LCD_CURSOR_OFF

Turn off cursor

_1CD _UNDERLINE ON

Underline cursor on

_ICD BLINK CURSOR ON

Blink cursor on

_LCD_MOVE_CURSOR_LEFT

Move cursor left without changing display data RAM

_ICD MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

_LCD_TURN_ON

Turn Lcd display on

_ICD_TURN_OFF

Turn Lcd display off

_ICD SHIFT LEFT

Shift display left without changing display data RAM

_LCD_SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

The following code demonstrates usage of the Lcd Library routines:

Copy Code To Clipboard

program Lcd COG 2x16;

// LCD module connections
LCD RS : sbit at LATBZ2 bit;
LCD EN : sbit at LATB37bit;
LCD D4 : sbit at LATB4 bit;
LCD D5 : sbit at LATBS bit;
LCD7D6 : sbit at LATBﬁibit;
LCD D7 : sbit at LATB7 bit;

var
var
var
var
var
var

var
var
var
var
var
var

LCD RS Direction : sbit at
LCD EN Direction : sbit at
LCD D4 Direction : sbit at
LCD D5 Direction : sbit at
LCD D6 Direction : sbit at
LCD D7 Direction : sbit at

// End LCD module connections

var

txtl : array[16] of char;

txt2 : array[10] of char;

txt3 : array/[8] of char;,
txt4 : array/[7] of char;
i : byte;

procedure Move Delay();

begin
Delay ms (500) ;
end;
begin
CHECON := 0x32;
ADIPCFG := 0OxFFFF;
txtl := 'mikroElektronika’
txt2 := ‘LV32MX vé6’;
txt3 := ‘Lcd4bit’;
txt4 := ‘example’;

Led Init();

Led Cmd (_LCD CLEAR) ;

Lcd Cmd (_LCD CURSOR _OFF) ;
LCD Out (1,6,txt3);

LCD Out (2,6,txt4) ;
Delay ms (2000) ;

Led Cmd( LCD CLEAR) ;

LCD Out (1,1,txtl);
Led Out (2,4,txt2) ;
Delay ms (500) ;

TRISB2 bit;
TRISB3 bit;
TRISB4 bit;
TRISB5 bit;
TRISB6 bit;
TRISB7 bit;

/7
/7
//

/7

Loop variable

Function used for text moving

You can change the moving speed here

Configure AN pins as digital I/0

Initialize LCD

Clear

display

Cursor off

Write
Write

Clear

Write
Write

text in first row
text in second row

display

text in first row
text in second row
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// Moving text
for i:=0 to 3 do
begin

while TRUE do

end.

Lcd Cmd (. LCD SHIFT RIGHT) ;

Move_DelEy();

end;

begin

for

begin

i:=0 to 7 do

Led Cmd ( LCD_SHIFT LEFT) ;
Move Delay();

end;

for i:=0 to 7 do

end;

begin

Led Cmd (LCD _SHIFT RIGHT) ;
Move Delay();

end;

VCC3

VGC3

//

Move text to the right 4 times

Endless loop

Move text to the left 7 times

Move text to the right 7 times

VCC3
nnoonnononannaniannanaonona

vee

[5]
88

gEda

ENVREG D0

GND

PIC32MX460F512L =

1] IJLIIJLILIIJIJLILIItI

LILIUIJIJLIIJLILIIJLIf

LCD (COG) 2X16

Lcd HW connection

<
s}
o
@

OSCILLATOR |

=
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Memory Manager Library

This library provides routines for accessing microcontroller’s (internal) Flash memory.

Library Routines

- Heap_|Init
- malloc

- free

- LargestFreeMemBlock
- TotalFreeMemSize

Heap_Init
Prototype |procedure Heap Init();
Description | Sets Heap size.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example const HEAP SIZE = 3000; // declare Heap size
Heap Init(); // set Heap size
Notes None.
GetMem
Prototype procedure GetMem(var P: “dword; WantedSize: word);
Description | Fetches memory from the memory heap.
Parameters | - iantedsize: pointer to the fetched memory
- WantedSize: size in bytes of the dynamic variable to allocate
Returns Returns a pointer to the fetched memory (of “WantedSize” bytes) in P if success; Otherwise 0 (no free
blocks of memory are large enough).
Requires Nothing.
Example GetMem (ptr, 20*sizeof (PBuffer)); // ptr will point to a memory block where
PBuffer is allocated
Notes None.
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FreeMem

Prototype procedure fFreeMem(var P: “dword; ActualSize: word);

Description | FreeMem destroys the variable referenced by P and returns its memory to the heap.

Parameters | - P: variable of any pointer type previously assigned by the Getmem procedure.
- Actualsize: specifies the size in bytes of the dynamic variable to dispose of and should be the
same as the one used to Getmem.

Returns Nothing.

Requires Nothing.

Exan“ﬂe FreeMem (ptr,20*sizeof (PBuffer)); // ptr will point to a memory block where
PBuffer is allocated

Notes None.

MM_LargestFreeMemBlock

Prototype function MM LargestFreeMemBlock () : word;
Description | This function is used to determine largest available free memory block for the Heap.
Parameters | None.
Returns Returns, after defragmentation of the freelist the size (in bytes) of the largest free block of contiguous
memory on the heap.
Requires Nothing.
Example var block : word;
begin
block := MM LargestFreeMemBlock () ;
end;
Notes None.

MM_TotalFreeMemSize

Prototype function MM TotalFreeMemSize () : word;
Description | This function is used to determine total free memory size on the heap.
Parameters | None.
Returns Returns the size (in bytes) of the total free memory on the heap.
Requires Nothing.
Example var total : word;

begin

total := MMiTotalFreeMemSize();

end;

Notes None.
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Multi Media Card Library

The Multi Media Card (MMC) is a Flash memory card standard. MMC cards are currently available in sizes up to and
including 32 GB and are used in cellular phones, digital audio players, digital cameras and PDA’s.

mikroPascal PRO for PIC32 provides a library for accessing data on Multi Media Card via SPI communication. This
library also supports SD (Secure Digital) and high capacity SDHC (Secure Digital High Capacity) memory cards.

Secure Digital Card

Secure Digital (SD) is a Flash memory card standard, based on the older Multi Media Card (MMC) format.
SD cards are currently available in sizes of up to and including 2 GB, and are used in digital cameras, digital camcorders,
handheld computers, media players, mobile phones, GPS receivers, video games and PDAs.

Secure Digital High Capacity Card

SDHC (Secure Digital High Capacity, SD 2.0) is an extension of the SD standard which increases card’s storage
capacity up to 32 GB by using sector addressing instead of byte addressing in the previous SD standard.

SDHC cards share the same physical and electrical form factor as older (SD 1.x) cards, allowing SDHC-devices to
support both newer SDHC cards and older SD-cards. The current standard limits the maximum capacity of an SDHC
card to 32 GB.

Important:

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only.

- Library functions populate both FAT1 and FAT2 tables when writing to files, but the file data is being read from the
FAT1 table only; i.e. there is no recovery if the FAT1 table gets corrupted.

- If MMC/SD card has Master Boot Record (MBR), the library will work with the first available primary (logical) partition
that has non-zero size. If MMC/SD card has Volume Boot Record (i.e. there is only one logical partition and no
MBRs), the library works with entire card as a single partition. For more information on MBR, physical and logical
drives, primary/secondary partitions and partition tables, please consult other resources, e.g. Wikipedia and similar.

- Before write operation, make sure you don’t overwrite boot or FAT sector as it could make your card on PC or digital
camera unreadable. Drive mapping tools, such as Winhex, can be of a great assistance.

- Library uses SPI module for communication. The user must initialize the appropriate SPI module before using
the MMC Library.

- For MCUs with multiple SPI modules it is possible to initialize all of them and then switch by using the
SPI set Active () function. See the SPI Library functions.

The SPI module has to be initialized through sP1x Init Advanced routine with the following parameters:

- SPI Master

- 8bit mode

- secondary prescaler 1

- primary prescaler 64

- Slave Select disabled

- data sampled in the middle of data output time

- clock idle high

- Serial output data changes on transition from active clock state to idle clock state

Tip : Once the MMC/SD card is initialized, SPI module can be reinitialized at higher a speed. See the Mmc_Init and
Mmc_Fat_Init routines.
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Library Dependency Tree

o
(wcrarte  }———(csung )
—{cmpe ]

External dependencies of MMC Library

The following variable must be defined
in all projects using MMC library:

Description:

Example:

var Mmc Chip Select : sbit; sfr;
external;

Chip select pin.

var Mmc Chip Select :

bit;

sbit at LATFO

var Mmc Chip Select Direction
sbit; sfr; external;

Direction of the chip select pin.

var Mmc Chip Select Direction : sbit

at TRISFO bit;

Library Routines

- Mmc_Init

- Mmc_Read_Sector
- Mmc_Write_Sector
- Mmc_Read_Cid

- Mmc_Read_Csd

Routines for file handling:

- Mmc_Fat_Init

- Mmc_Fat_QuickFormat
- Mmc_Fat_Assign

- Mmc_Fat_Reset

- Mmc_Fat_Read

- Mmc_Fat_Rewrite

- Mmc_Fat_Append

- Mmc_Fat_Delete

- Mmc_Fat_Write

- Mmc_Fat_Set_File_Date
- Mmc_Fat_Get_File_Date

- Mmc_Fat_Get_File_Date_Modified

- Mmc_Fat_Get_File_Size
- Mmc_Fat_Get_Swap_File
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Mmc_Init

Prototype

function Mmc_Init(): word;

Description

Initializes MMC through hardware SPI interface.

Mmc_Init needs to be called before using other functions of this library.

Parameters

None.

Returns

- 0 - if MMC/SD card was detected and successfully initialized
- 1 - otherwise

Requires

The appropriate hardware SPI module must be previously initialized.
Global variables :

-Mme Chip Select: Chip Select line
-Mmc Chip Select Direction: Direction of the Chip Select pin

must be defined before using this function.

Example

// MMC module connections

var Mmc Chip Select : sbit at LATFO bit;

var Mmc Chip Select Direction : sbit at TRISF0 bit;
// MMC module connections

// Initialize the SPI module
SPI1 Init Advanced( SPI MASTER, SPI 8 BIT,  SPI PRESCALE SEC 1,  SPI
PRESCALE PRI 64, SPI_SS DISABLE,

_SPI_DATA SAMPLE MIDDLE, SPI CLK IDLE HIGH, SPI ACTIVE 2
IDLE) ;
// Loop until MMC is initialized
while (Mmc Init())
// Reinitialize the SPI module at higher speed (change primary prescaler).
SPI1 Init Advanced( SPI MASTER,  SPI 8 BIT,  SPI PRESCALE SEC 1,  SPI_
PRESCALE PRI 4, SPI SS DISABLE,

_SPI _DATA SAMPLE MIDDLE, SPI CLK IDLE HIGH, SPI ACTIVE 2_
IDLE) ;

Notes

None.
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Mmc_Read_Sector

Prototype function Mmc Read Sector (sector: dword; var dbuff: array[512] of byte):
word;
Description | The function reads one sector (512 bytes) from MMC card.
Parameters | - sector: MMC/SD card sector to be read.
- dbuf £: buffer of minimum 512 bytes in length for data storage.
Returns - 0 - if reading was successful
- 1 - if an error occurred
Requires MMC/SD card must be initialized. See Mmc_Init.
Example // read sector 510 of the MMC/SD card
var error : word;
sectorNo dword;
dataBuffer : array[512] of byte;
sectorNo := 510;
error := Mmc Read Sector (sectorNo, dataBuffer) ;
Notes None.
Mmc_Write_Sector
Prototype function Mmc Write Sector (sector: dword; wvar data: array[512] of byte):
word;
Description | The function writes 512 bytes of data to one MMC card sector.
Parameters |- sector: MMC/SD card sector to be written to.
- dbuf f: data to be written (buffer of minimum 512 bytes in length).
Returns - 0 - if writing was successful
- 1 - if there was an error in sending write command
- 2 - if there was an error in writing (data rejected)
Requires MMC/SD card must be initialized. See Mmc_|Init.
Example // write to sector 510 of the MMC/SD card
var error : word;
sectorNo : dword;
dataBuffer : array[512] of byte;
sectorNo := 510;
error := Mmc Write Sector (sectorNo, dataBuffer);
Notes None.
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Mmc_Read_ Cid

Prototype function Mmc Read Cid(var data cid: array([16] of byte): word;
Description | The function reads 16-byte CID register.
Parameters | - data cid: buffer of minimum 16 bytes in length for storing CID register content.
Returns - 0 - if CID register was read successfully

- 1 - if there was an error while reading
Requires MMC/SD card must be initialized. See Mmc_Init.
Example var error : word;

dataBuffer : array[l6] of byte;

é%éor := Mmc_ Read Cid(dataBuffer);

Notes None.

Mmc_Read_ Csd

Prototype function Mmc Read Csd(var data for registers: array([l16] of byte): word;
Description | The function reads 16-byte CSD register.
Parameters | - data csd: buffer of minimum 16 bytes in length for storing CSD register content.
Returns - 0 - if CSD register was read successfully

- 1 - if there was an error while reading
Requires MMC/SD card must be initialized. See Mmc_Init.
Example var error : word;

dataBuffer : array[l6] of byte;

é%éor := Mmc Read Csd(dataBuffer);

Notes None.
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Mmc_Fat_Init

Prototype function Mmc Fat Init(): word;

Description | Initializes MMC/SD card, reads MMC/SD FAT 16 boot sector and extracts necessary data needed by
the library.

Parameters | None.

Returns - 0 - if MMC/SD card was detected and successfully initialized
- 1 - if FAT16 boot sector was not found
- 255 - if MMC/SD card was not detected

Requires Global variables :

-Mmc Chip select: Chip Selectline
-Mmc Chip sSelect Direction: Direction of the Chip Select pin

must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the SPIx_Init, SPIx_Init_
Advanced routines.

Example // MMC module connections

var Mmc Chip Select : sbit at LATFO bit;

var Mmc Chip Select Direction : sbit at TRISFO bit;
// MMC module connections

// Initialize the SPI module
SPI1 Init Advanced( SPI MASTER,  SPI 8 BIT,  SPI PRESCALE SEC 1,  SPI
PRESCALE PRI 64, SPI SS DISABLE,

_SPI_DATA SAMPLE MIDDLE, SPI CLK IDLE HIGH, SPI ACTIVE 2 _
IDLE) ;
// Initialize MMC/SD card and MMC FAT16 library globals
Mmc Fat Init();
// Reinitialize the SPI module at higher speed (change primary prescaler).
SPI1 Init Advanced( SPI MASTER, _SPI 8 BIT,  SPI PRESCALE SEC 1,  SPI
PRESCALE PRI 4, SPI SS DISABLE,

_SPI DATA SAMPLE MIDDLE, SPI CLK IDLE HIGH, SPI ACTIVE 2
IDLE) ;

Notes MMC/SD card has to be formatted to FAT16 file system.
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Mmc_Fat_QuickFormat

Prototype function Mmc_Fat_QuickFormat (var mmc fat label : string([11l]) : word;

Description | Formats to FAT16 and initializes MMC/SD card.

Parameters | -mmc fat label:volume label (11 characters in length). If less than 11 characters are provided, the
label will be padded with spaces. If null string is passed volume will not be labeled

Returns - 0 - if MMC/SD card was detected, successfully formated and initialized
- 1 - if FAT16 format was unseccessful
- 255 - if MMC/SD card was not detected

Requires The appropriate hardware SPI module must be previously initialized.

Example // Initialize the SPI module
SPI1 Init Advanced( SPI _MASTER,  SPI 8 BIT,  SPI PRESCALE SEC 1, _ SPI
PRESCALE PRI 64, SPI SS DISABLE, SPI DATA SAMPLE MIDDLE, _SPI CLK IDLE
HIGH, SPI ACTIVE 2 IDLE);
// Format and initialize MMC/SD card and MMC FAT16 library globals
Mmc Fat QuickFormat ('mikroE’) ;
// Reinitialize the SPI module at higher speed (change primary prescaler).
SPI1 Init Advanced( SPI _MASTER,  SPI 8 BIT,  SPI PRESCALE SEC 1, _ SPI
PRESCALE PRI 4, SPI SS DISABLE, _ SPI DATA SAMPLE MIDDLE, _ SPI CLK IDLE
HIGH, SPI ACTIVE 2 IDLE);

Notes This routine can be used instead or in conjunction with Mmc_Fat_Init routine.
If MMC/SD card already contains a valid boot sector, it will remain unchanged (except volume label
field) and only FAT and ROOT tables will be erased. Also, the new volume label will be set.
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Mmc_Fat_Assign

Prototype

function Mmc Fat Assign (var filename: array[12] of char; file cre attr: byte):
word;

Description

Assigns file for file operations (read, write, delete...). All subsequent file operations will be applied on
an assigned file.

Parameters

- filename: name of the file that should be assigned for file operations. File name should be in DOS 8.3
(file_name.extension) format. The file name and extension will be automatically padded with spaces
by the library if they have less than length required (i.e. “mikro.tx” -> “mikro .tx “), so the user does no
have to take care of that. The file name and extension are case insensitive. The library will convert
them to proper case automatically, so the user does not have to take care of that.

Also, in order to keep backward compatibility with the first version of this library, file names can be
entered as UPPERCASE string of 11 bytes in length with no dot character between file name and
extension (i.e. “MIKROELETXT” -> MIKROELE.TXT). In this case last 3 characters of the string are
considered to be file extension.

- file cre attr: file creation and attributes flags. Each bit corresponds to the appropriate file
attribute:

Bit | Mask Description
0 0x01 Read Only
1 0x02 Hidden

2 0x04 System

3 0x08 Volume Label
4

5

6

0x10 Subdirectory
0x20 Archive

0x40 Device (internal use only, never found on disk)

File creation flag. If file does not exist and this flag is set, a

7 0x80 new file with specified name will be created.

Returns

- 1 - if file already exists or file does not exist but a new file is created.
- 0 - if file does not exist and no new file is created.

Requires

MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.

Example

// create file with archive attribut if it does not already exist
Mmc Fat Assign('MIKRO0O07.TXT’,0xA0);

Notes

Long File Names (LFN) are not supported.
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Mmc_Fat Reset

Prototype procedure Mmc Fat Reset (var size: dword);

Description | Procedure resets the file pointer (moves it to the start of the file) of the assigned file, so that the file
can be read.

Parameters | - size: buffer to store file size to. After file has been opened for reading, its size is returned through
this parameter.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example var size : dword;
l\./lr.néih'atiReset (size);

Notes None.

Mmc_Fat_Read

Prototype procedure Mmc Fat Read(var bdata : byte);

Description | Reads a byte from the currently assigned file opened for reading. Upon function execution file pointers
will be set to the next character in the file.

Parameters | - bdata: buffer to store read byte to. Upon this function execution read byte is returned through this
parameter.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for reading. See Mmc_Fat_Reset.

Example var character : byte;
l\./lr.m.:ih'atiRead (character) ;

Notes None.
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Mmc_Fat_Rewrite

Prototype procedure Mmc Fat Rewrite();

Description | Opens the currently assigned file for writing. If the file is not empty its content will be erased.

Parameters | None.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example // open file for writing
Mmc Fat Rewrite();

Notes None.

Mmc_Fat_Append

Prototype procedure Mmc Fat Append();

Description | Opens the currently assigned file for appending. Upon this function execution file pointers will be
positioned after the last byte in the file, so any subsequent file write operation will start from there.

Parameters | None.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example // open file for appending

Mmc Fat Append() ;

Notes

None.

Mmc_Fat_Delete

Prototype |procedure Mmc Fat Delete();

Description | Deletes currently assigned file from MMC/SD card.

Parameters | None.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example // delete current file
Mmc Fat Delete();

Notes None.
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Mmc_Fat_Write

Prototype procedure Mmc Fat Write(var fdata: array[512] of byte; data len: word);
Description | Writes requested number of bytes to the currently assigned file opened for writing.
Parameters | - fdata: data to be written.

- data len: number of bytes to be written.
Returns Nothing.
Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.

The file must be previously assigned. See Mmc_Fat_Assign.

The file must be opened for writing. See Mmc_Fat_Rewrite or Mmc_Fat_Append.
Example var file contents : array[42] of byte;

Mmc Fat Write (file contents, 42); // write data to the assigned file
Notes None.

Mmc_Fat_Set_File_Date

Prototype procedure Mmc Fat Set File Date(year: word; month: byte; day: byte; hours:
byte; mins: byte; seconds: byte);

Description | Sets the date/time stamp. Any subsequent file write operation will write this stamp to the currently
assigned file’s time/date attributes.

Parameters | - year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12
- day: day attribute. Valid values: 1-31
- hours: hours attribute. Valid values: 0-23
- mins: minutes attribute. Valid values: 0-59
- seconds: seconds attribute. Valid values: 0-59

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for writing. See Mmc_Fat_Rewrite or Mmc_Fat_Append.

Example // April 1st 2005, 18:07:00
Mmc Fat Set File Date (2005, 4, 1, 18, 7, 0);

Notes None.
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Mmc_Fat_Get File Date

Prototype procedure Mmc_Fat_Get_File_Date (var year: word; wvar month: byte; war day:
byte; war hours: byte; wvar mins: byte);

Description | Reads time/date attributes of the currently assigned file.

Parameters | - year: buffer to store year attribute to. Upon function execution year attribute is returned through this
parameter.
- month: buffer to store month attribute to. Upon function execution month attribute is returned through
this parameter.
- day: buffer to store day attribute to. Upon function execution day attribute is returned through this
parameter.
- hours: buffer to store hours attribute to. Upon function execution hours attribute is returned through
this parameter.
- mins: buffer to store minutes attribute to. Upon function execution minutes attribute is returned
through this parameter.

Returns Nothing.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example var year : word;

month, day, hours, mins : byte;,

Mmc Fat Get File Date(year, month, day, hours, mins);

Notes None.
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Mmc_Fat_Get_File_Date Modified

Prototype procedure Mmc Fat Get File Date Modified(var year: word; var month: byte;
var day: byte; var hours: byte; var mins: byte);

Description | Retrieves the last modification date/time for the currently selected file. Seconds are not being retrieved
since they are written in 2-sec increments.

Parameters | - year: buffer to store year attribute to. Upon function execution year attribute is returned through this
parameter.
- month: buffer to store month attribute to. Upon function execution month attribute is returned through
this parameter.
- day: buffer to store day attribute to. Upon function execution day attribute is returned through this
parameter.
- hours: buffer to store hours attribute to. Upon function execution hours attribute is returned through
this parameter.
- mins: buffer to store minutes attribute to. Upon function execution minutes attribute is returned
through this parameter.

Returns Nothing.

Requires The file must be assigned, see Mmc_Fat_Assign.

Example var year : word;

month, day, hours, mins : byte;

Mmc Fat Get File Date Modified(year, month, day, hours, mins);

Mmc_Fat Get_File_Size

Prototype function Mmc Fat Get File Size(): dword;

Description | This function reads size of the currently assigned file in bytes.

Parameters | None.

Returns This function returns size of active file (in bytes).

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
The file must be previously assigned. See Mmc_Fat_Assign.

Example var my file size : dword;
I%ly;ﬁleisize := Mmc_Fat Get File Size();

Notes None.
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Mmc_Fat _Get Swap_ File

Prototype function Mmc Fat Get Swap File(sectors cnt: dword; var filename : string[1l1l];
file attr : byte) : dword;

Description | This function is used to create a swap file of predefined name and size on the MMC/SD media. If a
file with specified name already exists on the media, search for consecutive sectors will ignore sectors
occupied by this file. Therefore, it is recommended to erase such file if it already exists before calling
this function. If it is not erased and there is still enough space for a new swap file, this function will
delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to MMC/SD media as fast as possible,
by using the Mmc_Read_Sector() and Mmc_Write_Sector() functions directly, without potentially
damaging the FAT system. The swap file can be considered as a “window” on the media where the
user can freely write/read data. It's main purpose in this library is to be used for fast data acquisition;
when the time-critical acquisition has finished, the data can be re-written into a “normal” file, and
formatted in the most suitable way.

Parameters | - sectors cnt: number of consecutive sectors that user wants the swap file to have.

- filename: name of the file that should be assigned for file operations. File name should be in DOS 8.3
(file_name.extension) format. The file name and extension will be automatically padded with spaces
by the library if they have less than length required (i.e. “mikro.tx” -> “mikro .tx “), so the user does no
have to take care of that. The file name and extension are case insensitive. The library will convert
them to proper case automatically, so the user does not have to take care of that.

Also, in order to keep backward compatibility with the first version of this library, file names can be
entered as UPPERCASE string of 11 bytes in length with no dot character between file name and
extension (i.e. “MIKROELETXT” -> MIKROELE.TXT). In this case last 3 characters of the string are
considered to be file extension.

-file attr: file creation and attributes flags. Each bit corresponds to the appropriate file attribute:

Bit | Mask Description
0 0x01 Read Only
1 0x02 Hidden
2 0x04 System
3 0x08 Volume Label
4 0x10 Subdirectory
5 0x20 Archive
6 0x40 Device (internal use only, never found on disk)
7 0x80 Not used
Returns - Number of the start sector for the newly created swap file, if there was enough free space on the

MMC/SD card to create file of required size.
- 0 - otherwise.

Requires MMC/SD card and MMC library must be initialized for file operations. See Mmc_Fat_|Init.
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Example S ———————— Try to create a swap file with archive atribute, whose size
will be at least 1000 sectors.

// If it succeeds, it sends No. of start sector over UART

var size : dword;

size := Mmc Fat Get Swap File (1000, 'mikroE.txt’, 0x20);
if (size <> 0) then
begin
UARTliPVri te (0xAA) ;
UART1 Write (Lo (size));
UARTI Write (Hi(size));
UART1 Write (Higher (size));
UART1 Write (Highest (size));
UARTI Write (OxAA);
end;,

Notes Long File Names (LFN) are not supported.

Library Example
This project consists of several blocks that demonstrate various aspects of usage of the Mmc_Fat16 library. These are:

- Creation of new file and writing down to it;

- Opening existing file and re-writing it (writing from start-of-file);

- Opening existing file and appending data to it (writing from end-of-file);
- Opening a file and reading data from it (sending it to UART terminal);

- Creating and modifying several files at once;

- Reading file contents;

- Deleting file(s);

- Creating the swap file (see Help for details);

Copy Code To Clipboard
program MMC FAT Test;
// MMC module connections
var MMC chip select : sbit at LATGY bit; // for writing to output pin always use latch
var MMC chip select direction : sbit at TRISGY bit;
// eof MMC module connections
const LINE LEN = 43;
var
err txt : string[20];
file contents : string[LINE LEN];
filename : string[14]; // File names
character : byte;
loop, loop2 : byte;

size : longint;

buffer : array[512] of byte;
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// UART write text and new line (carriage return + line feed)
procedure UART Write Line( var uart text : string);
begin
UART1 Write Text (uart text);
UART1 Write(13);
UART1 Write(10);

end;
/) ==mmm———————— Creates new file and writes some data to it
procedure M Create New File();
begin
filename[7] := ‘A’; // Set filename for single-file tests
Mmc Fat Set File Date(2011,1,12,11,9,0); // Set file date & time info
Mmc_ Fat Assign(filename, O0xAO); // Will not find file and then create file
Mmc Fat Rewrite; // To clear file and start with new data
for loop:=1 to 99 do // We want 5 files on the MMC card
begin
UART1 Write('.’);
file contents[0] := loop div 10 + 48;
file contents[1] := loop mod 10 + 48;
Mmc Fat Write (file contents, LINE LEN-1); // write data to the assigned file
end;
end;
[/ == ——————— Creates many new files and writes data to them
procedure M Create Multiple Files();
begin
for loop2 := ‘B’ to ‘'Z’ do
begin
UART1 Write (loop2); // signal the progress
filename [7] := loop2; // set filename
Mmc Fat Set File Date(2011,1,12,11,9,0); // Set file date & time info
Mmc Fat Assign (filename, O0xA0); // find existing file or create a new one
Mmc Fat Rewrite; // To clear file and start with new data
for loop := 1 to 44 do
begin
file contents[0] := byte(loop div 10 + 48);
file contents[1] := byte(loop mod 10 + 48);
Mmc_Fat Write (file contents, LINE LEN-1); // write data to the assigned file
end;
end;
end;
/)= ——— Opens an existing file and rewrites it
procedure M Open File Rewrite();
begin
filename[7] := ‘C’; // Set filename for single-file tests

Mmc Fat Assign (filename, 0);
Mmc Fat Rewrite;

for loop := 1 to 55 do
begin
file contents[0] := byte(loop div 10 + 48);
file contents[1] := byte(loop mod 10 + 48);
Mmc_Fat Write (file_contents, 42); // write data to the assigned file
end;
end;
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[/ =mmmm e Opens an existing file and appends data to it
// (and alters the date/time stamp)

procedure M Open File Append();

begin

filename[7] := ‘B’;

Mmc Fat Assign (filename, 0);
Mmc Fat Set File Date (2009, 1,
Mmc Fat Append();
file contents := ‘'
file contents[26] := 10;
Mmc_ Fat Write (file contents,

end;

23,

27

Opens an existing file,
procedure M Open File Read();
begin
filename[7] := ‘B’;
Mmc Fat Assign (filename,
Mmc Fat Reset (size);
while size > 0 do
begin
Mmc Fat Read (character);
UART1 Write (character);
Dec (size);

0);

end;
end;
[/ =mmm————————— Deletes a file.
// and then deleted.

procedure M Delete File();
begin
filename [7] := ‘F’;
Mmc Fat Assign (filename,
Mmc Fat Delete;

0);

17,

for mikroElektronika 20097 ;

If file doesn’t exist,

22, 0);

// Prepare file for append
// Prepare file for append
// LF

// Write data to assigned file

reads data from it and puts it to USART

// To read file, procedure returns size of file

// Write data to UART

it will first be created

and if so sends its creation date

end;
/) ———————————— Tests whether file exists,
// and file size via USART
procedure M Test File Exist;
var

fsize: longint;

year: word;

month, day, hour, minute: byte;

outstr: array[l2] of char;

begin
filename [7] := ‘B’;
if Mmc_ Fat Assign (filename,
begin

0) <> 0 then

//--- file has been found - get its date
Mmc Fat Get File Date (year,month,day,hour,minute);

UART1 Write Text (' created:
WordToStr (year, outstr);
UART1 Write Text (outstr);
ByteToStr (month, outstr);
UART1 Write Text (outstr)
WordToStr (day, outstr);

Y)

’
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UART1 Write Text (outstr);
WordToStr (hour, outstr);

UART1 Write Text (outstr);
WordToStr (minute, outstr);
UART1 Write Text (outstr);

//-=-= file has been found - get its modified date

Mmc Fat Get File Date Modified(year, month, day, hour, minute);
UART1 Write Text (' modified: Y);

WordToStr (year, outstr);

UART1 Write Text (outstr);

ByteToStr (month, outstr);

UART1 Write Text (outstr)
WordToStr (day, outstr);
UART1 Write Text (outstr);
WordToStr (hour, outstr);
UART1 Write Text (outstr);
WordToStr (minute, outstr);
UART1 Write Text (outstr);

’

//--- get file size
fsize := Mmc Fat Get File Size;
LongWordToStr (longint (fsize), outstr);
UART Write Line (outstr);

end

else

begin
//--- file was not found - signal it
UART1 Write (0x55);
Delay ms (1000);
UART1 Write (0x55);

end;
end;
[/ == ——————— Tries to create a swap file, whose size will be at least 100
// sectors (see Help for details)
procedure M Create Swap File();
var 1 : word;
begin
for i:=0 to 511 do
Buffer[i] := 1i;
size := Mmc Fat Get Swap File (5000, ‘mikroE.txt’, 0x20); // see help on this

function for details

if (size <> 0) then
begin
LongIntToStr (size, err txt);
UART Write Line(err txt);

for i:=0 to 4999 do

begin
Mmc Write Sector(size, Buffer);
Inc(size);
UART1 Write('‘.’);

end;

end;
end;
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S/ ————— Main. Uncomment the function(s) to test the desired operation(s)
begin

{$DEFINE COMPLETE EXAMPLE} // comment this line to get smaller example

err txt := 'FAT16 not found’;

file contents := ‘XX MMC/SD FAT16 library by Anton Rieckert#’;

file contents([41] := 10; // newline

filename := ‘MIKROOOXTXT’ ;

CHECON := 0x32;

ADIPCFG := OxFFFF; // initialize AN pins as digital

// Initialize UARTI1 module
UARTI Init(56000);
Delay ms(10);

UART Write Line('MCU-Started’); // MCU present report

//--—- set up SPI for the file read

SPI2 Init Advanced( SPI _MASTER, _SPI 8 BIT, 64, _SPI SS DISABLE, _SPI DATA SAMPLE
MIDDLE, SPI CLK IDLE HIGH, _SPI ACTIVE 2 IDLE);

Delay ms (10);

// use fatlé6 quick format instead of init routine if a formatting 1is needed
if Mmc Fat Init() = 0 then
begin
// reinitialize spi at higher speed
SPI2 Init Advanced( SPI_MASTER, SPI 8 BIT, 8, SPI SS DISABLE, _SPI DATA SAMPLE
MIDDLE, _SPI CLK IDLE HIGH, _SPI _ACTIVE 2 IDLE) ;

//--- Test start
UART Write Line('Test Start.’);
//-—-— Test routines. Uncomment them one-by-one to test certain features

M Create New File();

{$IFDEF COMPLETE EXAMPLE}
M Create New File();

M Create Multiple Files();
M Open File Rewrite();

M Open File Append();

M Open File Read();

M Delete File();

M Test File Exist();

M Create Swap File();

{ SENDIF}

UART Write Line('‘'Test End.’);
end
else
begin
UART Write Line(err txt); // Note: Mmc Fat Init tries to initialize a card more
than once.
// If card is not present, initialization may last
longer (depending on clock speed)
end;
end.
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HW Connection

SPLMISD.
MMC-CE¥

SPLMOSI

SPISCK
e
N y Ri3 | [Ri5 [ [RIT
2Kz | [zKz | |2K2

1
cs =
sl z
GND o2
[+33V 3
SCH
MMC/SD ==

T
CARD Lo A4 | 16 | |R12
ELeY 3K w3

Pin diagram of MMC memory card

OneWire Library

The OneWire library provides routines for communication via the Dallas OneWire protocol, for example with DS18x20
digital thermometer. OneWire is a Master/Slave protocol, and all communication cabling required is a single wire.
OneWire enabled devices should have open collector drivers (with single pull-up resistor) on the shared data line.

Slave devices on the OneWire bus can even get their power supply from data line. For detailed schematic see device
datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device also has a unique 64-bit registration number (8-bit device type, 48-bit serial number and 8-bit
CRC), so multiple slaves can co-exist on the same bus.

Important :

- Oscillator frequency Fosc needs to be at least 4MHz in order to use the routines with Dallas digital thermometers.
- This library implements time-based activities, so interrupts need to be disabled when using OneWire library.

Library Routines

- Ow_Reset
- Ow_Read
- Ow_Write
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Ow_Reset
Prototype function Ow Reset (var port: word; pin: word): word;
Description | Issues OneWire reset signal for DS18x20.
Parameters | - port: OneWire bus port
- pin: OneWire bus pin
Returns - 0 if the device is present
- 1 if the device is not present
Requires Devices compliant with the Dallas OneWire protocol.
Example // Issue Reset signal on One-Wire Bus connected to pin RF6
Ow_ Reset (&PORTEF, 6) ;
Notes None.
Ow_Read
Prototype function Ow Read(var port : word; pin : word): byte;
Description | Reads one byte of data via the OneWire bus.
Parameters | - port: OneWire bus port
- pin: OneWire bus pin
Returns Data read from an external device over the OneWire bus.
Requires Devices compliant with the Dallas OneWire protocol.
Example // Read a byte from the One-Wire Bus connected to pin RF6
var read data : byte;
.réédidata := Ow_Read (PORTF, 6);
Notes None.
Ow_Write
Prototype procedure Ow Write(var port: word; pin, data : byte);
Description | Writes one byte of data via the OneWire bus.
Parameters | - port: OneWire bus port
- pin: OneWire bus pin
- data :data to be written
Returns Nothing.
Requires Devices compliant with the Dallas OneWire protocol.
Example // Send a byte to the One-Wire Bus connected to pin RF6
Ow Write (&PORTF, 6, OxCC);
Notes None.
MikroElektronika
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Port Expander Library

mikroPascal PRO for PIC32 provides a library for communication with the Microchip’s Port Expander MCP23S17 via
SPI interface. Connections of the PIC32 MCU and MCP23S17 is given on the schematic at the bottom of this page.

Important:

- The library uses the SPI module for communication. User must initialize the appropriate SPI module before using

the Port Expander Library.

- For MCUs with multiple SPI modules it is possible to initialize all of them and then switch by using the sPT set
Active () function. See the SPI Library functions.
- Library does not use Port Expander interrupts.

Library Dependency Tree
[ Port Expander  —{ sP1 )

External dependencies of Port

Expander Library

The following variables must be defined

sbit; sfr; external;

in all projects using Port Expander | Description: Example:

Library:

var SPExpanderRST : sbit; sfr; . var SPExpanderRST : sbit at LATFO
Reset line. . -

external; bit;

var SPExpanderCS : sbit; sfr; . . var SPExpanderCS : sbit at LATF1
Chip Select line. . -

external; bit;

var SPExpanderRST Direction var SPExpanderRST Direction : sbit

Direction of the Reset pin.

at TRISFO bit;

var  SPExpanderCS Direction
sbit; sfr; external;

Direction of the Chip Select pin.

var SPExpanderCS Direction : sbit at
TRISF1 bit;

Library Routines

- Expander_Init

- Expander_Init_Advanced

- Expander_Read_Byte

- Expander_Write_Byte

- Expander_Read_PortA

- Expander_Read_PortB

- Expander_Read_PortAB

- Expander_Write_PortA

- Expander_Write_PortB

- Expander_Write_PortAB

- Expander_Set_DirectionPortA
- Expander_Set_DirectionPortB

- Expander_Set_DirectionPortAB

- Expander_Set_PullUpsPortA
- Expander_Set_PullUpsPortB

- Expander_Set_PullUpsPortAB
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Expander_Init

Prototype procedure Expander Init (ModuleAddress : byte);

Description | Initializes Port Expander using SPI communication.
Port Expander module settings:

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
- BANK_O register adressing

- slew rate enabled

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page

Returns Nothing.

Requires Global variables:

- SPExpanderCsS: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCS Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPIx_Init and SPIx_Init_Advanced routines.

Example // Port Expander module connections
var SPExpanderRST : sbit at LATF0 bit;
SPExpanderCS : sbit at LATF1 bit;
SPExpanderRST Direction : sbit at TRISFO bit;

SPExpanderCS Direction : sbit at TRISFI1 bit;
// End of Port Expander module connections

// If Port Expander Library uses SPI module

SPI1 Init(); // Initialize SPI module used with PortExpander
Expander Init(0); // Initialize Port Expander
Notes None.
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Expander_Init_Advanced

Prototype procedure Expander Init Advanced(var rstPort : byte; rstPin : byte; haen
byte);

Description | Initializes Port Expander using SPI communication.

Parameters | - rstPort: Port Expander’s reset port
- rstPin: Port Expander’s reset pin
- haen: Port Expander’s hardware address

Returns Nothing.

Requires - SPExpanderCs: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPIx_Init and SPIx_Init_Advanced routines.

Example // Port Expander module connections

sbit SPExpanderRST at RFO bit;

sbit SPExpanderCS at RF1 bit;

sbit SPExpanderRST Direction at TRISFO bit;
sbit SPExpanderCS Direction at TRISF1 bit;
// End Port Expander module connections

// If Port Expander Library uses SPI module

SPI1 Init(); // Initialize SPI1 module used with PortExpander
Expander Init Advanced (&PORTB, 0, 0); // Initialize Port Expander
Notes None.
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Expander_Read_Byte

Prototype function Expander Read Byte (ModuleAddress, RegAddress : byte) : byte;
Description | The function reads byte from Port Expander.
Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- RegAddress: Port Expander’s internal register address
Returns Byte read.
Requires Port Expander must be initialized. See Expander_|nit.
Example // Read a byte from Port Expander’s register
var read data : byte;
.ré(.adidata := Expander Read Byte(0,1);
Notes None.

Expander_Write Byte

Prototype procedure Expander Write Byte (ModuleAddress, RegAddress, Data : byte);
Description | Routine writes a byte to Port Expander.
Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- RegAddress: Port Expander’s internal register address
- Data: data to be written
Returns Byte read.
Requires Port Expander must be initialized. See Expander_|nit.
Example // Write a byte to the Port Expander’s register
Expander Write Byte (0,1, 0xFF);
Notes None.

Expander_Read PortA

Prototype function Expander Read PortA (ModuleAddress : byte) : byte;

Description | The function reads byte from Port Expander’s PortA.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page

Returns Byte read.

Requires Port Expander must be initialized. See Expander_|nit.
Port Expander’s PortA should be configured as input. See Expander_Set_DirectionPortA and
Expander_Set_DirectionPortAB routines.

Example // Read a byte from Port Expander’s PORTA
var read data : byte;
Expander Set DirectionPortA(0,$FF); // set expander’s porta to be input
read data := Expander Read PortA(0);

Notes None.
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Expander_Read PortB

Prototype function Expander Read PortB(ModuleAddress : byte) : byte;
Description | The function reads byte from Port Expander’s PortB.
Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
Returns Byte read.
Requires Port Expander must be initialized. See Expander_|Init.
Port Expander’'s PortB should be configured as input. See Expander_Set DirectionPortB and
Expander_Set_DirectionPortAB routines.
Example // Read a byte from Port Expander’s PORTB
var read data : byte;
Expander Set DirectionPortB(0,$FF); // set expander’s portb to be
input
read data := Expander Read PortB(0);
Notes None.

Expander_Read PortAB

Prototype function Expander Read PortAB (ModuleAddress : byte) : word;
Description | The function reads word from Port Expander’s ports. PortA readings are in the higher byte of the resuilt.
PortB readings are in the lower byte of the result.
Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
Returns Word read.
Requires Port Expander must be initialized. See Expander_Init.
Port Expander’s PortA and PortB should be configured as inputs. See Expander_Set_DirectionPortA,
Expander_Set_DirectionPortB and Expander_Set_DirectionPortAB routines.
Example // Read a byte from Port Expander’s PORTA and PORTB
var read data : word;
Expander Set DirectionPortAB(0,S$FFFF); // set expander’s porta and portb
to be input
read data := Expander Read PortAB(0);
Notes None.
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Expander_Write PortA

Prototype procedure Expander Write PortA (ModuleAddress, Data : byte);

Description | The function writes byte to Port Expander’s PortA.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data to be written

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|nit.
Port Expander’s PortA should be configured as output. See Expander_Set DirectionPortA and
Expander_Set_DirectionPortAB routines.

Example // Write a byte to Port Expander’s PORTA
Expander Set DirectionPortA(0,$00); // set expander’s porta to be
output
J.E;q.oanderiv\]ri te PortA(0, $AA);

Notes None.

Expander_Write_PortB

Prototype procedure Expander Write PortB(ModuleAddress, Data : byte);

Description | The function writes byte to Port Expander’s PortB.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data to be written

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|nit.
Port Expander’s PortB should be configured as output. See Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

Example // Write a byte to Port Expander’s PORTB
é;f];)ander_Set_DirectionPortB (0,500) ; // set expander’s portb to be output
Expander Write PortB(0,$55);

Notes None.
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Expander_Write_PortAB

Prototype procedure Expander Write PortAB (ModuleAddress : byte; Data : word);

Description | The function writes word to Port Expander’s ports.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data to be written. Data to be written to PortA are passed in Data’s higher byte. Data to be
written to PortB are passed in Data’s lower byte

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|Init.

Port Expander’s PortA and PortB should be configured as outputs. See Expander_Set_DirectionPortA,
Expander_Set_DirectionPortB and Expander_Set_DirectionPortAB routines.

Example // Write a byte to Port Expander’s PORTA and PORTB
Expander Set DirectionPortAB(0, $0000) ; // set expander’s porta and portb
to be output
Expander Write PortAB(0, $AA55);

Notes None.

Expander_Set_DirectionPortA

Prototype |procedure Expander Set DirectionPortA(ModuleAddress, Data : byte);

Description | The function sets Port Expander’s PortA direction.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data to be written to the PortA direction register. Each bit corresponds to the appropriate pin of
the PortAregister. Set bit designates corresponding pin as input. Cleared bit designates corresponding
pin as output.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|nit.

Example // Set Port Expander’s PORTA to be output
Expander Set DirectionPortA(0, S00) ;

Notes None.
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Expander_Set DirectionPortB

Prototype procedure Expander Set DirectionPortB (ModuleAddress, Data : byte);

Description | The function sets Port Expander’s PortB direction.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data to be written to the PortB direction register. Each bit corresponds to the appropriate pin of
the PortB register. Set bit designates corresponding pin as input. Cleared bit designates corresponding
pin as output.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|Init.

Example // Set Port Expander’s PORTB to be input
Expander Set DirectionPortB(0,$FF);

Notes None.

Expander_Set_DirectionPortAB

Prototype procedure Expander Set DirectionPortAB (ModuleAddress, Direction : word);

Description | The function sets Port Expander’s PortA and PortB direction.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Direction: data to be written to direction registers. Data to be written to the PortA direction register
are passed in Direction’s higher byte. Data to be written to the PortB direction register are passed
in Direction’s lower byte. Each bit corresponds to the appropriate pin of the PortA/PortB register.
Set bit designates corresponding pin as input. Cleared bit designates corresponding pin as output.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_Init.

Example // Set Port Expander’s PORTA to be output and PORTB to be input
Expander Set DirectionPortAB(0,$00FF) ;

Notes None.

Expander_Set PullUpsPortA

Prototype procedure Expander Set PullUpsPortA (ModuleAddress, Data : byte);

Description | The function sets Port Expander’s PortA pull up/down resistors.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data for choosing pull up/down resistors configuration. Each bit corresponds to the appropriate
pin of the PortA register. Set bit enables pull-up for corresponding pin.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|Init.

Example // Set Port Expander’s PORTA pull-up resistors
Expander Set PullUpsPortA(0, $FF);

Notes None.
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Expander_Set PullUpsPortB

Prototype procedure Expander Set PullUpsPortB (ModuleAddress, Data : byte);

Description | The function sets Port Expander’s PortB pull up/down resistors.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- Data: data for choosing pull up/down resistors configuration. Each bit corresponds to the appropriate
pin of the PortB register. Set bit enables pull-up for corresponding pin.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|Init.

Example // Set Port Expander’s PORTB pull-up resistors
Expander Set PullUpsPortB (0, OxFF);

Notes None.

Expander_Set PullUpsPortAB

Prototype procedure Expander Set PullUpsPortB (ModuleAddress, Data : byte);

Description | The function sets Port Expander’s PortA and PortB pull up/down resistors.

Parameters | - ModuleAddress: Port Expander hardware address, see schematic at the bottom of this page
- PullUps: data for choosing pull up/down resistors configuration. PortA pull up/down resistors
configuration is passed in Pul 1Ups’s higher byte. PortB pull up/down resistors configuration is passed
in PullUps’s lower byte. Each bit corresponds to the appropriate pin of the PortA/PortB register. Set
bit enables pull-up for corresponding pin.

Returns Nothing.

Requires Port Expander must be initialized. See Expander_|Init.

Example // Set Port Expander’s PORTB pull-up resistors
Expander Set PullUpsPortB (0, OXFF);

Notes None.
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Library Example

The example demonstrates how to communicate with Port Expander MCP23S17. Note that Port Expander pins A2 A1
AOQ are connected to GND so Port Expander Hardware Address is 0.

Copy Code To Clipboard
program PortExpander;

// Port Expander module connections
var SPExpanderRST : sbit at LATFO bit;

SPExpanderCS : sbit at LATFI bit;
SPExpanderRST Direction : sbit at TRISFO bit;
SPExpanderCS Direction : sbit at TRISFI1 bit;

// End Port Expander module connections

var counter : word;

begin
counter := 0;
CHECON := 0x32;
ADIPCFG := OxFFFEF; // Configure AN pins as digital
TRISB := 0x00;,
LATB := OxFF;

// If Port Expander Library uses SPI1 module
SPI2 Tnit Advanced( SPI_MASTER, SPI 8 BIT, 4, _SPI SS DISABLE, SPI DATA SAMPLE
MIDDLE, SPI_CLK IDLE LOW, SPI ACTIVE 2 IDLE);
Expander Init(0); // Initialize Port Expander

Expander Set DirectionPortA(0, 0x00); // Set Expander’s PORTA to be output

Expander Set DirectionPortB(0,0xFF); // Set Expander’s PORTB to be input

Expander Set PullUpsPortB(0,0xFF); // Set pull-ups to all of the Expander’s PORTB
pins
while ( TRUE ) do // Endless loop
begin

Expander Write PortA(0, counter); // Write 1 to expander’s PORTA
Inc (counter) ;

PORTB := Expander Read PortB(0); // Read expander’s PORTB and write it to LEDs
Delay ms(75);
end;

end.
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HW Connection
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PS/2 Library

The mikroPascal PRO for PIC32 provides a library for communication with the common PS/2 keyboard.

Important:

- The library does not utilize interrupts for data retrieval, and requires the oscillator clock to be at least 6MHz.
- The pins to which a PS/2 keyboard is attached should be connected to the pull-up resistors.

- Although PS/2 is a two-way communication bus, this library does not provide MCU-to-keyboard communication; e.g.
pressing the Caps Lock key will not turn on the Caps Lock LED.

External dependencies of PS/2 Library

The following variables must be defined
in all projects using PS/2 Library:

Description:

Example:

ar PS2 Dat sbit; sfr; . . .

v e Hata * PS/2 Data line. var PS2 Data : sbit at RBO bit;
external; - -

ar PS2 Clock sbit; sfr; . . .

v —-roc * PS/2 Clock line. var PS2 Clock : sbit at RB1 bit;
external; - —

var PS2 Data Direction sbit; . . . var PS2 Data Direction sbit at
sfr; external; Direction of the PS/2 Data pin. TRISBO bit;

var PS2 Clock Direction sbit; - . var PS2 Clock Direction sbit at
sfr; external; Direction of the PS/2 Clock pin. TRISB1 bit;

Library Routines

- Ps2_Config
- Ps2_Key_Read
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Ps2_Config

Prototype

procedure Ps2 Config () ;

Description

Initializes the MCU for work with the PS/2 keyboard.

Parameters

None.

Returns

Nothing.

Requires

Global variables:

- PS2 Data: Data signal line

- PS2 Clock: Clock signal line

-PS2 Data Direction: Direction of the Data pin

-PS2 Clock Direction: Direction of the Clock pin

must be defined before using this function.

Example // PS2 pinout definition

var PS2 Data : sbit at RBO bit;

var PS2 Clock : sbit at RBI1 bit;

var PS2 Data Direction : sbit at TRISBO bit;

var PS2 Clock Direction : sbit at TRISBI bit;

// End of PS2 pinout definition// Init PS/2 Keyboard
Notes None.

Ps2 Key Read

Prototype function Ps2 Key Read(var value byte; wvar special byte; var pressed
byte) : word;

Description | The function retrieves information on key pressed.

Parameters | - value: holds the value of the key pressed. For characters, numerals, punctuation marks, and space
value will store the appropriate ASCII code. Routine “recognizes” the function of Shift and Caps Lock,
and behaves appropriately. For special function keys see Special Function Keys Table.

- special: is a flag for special function keys (F1, Enter, Esc, etc). If key pressed is one of these,
special will be set to 1, otherwise 0.
- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Returns - 1 if reading of a key from the keyboard was successful
- 0 if no key was pressed

Requires PS/2 keyboard needs to be initialized. See Ps2_Config routine.

Example var value, special, pressed : word;

// Press Enter to continue:
repeat {
if (Ps2 Key Read(value, special, pressed)) then
if ((value = 13) and (special = 1)) then break;
until (0=1);
Notes None.
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Special Function Keys

Key Value returned
F1 1
F2 2
F3 3
F4 4
F5 5
F6 6
F7 7
F8 8
F9 9
F10 10
F11 1
F12 12
Enter 13
Page Up 14
Page Down 15
Backspace 16
Insert 17
Delete 18
Windows 19
Ctrl 20
Shift 21
Alt 22
Print Screen 23
Pause 24
Caps Lock 25
End 26
Home 27
Scroll Lock 28
Num Lock 29
Left Arrow 30
Right Arrow 31
Up Arrow 32
Down Arrow 33
Escape 34
Tab 35
MikroElektronika
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and sends them via UART.
Copy Code To Clipboard

program PS2 Example;

var keydata, special, down : byte;

var PS2 Data : sbit at RDO bit;
PS2 Clock : sbit at RD1 bit;
PS2 Data Direction : sbit at TRISDO bit;

PS2 Clock Direction : sbit at TRISD1 bit;

begin
CHECON := 0x32;
AD1PCFG := OxFFFF; // Configure AN pins as digital I/O
UART1 Init(56000); // Initialize UART module at 19200 bps
Ps2 Config () ; // Init PS/2 Keyboard
Delay ms (100); // Wait for keyboard to finish
UART1 Write Text(‘Ready’); // Ready
UART1 Write(13); // Line Feed
UART1 Write(10); // Carriage return
while TRUE do // Endless loop
begin
if Ps2 Key Read(keydata, special, down) then // If data was read from PS/2
begin
if (down <> 0) and (keydata = 16) then // Backspace
begin
UART1 Write (0x08); // Send Backspace to usart terminal
end
else if (down <> 0) and (keydata = 13) then // Enter
begin
UART1 Write(10); // Send carriage return to usart terminal
UART1 Write(13); // Uncomment this line if usart terminal

also expects line feed
// for new line transition

end
else if (down <> 0) and (special = 0) and (keydata <> 0) then // Common key

read

begin

UART1 Write (keydata); // Send key to usart terminal
end;
end;
Delay ms (1) ; // Debounce period
end;

end.

361 MikroElektronika



mikoPascal PRO for PIC32

HW Connection
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Example of PS2 keyboard connection

PWM Library

The CCP module is available with a number of PIC32 MCUs. mikroPascal PRO for PIC32 provides a library which
simplifies using of the PWM HW Module.

Important : PWM module uses either Timer2 or Timer3 module.

Library Routines

- PWM_Init

- PWM_Init_Advanced
- PWM_Set_Duty

- PWM_Start

- PWM_Stop
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PWM_ Init

Prototype function PWM Init (freq hz dword; enable channel x, timer prescale, use_
timer_x : word) : word;

Description | Initializes the PWM module with duty ratio O.

Parameters | - freq hz: PWM frequency in Hz (refer to device datasheet for correct values in respect with Fosc)
- enable channel x: number of PWM channel to be initialized. Refer to MCU’s datasheet for
available PWM channels
- timer prescale:timer prescaler parameter. Valid values: 1, 8, ¢4, and 256
-use timer x:timerto be used with the PWM module. Valid values: 2 (Timer2) and 3 (Timer3)

Returns - OxFFFF - if timer settings are not valid
- otherwise returns calculated timer period

Requires MCU must have the HW PWM Module.

Example // Initializes the PWM module at 5KHz, channel 1, no clock prescale, timer2
var pwm periodl : word;
pwm periodl := PWM Init (5000, 1, 0, 2);

Notes Number of available PWM channels depends on MCU. Refer to MCU datasheet for details.

PWM_Init_Advanced

Prototype function PWM Init Advanced(freq hz, Fpb kHz dword; enable channel x,
timer prescale, use timer x : word) : word;
Description | Initializes the PWM module with duty ratio 0.
Parameters | - freq hz: PWM frequency in Hz
- Fpb kHz: Peripheral Bus Clock frequency in kHz.
- enable channel x: number of PWM channel to be initialized. Refer to MCU’s datasheet for
available PWM channels
- timer prescale: timer prescaler parameter. Valid values: 1, 8, 64, and 256
use_timer_x: timer to be used with the PWM module. Valid values: 2 (Timer2) and 3 (Timer3)
Returns - OxFEFF - if timer settings are not valid
- otherwise returns calculated timer period
Requires MCU must have the HW PWM Module.
Example
Notes Number of available PWM channels depends on MCU. Refer to MCU datasheet for details.
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PWM_Set Duty

Prototype procedure PWM Set Duty(duty, channel : word);
Description | The function changes PWM duty ratio.
Parameters | - duty: PWM duty ratio. Valid values: 0 to timer period returned by the PWM_Init function.
- channel: number of PWM channel to change duty to.
Returns Nothing.
Requires MCU must have the HW PWM Module.
PWM channel must be properly initialized. See PWM_Init routine.
Example // Set channel 1 duty ratio to 50%:
var pwm periodl : word;
l‘DV'\/Z;QSetiDuty (pwm periodl div 2, 1);
Notes Number of available PWM channels depends on MCU. Refer to MCU datasheet for details.
PWM _Start
Prototype procedure PWM Start (enable channel x : byte);
Description | Starts PWM at requested channel.
Parameters | - enable channel x:number of PWM channel
Returns Nothing.
Requires MCU must have the HW PWM Module.
PWM channel must be properly configured. See the PWM_lInit and PWM_Set_Duty routines.
Example // start PWM at channel 1
PWM Start(l);
Notes Number of available PWM channels depends on MCU. Refer to MCU datasheet for details.
PWM_Stop
Prototype procedure PWM Stop(disable channel x : byte);
Description | Stops PWM at requested channel.
Parameters | - disable channel x:number of PWM channel
Returns Nothing.
Requires MCU must have the HW PWM Module.
Example // stop PWM at channel 1
PWM Stop(1);
Notes Number of available PWM channels depends on MCU. Refer to MCU datasheet for details.
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Library Example

The example changes PWM duty ratio on channels 1 and 2 continuously. If LEDs are connected to channels 1 and 2,
a gradual change of emitted light will be noticeable.

Copy Code To Clipboard
program Pwm Demo;
var current duty, old duty, current dutyl, old dutyl : word;

pwm periodl, pwm period2 : word;

procedure InitMain();

begin
CHECON := 0x32;
AD1PCFG := OxFFFF; // configure pins as digital I/O
TRISB := OxFFFE; // configure PORTB pins as input
PORTD := 0; // set PORTD to 0
TRISD := O; // designate PORTD pins as output
end;
begin
InitMain () ;
current duty := 100; // initial value for current duty
current dutyl := 100; // initial value for current dutyl
pwm periodl := PWM Init (5000 , 1, 1, 2);
pwm period2 := PWM Init (10000, 2, 1, 3);

PWM Start (1) ;
PWM Start (2);

PWM Set Duty(current duty, 1); // Set current duty for PWM1
PWM Set Duty(current dutyl, 2); // Set current duty for PWM2
while (TRUE) do // endless loop
begin
if RBO bit = 1 then // button on RBO pressed
begin
Delay ms (1) ;
current duty := current duty + 5; // increment current duty

if (curEént_duty > pwm periodl) then // 1f we increase current duty greater
then possible pwm periodl value

current duty := 0; // reset current duty value to zero
PWM Set Duty (current duty, 1); // set newly acquired duty ratio
end;
if RB1 bit = 1 then // button on RB1l pressed
begin
Delay_ms(l);
current duty := current duty - 5; // decrement current duty

if (current duty > pwm periodl) then // if we decrease current duty greater
then possible pwm periodl value (overflow)
current duty := pwm periodl; // set current duty to max possible value
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PWM Set Duty(current duty, 1); // set newly acquired duty ratio
end;
if RB2 bit = 1 then // button on RB2 pressed
begin
Delay ms(1);
current dutyl := current dutyl + 5; // increment current dutyl

if (current dutyl > pwm period2) then // if we increase current dutyl greater
then possible pwm period2 value

current dutyl := 0; // reset current dutyl value to zero
PWM Set Duty (current dutyl, 2); // set newly acquired duty ratio
end;
if RB3 bit = 1 then // button on RB3 pressed
begin
Delay ms (1) ;
current dutyl := current dutyl - 5; // decrement current duty

if (current dutyl > pwm period2) then // if we decrease current dutyl greater
then possible pwm periodl value (overflow)
current dutyl := pwm period2; // set current duty to max possible value

PWM Set Duty(current dutyl, 2);
end;

Delay ms(2); // slow down change pace a little

end;
end.

HW Connection
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RS-485 Library

RS-485 is a multipoint communication which allows multiple devices to be connected to a single bus. mikroPascal PRO
for PIC32 provides a set of library routines for comfortable work with RS485 system using Master/Slave architecture.
Master and Slave devices interchange packets of information. Each of these packets contains synchronization bytes,
CRC byte, address byte and the data. Each Slave has unique address and receives only packets addressed to it. The
Slave can never initiate communication.

It is the user’s responsibility to ensure that only one device transmits via 485 bus at a time.

The RS-485 routines require the UART module. Pins of UART need to be attached to RS-485 interface transceiver,
such as LTC485 or similar (see schematic at the bottom of this page).

Library constants:

- START byte value = 150

- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address 50 will be received by all Slaves
except the Slaves with addresses 150 and 169).

Important :
- The library uses the UART module for communication. The user must initialize the appropriate UART module before
using the RS-485 Library.

- For MCUs with multiple UART modules it is possible to initialize them and then switch by using the UART_Set_Active
routine.

Library Dependency Tree
(Rs48s ——+{ uarT )

External dependencies of RS-485 Library

The following variable must be defined i

. . . X Description: Example:

in all projects using RS-485 Library:

var RS485 rxtx pin : sbit; sfr; | Control RS-485 Transmit/Receive | var RS485 rxtx pin : sbit at RF2_
external; operation mode bit;

var RS485 rxtx pin direction : | Direction of the RS-485 Transmit/ | var RS485 rxtx pin direction : sbit
sbit; sfr; external; Receive pin at TRISF2 bit;
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Library Routines

- RS485Master_Init

- RS485Master_Receive
- RS485Master_Send

- RS485Slave_Init

- RS485Slave_Receive
- RS485Slave_Send

RS485Master_Init

Prototype

procedure RS485Master Init();

Description

Initializes MCU as a Master for RS-485 communication.

Parameters

None.

Returns

Nothing.

Requires

Global variables:

-RS485 rxtx pin -this pinis connected to RE/DE input of RS-485 transceiver(see schematic at the
bottom of this page). RE/DE signal controls RS-485 transceiver operation mode.

-RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin.

must be defined before using this routine.

UART HW module needs to be initialized. See UARTx_Init.

Example

// RS485 module pinout

var RS485 rxtx pin : sbit at RF2 bit;

var RS485 rxtx pin direction : sbit at TRISF2 bit;
// End of RS485 module pinout

UARTI1 Init(9600); // initialize UARTI1 module
RS485Master Init(); // intialize MCU as a Master
for RS-485 communication

Notes

None




mikroPascal PRO for PIC32

RS485Master Receive

Prototype procedure RS485Master Receive (var data : array[l10] of byte);

Description | Receives messages from Slaves. Messages are multi-byte, so this routine must be called for each
byte received.

Parameters | - data buffer: 7 byte buffer for storing received data. Data will be stored in the following manner:
-data buffer[0..2]: message content
-data_buffer[3]: number of message bytes received, 1-3
-data buffer[4]:is setto 255 when message is received
-data buffer[5]:is setto 255 if error has occurred
-data buffer[6]:address of the Slave which sent the message
The routine automatically adjusts data[4] and data [5] upon every received message. These flags
need to be cleared by software.

Returns Nothing.

Requires MCU must be initialized as a Master for RS-485 communication. See RS485Master_Init.

Example var msg : array[8] of byte;
RS485Master7Receive(msq);

Notes None

RS485Master_Send

Prototype procedure RS485Master Send(var buffer : array[20] of byte; datalen : byte;
slave address : byte);
Description | Sends message to Slave(s). Message format can be found at the bottom of this page.
Parameters | - data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address
Returns Nothing.
Requires MCU must be initialized as a Master for RS-485 communication. See RS485Master_Init.
It is the user’s responsibility to ensure (by protocol) that only one device sends data via 485 bus at a
time.
Example var msg : arrayl[8] of byte;
// send 3 bytes of data to Slave with address 0x12
RS485Master Send(msg, 3, 0x12);
Notes None
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RS485Slave _Init

Prototype procedure RS485Slave Init(slave address : byte);
Description | Initializes MCU as a Slave for RS-485 communication.
Parameters | - Slave address: Slave address
Returns Nothing.
Requires Global variables:
- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485 transceiver(see schematic at
the bottom of this page). RE/DE signal controls RS-485 transceiver operation mode. Valid values: 1
(for transmitting) and 0 (for receiving
-RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin.
must be defined before using this routine.
UART HW module needs to be initialized. See UARTX_Init.
Example Initialize MCU as a Slave with address 160:
// RS485 module pinout
var RS485 rxtx pin : sbit at RF2 bit; // transmit/receive control set
to PORTC.BZ2
var RS485 rxtx pin direction : sbit at TRISF2 bit;
// End of RS485 module pinout
UART1 Init(9600) ; // initialize UARTI module
RS485Slave Init (160); // intialize MCU as a Slave for RS-485
communication with address 160v
Notes None
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RS485Slave Receive

Prototype

procedure RS485S5lave Receive (var data buffer : array[20] of byte);

Description

Receives messages from Master. If Slave address and Message address field don’t match then the
message will be discarded. Messages are multi-byte, so this routine must be called for each byte
received.

Parameters

-data buffer: 6 byte buffer for storing received data, in the following manner:
-data buffer[0..2]: message content

-data buffer[3]:number of message bytes received, 1-3

-data buffer[4]:is setto 255 when message is received

-data buffer[5]:is setto 255 if error has occurred

The routine automatically adjusts data[4] and data [5] upon every received message. These flags
need to be cleared by software.

Returns

Nothing.

Requires

MCU must be initialized as a Slave for RS-485 communication. See RS485Slave_|Init.

Example

var msg : array[8] of byte;

RS485Slave Read (msg) ;

Notes

None

RS485Slave Send

Prototype procedure RS485S5Slave Send(var data : array([20] of byte; datalen : byte);
Description | Sends message to Master. Message format can be found at the bottom of this page.
Parameters | - data buffer: datato be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
Returns Nothing.
Requires MCU must be initialized as a Slave for RS-485 communication. See RS485Slave_Init. It is the user’s
responsibility to ensure (by protocol) that only one device sends data via 485 bus at a time.
Example var msg : array[8] of byte;
// send 2 bytes of data to the Master
RS485Slave Send(msg, 2);
Notes None
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Library Example

The example demonstrates working with the PIC32 as a Master node in RS-485 communication. Master sends message
to Slave with address 160 and waits for a response. After the response is received, the first byte of received data is
incremented and sent back to the Slave. The received data is displayed on PORTB while error on receiving (0xAA)
and number of consecutive unsuccessful retries are displayed on PORTD. Hardware configurations in this example are
made for the LV-32MX v6 board and PIC32MX460F512L.

Copy Code To Clipboard
program RS485 Master Example;

var dat : array[l0] of byte; // buffer for receving/sending messages
i, 3 : byte;
cnt : longint;

var rs485 rxtx pin : sbit at RF2 bit; // set transcieve pin
rs485 rxtx pin direction : sbit at TRISF2 bit; // set transcieve pin direction

// Interrupt routine
procedure interrupt(); iv IVT UART 2; ilevel 7; ics ICS SRS;
begin

RS485Master Receive (dat);

U2RXIF bit := 0; // ensure interrupt not pending
end;

begin
cnt := 0;

CHECON = 0x32;
AD1PCFG := OxFFFF;
PORTB := ;

PORTD :
TRISB
TRISD :=

’

Il
oo oo

UART2_ Init (19200); // initialize UART2 module
Delay ms (100);

RS485Master Init(); // initialize MCU as Master

dat[0] := OxAA;

dat[1] := 0xFO;

dat[2] := O0x0F;

dat[4] := 0; // ensure that message received flag is 0
dat[5] := 0; // ensure that error flag is 0

dat[6] := 0;

U2IP0 bit := 1; // set interrupt

U2IP1 bit := 1; // priority

U2IP2 bit := 1; // to 7

URXISEL1 U2STA bit := 0; // 0x = Interrupt flag bit is set when a character is received
U2RXIF bit := 0; // ensure interrupt not pending
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MVEC bit := 1; // Interrupt controller configured for multi vectored mode
asm
ei RO; // Enable all interrupts
end;
U2RXIE bit := 1; // enable intterupt

RS485Master Send(dat,1,160);

while (TRUE) do
begin // upon completed valid message receiving
// data[4] is set to 255
Inc(cnt);

if (dat[5] <> 0) then // if an error detected, signal it
PORTD := OxAA; // by setting portd to OxAA
if (dat[4] <> 0) then // if message received successfully
begin
cnt = 0;
dat[4] := 0; // clear message received flag
J = dat[3];
for i := 1 to dat[3] do // show data on PORTB
PORTB := dat[i-1];
dat[0] := dat[0]+1; // send back to master

Delay ms(1);
RS485Master Send(dat,1,160);

end;
if (cnt > 100000) then // 1if in 100000 poll-cycles the answer
begin
Inc (PORTD) ; // was not detected, signal
cnt := 0; // failure of send-message
RS485Master Send(dat,1,160);
if (PORTD > 10) then // if sending failed 10 times
begin
RS485Master Send(dat,1,50); // send message on broadcast address
end;
end;
end;

end.

Copy Code To Clipboard

program RS485 Slave Example;

var dat : array[20] of byte; // buffer for receving/sending messages
i, 3 : byte;

var rs485 rxtx pin : sbit at RF2 bit; // set transcieve pin
rs485 rxtx pin direction : sbit at TRISF2 bit; // set transcieve pin direction

// Interrupt routine
procedure interrupt(); iv IVT UART 2; ilevel 7; ics ICS_SRS;
begin

RS48551lave_Receive (dat);
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U2RXIF bit := 0; // ensure interrupt not pending
end;
begin
CHECON = 0x32;
ADIPCFG := OxFFFF;
TRISB := 0;
TRISD := 0;
PORTB := 0;
PORTD := 0;
UART2_ Init (19200); // initialize UART2 module
Delay ms (100);
RS485S5lave Init (160); // Intialize MCU as slave, address 160
dat[0] := OxAA;
dat[1] = 0xFO;
dat[2] := O0x0F;
dat[4] := 0; // ensure that message received flag is 0
dat[5] := 0; // ensure that error flag is 0
dat[6] := 0;
U2IP0 bit := 1; // set interrupt
U2IP1 bit := 1; // priority
U2IP2 bit := 1; // to 17
URXISEL1 U2STA bit := 0; // 0Ox = Interrupt flag bit is set when a character is
received
U2RXIF bit := 0; // ensure interrupt not pending
MVEC bit := 1; // Interrupt controller configured for multi vectored mode
asm
ei RO; // Enable all interrupts
end;
U2RXIE bit := 1; // enable intterupt
while (TRUE) do
begin
if (dat[5] <> 0) then // if an error detected, signal it by
begin
PORTD := 0xAA; // setting portd to OxAA
dat[5] := 0;
end;
if (dat[4] <> 0) then // upon completed valid message receive
begin
dat[4] := 0; // data[4] is set to OxFF
j := dat[3];
for i := 1 to dat[3] do // show data on PORTB
PORTB := dat[i-1];
dat[0] := dat[0]+1; // increment received dat[0]
Delay ms(1);
RS485Slave Send(dat,1); // and send it back to master
end;
end;

end.
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HW Connection
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Example of interfacing PC to PIC32 MCU via RS485 bus with LTC485 as RS-485 transceiver
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Message format and CRC calculations
Q: How is CRC checksum calculated on RS485 master side?
Copy Code To Clipboard

const START BYTE : byte = 0x96; // 10010110
const STOP BYTE : byte = 0xA9; // 10101001

PACKAGE:

START BYTE 0x96

ADDRESS

DATALEN

[DATAL] // if exists
[DATA2] // if exists
[DATA3] // if exists
CRC

STOP_BYTE 0xA9

DATALEN bits

bit7 = 1 MASTER SENDS
0 SLAVE SENDS

bit6é = 1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or STOP BYTE
0 ADDRESS UNCHANGED

bit5 = 0 FIXED

bit4 = 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO START BYTE or STOP BYTE
0 DATA3 (if exists) UNCHANGED

bit3 = 1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO START BYTE or STOP BYTE
0 DATA2 (if exists) UNCHANGED

bit2 = 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO START BYTE or STOP BYTE
0 DATAl (if exists) UNCHANGED

bitlbit0 = 0 to 3 NUMBER OF DATA BYTES SEND

CRC generation

crc _send := datalen =xor address;

crc_send := crc_send xor datal0]; // 1if exists

crc_send := crc_send xor datall]; // 1f exists

crc_send := crc_send xor datal2]; // 1if exists

crc send := crc_send not crc send;

if ((crc_send = START BYTE) or (crc send = STOP BYTE)) then
crc_send := crc send + 1;

NOTE: DATALEN<4..0> can not take the START BYTE<4..0> or STOP BYTE<4..0> values.
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Software I>C Library

The mikroPascal PRO for PIC32 provides routines for implementing Software 12C communication. These routines are
hardware independent and can be used with any MCU. The Software I?C library enables you to use MCU as Master in
I2C communication. Multi-master mode is not supported.

Important:

- This library implements time-based activities, so interrupts need to be disabled when using Software I*C.

- All I*C Library functions are blocking-call functions (they are waiting for I?C clock line to become logical one).

- The pins used for the Software I1°C communication should be connected to the pull-up resistors. Turning off the LEDs
connected to these pins may also be required.

- Every Software I?C library routine has its own counterpart in Hardware I°C library, except 12C Repeated Start.
Soft I2C Start isusedinstead of I2C Repeated Start.

- Working clock frequency of the Software 12C is 20kHz.

External dependencies of Software I>C Library

The following variable must be defined o

. R . X Description: Example:

in all projects using RS-485 Library:

var Soft I2C Scl : sbit; sfr; . . )
SORE_Leb = Soft I2C Clock line. var Soft I2C Scl : sbit at RF3 bit;

external; - - -
Soft I2C sd : bit; fr; . . p .

var Solt_lob saa SPTES SRR Soft I°C Data line. var Soft I2C Sda : sbit at RF2 bit;

external; - - -

var  Soft I2C Scl Direction  : | Direction of the Soft I°C Clock | var Soft 12C Scl Direction : sbit at

sbit; sfr; external; pin. TRISF3 bit;

var Soft I2C Sda Direction . . A . var Soft I2C Sda Direction : sbit at

sbit; sfr; external; Direction of the Soft I>C Data pin. TRISF2 bit;

Library Routines

- Soft_I2C_Init

- Soft_I2C_Start
- Soft_I2C_Read
- Soft_I2C_Write
- Soft_I2C_Stop
- Soft_I2C_Break
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Soft_12C_Init
Prototype procedure Soft I2C Init();
Description | Configures the software I2C module.
Parameters | None.
Returns Nothing.
Requires Global variables:

-Soft 12C scl: Soft I>C clock line
- Soft I2C sda: Soft I>C data line
-Soft I2C scl Pin Direction: Direction of the Soft I?C clock pin
-Soft I2C sda Pin Direction: Direction of the Soft I°C data pin

must be defined before using this function.

Example // Software I2C connections
var Soft I2C Scl : sbit at RF3 bit;
Soft I2C Sda : sbit at RF2 bit;
Soft I2C Scl Direction : sbit at TRISF3 bit;
Soft I2C Sda Direction : sbit at TRISFZ bit;
// End Software I2C connections
Soft I2C Init();
Notes None

Soft_I2C_Start

Prototype |procedure Soft I2C Start();
Description | Determines if the I?C bus is free and issues START signal.
Parameters | None.
Returns Nothing.
Requires Software I?C must be configured before using this function. See Soft_I2C_Init routine.
Example // Issue START signal
Soft I2C Start();
Notes None
MikroElektronika
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Soft_12C_Read

Prototype function Soft I2C Read(ack : word) : byte;
Description | Reads one byte from the slave.
Parameters | - ack: acknowledge signal parameter. If the ack==0 not acknowledge signal will be sent after reading,
otherwise the acknowledge signal will be sent.
Returns One byte from the Slave.
Requires Soft 12C must be configured before using this function. See Soft_I2C_Init routine.
Also, START signal needs to be issued in order to use this function. See Soft_I12C_Start routine.
Example var take : byte;
// ‘ Read data and send the not acknowledge signal
take := Soft I2C Read(0);
Notes None

Soft_12C_Write

Prototype function Soft I2C Write(data : byte) : byte;
Description | Sends data byte via the I°C bus.
Parameters | - data : data to be sent
Returns - 0 if there were no errors.
- 1 if write collision was detected on the I?C bus.
Requires Soft I?C must be configured before using this function. See Soft_I2C_Init routine.
Also, START signal needs to be issued in order to use this function. See Soft_I2C_Start routine.
Example var data , error : byte;
é.m.for := Soft I2C Write(data );
error := Soft I2C Write(SA3);
Notes None

Soft_12C_Stop

Prototype procedure Soft I2C Stop();
Description | Issues STOP signal.
Parameters | None.
Returns Nothing.
Requires Soft I)C must be configured before using this function. See Soft_I2C_lInit routine.
Example // Issue STOP signal
Soft I2C Stop();
Notes None
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Soft_[2C_Break

Prototype procedure Soft I2C Break();
Description | All Software I?C Library functions can block the program flow (see note at the top of this page). Calling
this routine from interrupt will unblock the program execution. This mechanism is similar to WDT.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example var datal, error, counter : byte;
procedure TimerlInt(); org IVT ADDR T1INTERRUPT;
begin
counter := 0;
if (counter >= 20)
begin
Soft I2C Break();
counter := 0; // reset counter
end
else
Inc (counter) ; // increment counter
T1IF bit := 0; // Clear Timerl overflow interrupt flag
end;
begin
// try Soft I2C Init with blocking prevention mechanism
IPCO := IPCO or 0x1000; // Interrupt priority level = 1
T1IE bit := 1; // Enable Timerl interrupts
TICON := 0x8030; // Timerl ON, internal clock FCY, prescaler
1:256
Soft I2C Init();
T1IE bit := 0; // Disable Timerl interrupts
end.
Notes Interrupts should be disabled before using Software I?C routines again (see note at the top of this
page).
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Library Example

The example demonstrates use of the Software 12C Library. The PIC32 MCU is connected (SCL, SDA pins) to PCF8583
RTC (real-time clock). Program sends date/time to RTC.

Copy Code To Clipboard

program RTC Read;

var

seconds,

minutes,

hours,

// Software I2C connections
var Soft I2C Scl

// End Software I2C connections

Soft I2C

Sda

Soft_IZCiScl_Direction
Soft I2C Sda Direction

// LCD module connections

: LATB2 bit;
LATB3 bit;
LATB4 bit;
LATB5 bit;
LATB6 bit;
LATB7 bit;

var
var
var
var
var
var

var
var
var
var
var
var

LCD_RS
LCD_EN
LCD_D4
LCD D5
LCD D6
LCD_D7

sbit
sbit
sbit
sbit
sbit
sbit

at
at
at
at
at
at

LCD RS Direction
LCD _EN Direction
LCD D4 Direction
LCD D5 Direction
LCD D6 Direction
LCD D7 Direction
// End LCD " module connections

procedure Read Time () ;
begin

Soft I2C Start
Soft I2C Write
Soft I2C Write
Soft I2C Start

(
(
(
(

’

sbit
sbit
sbit
sbit
sbit
sbit

xA0) ;

)7
0
2) i
)7

Soft I2C Write (OxAl);

day, month, year : byte;

// Global date/time variables

sbit at RF3 bit;
sbit at RF4 bit;
sbit at TRISF3 bit;
sbit at TRISF4 bit;

at
at
at
at
at
at

seconds := Soft I2C Read(l
minutes := Soft I2C Read(l
hours := Soft I2C Read(l);
day := Soft I2C Read(l);

month := Soft I2C Read(0);

Soft I2C Stop();
end;

)7
)7

TRISB2 bit;
TRISB3 bit;
TRISB4 bit;
TRISBS bit;
TRISB6 bit;
TRISB7 bit;

Reads time and date information from RTC (PCF8583)

// Issue start signal

// Address PCF8583, see PCF8583 datasheet
// Start from address 2

// Issue repeated start signal

// Address PCF8583 for reading R/W=1

// Read seconds byte

// Read minutes byte

// Read hours byte

// Read year/day byte

// Read weekday/month byte}

// Issue stop signal}
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[ — Formats date and time
procedure Transform Time () ;
begin
seconds := ((seconds and 0xF0) shr 4)*10 + (seconds and 0x0F);// Transform seconds
minutes := ((minutes and 0xF0) shr 4)*10 + (minutes and 0x0F);// Transform months
hours = ((hours and 0xF0) shr 4)*10 + (hours and 0x0F); // Transform hours
year i= (day and 0xC0O) shr 6; // Transform year
day = ((day and 0x30) shr 4)*10 + (day and 0x0F) ; // Transform day
month ((month and 0x10) shr 4)*10 + (month and 0x0F); // Transform month
end;
[/ == e Output values to LCD
procedure Display Time () ;
begin N
Lcd Chr(l, 6, (day / 10) + 48); // Print tens digit of day variable
Lcd:Chr(l, 7, (day mod 10) + 48); // Print oness digit of day variable
Led Chr(l, 9, (month / 10) + 48);
Led Chr(1,10, (month mod 10) + 48);
Lcd Chr (1,15, year + 49); // Print year vaiable + 1 (start from year 2011)
Lcd Chr (2, 6, (hours / 10) + 48);
Led _Chr(2, 7, (hours mod 10) + 48);
Lcd Chr (2, 9, (minutes / 10) + 48);
Led Chr(2,10, (minutes mod 10) + 48);
Lcd Chr (2,12, (seconds / 10) + 48);
Led Chr (2,13, (seconds mod 10) + 48);
end;
[/ == Performs project-wide init
procedure Init Main();
begin
CHECON := 0x30;
AD1PCFG := OxFFFE; // Initialize AN pins as digital
Soft I2C Init(); // Initialize Soft I2C communication
Led Init(); // Initialize LCD
Lcd Cmd( LCD CLEAR) ; // Clear LCD display
Led_Cmd (CLCD_CURSOR OFF); // Turn cursor off
Led Out(l,1,"Date:’); // Prepare and output static text on LCD
Lcd Chr (1,8,7:7);
Led Chr(1,11,7:7);
Led Out (2,1, Time:");
Led Chr(2,8,7:7);
Led Chr(2,11,7:7);
Led_Out(1,12,72017);
end;
[ = ——— Main procedure
begin

Delay ms(1000);

//
//
//

/7
//

Init Main();

while TRUE do
begin
Read Time () ;
Transform Time () ;
Display Time () ;
end;
end.

Perform initialization
Endless loop
Read time from RTC (PCF8583)

Format date and time
Prepare and display on LCD
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Software SPI Library

The mikroPascal PRO for PIC32 provides routines for implementing Software SPI communication. These routines are
hardware independent and can be used with any MCU. The Software SPI Library provides easy communication with
other devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.

Library configuration:

- SPI to Master mode

- Clock value = 20 kHz.

- Data sampled at the middle of interval.
- Clock idle state low.

- Data sampled at the middle of interval.
- Data transmitted at low to high edge.

The library configures SPI to the master mode, clock = 20kHz, data sampled at the middle of interval, clock idle state
low and data transmitted at low to high edge.

Important : The Software SPI library implements time-based activities, so interrupts need to be disabled when using it.

External dependencies of Software SPI Library

The following variables must be defined

in all projects using Software SPI | Description: Example:
Library:
var SoftSpi SDI sbit; sfr; . . . .
Pi_ Data In line. var SoftSpi SDI : sbit at RF2 bit;
external; - -
var SoftSpi SDO sbit; sfr; . var SoftSpi SDO sbit at LATF3
SO TIPS Data Out line. 2E SOTEeRLS -
external; bit;
var SoftSpi CLK sbit; sfr; . var SoftSpi CLK sbit at LATF6
- Clock line. . - -
external; bit;
var SoftSpi_SDI_Direction N . var SoftSpi SDI Direction sbit at
sbit; sfr; external; Direction of the Data In pin. TRISF2 bit;
var SoftSpi SDO_Direction - . var SoftSpi SDO Direction sbit at
sbit; sfr; external; Direction of the Data Out pin TRISF3 bit;
var SoftSpi CLK Direction . . . var SoftSpi CLK Direction sbit at
sbit; sfr; external; Dirsction of the Clock pin. TRISF6 bit;
Library Routines
- Soft_SPI_Init
- Soft_SPI_Read
- Soft_SPI_Write
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Soft_SPI_Init

Prototype

procedure Soft SPI_ Init();

Description

Routine initializes the software SPI module.

Parameters

None.

Returns

Nothing.

Requires

Global variables:

-SoftSpi SDI
-SoftSpi SDO
-SoftSpi CLK
-SoftSpi SDI

: Data in line
: Data out line
: Data clock line

_Direction: Direction of the Data in pin
- SoftSpi SDO Direction: Direction of the Data out pin
- SoftSpi CLK Direction: Direction of the Data clock pin

must be defined before using this function.

Example

// Software
var SoftSpi
var SoftSpi
var SoftSpi

var
var
var

SoftSpi
SoftSpi
SoftSpi

SPI module
SDT sbit at
SDO sbit at
CLK : sbit at

SDI Direction
SDO Direction
CLK Direction

connections

RF2 bit;
LATF3 bit;
LATF6 bit;

sbit at TRISF2 bit;
sbit at TRISF3 bit;
sbit at TRISF6 bit;

// End Software SPI module connections

Soft SPI Init(); // Init Soft SPI

Notes

None
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Soft_ SPI_Read

Prototype function Soft SPI Read(data byte) byte;

Description | This routine performs 3 operations simultaneously. It provides clock for the Software SPI bus, reads
a byte and sends a byte.

Parameters | - sdata: data to be sent.

Returns Byte received via the SPI bus.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_Init routine.

Example var data read, data send byte;
// Read a byte and assign it to data read variable
// (data_send byte will be sent via SPI during the Read operation)
data read := Soft SPI Read(data send);

Notes None

Soft_ SPI_Write

Prototype procedure Soft SPI Write (sdata byte) ;
Description | This routine sends one byte via the Software SPI bus.
Parameters | - sdata: data to be sent.
Returns Nothing.
Requires Soft SPI must be initialized before using this function. See Soft_SPI_Init.
Example // Write a byte to the Soft SPI bus
Soft SPI Write (0xAA) ;
Notes None

Library Example

This code demonstrates using library routines for Soft_SPI communication. Also, this example demonstrates working
with max7219. Eight 7 segment displays are connected to MAX7219. MAX7219 is connected to SDO, SDI, SCK pins
are connected accordingly.

Copy Code To Clipboard

// DAC module connections

var Chip Select

sbit at LATDO bit;

SoftSpi CLK
SoftSpi SDI
SoftSpi SDO

sbit
sbit
sbit

at LATD6 bit;
at RD2 bit;
at LATD3 bit;

var Chip Select Direction
SoftSpi CLK Direction
SoftSpi SDI Direction
SoftSpi SDO Direction

sbit
sbit
sbit
sbit

at TRISDO bit;
at TRISD6 bit;
at TRISD2 bit;
at TRISD3 bit;

// End DAC module connections
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var value word;

procedure InitMain();

begin
TRISBO bit := 1;
TRISBl bit := 1;
Chip Select := 1;

Chip Select Direction := 0;
Soft Spi Init();

end;

// DAC increments (0..4095)

procedure DAC Output ( valueDAC word) ;
var temp byte; volatile;
begin
Chip Select := 0;

// Send High Byte

--> output voltage

Set RBO pin as input
Set RB1 pin as input
Deselect DAC

Set CS# pin as Output
Initialize Soft SPI

(0..Vref)

// Select DAC chip

temp := word(valueDAC shr 8) and 0x0F; // Store valueDAC[11..8] to temp[3..0]
temp := temp or 0x30; // Define DAC setting, see MCP4921 datasheet
Soft SPI Write (temp); // Send high byte via Soft SPI
// Send Low Byte
temp := valueDAC; // Store valueDAC[7..0] to temp[7..0]
Soft SPI Write (temp); // Send low byte via Soft SPI
Chip Select := 1; // Deselect DAC chip
end;
begin
CHECON := 0x32;
AD1PCFG := OxFFFEF; // Configure AN pins as digital
InitMain () ; // Perform main initialization
value := 2048; // When program starts, DAC gives
// the output in the mid-range
while (TRUE) do // Endless loop
begin
if ((RBO bit) and (value < 4095)) then // If RBO button is pressed
Inc (value) // increment value
else
begin
if ((RB1 _bit) and (value > 0)) then // If RBI button is pressed
Dec (value) ; // decrement value
end;

DAC Output (value) ;
Delay ms (1) ;
end;
end.

// Send value to DAC chip
// Slow down key repeat pace
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Software UART Library

The mikroPascal PRO for PIC32 provides routines for implementing Software UART communication. These routines
are hardware independent and can be used with any MCU.
The Software UART Library provides easy communication with other devices via the RS232 protocol.

Important: The Software UART library implements time-based activities, so interrupts need to be disabled when using it.

Library Routines

- Soft_ UART _Init

- Soft. UART_Read
- Soft UART_Write
- Soft. UART_Break

Soft_ UART_Init

Prototype function SoftiUZ\RTilnit (var port: word; rx, tx: word; baud rate : dword;
inverted : word) : byte;

Description | Configures and initializes the software UART module.
Software UART routines use Delay_Cyc routine. If requested baud rate is too low then calculated
parameter for calling Delay Cyc exceeds Delay Cyc argument range.
If requested baud rate is too high then rounding error of Delay Cyc argument corrupts Software
UART timings.

Parameters | - port: software UART port address
- rx: receiver pin
- tx: transmiter pin
- baud rate: requested baudrate. Maximum baud rate depends on the MCU'’s clock and working
conditions
- inverted: if set to non-zero value, indicates inverted logic on output

Returns - 2 - error, requested baud rate is too low
- 1 - error, requested baud rate is too high
- 0 - successful initialization

Requires Nothing.

Example This will initialize software UART and establish the communication at 9600 bps:
// Initialize Software UART communication on pins RF2 (Rx), RF3(Tx), at 14400
bps
Soft UART Init (PORTF, 2, 3, 14400, 0);

Notes The Software UART library implements time-based activities, so interrupts need to be disabled when
using it.
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Soft UART_Read

Prototype function Soft UART Read(var error : byte) : byte;
Description | The function receives a byte via software UART.
This is a blocking function call (waits for start bit). Programmer can unblock it by calling Soft UART_
Break routine.
Parameters | - error: Error flag. Error code is returned through this variable. Values :
- 0 - no error
- 1 - stop bit error
- 255 - user abort, Soft. UART_Break called
Returns Byte received via UART.
Requires Software UART must be initialized before using this function. See the Soft_ UART_Init routine.
Example var data : byte;
error : word;
// wait until data is received
repeat
data := Soft UART Read(error);
until (error = 0);
// Now we can work with data:
if (data ) then begin end
Notes The Software UART library implements time-based activities, so interrupts need to be disabled when
using it.

Soft UART_Write

Prototype procedure Soft UART Write(udata : byte);

Description | This routine sends one byte via the Software UART bus.

Parameters | - udata: data to be sent.

Returns Nothing.

Requires Software UART must be initialized before using this function. See the Soft UART _Init routine.
Be aware that during transmission, software UART is incapable of receiving data — data transfer
protocol must be set in such a way to prevent loss of information.

Example var some byte : byte;
some byte := $0A;
// Write a byte via Soft UART
Soft UART Write(some byte);

Notes The Software UART library implements time-based activities, so interrupts need to be disabled when
using it.
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Soft UART_Break

Prototype |procedure Soft UART Break();

Description | Soft UART_Read is blocking routine and it can block the program flow. Calling Soft. UART_Break
routine from the interrupt will unblock the program execution. This mechanism is similar to WDT.

Parameters | None.

Returns Nothing.

Requires Nothing.

Example var datal, error, counter : byte;

procedure TimerlInt(); org IVT ADDR T1INTERRUPT;

begin
counter := 0;
if (counter >= 20) then
begin
Soft UART Break();
counter := 0; // reset counter
end
else
Inc (counter); // increment counter
T1IF bit := 0; // Clear Timerl overflow interrupt flag
end;
begin
if (Soft UART Init (PORTF, 2, 3, 14400, 0) = 0)

Soft UART Write (0x55);

// try Soft UART Read with blocking prevention mechanism

IPCO := IPCO or 0x1000; // Interrupt priority level = 1

T1IE bit := 1; // Enable Timerl interrupts

T1CON := 0x8030; // Timerl ON, internal clock FCY, prescaler
1:256

datal := Soft UART Read(&error);

T1IE bit := 0; // Disable Timerl interrupts
end.

Notes The Software UART library implements time-based activities, so interrupts need to be disabled when

using it.
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Library Example

This example demonstrates simple data exchange via software UART. If MCU is connected to the PC, you can test the
example from the mikroPascal PRO for PIC32 USART communication terminal, launch it from the drop-down menu
Tools » USART Terminal or simply click the USART Terminal Icon &l

Copy Code To Clipboard
program Soft UART;

var error : byte;
counter, byte read : byte;

// Auxiliary variables

begin
CHECON := 0x32;
ADIPCFG := OxFFFF; // Configure AN pins as digital I/O
TRISB := 0x00; // Set PORTB as output (error signalization)
PORTB := 0; // No error
error := Soft UART Init (PORTF, 2, 8, 56000, 0); // Initialize Soft UART at 56000 bps
if (error > 0) then
begin
PORTB := error; // Signalize Init error
while (TRUE) do nop; // Stop program
end;
Delay ms (100);
for counter := ‘z’ downto ‘A’ do // Send bytes from ‘z’ downto ‘A’
begin
Soft UART Write (counter);
Delay ms (100);
end;
while TRUE do // Endless loop
begin
byte read := Soft UART Read(error); // Read byte, then test error flag
if (error <> 0) then // If error was detected
PORTB := error // signal it on PORTB
else
Soft UART Write(byte read); // If error was not detected, return byte read
end;
end.
MikroElektronika



mikroPascal PRO for PIC32

Sound Library
The mikroPascal PRO for PIC32 provides a Sound Library to supply users with routines necessary for sound signalization

in their applications. Sound generation needs additional hardware, such as piezo-speaker (example of piezo-speaker
interface is given on the schematic at the bottom of this page).

Library Routines

- Sound_Init
- Sound_Play

Sound_Init

Prototype procedure Sound Init(var snd port, snd pin: word);

Description | Configures the appropriate MCU pin for sound generation.

Parameters | - snd port: sound output port address
- snd_pin: sound output pin

Returns Nothing.

Requires Nothing.

Example // Initialize the pin RD3 for playing sound
Sound Init (PORTD, 3);

Notes None.

Sound_Play

Prototype procedure Sound Play(freq in hz, duration ms: word);

Description | Generates the square wave signal on the appropriate pin.

Parameters | - freq in hz: signal frequency in Hertz (Hz)
- duration ms: signal duration in miliseconds (ms)

Returns Nothing.

Requires In order to hear the sound, you need a piezo speaker (or other hardware) on designated port. Also, you
must call Sound_Init to prepare hardware for output before using this function.

Example // Play sound of 1KHz in duration of 100ms
Sound Play (1000, 100);

Notes None.
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Library Example
The example is a simple demonstration of how to use the Sound Library for playing tones on a piezo speaker.
Copy Code To Clipboard
program Sound;
procedure Tonel () ;
begin
Sound Play (659, 250); // Frequency = 659Hz, duration = 250ms
end;
procedure Tone?2 () ;
begin
Sound Play (698, 250); // Frequency = 698Hz, duration = 250ms

end;

procedure Tone3 () ;

begin
Sound Play (784, 250); // Frequency = 784Hz, duration = 250ms
end;
procedure Melody () ; // Plays the melody “Yellow house”
begin
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3();
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3();
Tone3(); Tone3(); Tone2(); Tone2(); Tonel();
end;
procedure ToneA() ; // Tones used in Melody2 function
begin
Sound Play( 880, 50);
end;
procedure ToneC() ;
begin
Sound Play (1046, 50);
end;
procedure ToneE () ;
begin
Sound Play (1318, 50);
end;
procedure Melody2 () ; // Plays Melody?2
var counter : byte;
begin
for counter := 9 downto 1 do
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begin
ToneA () ;
ToneC () ;
ToneE () ;
end;
end;

begin
CHECON :=
AD1PCFEG :=

0x32;
OxXFFFE;
TRISB := 0OxF8;

Sound Init (PORTD, 3);
Sound Play (880, 1000);

/7

/7

Configure AN pins as digital I/0

Configure RB7..RB3 as input

while TRUE do // endless loop
begin
if (Button(PORTB,7,1,1)) then // If PORTB.7 is pressed play Tonel
begin
Tonel () ;
while (RB7 bit <> 0) do nop; // Wait for button to be released
end;
if (Button (PORTB,6,1,1)) then // If PORTB.6 is pressed play Tonel
begin
Tone2 () ;
while (RB6 bit <> 0) do nop; // Wait for button to be released
end;
if (Button(PORTB,5,1,1)) then // If PORTB.5 is pressed play Tonel
begin
Tone3 () ;
while (RB5 bit <> 0) do nop; // Wait for button to be released
end;
if (Button (PORTB,4,1,1)) then // If PORTB.4 is pressed play Tonel
begin
Melody2 () ;
while (RB4 bit <> 0) do nop; // Wait for button to be released
end;
if (Button (PORTB,3,1,1)) then // If PORTB.3 is pressed play Tonel
begin
Melody () ;
while (RB3 bit <> 0) do nop; // Wait for button to be released
end;
end;
end.
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SPI Library

The SPI module is available with all PIC32 MCUs. mikroPascal PRO for PIC32 provides a library for initializing the
Slave mode and initializing and comfortable work with the Master mode. The PIC32 can easily communicate with other
devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.

Important:

- SPI library routines require you to specify the module you want to use. To select the desired SPI module, simply
change the letter x in the routine prototype for a number from 1 to 3.

- Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet before utilizing
this library.

- Switching between the SPI modules in the SPI library is done by the SPI_Set_Active function (both SPI modules have
to be previously initialized).

Library Routines

- SPIx_Init

- SPIx_Init_Advanced
- SPIx_Read

- SPIx_Write

- SPI_Set_Active
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SPIx_Init

Prototype procedure SPIx Init();

Description | Configures and initializes the SPI module with default settings.
Default settings:
- Master mode.
- 8-bit data mode.
- Serial clock set to System clock/64.
- Slave Select disabled.
- Input data sampled in the middle of interval.
- Clock idle state low.
- Serial output data changes on transition from idle clock state to active clock state

Parameters | None.

Returns Nothing.

Requires MCU must have the SPI1 module.

Example // Initialize the SPI1 module with default settings
SPI1 Init();

Notes SPI library routines require you to specify the module you want to use. To select the desired SPI
module, simply change the letter x in the routine prototype for a number from 1 to 3.
Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
Switching between the SPI modules in the SPI library is done by the SPI_Set_Active function (both
SPI modules have to be previously initialized).
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SPIx_Init_Advanced

Prototype

procedure SPIx Init Advanced (master mode, data mode, clock divider,

slave
select, data sample, clock idle, edge: word);

Description | Configures and initializes the SPI module with user defined settings.

Parameters

ParameterSmasterimode, data mode, clock divider, slave select,

_ data sample,
clock idle and determine the working mode for SPI.

The master mode parameter determines the working mode for SPI module.

Master/Slave mode
Description Predefined library const
Master mode _SPI_MASTER
Slave mode _SPI_SLAVE

The parameter data mode the data length mode, which can be 8-bits (per transmitions cycle), 16-bits
pr 32-bits.

Data Length Mode
Description Predefined library const
32-bit mode _SPI 32 BIT
16-bit mode _SPI 16 BIT
8-bit mode _SPI 8 BIT

The parameter clock divider determines the value of the SPI clock speed. Used only in the Maste
Mode.

Clock Divider Value
Valid values from 2 to 1024

The parameter s1ave select determines whether the Slave Select (SS) pin is used in communication
\Valid in the Slave Mode only.

Slave Select Enable/Disable

Description Predefined library const
SS used for the Slave mode ~SPI SS ENABLE

SS not used for the Slave mode | SPI SS DISABLE

The parameter data sample determines the sample moment (phase) of input data.

Data Sampling Moment
Description Predefined library const
Data sampled in the middle of data output SPT DATA SAMPLE MIDDLE
time - - - -
Data sampled at end of data output time _SPI DATA SAMPLE END

391



mikoPascal PRO for PIC32

Parameters

The parameter clock idle determines the behaviour of the SPI clock (CLK) line in IDLE phase.

Clock Polarity

Description Predefined library const
IDLE state is Lo, ACTIVE state is Hi _SPI _CLK IDLE LOW
IDLE state is Hi, ACTIVE state is Lo _SPI CLK IDLE HIGH

The parameter cdge determines on which clock edge data is considered to be valid.

Clock Edge
Description Predefined library const
Data is valid on ACTIVE-to-IDLE transition _SPI_ACTIVE 2 IDLE
Data is valid on IDLE-to-ACTIVE transition _SPI IDLE 2 ACTIVE

Returns Nothing.

Requires MCU must have the SPI module.

Example // Set SPI1 to the Master Mode, data length is 16-bit, clock = Fcy (no clock
scaling), data sampled in the middle of interval, clock IDLE state high and
data transmitted at low to high clock edge:

SPI1 Init Advanced( SPI MASTER, SPI 16 BIT, 1, SPI SS DISABLE, SPI DATA
SAMPLE MIDDLE, SPI CLK IDLE HIGH, _SPI ACTIVE 2 IDIE);
Notes SPI library routines require you to specify the module you want to use. To select the desired SPI

module, simply change the letter x in the routine prototype for a number from 1 to 3.

Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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SPIx_Read

Prototype function SPIx Read(data out: word): word;

Description | Reads one word or byte (depending on mode set by init routines) from the SPI bus.

Parameters | - data out:dummy data for clock generation (see device Datasheet for SPI modules implementation
details)

Returns Received data.

Requires Routine requires at least one SPI module.
Used SPI module must be initialized before using this function. See the SPIx_Init and SPIx_Init_
Advanced routines.

Example // read a byte from the SPI bus
var take, buffer : byte;
'L;‘i]‘(e := SPI1 Read (buffer);

Notes SPI library routines require you to specify the module you want to use. To select the desired SPI
module, simply change the letter x in the routine prototype for a number from 1 to 3.
Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

SPIx_Write

Prototype procedure SPIx Write(data out : word);

Description | Writes one word or byte (depending on mode set by init routines) via the SPI bus.

Parameters | - data out: data to be sent

Returns Nothing.

Requires Routine requires at least one SPI module.
Used SPI module must be initialized before using this function. See the SPIx_Init and SPIx_Init_
Advanced routines.

Example // write a byte to the SPI bus
var buffer : byte;
:SZ.).I17Wri te (buffer) ;

Notes SPI library routines require you to specify the module you want to use. To select the desired SPI

module, simply change the letter x in the routine prototype for a number from 1 to 3.

Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.
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SPI_Set_Active

Prototype procedure SPI Set Active(read ptr : "TSPI Rd Ptr; write ptr : 7"TSPI Wr
Ptr);
Description | Sets the active SPI module which will be used by the SPIx_Read and SPIx_Write routines.
Parameters | Parameters:
- read ptr: SPI1_Read handler
-write ptr:SPIM_Write handler
Returns Nothing.
Requires Routine is available only for MCUs with multiple SPI modules.
Used SPI module must be initialized before using this function. See the SPIx_Init and SPIx_lInit_
Advanced routines.
Example SPI Set Active (@SPI1_Read, @SPI1 Write),; // Sets the SPI1 module active
Notes Number of SPI modules per MCU differs from chip to chip. Please, read the appropriate datasheet
before utilizing this library.

Library Example

The code demonstrates how to use SPI library functions for communication between SPI2 module of the MCU and
MCP4921 DAC chip.

Copy Code To Clipboard

program SPI;

// DAC module connections
var Chip Select : sbit at LATFO bit;

Chip Select Direction : sbit at TRISFO bit;
// End DAC module connections

var value

word;

procedure InitMain();

begin
TRISBO bit := 1; // Set RBO pin as input
TRISB1 bit := 1; // Set RB1 pin as input
Chip Select := 1; // Deselect DAC
Chip Select Direction := 0; // Set CsS# pin as Output
SPI2 Init(); // Initialize SPI2 module
end;
// DAC increments (0..4095) --> output voltage (0..Vref)
procedure DAC Output ( valueDAC : word);
var temp byte;
begin
Chip Select := 0; // Select DAC chip
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// Send High Byte

temp := word(valueDAC shr 8) and 0x0F; // Store valueDAC[11l..8] to temp[3..0]
temp := temp or 0x30; // Define DAC setting, see MCP4921 datasheet
SPI2 Write (temp); // Send high byte via SPI
// Send Low Byte
temp := valueDAC; // Store valueDAC[7..0] to temp[7..0]
SPI2 Write (temp) ; // Send low byte via SPI
Chip Select := 1; // Deselect DAC chip

end;

begin

CHECON := 0x32;

ADIPCFG := OxFFFF; // Configure AN pins as digital

InitMain () ; // Perform main initialization

value := 2048; // When program starts, DAC gives

// the output in the mid-range
InitMain () ; // Perform main initialization

value := 2048; // When program starts, DAC gives
// the output in the mid-range

while ( TRUE ) do // Endless loop
begin
if ((RBO _bit) and (value < 4095)) then // If RAO button is pressed
Inc (value) // increment value
else
begin
if ((RB1 bit) and (value > 0)) then // If RA1l button is pressed
Dec (value) ; // decrement value
end;
DAC_Output (value) ; // Send value to DAC chip
Delay ms(1); // Slow down key repeat pace
end;
end.
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SPI Ethernet Library

The ENC28J60 is a stand-alone Ethernet controller with an industry standard Serial Peripheral Interface (SPI). It is
designed to serve as an Ethernet network interface for any controller equipped with SPI.

The ENC28J60 meets all of the IEEE 802.3 specifications. It incorporates a number of packet filtering schemes to limit
incoming packets. It also provides an internal DMA module for fast data throughput and hardware assisted IP checksum
calculations. Communication with the host controller is implemented via two interrupt pins and the SPI, with data rates
of up to 10 Mb/s. Two dedicated pins are used for LED link and network activity indication.

This library is designed to simplify handling of the underlying hardware (ENC28J60). It works with any PIC32 with
integrated SPI and more than 4 Kb ROM memory. 38 to 40 MHz clock is recommended to get from 8 to 10 Mhz SPI
clock, otherwise PIC32 should be clocked by mNC28760 clock output due to its silicon bug in SPI hardware. If you try
lower PIC32 clock speed, there might be board hang or miss some requests.

SPI Ethernet library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Important:

- Global library variable SPT Ethernet userTimerSec is used to keep track of time for all client implementations
(ARP, DNS, UDP and DHCP). It is user responsibility to increment this variable each second in it's code if any of the
clients is used.

- For advanced users thereis  EthEnc28j60Private.mpas unitin Uses folder of the compiler with description of
all routines and global variables, relevant to the user, implemented in the SPI Ethernet Library.

- The appropriate hardware SPI module must be initialized before using any of the SPI Ethernet library routines.
Refer to SPI Library.

- For MCUs with multiple SPI modules it is possible to initialize them and then switch by using the
SPI Set Active () routine.

Library Dependency Tree

—| sp1 '
(S Ereme )|
L—»| string |
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External dependencies of SPI Ethernet Library

The following variables must be defined in all projects
using SPI Ethernet Library:

Description:

Example:

var SPI Ethernet CS : sbit at

var SPI Ethernet CS : sbit; sfr; external; ENC28J60 chip select pin. LATF1 bit;
. var SPI Ethernet RST sbit
var SPI Ethernet RST sbit; sfr; external; | ENC28J60 reset pin. S -
- - at LATFO bit;
var SPI Ethernet CS Direction sbit; sfr; | Direction of the ENC28J60 | var SPI Ethernet CS Direction
external; chip select pin. sbit at TRISF1 bit;
. . var SPI_Ethernet RST
var SPI Ethernet RST Direction sbit; sfr; | Direction of the ENC28J60 ‘ ‘ - - -
- — — K Direction sbit at TRISFO
external; reset pin. L -
bit;
The following routines m fined in all project e
'e ollowing rout -es ust be defined all proj Description: Examples:
using SPI Ethernet Library:
function SPI _Ethernet UserTCP (var remoteHost
array (4] of byte,
remotePort
vord, .
wer LocalPort Refer to the library example at
word TCP request handler. the bottom of this page for code
! implementation.
regLength plementatio
word)
var flags:
TEthPktFlags) word;
function SPI Ethernet UserUDP (var remoteHost
array (4] of byte,
remotePort
vord .
werdy destPort Refer to the library example at
word UDP request handler. the bottom of this page for code
, . .
reqLength implementation.
word,
var flags:
TEthPktFlags) word;
MikroElektronika

ang



mikroPascal PRO for PIC32

Library Routines

- SPI_Ethernet_Init

- SPI_Ethernet_Enable

- SPI_Ethernet_Disable

- SPI_Ethernet_doPacket

- SPI_Ethernet_putByte

- SPI_Ethernet_putBytes

- SPI_Ethernet_putString

- SPI_Ethernet_putConstString

- SPI_Ethernet_putConstBytes

- SPI_Ethernet_getByte

- SPI_Ethernet_getBytes

- SPI_Ethernet_UserTCP

- SPI_Ethernet_UserUDP

- SPI_Ethernet_setUserHandlers
- SPI_Ethernet_getlpAddress

- SPI_Ethernet_getGwlpAddress
- SPI_Ethernet_getDnslpAddress
- SPI_Ethernet_getlpMask

- SPI_Ethernet_confNetwork

- SPI_Ethernet_arpResolve

- SPI_Ethernet_sendUDP

- SPI_Ethernet_dnsResolve

- SPI_Ethernet_initDHCP

- SPI_Ethernet_doDHCPLeaseTime
- SPI_Ethernet_renewDHCP

SPI_Ethernet_Init

Prototype

procedure SPI Ethernet Init(mac: “byte; ip: “byte; fullDuplex: byte);

Description

This is MAC module routine. It initializes ENC28760 controller. This function is internaly splited into 2
parts to help linker when coming short of memory.

ENC28J60 controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x19AD.

- transmit buffer start address: 0x19AE.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to 60 bytes + CRC.

- maximum packet size is setto 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0C12 in half duplex mode.
- Collision window is set to 63 in half duplex mode to accomodate some ENC28J60 revisions silicon bugs.
- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).
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Parameters | - mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode) and 1 (full duplex
mode).

Returns Nothing.

Requires Global variables:

-SPI Ethernet Cs: Chip Select line

-SPI Ethernet CS Direction: Direction of the Chip Select pin
- SPI Ethernet RST: Resetline

- SPI Ethernet RST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See the SPIx_Init and SPIx_Init_Advanced routines.

Example // SPI Ethernet module connections

var SPI Ethernet RST : sbit at RFO bit;

var SPI Ethernet CS : sbit at RF1 bit;

var SPI Ethernet RST Direction : sbit at TRISFO bit;
var SPI Ethernet CS Direction : sbit at TRISF1 bit;

const SPI Ethernet HALFDUPLEX = 0;
const SPI Ethernet FULLDUPLEX = 1;

var
myMacAddr : array[6] of byte; // my MAC address
myIpAddr : array[4] of byte; // my IP addr
myMacAddr[0] := 0x00;
myMacAddr[1l] := 0x14;
myMacAddr [2] := O0xA5;
myMacAddr [3] := 0x76;
myMacAddr[4] := 0x19;
myMacAddr [5] := 0x3F;
myIpAddr[0] = 192;
myIpAddr[1l] = 168;
myIpAddr[2] = 1;
myIpAddr[3] = 60;

SPI1 Init();
SPI Ethernet Init (myMacAddr, myIpAddr, SPI Ethernet FULLDUPLEX) ;

Notes None.
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SPI_Ethernet_Enable

Prototype procedure SPI Ethernet Enable (enFlt : byte);

Description | This is MAC module routine. This routine enables appropriate network traffic on the ExnCc28760 module
by the means of it’s receive filters (unicast, multicast, broadcast, crc). Specific type of network traffic
will be enabled if a corresponding bit of this routine’s input parameter is set. Therefore, more than one
type of network traffic can be enabled at the same time. For this purpose, predefined library constants
(see the table below) can be ORed to form appropriate input value.

Advanced filtering available in the ENC28760 module such as Pattern Match, Magic Packet
and Hash Table can not be enabled by this routine. Additionaly, all filters, except CRC, enabled with
this routine will work in OR mode, which means that packet will be received if any of the enabled filters
accepts it.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC28760 module. The ENC28760 module
should be properly cofigured by the means of SPI_Ethernet_Init routine.

Parameters | - ent'1t: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/
receive filter:

Bit | Mask Description Predefined library const
o | oxo1 MAC Broadcast traffic/receive filter flag. When set, _SPI Ethernet
MAC broadcast traffic will be enabled. BROADCAST
1 | 0x02 MAC Multicast traffic/receive filter flag. When set, _SPI Ethernet
MAC multicast traffic will be enabled. MULTICAST
2 | 0x04 not used none
3 | 0x08 not used none
4 | 0x10 not used none
CRC check flag. When set, packets with invalid
S [0x20 CRC field will be discarded. SoRL Erhernet CRC
6 | 0x40 not used none
MAC Unicast traffic/receive filter flag. When set,
[ MAC unicast traffic will be enabled. ORL Erhernet UNICAST

Returns Nothing.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example SPI Ethernet Enable( SPI Ethernet CRC or SPI Ethernet UNICAST); // enable
CRC checking and Unicast traffic

Notes Advanced filtering available in the ENC287J60 module such as Pattern Match, Magic Packet
and Hash Table can not be enabled by this routine. Additionaly, all filters, except CRC, enabled with
this routine will work in OR mode, which means that packet will be received if any of the enabled filters
accepts it.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC28J60 module. The ENC28J60 module
should be properly cofigured by the means of SPI_Ethernet_Init routine.
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SPI_Ethernet_Disable

Prototype procedure SPI Ethernet Disable(disFlt : byte);

Description | This is MAC module routine. This routine disables appropriate network traffic on the ENC28760 module
by the means of it's receive filters (unicast, multicast, broadcast, crc). Specific type of network traffic
will be disabled if a corresponding bit of this routine’s input parameter is set. Therefore, more than one
type of network traffic can be disabled at the same time. For this purpose, predefined library constants
(see the table below) can be ORed to form appropriate input value.

Parameters | - disF1t: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/
receive filter:

Bit | Mask Description Predefined library const
o | ox01 MAC Broadcast traffic/receive filter flag. When set, _SPI Ethernet
MAC broadcast traffic will be disabled. BROADCAST
MAC Multicast traffic/receive filter flag. When set, MAC _SPI Ethernet
1 0x02 . . . .
multicast traffic will be disabled. MULTICAST
0x04 not used none
3 | 0x08 not used none
0x10 not used none
CRC check flag. When set, CRC check will be disabled
2 s S i . PI Ett R
5 | =20 and packets with invalid CRC field will be accepted. _oPL_Rrhernet CRe
6 | 0x40 not used none
MAC Unicast traffic/receive filter flag. When set, MAC _SPI Ethernet
7 0x80 R X . .
unicast traffic will be disabled. UNICAST

Returns Nothing.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example SPI Ethernet Disable( SPI Ethernet CRC | SPI Ethernet UNICAST); // disable
CRC checking and Unicast traffic

Notes Advanced filtering available in the ENC287J60 module such as Pattern Match, Magic Packet

and Hash Table can not be disabled by this routine.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC28760 module. The ENC28J60 module
should be properly cofigured by the means of SPI_Ethernet_Init routine.
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SPI_Ethernet_doPacket

Prototype function SPI Ethernet doPacket () : byte;
Description | This is MAC module routine. It processes next received packet if such exists. Packets are processed
in the following manner:
- ARP & ICMP requests are replied automatically.
- upon TCP request the SPI_Ethernet_UserTCP function is called for further processing.
- upon UDP request the SP1_Ethernet_UserUDP function is called for further processing.
Parameters | None.
Returns - 0 - upon successful packet processing (zero packets received or received packet processed
successfully).
- 1 - upon reception error or receive buffer corruption. ENC28J60 controller needs to be restarted.
- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).
- 3 - received IP packet was not IPv4.
- 4 - received packet was of type unknown to the library.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example while true do
begin
SPI Ethernet doPacket(); // process received packets
end;
Notes SPI Ethernet doPacket mustbe called as often as possible in user’s code.

SPI_Ethernet_putByte

Prototype procedure SPI Ethernet putByte(v : byte);
Description | This is MAC module routine. It stores one byte to address pointed by the current ENC28760 write
pointer (EWRPT).
Parameters | - v: value to store
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
data : byte;
ééiiEthernetiputByte(data); // put an byte into ENC28J60 buffer
Notes None.
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SPI_Ethernet_putBytes

Prototype procedure SPI Ethernet putBytes(ptr “byte; n : word);
Description | This is MAC module routine. It stores requested number of bytes into ENC28760 RAM starting from
current ENC28J60 write pointer (EWRPT) location.
Parameters | - pt r: RAM buffer containing bytes to be written into ENC28760 RAM.
- n: number of bytes to be written.
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
buffer : array[l7] of byte;
buffer := ‘mikroElektronika’;
SPI_Ethernet putBytes (buffer, 16); // put an RAM array into ENC28J60
buffer
Notes None.

SPI_Ethernet_putConstBytes

Prokﬂype procedure SPI Ethernet putConstBytes (const ptr “byte; n : word);
Description | This is MAC module routine. It stores requested number of const bytes into ENC287T60 RAM starting
from current ENC28760 write pointer (EWRPT) location.
Parameters | - ptr: const buffer containing bytes to be written into ENC28760 RAM.
- n: number of bytes to be written.
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example const
buffer : array[l7] of byte;
buffer := ‘mikroElektronika’;
SPI Ethernet putConstBytes (buffer, 16); // put a const array into ENC28J60
buffer
Notes None.
MikroElektronika
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SPI_Ethernet_putString

Prokﬂype function SPI_Ethernet_putString(ptr “byte) : word;
Description | This is MAC module routine. It stores whole string (excluding null termination) into ENC28760 RAM
starting from current ENC28.760 write pointer (EWRPT) location.
Parameters | - ptr: string to be written into ENC28760 RAM.
Returns Number of bytes written into ENC28760 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
buffer string[16];
bﬁffer := ‘mikroElektronika’;
ééiiEthernetiputString(buffer); // put a RAM string into ENC28J60 buffer
Notes None.

SPI_Ethernet_putConstString

Prototype function SPI Ethernet putConstString(const ptr “byte) : word;
Description | This is MAC module routine. It stores whole const string (excluding null termination) into ENC28760
RAM starting from current ENC28760 write pointer (EWRPT) location.
Parameters | - ptr: const string to be written into ENC28J60 RAM.
Returns Number of bytes written into EnC28760 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example const
buffer string([16];
buffer := ‘mikroElektronika’;
SPI_Ethernet putConstString(buffer); // put a const string into ENC28J60
buffer
Notes None.

SPI_Ethernet_getByte

Prototype function SPI Ethernet getByte() : byte;
Description | This is MAC module routine. It fetches a byte from address pointed to by current ENC28760 read
pointer (ERDPT).
Parameters | None.
Returns Byte read from ENC28J60 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
buffer : byte;
Eﬁffer := SPI Ethernet getByte(); // read a byte from ENC28J60 buffer
Notes None.
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SPI_Ethernet_getBytes

Prototype procedure SPI Ethernet getBytes(ptr “byte; addr : word; n : word);
Description | This is MAC module routine. It fetches equested number of bytes from ENC28760 RAM starting from
given address. If value of 0xFFFF is passed as the address parameter, the reading will start from
current ENC28J60 read pointer (ERDPT) location.
Parameters | - pt r: buffer for storing bytes read from ENC28760 RAM.
- addr: ENC28J60 RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
buffer: array([16] of byte;
SPI Ethernet getBytes (buffer, 0x100, 16); // read 16 bytes, starting from
address 0x100
Notes None.

SPI_Ethernet_UserTCP

Prototype function SPI Ethernet UserTCP (var remoteHost : array[4] of byte; remotePort,
localPort, reglength : word; war flags: TEthPktFlags) : word;

Description | This is TCP module routine. It is internally called by the library. The user accesses to the TCP request
by using some of the SPI_Ethernet_get routines. The user puts data in the transmit buffer by using
some of the SPI_Ethernet_put routines. The function must return the length in bytes of the TCP reply,
or 0 if there is nothing to transmit. If there is no need to reply to the TCP requests, just define this
function with return(0) as a single statement.

Parameters | - remoteHost: client’s IP address.

- remotePort: client's TCP port.

- localPort: port to which the request is sent.

- reqLength: TCP request data field length.

- flags: structure consisted of two bit fields :

Copy Code To Clipboard

type TEthPktFlags = record
canCloseTCP: boolean; // flag which closes socket
isBroadcast: boolean; // flag which denotes that the IP package has been

received via subnet broadcast address

end;

Returns - 0 - there should not be a reply to the request.

- Length of TCP reply data field - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example This function is internally called by the library and should not be called by the user’s code.

Notes The function source code is provided with appropriate example projects. The code should be adjusted
by the user to achieve desired reply.

MikroElektronika
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SPI_Ethernet_UserUDP

Prototype function SPI Ethernet UserUDP (var remoteHost : array[4] of byte; remotePort,
destPort, reqlength : word; wvar flags: TEthPktFlags) : word;

Description | This is UDP module routine. It is internally called by the library. The user accesses to the UDP request
by using some of the SPI_Ethernet_get routines. The user puts data in the transmit buffer by using
some of the SPI_Ethernet_put routines. The function must return the length in bytes of the UDP reply,
or 0 if nothing to transmit. If you don’t need to reply to the UDP requests, just define this function with
a return(0) as single statement.

Parameters | - remoteHost: client’s IP address.

- remotePort: client’s port.

- localport: port to which the request is sent.

- reqLength: UDP request data field length.

- flags: structure consisted of two bit fields :

Copy Code To Clipboard

type TEthPktFlags = record
canCloseTCP: boolean; // flag which closes socket (not relevant to UDP)
isBroadcast: boolean; // flag which denotes that the IP package has been

received via subnet broadcast address

end;

Returns - 0 - there should not be a reply to the request.

- Length of UDP reply data field - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example This function is internally called by the library and should not be called by the user’s code.

Notes The function source code is provided with appropriate example projects. The code should be adjusted
by the user to achieve desired reply.

SPI_Ethernet_setUserHandlers

Prototype |procedure SPI_Ethernet setUserHandlers (TCPHandler : "TSPI_Ethernet UserTCP;
UDPHandler *"TSPI Ethernet UserUDP);

Description | Sets pointers to User TCP and UDP handler function implementations, which are automatically called
by SPI Ethernet library.

Parameters | - TCPHandler: TCP request handler
- UbpPHandler: UDP request handler.

Returns Nothing.

Requires SPI_Ethernet_UserTCP and SPI_Ethernet_UserUDP have to be previously defined.

Example SPI Ethernet setUserHandlers (@SPI_Ethernet UserTCP, @SPI Ethernet
UserUDP) ;

Notes Since all libraries are built for SSA, SSA restrictions regarding function pointers dictate that modules
that use SPI_Ethernet_setUserHandlers must also be built for SSA.
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SPI_Ethernet_getlpAddress

Prototype function SPI Ethernet getIpAddress() : word;
Description | This routine should be used when DHCP server is present on the network to fetch assigned IP
address.
Parameters | None.
Returns Pointer to the global variable holding IP address.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
ipAddr : array[4] of byte; // user IP address buffer
memcpy (ipAddr, SPI Ethernet getIpAddress(), 4); // fetch IP address
Notes User should always copy the IP address from the RAM location returned by this routine into it's own IP
address buffer. These locations should not be altered by the user in any case!
Ethernet_getGwIpAddress
Prokﬁype function SPI Ethernet getGwIpAddress() : word;
Description | This routine should be used when DHCP server is present on the network to fetch assigned gateway
IP address.
Parameters | None.
Returns Pointer to the global variable holding gateway IP address.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
gwlIpAddr : array([4] of byte; // user gateway IP address buffer
memcpy (gwIpAddr, SPI Ethernet getGwIpAddress(), 4); // fetch gateway IP
address
Notes User should always copy the IP address from the RAM location returned by this routine into it's own

gateway IP address buffer. These locations should not be altered by the user in any case!

SPI|_Ethernet_getDnslpAddress

Prototype function SPI Ethernet getDnsIpAddress () : word;
Description | This routine should be used when DHCP server is present on the network to fetch assigned DNS IP
address.
Parameters | None.
Returns Pointer to the global variable holding DNS IP address.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
dnsIpAddr : array([4] of byte; // user DNS IP address buffer
memcpy (dnsIpAddr, SPI_Ethernet getDnsIpAddress(), 4); // fetch DNS server
address
Notes User should always copy the IP address from the RAM location returned by this routine into it's own
DNS IP address buffer. These locations should not be altered by the user in any case!
MikroElektronika

414



mikroPascal PRO for PIC32

SPI_Ethernet_getlpMask

Prototype

function SPI Ethernet getIpMask () : word;

Description

This routine should be used when DHCP server is present on the network to fetch assigned IP subnet
mask.

Parameters

None.

Returns

Pointer to the global variable holding IP subnet mask.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example

var
IpMask : array[4] of byte; // user IP subnet mask buffer

memcpy (IpMask, SPI Ethernet getIpMask(), 4); // fetch IP subnet mask

Notes

User should always copy the IP address from the RAM location returned by this routine into it's own IP
subnet mask buffer. These locations should not be altered by the user in any case!

SPI_Ethernet_confNetwork

Prototype

procedure SPI Ethernet confNetwork(var ipMask, gwIpAddr, dnsIpAddr
array (4] of byte);

Description

Configures network parameters (IP subnet mask, gateway IP address, DNS IP address) when DHCP
is not used.

Parameters

- ipMask: IP subnet mask.
- gwIpAddr gateway IP address.
- dnsIpAddr: DNS IP address.

Returns

Nothing.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example

var
ipMask : array[4] of byte; // network mask (for example

255.255.255.0)
gwIpAddr : array[4] of byte; // gateway (router) IP address
dnsIpAddr : array[4] of byte; // DNS server IP address
gwIpAddr([0]
gwIpAddr[1l]
gwIpAddr([2]
gwIpAddr[3]

192;
168;
20;
6;

dnsIpAddr[0]
dnsIpAddr[1]
dnsIpAddr[2]
dnsIpAddr [3]

192;
168;
20;

100;

ipMask[0]
ipMask([1]
ipMask[2]
ipMask([3]

255;
255;
255;
0;

SPI_Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr); // set network
configuration parameters

Notes

The above mentioned network parameters should be set by this routine only if DHCP module is not
used. Otherwise DHCP will override these settings.
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SPI_Ethernet_arpResolve

Prokﬂype function SPI Ethernet arpResolve (var ip array[4] of byte; tmax byte)
word;

Description | This is ARP module routine. It sends an ARP request for given IP address and waits for ARP reply. If
the requested IP address was resolved, an ARP cash entry is used for storing the configuration. ARP
cash can store up to 3 entries. For ARP cash structure refer to “eth enc28j60LibDef.h” header
file in the compiler’s Uses folder.

Parameters | - ip: IP address to be resolved.

- tmax: time in seconds to wait for an reply.

Returns - MAC address behind the IP address - the requested IP address was resolved.
- 0 - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example var

IpAddr array[4] of byte; // IP address

TpAddr[0] := 192;

IpAddr[0] := 168;

IpAddr[0] := 1;

IpAddr[0] := 1;

éfiiEthernetiarpResolve(IpAddr, 5); // get MAC address behind the above
IP address, wait 5 secs for the response

Notes The Ethernet services are not stopped while this routine waits for ARP reply. The incoming packets will
be processed normaly during this time.

SPI_Ethernet_sendUDP

Prokﬂype function SPI Ethernet sendUDP(var destIP array[4] of byte; sourcePort,
destPort word; pkt “byte; pktLen word) : byte;
Description | This is UDP module routine. It sends an UDP packet on the network.
Parameters | - dest1P: remote host IP address.
- sourcePort: local UDP source port number.
- destPort: destination UDP port number.
- pkt: packet to transmit.
- pktLen: length in bytes of packet to transmit.
Returns - 1 - UDP packet was sent successfully.
- 0 - otherwise.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
IpAddr array[4] of byte; // remote IP address
IpAddr[0] := 192;
IpAddr[0] := 168;
IpAddr[0] := 1;
IpAddr[0] := 1;
SPI_Ethernet sendUDP(IpAddr, 10001, 10001, ‘Hello’, 5); // send Hello
message to the above IP address, from UDP port 10001 to UDP port 10001
Notes None.
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SPI_Ethernet_dnsResolve

Prototype function SPI Ethernet dnsResolve(var host : string; tmax : byte) : word;
Description | This is DNS module routine. It sends an DNS request for given host name and waits for DNS reply. If
the requested host name was resolved, it's IP address is stored in library global variable and a pointer
containing this address is returned by the routine. UDP port 53 is used as DNS port.
Parameters | - host: host name to be resolved.
- tmax: time in seconds to wait for an reply.
Returns - pointer to the location holding the IP address - the requested host name was resolved.
- 0 - otherwise.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example var
remoteHostIpAddr : array([4] of byte; // user host IP address buffer
// SNTP server:
// Zurich, Switzerland: Integrated Systems Lab, Swiss Fed. Inst. of
Technology
// 129.132.2.21: swisstime.ethz.ch
// Service Area: Switzerland and Europe
memcpy (remoteHostIpAddr, SPI Ethernet dnsResolve ( ‘swisstime.ethz.ch’, 5),
4) ;
Notes The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will
be processed normaly during this time.
User should always copy the IP address from the RAM location returned by this routine into it's own
resolved host IP address buffer. These locations should not be altered by the user in any case!
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SPI_Ethernet_initDHCP

Prototype function SPI Ethernet initDHCP (tmax : byte) : byte;

Description | This is DHCP module routine. It sends an DHCP request for network parameters (IP, gateway, DNS
addresses and IP subnet mask) and waits for DHCP reply. If the requested parameters were obtained
successfully, their values are stored into the library global variables.

These parameters can be fetched by using appropriate library IP get routines:

- SPI_Ethernet_getlpAddress - fetch IP address.

- SPI_Ethernet_getGwlpAddress - fetch gateway IP address.

- SPI_Ethernet_getDnslpAddress - fetch DNS IP address.

- SPI_Ethernet_getlpMask - fetch IP subnet mask.

UDP port 68 is used as DHCP client port and UDP port 67 is used as DHCP server port.

Parameters | - tmax: time in seconds to wait for an reply.

Returns - 1 - network parameters were obtained successfully.

- 0 - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

Example .

SPI Ethernet initDHCP(5); // get network configuration from DHCP server,
wait 5 sec for the response

Notes The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will
be processed normaly during this time.

When DHCP module is used, global library variable SPT Ethernet userTimerSec isused to keep
track of time. It is user responsibility to increment this variable each second in it's code.

SPI_Ethernet_ doDHCPLeaseTime

Prokﬂype function SPI Ethernet doDHCPLeaseTime () : byte;
Description | This is DHCP module routine. It takes care of IP address lease time by decrementing the global lease
time library counter. When this time expires, it's time to contact DHCP server and renew the lease.
Parameters | None
Returns - 0 - lease time has not expired yet.
- 1 - lease time has expired, it's time to renew it.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example while true do
begin
if (SPTiEthernetidoDHCPLeaseTime() <> 0) then
begin
// it’s time to renew the IP address lease
end;
end;
Notes None.
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SPI_Ethernet_renewDHCP

Prototype function SPI_Ethernet_ renewDHCP(tmax : byte) : byte;

Description | This is DHCP module routine. It sends IP address lease time renewal request to DHCP server.

Parameters | - tmax: time in seconds to wait for an reply.

Returns - 1 - upon success (lease time was renewed).
- 0 - otherwise (renewal request timed out).
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
Example while true do
begin

if (SPI _Ethernet doDHCPLeaseTime () <> 0) then
begin
SPI_Ethernet renewDHCP(5); // it’s time to renew the IP address
lease, with 5 secs for a reply
end;

end;

Notes None.
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Library Example
This code shows how to use the Ethernet mini library:

- the board will reply to ARP & ICMP echo requests
- the board will reply to UDP requests on any port:
- returns the request in upper char with a header made of remote host IP & port number

- the board will reply to HTTP requests on port 80, GET method with pathnames:

- / will return the HTML main page

- /s will return board status as text string

- 1t0 ... /t7 will toggle RDO to RD7 bit and return HTML main page

- all other requests return also HTML main page.

Copy Code To Clipboard

program HTTP Demo;

{***********************************
* RAM variables
*}

// mE ehternet NIC pinout

var
SPI_Ethernet Rst : sbit at LATFO bit; // for writing to output pin always use latch
SPI_Ethernet CS : sbit at LATF1l bit; // for writing to output pin always use latch
SPI Ethernet Rst Direction : sbit at TRISFO bit;
SPI Ethernet CS Direction : sbit at TRISF1 bit;

// end ethernet NIC definitions

var myMacAddr : array([6] of byte; // my MAC address
myIpAddr : array([4] of byte; // my IP address
gwIpAddr : array([4] of byte; // gateway (router) IP address
ipMask : array|[4] of byte; // network mask (for example : 255.255.255.0)
dnsIpAddr : array([4] of byte; // DNS server IP address

{********k**********k****************k**************************

* ROM constant strings
*}

const httpHeader : string([30] = ‘HTTP/1.1 200 OK’+#10+’Content-type: ‘; // HITP
header
const httpMimeTypeHTML : string[11] = ‘text/html’+#10+#10; // HTML MIME type

const httpMimeTypeScript : string[l2]
const httpMethod : string[5] = ‘GET /';
{*

* web page, splited into 2 parts

* when coming short of ROM, fragmented data is handled more efficiently by linker
*

‘text/plain’ +#10+410; // TEXT MIME type

* this HTML page calls the boards to get 1its status, and builds itself with
javascript

*}
const indexPage : string[761] =
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‘<meta http-equiv="refresh” content="3;url=http://192.168.20.60">" +
‘<HTML><HEAD></HEAD><BODY>' +
‘<h1>PIC32 + ENC28J60 Mini Web Server</hl>’+
‘<a href=/>Reload</a>"+
‘<script src=/s></script>’+
‘<table><tr><td valign=top><table border=1 style="font-size:20px
;font-family: terminal ;”>'+
‘<tr><th colspan=2>ADC</th></tr>’+
‘<tr><td>ANO</td><td><script>document.write (ANO)</script></td></
tr>"+
‘<tr><td>AN1</td><td><script>document.write (AN1l)</script></td></
tr>"+
‘</table></td><td><table border=1 style="font-size:20px ;font-family:
terminal ;”>'+
‘<tr><th colspan=2>PORTB</th></tr>’+
‘<script>'+
‘var str,1i;’+
‘str=""; "+
Vfor (1i=2;1<10;i++) "+
‘{str+="<tr><td bgcolor=pink>BUTTON #”+i+”</td>";’+
‘1f (PORTB& (1<<1)) {str+="<td bgcolor=red>ON"; }’+
‘else {str+="<td bgcolor=#cccccc>0FF”; }'+
‘str+="</td></tr>"; '+
‘document.write (str);’+
‘</script>’;

const indexPage2 : string[466] =
‘</table></td><td>’+
‘<table border=1 style="font-size:20px ;font-family: terminal

>+
‘<tr><th colspan=3>PORTD</th></tr>’+
‘<script>'+
‘var str,i;’+
‘str="";"+
‘for (1=0;1<8;1i++) "+
‘{str+="<tr><td bgcolor=yellow>LED #”+i+”</td>";’'+
‘1f (PORTD& (1<<1)) {str+="<td bgcolor=red>ON";}’+
‘else {str+="<td bgcolor=#cccccc>0FF”; }'+
‘str+="</td><td><a href=/t”+i+”>Toggle</a></td></tr>";}’+
‘document.write (str);’+
‘</script>'+
‘</table></td></tr></table>’+
‘This is HTTP request #<script>document.write (REQ)</script></BODY></
HTML>' ;
var getRequest : array[l15] of byte; // HTTP request buffer
dyna : array[30] of char; // buffer for dynamic response
httpCounter : word; // counter of HTTP requests

{*******************************************

* user defined functions

*}
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{*
* this function is called by the library

* the user accesses to the HTTP request by successive calls to SPI Ethernet getByte()
* the user puts data in the transmit buffer by successive calls to SPI Ethernet

putByte ()

* the function must return the length in bytes of the HTTP reply, or 0 if nothing to

transmit
*
* if you don’t need to reply to HTTP requests,
* just define this function with a return(0) as single statement
*
*}
function SPI Ethernet UserTCP(var remoteHost : array([4] of byte;

remotePort, localPort, reglength : word; wvar flags:

TEthPktFlags) : word;
var 1 : word; // my reply length
bitMask : dword; // for bit mask
tmp: string[11]; // to copy const array to ram for memcmp
begin
result := 0;

// should we close tcp socket after response is sent?

// library closes tcp socket by default if canCloseTCP flag is not reset here

// flags.canCloseTCP := 0; // 0 - do not close socket
// otherwise - close socket

if (localPort <> 80) then // I listen only to web request on port 80
begin
result := 0;
exit;
end;

// get 10 first bytes only of the request, the rest does not matter here

for i := 0 to 9 do
getRequest[i] := SPI Ethernet getByte();
getRequest[i] := O;

// copy httpMethod to ram for use in memcmp routine
for i := 0 to 4 do
tmp[i] := httpMethod[i];

if (memcmp (@getRequest, @tmp, 5) <> 0) then // only GET method is supported here

begin
result := 0;
exit;
end;
Inc (httpCounter) ; // one more request done
if (getRequest[5] = ‘s’) then // if request path name starts with s,

store dynamic data in transmit buffer
begin

// the text string replied by this request can be interpreted as javascript

statements
// by browsers
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result := SPI Ethernet putConstString(@httpHeader) ; // HTTP header
result := result + SPI Ethernet putConstString (@GhttpMimeTypeScript),; // with
text MIME type

// add AN2 value to reply
WordToStr (ADC1 Get Sample (0), dyna);

tmp := ‘var ANO=';

result := result + SPI Ethernet putString(€tmp);
result := result + SPI Ethernet putString(@dyna);
tmp := ‘;’;

result := result + SPI Ethernet putString(@tmp);

// add AN3 value to reply
WordToStr (ADC1 Get Sample (1), dyna);

tmp := ‘var ANI1=’;

result := result + SPI Ethernet putString(€tmp);
result := result + SPI Ethernet putString(@dyna);
tmp := ‘;’;

result := result + SPI Ethernet putString(@tmp);

// add PORTB value (buttons) to reply

tmp := ‘var PORTB= ‘;

result := result + SPI Ethernet putString(@tmp);
WordToStr (PORTB, dyna);

result := result + SPI Ethernet putString(@dyna);
tmp := ‘;’;

result := result + SPI Ethernet putString(@tmp);

// add PORTD value (LEDs) to reply

tmp := ‘var PORTD= ‘;

result := result + SPI Ethernet putString(@tmp);
WordToStr (PORTD, dyna);

result := result + SPI Ethernet putString(@dyna);
tmp := ‘;’;

result := result + SPI Ethernet putString(@tmp);

// add HTTP requests counter to reply
WordToStr (httpCounter, dyna);
tmp := ‘var REQ= '
result := result + SPI Ethernet putString(€tmp);
result := result + SPI Ethernet putString(@dyna);
tmp := ‘;’;
result := result + SPI Ethernet putString(@tmp);
end
else
if (getRequest[5] = 't’) then // if request path name starts
with t, toggle PORTD (LED) bit number that comes after
begin
bitMask := 0;
if(isdigit (getRequest[6]) <> 0) then // 1f 0 <= bit number <= 9,
bits 8 & 9 does not exist but does not matter
begin
bitMask := getRequest[6] - ‘'07; // convert ASCII to integer
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bitMask := 1 shl bitMask; // create bit mask
LATD := PORTD xor bitMask; // toggle PORTD with xor operator
end;

end;

if (result = 0) then // what do to by default

begin
result := SPI Ethernet putConstString(@httpHeader) ; // HTTP header
result := result + SPI Ethernet putConstString (@httpMimeTypeHTML); // with HTML
MIME type
result := result + SPI Ethernet putConstString(@indexPage); // HTML page
first part
result := result + SPI Ethernet putConstString(@indexPageZ2) ; // HTML page
second part
end;
// return to the library with the number of bytes to transmit

end;

{ *

* this function is called by the library

* the user accesses to the UDP request by successive calls to SPI Ethernet getByte()

* the user puts data 1in the transmit buffer by successive calls to SPI Ethernet
putByte ()

* the function must return the length in bytes of the UDP reply, or 0 if nothing to
transmit

*

* if you don’t need to reply to UDP requests,

* just define this function with a return(0) as single statement
*

*}
function SPI Ethernet UserUDP(var remoteHost : array[4] of byte;
remotePort, destPort, regLength : word, var flags:
TEthPktFlags) : word;

var tmp : string[5];

begin
result := 0;
// reply is made of the remote host IP address in human readable format
byteToStr (remoteHost[0], dyna); // first IP address byte
dyna[3] := ‘.7,
byteToStr (remoteHost[1], tmp); // second
dyna[4] := tmp[0];
dyna[5] := tmp[1l];
dynal[6] := tmp[Z];
dynal[7] := ‘.7,
byteToStr(remoteHost[Z], tmp) ; // second
dynal[8] := tmp[O0];
dyna[9] := tmp[1l];
dyna[10] := tmp[2];
dyna[l1l] := '.’
byteToStr(remoteHost[B], tmp) ; // second
dyna[l12] := tmp[0];
dyna[l13] := tmp[1];
dyna[14] := tmp[2];
dyna[l15] := ‘:7; // add separator
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// then remote host port number
WordToStr (remotePort, tmp);

dyna[l6] := tmp[O0];
dyna[l7] := tmp[1];
dyna[18] := tmp[Z];
dyna[19] := tmp[3];
dyna[20] := tmp[4];
dyna[21] := ‘[';
WordToStr (destPort, tmp);,
dyna[22] := tmp[0];
dyna[23] := tmp[1l];
dyna[24] := tmp[Z2];
dyna[25] := tmp[3];
dyna[26] := tmp[4];
dynal[27] := ‘]’;
dyna[28] := 0;

// the total length of the request is the length of the dynamic string plus the text
of the request
result := 28 + reqlLength;

// puts the dynamic string into the transmit buffer
SPI Ethernet putBytes (@dyna, 28);

// then puts the request string converted into upper char into the transmit buffer
while (reqgLength <> (0) do

begin
SPI Ethernet putByte (SPI Ethernet getByte());
reqlLength := reqlLength - 1;
end;
// back to the library with the length of the UDP reply
end;
begin
CHECON := 0x32;
ADIPCFG := OxFFFC; // all digital but RBI (AN1) and RBO (ANO)
PORTB := 0;
TRISB := OxXFFFF; // set PORTB as input for buttons and adc
PORTD := 0;
TRISD := 0; // set PORTD as output,

ADC1 Init();
httpCounter := 0;

// set mac address

myMacAddr [0] := 0x00;
myMacAddr[1] := 0x14;
myMacAddr[2] := 0xA5;
myMacAddr[3] := 0x76;
myMacAddr[4] := 0x19;
myMacAddr [5] := 0x3F;
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// set IP address

myIpAddr[0] := 192;
myIpAddr[1l] := 168;
myIpAddr[2] := 20;
myIpAddr[3] := 60;

// set gateway address

gwIpAddr[0] := 192;
gwIpAddr([1] = 168;
gwIpAddr([2] := 20;
gwIpAddr[3] := 6;

// set dns address

dnsIpAddr([0] := 192;
dnsIpAddr([1] := 168;
dnsIpAddr([2] := 20;
dnsIpAddr([3] := 1;

// set subnet mask

ipMask|[0] ;= 255;
ipMask([1] ;= 255,
ipMask([Z] := 255,
ipMask[3] :=0;
{*
* starts ENC28J60 with
* reset bit on PORTC.BO
* CS bit on PORTC.BI
* my MAC & IP address
* full duplex
*

SPI2 Init Advanced( SPI MASTER, _SPI 8 BIT, 16,
_SPI SS DISABLE, SPI DATA SAMPLE MIDDLE, SPI CLK IDLE LOW, SPI_
IDLE 2 ACTIVE) ;

SPI Ethernet Init (myMacAddr, myIpAddr, SPI Ethernet FULLDUPLEX) ; // init
ethernet module
SPI Ethernet setUserHandlers (@SPI Ethernet UserTCP, @SPI Ethernet UserUDP); // set

user handlers

// dhcp will not be used here, so use preconfigured addresses
SPI_Ethernet_coanetwork(ipMask, gwIpAddr, dnsIpAddr);

while true do // do forever
begin
SPI Ethernet doPacket () ; // process incoming Ethernet packets
{*

* add your stuff here if needed
* SPI Ethernet doPacket () must be called as often as possible
* otherwise packets could be 1lost
*}
end;
end.
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SPI Ethernet ENC24J600 Library

The ENC24J600 is a stand-alone Ethernet controller with an industry standard Serial Peripheral Interface (SPI). It is
designed to serve as an Ethernet network interface for any controller equipped with SPI.

The ENC24J600 meets all of the IEEE 802.3 specifications applicable to 10Base-T and 100Base-TX Ethernet. It
incorporates a number of packet filtering schemes to limit incoming packets. It also provides an internal, 16-bit wide
DMA module for fast data throughput and hardware assisted IP checksum calculations. Communication with the host
controller is implemented via two interrupt pins and the SPI, with data rates of 10/100 Mb/s. Two dedicated pins are
used for LED link and network activity indication.

This library is designed to simplify handling of the underlying hardware (ENC24J600). It works with any PIC32 with
integrated SPI and more than 4 Kb ROM memory. 38 to 40 MHz clock is recommended to get from 8 to 10 Mhz SPI
clock, otherwise PIC32 should be clocked by ENC24J600 clock output due to its silicon bug in SPI hardware. If you try
lower PIC32 clock speed, there might be board hang or miss some requests.

SPI Ethernet ENC24J600 library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Important:

- Global library variable SPT Ethernet 247600 userTimerSec is used to keep track of time for all client
implementations (ARP, DNS, UDP and DHCP). It is user responsibility to increment this variable each second in it’s
code if any of the clients is used.

- For advanced users thereis  EthEnc247600Private.mpas unitin Uses folder of the compiler with description
of all routines and global variables, relevant to the user, implemented in the SPI Ethernet ENC24J600 Library.

- The appropriate hardware SPI module must be initialized before using any of the SPI Ethernet ENC24J600 library
routines. Refer to SPI Library.

- For MCUs with multiple SPI modules it is possible to initialize them and then switch by using the SPT set Active ()

routine.

Library Dependency Tree

— spI '
(S Eremer )|
L—»| String |
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External dependencies of SPI Ethernet ENC24J600 Library

The following variables must be defined
in all projects using SPI Ethernet | Description:
ENC24J600 Library:

Example:

var SPI_Ethernet 243600 _CS

sbit; sfr, external: ENC24J600 chip select pin.

LATF1 bit;

var SPI Ethernet 2437600 CS : sbit at

Direction : sbit; sfr; external; | selectpin.

var SPI_Ethernet 247600 _Cs_ | Direction of the ENC24J600 chip

var SPI Ethernet 243600 CS Direction
sbit at TRISF1 bit;

The following routines must be defined in all project using SPI Ethernet
ENC24J600 Library:

Description:

Example:

function SPI Ethernet 243600 UserTCP(var remoteHost
array[4] of byte,
remotePort : word,
localPort : word,
reglLength : word)
var flags: TEthj600PktFlags)
: word;

TCP request handler.

Refertothelibrary example
at the bottom of this page
for code implementation.

function SPI Ethernet 247600 UserUDP(var remoteHost
array (4] of byte,

remotePort : word,
destPort : word,
reqglength : word,

var flags: TEthj600PktFlags)

word;

UDP request handler.

Refertothe library example
at the bottom of this page
for code implementation.
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Library Routines

- SPI_Ethernet_24j600_Init

- SPI_Ethernet_24j600_Enable

- SPI_Ethernet_24j600_Disable

- SPI_Ethernet_24j600_doPacket

- SPI_Ethernet_24j600_putByte

- SPI_Ethernet_24j600_putBytes

- SPI_Ethernet_24j600_putString

- SPI_Ethernet_24j600_putConstString

- SPI_Ethernet_24j600_putConstBytes

- SPI_Ethernet_24j600_getByte

- SPI_Ethernet_24j600_getBytes

- SPI_Ethernet_24j600_UserTCP

- SPI_Ethernet_24j600_UserUDP

- SPI_Ethernet_24j600_getlpAddress

- SPI_Ethernet_24j600_getGwlpAddress
- SPI_Ethernet_24j600_getDnslpAddress
- SPI_Ethernet_24j600_getlpMask

- SPI_Ethernet_24j600_confNetwork

- SPI_Ethernet_24j600_arpResolve

- SPI_Ethernet_24j600_sendUDP

- SPI_Ethernet_24j600_dnsResolve

- SPI_Ethernet_24j600_initDHCP

- SPI_Ethernet_24j600_doDHCPLeaseTime
- SPI_Ethernet_24j600_renewDHCP
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SPI_Ethernet_24j600_Init

Prototype |procedure SPI_Ethernet 24j600_Init(mac: “byte; ip: “byte; fullDuplex:
configuration) ;

Description | This is MAC module routine. It initializes ENC24J600 controller. This function is internaly splited into 2
parts to help linker when coming short of memory.

ENC24J600 controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x19AD.

- transmit buffer start address: 0x19AE.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to 60 bytes + CRC.

- maximum packet size is setto 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 012 in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0C12 in half duplex mode.
- Collision window is set to 63 in half duplex mode to accomodate some ENC24 7600 revisions silicon bugs.
- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).

Parameters | - mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- configuration: ethernet negotiation, duplex and speed mode settings. For this purpose, predefined
library constants (see the list below) can be combined using logical AND to form appropriate value:

Description Predefined library const
Set Auto-negotiation SPI Ethernet 247600 AUTO NEGOTIATION
Set manual negotiation. SPI_Ethernet 24j600 MANUAL NEGOTIATION
Set Half duplex Mode SPI Ethernet 243600 HALFDUPLEX
Set Full duplex Mode SPI Ethernet 243600 FULLDUPLEX
Set transmission speed of 10Mbps SPI_Ethernet 243600_SPD10
Set transmission speed of 100Mbps SPI Ethernet 243600 SPD100
Note:

- It is advisable to use only the Auto-negotiation setting. If manual negotiation is used, then duplex and
speed mode setting must be set also.
- Duplex and speed mode may be set only when using manual negotiation.
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Returns Nothing.

Requires Global variables:

- SPI Ethernet 247600 Cs: Chip Select line

- SPI Ethernet 247600 CS Direction: Direction of the Chip Select pin
- SPI_Ethernet 2473600 RST: Resetline

- SPI Ethernet 247600 RST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See the SPIx_Init and SPIx_Init_Advanced routines.
Example // SPI Ethernet ENC24J600 module connections

var SPI Ethernet 2437600 CS : sbit at RF1 bit;

var SPI Ethernet 243600 CS Direction : sbit at TRISF1 bit;

var
myMacAddr : array[6] of byte; // my MAC address
myIpAddr : array[4] of byte; // my IP addr
myMacAddr [0] := 0x00;
myMacAddr[1] := 0x14;
myMacAddr [2] := 0xA5;
myMacAddr [3] := 0x76;
myMacAddr[4] := 0x19;
myMacAddr [5] := O0x3F;
myIpAddr [0] = 192;
myIpAddr[l] := 168;
myIpAddr[2] = 1;
myIpAddr [3] 1= 60;

SPI1 Init();

SPI Ethernet 247600 Init (myMacAddr, myIpAddr, SPI Ethernet 243600 MANUAL
NEGOTIATION and SPI_Ethernet_24j600_FULLDUPLEX and SPI_Ethernet_24j600_
SPD100) ;

Notes None.
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SPI_Ethernet_24j600_Enable

Prototype

procedure SPI Ethernet 24j600 Enable(enFlt : word);

Description

This is MAC module routine. This routine enables appropriate network traffic on the ExNCc247600
module by the means of it's receive filters (unicast, multicast, broadcast, crc). Specific type of network
traffic will be enabled if a corresponding bit of this routine’s input parameter is set. Therefore, more
than one type of network traffic can be enabled at the same time. For this purpose, predefined library
constants (see the table below) can be ORed to form appropriate input value.

Advanced filtering available in the ENC247600 module such as Pattern Match, Magic Packet
and Hash Table can not be enabled by this routine. Additionaly, all filters, except CRC, enabled with
this routine will work in OR mode, which means that packet will be received if any of the enabled filters
accepts it.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC247600 module. The ENC247600 module
should be properly cofigured by the means of SPT Ethernet 243600 Init routine.

Parameters

- enF1t: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/
receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive filter flag. When set, MAC _SPI Ethernet 243600
broadcast traffic will be enabled. BROADCAST

0 0x01

MAC Multicast traffic/receive filter flag. When set, MAC SPI Ethernet 247600

! V=02 multicast traffic will be enabled. MULTICAST

0x04 not used none

0x08 not used none

0x10 not used none

CRC check flag. When set, packets with invalid CRC field
will be discarded.

5 | 0x20 _SPI Ethernet 243600 _CRC

6 0x40 not used none

MAC Unicast traffic/receive filter flag. When set, MAC _SPI Ethernet 243600

7 080 unicast traffic will be enabled. UNICAST

Returns

Nothing.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example

SPI Ethernet 243j600 Enable( SPI Ethernet 24j600 CRCor SPI Ethernet 243j600
UNICAST),; // enable CRC checking and Unicast traffic

Notes

Advanced filtering available in the ENC247600 module such as Pattern Match, Magic Packet
and Hash Table can not be enabled by this routine. Additionaly, all filters, except CRC, enabled with
this routine will work in OR mode, which means that packet will be received if any of the enabled filters
accepts it.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC247600 module. The ENC247600 module
should be properly cofigured by the means of SPT Ethernet 247600 Init routine.
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SPI_Ethernet_24j600_Disable

Prototype procedure SPI Ethernet 243600 Disable(disFlt : word);

Description | This is MAC module routine. This routine disables appropriate network traffic on the ENC247600
module by the means of it’s receive filters (unicast, multicast, broadcast, crc). Specific type of network
traffic will be disabled if a corresponding bit of this routine’s input parameter is set. Therefore, more
than one type of network traffic can be disabled at the same time. For this purpose, predefined library
constants (see the table below) can be ORed to form appropriate input value.

Parameters | - disF1t: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/
receive filter:

Bit | Mask Description Predefined library const
o |oxo1 MAC Broadcast traffic/receive filter flag. When set, MAC SPI Ethernet 243600
broadcast traffic will be disabled. BROADCAST
1 002 MAC Multicast traffic/receive filter flag. When set, MAC _SPI Ethernet 243600
multicast traffic will be disabled. MULTICAST
0x04 not used none
0x08 not used none
0x10 not used none
CRC check flag. When set, CRC check will be disabled - ) P .
5 | 0x20 and packets with invalid CRC field will be accepted. SPI_Ethernet_243600_CRC
6 | 0x40 not used none
7 | oxs0 MAC Unicast traffic/receive filter flag. When set, MAC _SPI_Ethernet 243600_
unicast traffic will be disabled. UNICAST

Returns Nothing.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example SPI Ethernet 24j600 Disable( SPI Ethernet 2437600 CRC or _SPI
Ethernet 243600 UNICAST); // disable CRC checking and Unicast traffic

Notes Advanced filtering available in the ENC247600 module such as Pattern Match, Magic Packet

and Hash Table can not be disabled by this routine.

This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/
disabling receive/transmit logic or any other part of the ENC24 7600 module. The ENC247600 module
should be properly cofigured by the means of SPT Ethernet 247600 Init routine.

The ENC247600 module should be properly cofigured by the means of SPI_Ethernet_24j600_Init
routine.

MikroElektronika 434



mikroPascal PRO for PIC32

SPI_Ethernet_24j600_doPacket

Prototype function SPI Ethernet 243600 doPacket () : byte;
Description | This is MAC module routine. It processes next received packet if such exists. Packets are processed
in the following manner:
- ARP & ICMP requests are replied automatically.
- upon TCP request the SPI_Ethernet_24j600_UserTCP function is called for further processing.
- upon UDP request the SPI_Ethernet_24j600_UserUDP function is called for further processing.
Parameters | None.
Returns - 0 - upon successful packet processing (zero packets received or received packet
processed successfully).
- 1 - upon reception error or receive buffer corruption. ENC247600 controller needs to be restarted.
- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).
- 3 - received IP packet was not IPv4.
- 4 - received packet was of type unknown to the library.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example while true do
begin
SPI_Ethernet 243600 doPacket(); // process received packets
end;
Notes SPI Ethernet 247600 doPacket mustbe called as often as possible in user’s code.

SPI_Ethernet_24j600_putByte

Prototype procedure SPI Ethernet 247600 putByte(v : byte);
Description | This is MAC module routine. It stores one byte to address pointed by the current ENC247600 write
pointer (EWRPT).
Parameters | - v: value to store
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
data : byte;
ééiiEthernet724j6007putByte(data); // put an byte into ENC24J600 buffer
Notes None.
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SPI_Ethernet_24j600_putBytes

Prototype procedure SPI Ethernet 243600 putBytes (ptr “byte; n : word);
Description | This is MAC module routine. It stores requested number of bytes into mNC24.7600 RAM starting from
current ENC24.J600 write pointer (EWRPT) location.
Parameters | - pt r: RAM buffer containing bytes to be written into ENC24J600 RAM.
- n: number of bytes to be written.
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_lInit.
Example var
buffer : array([l7] of byte;
buffer := ‘mikroElektronika’;
SPI Ethernet 243600 putBytes (buffer, 16); // put an RAM array into
ENC24J600 buffer
Notes None.

SPI_Ethernet_24j600_putConstBytes

Prototype procedure SPI Ethernet 24j600 putConstBytes (const ptr “byte; n : word);
Description | This is MAC module routine. It stores requested number of const bytes into ENC24J600 RAM starting
from current ENC247600 write pointer (EWRPT) location.
Parameters | - ptr: const buffer containing bytes to be written into ENC247600 RAM.
- n: number of bytes to be written.
Returns Nothing.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example const
buffer : array([l7] of byte;
buffer := ‘mikroElektronika’;
SPI_Ethernet 243600 putConstBytes (buffer, 16); // put a const array into
ENC24J600 buffer
Notes None.
MikroElektronika
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SPI_Ethernet_24j600_putString

Prototype function SPI Ethernet 247600 putString(ptr : “byte) : word;
Description | This is MAC module routine. It stores whole string (excluding null termination) into ENC247600 RAM
starting from current ENC24.7600 write pointer (EWRPT) location.
Parameters | - ptr: string to be written into ENC247J600 RAM.
Returns Number of bytes written into ENC247600 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
buffer : string[l6];
Bﬁffer := ‘mikroElektronika’;
éﬁfﬁEthernet724j6007putString(buffer); // put a RAM string into ENC24J600
buffer
Notes None.

SPI_Ethernet_24j600_ putConstString

Prototype function SPI Ethernet 243600 putConstString(const ptr “byte) : word;
Description | This is MAC module routine. It stores whole const string (excluding null termination) into ENC247600
RAM starting from current ENC24 7600 write pointer (EWRPT) location.
Parameters | - ptr: const string to be written into ExNC247600 RAM.
Returns Number of bytes written into ENC247600 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example const
buffer string([16];
buffer := ‘mikroElektronika’;
SPI Ethernet 243600 putConstString(buffer); // put a const string into
ENC24J600 buffer
Notes None.

SPI_Ethernet_24j600_getByte

Prototype function SPI Ethernet 243600 getByte() : byte;
Description | This is MAC module routine. It fetches a byte from address pointed to by current ENC247600 read
pointer (ERDPT).
Parameters | None.
Returns Byte read from £NC247600 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
buffer : byte;
bﬁffer := SPI Ethernet 243600 getByte(); // read a byte from ENC24J600
buffer
Notes None.
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SPI_Ethernet_24j600_ getBytes

Prototype procedure SPI Ethernet 243600 getBytes (ptr “byte; addr word; n
word) ;

Description | This is MAC module routine. It fetches equested number of bytes from ENC24 7600 RAM starting from
given address. If value of 0xFFFF is passed as the address parameter, the reading will start from
current ENC24J600 read pointer (ERDPT) location.

Parameters | - pt r: buffer for storing bytes read from ENC247600 RAM.

- addr: ENC24J600 RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.

Returns Nothing.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example var

buffer: array([l16] of byte;
SPI Ethernet 243600 getBytes (buffer, 0x100, 16); // read 16 bytes, starting
from address 0x100

Notes None.

SPI_Ethernet 24j600_UserTCP

Prototype function SPI Ethernet 243600 UserTCP(var remoteHost array[4] of byte;
remotePort, localPort, reglength : word; wvar flags: TEthj600PktFlags) : word;

Description | This is TCP module routine. It is internally called by the library. The user accesses to the TCP request
by using some of the SPI_Ethernet_24j600_get routines. The user puts data in the transmit buffer by
using some of the SPI_Ethernet_24j600_put routines. The function must return the length in bytes of
the TCP reply, or 0 if there is nothing to transmit. If there is no need to reply to the TCP requests, just
define this function with return(0) as a single statement.

Parameters | - remotetost: client’s IP address.
- remotePort: client's TCP port.
- localport: port to which the request is sent.
- regLength: TCP request data field length.
- flags: structure consisted of two bit fields :
Copy Code To Clipboard
type TEthj600PktFlags = record

canCloseTCP: boolean; // flag which closes socket
isBroadcast: boolean; // flag which denotes that the IP package has been

received via subnet broadcast address
end;

Returns - 0 - there should not be a reply to the request.
- Length of TCP reply data field - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_lInit.

Example This function is internally called by the library and should not be called by the user’s code.

Notes The function source code is provided with appropriate example projects. The code should be adjusted
by the user to achieve desired reply.
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SPI_Ethernet_24j600_UserUDP

Prototype function SPI Ethernet 2437600 UserUDP(var remoteHost array([4] of byte;
remotePort, destPort, reglLength : word; wvar flags: TEthj600PktFlags) : word;
Description | This is UDP module routine. It is internally called by the library. The user accesses to the UDP request
by using some of the SPI_Ethernet_24j600_get routines. The user puts data in the transmit buffer by
using some of the SPI_Ethernet_24j600_put routines. The function must return the length in bytes of
the UDP reply, or 0 if nothing to transmit. If you don’t need to reply to the UDP requests, just define this
function with a return(0) as single statement.
Parameters | - remotetost: client’'s IP address.
- remotePort: client’s port.
- localPort: port to which the request is sent.
- reqLength: UDP request data field length.
- flags: structure consisted of two bit fields :
Copy Code To Clipboard
type TEthj600PktFlags = record
canCloseTCP: boolean; // flag which closes socket (not relevant to UDP)
isBroadcast: boolean; // flag which denotes that the IP package has been
received via subnet broadcast address
end;
Returns - 0 - there should not be a reply to the request.
- Length of UDP reply data field - otherwise.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example This function is internally called by the library and should not be called by the user’s code.
Notes The function source code is provided with appropriate example projects. The code should be adjusted

by the user to achieve desired reply.

SPI_Ethernet_24j600_getlpAddress

Prototype function SPI Ethernet 247600 getIpAddress() : word;

Description | This routine should be used when DHCP server is present on the network to fetch assigned IP
address.

Parameters | None.

Returns Pointer to the global variable holding IP address.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example var

ipAddr : array[4] of byte; // user IP address buffer
memcpy (ipAddr, SPI Ethernet 243600 getIpAddress(), 4); // fetch 1IP

address

Notes User should always copy the IP address from the RAM location returned by this routine into it's own IP
address buffer. These locations should not be altered by the user in any case!
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SPI_Ethernet_24j600_getGwlpAddress

Prototype function SPI Ethernet 247600 getGwIpAddress() : word;
Description | This routine should be used when DHCP server is present on the network to fetch assigned gateway
IP address.
Parameters | None.
Returns Pointer to the global variable holding gateway IP address.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
gwIpAddr : array([4] of byte; // user gateway IP address buffer
memcpy (gwIpAddr, SPI Ethernet 243600 getGwIpAddress(), 4); // fetch
gateway IP address
Notes User should always copy the IP address from the RAM location returned by this routine into it's own

gateway IP address buffer. These locations should not be altered by the user in any case!

SPI_Ethernet_24j600_getDnsIpAddress

Prototype function SPI Ethernet 243600 getDnsIpAddress () : word;
Description | This routine should be used when DHCP server is present on the network to fetch assigned DNS IP
address.
Parameters | None.
Returns Pointer to the global variable holding DNS IP address.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
dnsIpAddr : arrayl[4] of byte; // user DNS IP address buffer
memcpy (dnsIpAddr, SPI_Ethernet 243600 getDnsIpAddress(), 4); // fetch DNS
server address
Notes User should always copy the IP address from the RAM location returned by this routine into it's own
DNS IP address buffer. These locations should not be altered by the user in any case!
MikroElektronika
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SPI_Ethernet_24j600_getlpMask

Prototype

function SPI Ethernet 247600 getIpMask()

. word;

Description

This routine should be used when DHCP server is present on the network to fetch assigned DNS IP
address.

Parameters

None.

Returns

Pointer to the global variable holding IP subnet mask.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example

var

IpMask : array[4] of byte; // user IP subnet mask buffer

memcpy (IpMask, SPI_Ethernet 243600 getIpMask(), 4); // fetch IP subnet
mask

Notes

User should always copy the IP address from the RAM location returned by this routine into it's own IP
subnet mask buffer. These locations should not be altered by the user in any case!

SPI_Ethernet_24j600_confNetwork

Prototype

procedure SPI Ethernet 243600 confNetwork(var ipMask,
array[4] of byte);

gwIpAddr, dnsIpAddr

Description

Configures network parameters (IP subnet mask, gateway IP address, DNS IP address) when DHCP
is not used.

Parameters

- ipMask: IP subnet mask.
- gwIpAddr gateway IP address.
- dnsIpAddr: DNS IP address.

Returns

Nothing.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example

var
ipMask
255.255.255.0)
gwlpAddr : arrayl[4]
dnsIpAddr : array[4]

array[4] of byte; // network mask (for example

of byte;
of byte;

// gateway (router) IP address
// DNS server IP address

gwIpAddr([0]
gwIpAddr([1]
gwIpAddr([2]
gwIpAddr[3]
dnsIpAddr[0]
dnsIpAddr[1]
dnsIpAddr[2]
dnsIpAddr[3]
ipMask
ipMask

192;
168;
20;
6;

192;
168;
20;

100;

255;
255;
255;

(0]
[1]
ipMask[2]
ipMask[3] 0;

SPI Ethernet 243600 confNetwork (ipMask, gwIpAddr, dnsIpAddr);
network configuration parameters

//

set

Notes

The above mentioned network parameters should be set by this routine only if DHCP module is not
used. Otherwise DHCP will override these settings.
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SPI_Ethernet_24j600_arpResolve

Prototype function SPI Ethernet 247600 arpResolve (var ip array[4] of byte; tmax
byte) word;

Description | This is ARP module routine. It sends an ARP request for given IP address and waits for ARP reply. If
the requested IP address was resolved, an ARP cash entry is used for storing the configuration. ARP
cash can store up to 3 entries.

Parameters | - ip: IP address to be resolved.

- tmax: time in seconds to wait for an reply.

Returns - MAC address behind the IP address - the requested IP address was resolved.
- 0 - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example var

IpAddr array[4] of byte; // IP address

IpAddr[0] := 192;

IpAddr[0] = 168;

IpAddr[0] := 1;

IpAddr[0] := 1;

ééiiEthernet724j6007arpResolve(IpAddr, 5); // get MAC address behind the
above IP address, wait 5 secs for the response

Notes The Ethernet services are not stopped while this routine waits for ARP reply. The incoming packets will

be processed normaly during this time.

SPI_Ethernet_24j600_sendUDP

Prototype function SPI Ethernet 243600 sendUDP(var destIP array[4] of Dyte;
sourcePort, destPort : word; pkt “byte; pktLen : word) : byte;
Description | This is UDP module routine. It sends an UDP packet on the network.
Parameters | - dest1P: remote host IP address.
- sourcePort: local UDP source port number.
- destPort: destination UDP port number.
- pkt: packet to transmit.
- pktLen: length in bytes of packet to transmit.
Returns - 1 - UDP packet was sent successfully.
- 0 - otherwise.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
IpAddr array[4] of byte; // remote IP address
IpAddr[0] = 192;
IpAddr[0] = 168;
IpAddr[0] = 1;
IpAddr[0] = 1;
SPI_Ethernet 243600 sendUDP(IpAddr, 10001, 10001, ‘Hello’, 5); // send
Hello message to the above IP address, from UDP port 10001 to UDP port
10001
Notes None.
MikroElektronika
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SPI_Ethernet _24j600_dnsResolve

Prototype function SPI Ethernet 247600 dnsResolve(var host : string; tmax : byte)
word;

Description | This is DNS module routine. It sends an DNS request for given host name and waits for DNS reply. If
the requested host name was resolved, it's IP address is stored in library global variable and a pointer
containing this address is returned by the routine. UDP port 53 is used as DNS port.

Parameters | - host: host name to be resolved.

- tmax: time in seconds to wait for an reply.
Returns - pointer to the location holding the IP address - the requested host name was resolved.
- 0 - otherwise.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example var
remoteHostIpAddr : array[4] of byte; // user host IP address buffer
// SNTP server:
// Zurich, Switzerland: Integrated Systems Lab, Swiss Fed. Inst. of
Technology
// 129.132.2.21: swisstime.ethz.ch
// Service Area: Switzerland and Europe
memcpy (remoteHostIpAddr, SPI Ethernet 243600 dnsResolve(‘swisstime.ethz.
ch’, 5), 4);

Notes The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will
be processed normaly during this time.

User should always copy the IP address from the RAM location returned by this routine into it's own
resolved host IP address buffer. These locations should not be altered by the user in any case!
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SPI_Ethernet_24j600_initDHCP

Prototype function SPI Ethernet 243600 initDHCP (tmax : byte) : byte;

Description | This is DHCP module routine. It sends an DHCP request for network parameters (IP, gateway, DNS
addresses and IP subnet mask) and waits for DHCP reply. If the requested parameters were obtained
successfully, their values are stored into the library global variables.

These parameters can be fetched by using appropriate library IP get routines:

- SPI_Ethernet_24j600_getlpAddress - fetch IP address.

- SPI_Ethernet_24j600_getGwlIpAddress - fetch gateway IP address.

- SPI_Ethernet_24j600_getDnslpAddress - fetch DNS IP address.

- SPI_Ethernet_24j600_getlpMask - fetch IP subnet mask.

UDP port 68 is used as DHCP client port and UDP port ¢7 is used as DHCP server port.

Parameters | - tmax: time in seconds to wait for an reply.

Returns - 1 - network parameters were obtained successfully.

- 0 - otherwise.

Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.

Example .

SPI Ethernet 243600 initDHCP(5); // get network configuration from DHCP
server, wait 5 sec for the response

Notes The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will
be processed normaly during this time.

When DHCP module is used, global library variable sPT Ethernet 247600 userTimerSec is
used to keep track of time. It is user responsibility to increment this variable each second in it's code.
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SPI_Ethernet_24j600_doDHCPLeaseTime

Prototype function SPI Ethernet 247600 doDHCPLeaseTime () : byte;
Description | This is DHCP module routine. It takes care of IP address lease time by decrementing the global lease
time library counter. When this time expires, it's time to contact DHCP server and renew the lease.
Parameters | None.
Returns - 0 - lease time has not expired yet.
- 1 - lease time has expired, it's time to renew it.
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example while true do
begin
if (SPI Ethernet 243600 doDHCPLeaseTime () <> 0) then
begin
// 1it’s time to renew the IP address lease
end;
end;
Notes None.

SPI_Ethernet_24j600_renewDHCP

Prototype function SPI Ethernet 247600 renewDHCP(tmax : byte) : byte;
Description | This is DHCP module routine. It sends IP address lease time renewal request to DHCP server.
Parameters | - tmax: time in seconds to wait for an reply.
Returns - 1 - upon success (lease time was renewed).
- 0 - otherwise (renewal request timed out).
Requires Ethernet module has to be initialized. See SPI_Ethernet_24j600_Init.
Example while true do
begin
if (SPI_Ethernet 247600 doDHCPLeaseTime () <> 0) then
begin
SPI _Ethernet 243600 renewDHCP(5); // it’s time to renew the IP
address lease, with 5 secs for a reply
end;
end;
Notes None.
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SPI Graphic Lcd Library

mikroPascal PRO for PIC32 provides a library for operating Graphic Lcd 128x64 (with commonly used Samsung
KS108/KS107 controller) via SPI interface.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Important:

- When using this library with PIC32 family MCUs be aware of their voltage incompatibility with certain number of
Samsung KS0108 based Glcd modules.
So, additional external power supply for these modules may be required.

- Library uses the SPI module for communication. The user must initialize the appropriate SPI module before using
the SPI Glcd Library.

- For MCUs with multiple SPI modules it is possible to initialize all of them and then switch by using the sPT set

Active () routine. See the SPI Library functions.

- This Library is designed to work with the mikroElektronika’s Serial Lcd/Glcd Adapter Board pinout, see schematic at
the bottom of this page for details..

Library Dependency Tree

r—*| Port Expander ]
SFI Graphic Led |
—*| Glcd Fonts

External dependencies of SPI Lcd Library
The implementation of SPI Lcd Library routines is based on Port Expander Library routines.

External dependencies are the same as Port Expander Library external dependencies.

Library Routines
Basic routines:

- SPI_Glcd_lInit

- SPI_Glcd_Set_Side

- SPI_Glcd_Set_Page

- SPI_Glcd_Set_X

- SPI_Glcd_Read_Data
- SPI_Glcd_Write_Data

Advanced routines:

- SPI_Gilcd_Fill

- SPI_Glcd_Dot

- SPI_Glcd_Line

- SPI_Glcd_V_Line
- SPI_Glcd_H_Line
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- SPI_Glcd_Rectangle

- SPI_Glcd_Rectangle_Round_Edges
- SPI_Glcd_Rectangle_Round_Edges_Fill
- SPI_Glcd_Box

- SPI_Glcd_Circle

- SPI_Glcd_Circle_Fill

- SPI_Glcd_Set_Font

- SPI_Glcd_Write_Char

- SPI_Glcd_Write_Text

- SPI_Glcd_Image

- SPI_Glcd_Partiallmage

SPI_Gled_Init

Prototype procedure SPI Glcd Init (DeviceAddress : byte);

Description | Initializes the Glcd module via SPI interface.

Parameters | - DeviceAddress: SPl expander hardware address, see schematic at the bottom of this page

Returns Nothing.

Requires Global variables:

- SPExpanderCs: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.

The SPI module needs to be initialized. See SPIx_Init and SPIx_Init_Advanced routines.

Example // Port Expander module connections
var SPExpanderRST : sbit at LATFO bit;
SPExpanderCS : sbit at LATF1 bit;
SPExpanderRST Direction : sbit at TRISFO bit;
SPExpanderCS Direction : sbit at TRISF1 bit;

// End Port Expander module connections

// If Port Expander Library uses SPI module
SPI1 Init(); // Initialize SPI module used with PortExpander
SPI Glcd Init (0);

Notes None.
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SPI_Glcd_Set_Side

Prototype procedure SPI Glcd Set Side(x pos : byte);

Description | Selects Glcd side. Refer to the Glcd datasheet for detail explanation.

Parameters | - x pos: position on x-axis. Valid values: 0..127
The parameter x pos specifies the Glcd side: values from 0 to 63 specify the left side, values from 64
to 127 specify the right side.

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example The following two lines are equivalent, and both of them select the left side of Glcd:
SPI Glcd Set side(0);
SPI Glcd Set Side(10);

Notes For side, x axis and page layout explanation see schematic at the bottom of this page.

SPI_Glcd_Set _Page

Prototype procedure SPI Glcd Set Page (page : byte);

Description | Selects page of Glcd.

Returns - page: page number. Valid values: 0..7

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example SPI Glcd Set Page(5);

Notes For side, x axis and page layout explanation see schematic at the bottom of this page.

SPI_Glcd_Set X

Prototype |procedure SPI Glcd Set X (x pos : byte);

Description | Sets x-axis position to x pos dots from the left border of Glcd within the selected side.

Parameters | - x pos: position on x-axis. Valid values: 0..63

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example SPI_Glcd Set X (25);

Notes For side, x axis and page layout explanation see schematic at the bottom of this page.
MikroElektronika
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SPI_Glcd Read Data

Prototype function SPI Glcd Read Data() : byte;

Description | Reads data from the current location of Glcd memory and moves to the next location.

Returns One byte from Glcd memory.

Requires Glcd needs to be initialized for SPI communication, see SPI1_Glcd_Init routine.
Glcd side, x-axis position and page should be set first. See the functions SPI_Glcd_Set_Side, SPI_
Glcd_Set_X, and SPI_Glcd_Set_Page.

Parameters | None.

Example var data : byte;
data := SPI Glcd Read Data();

Notes None.

SPI_Glcd_Write_Data

Prototype procedure SPI Glcd Write Data(data_ : byte);

Description | Writes one byte to the current location in Glcd memory and moves to the next location.

Parameters | - data : data to be written

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Glcd side, x-axis position and page should be set first. See the functions SPI_Glcd_Set_Side, SPI_
Glcd_Set_X, and SPI_Glcd_Set_Page.

Example var data : byte;
SPI Glcd Write Data(data );

Notes None.
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SPI_Glcd_Fil

Prototype

procedure SPI Glcd Fill (pattern : byte);

Description

Fills Glcd memory with byte pattern.
To clear the Gled screen, use SPI Glcd Fill (0).
To fill the screen completely, use SPT Glcd Fill (0xEF).

Parameters | - pattern: byte to fill Glcd memory with
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example // Clear screen
SPI Glcd Fill(0);
Notes None.
SPI_Glcd_ Dot
Prototype procedure SPI Glcd Dot (x pos, y pos, color : byte);
Description | Draws a dot on Glcd at coordinates (x_pos, vy pos).
Parameters |- x pos: x position. Valid values: 0..127
-y _pos:y position. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the dot state: 0 clears dot, 1 puts a dot, and 2 inverts dot state.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example // Invert the dot in the upper left corner
SPI Glcd Dot (0, 0, 2);
Notes For x and y axis layout explanation see schematic at the bottom of this page.
MikroElektronika
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SPI_Glecd _Line
Prototype procedure SPI Glcd Line(x start, y start, x end, y end integer; color
byte);
Description | Draws a line on Glcd.
Parameters:
Parameters | - x start: x coordinate of the line start. Valid values: 0..127
-y start:y coordinate of the line start. Valid values: 0..63
- x_end: x coordinate of the line end. Valid values: 0..127
- y_end:y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
Parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example // Draw a line between dots (0,0) and (20,30)
SPI Glcd Line(0, 0, 20, 30, 1);
Notes None.
SPI_Glcd_V_Line
Prototype procedure SPI Glcd V Line(y start, y end, x pos, color : byte);
Description | Draws a vertical line on Glcd.
Parameters |- v start:y coordinate of the line start. Valid values: 0..63
- yv_end:y coordinate of the line end. Valid values: 0..63
- x_pos: x coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
Parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI1_Glcd_Init routine.
Example // Draw a vertical line between dots (10,5) and (10,25)
SPI Glcd V Line(5, 25, 10, 1);
Notes None.
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SPI _Glecd_H Line

Prototype procedure SPI Glcd H Line(x start, x end, y pos, color : byte);
Description | Draws a horizontal line on Glcd.
Parameters | - x start: x coordinate of the line start. Valid values: 0..127

- x_end: x coordinate of the line end. Valid values: 0..127

- v _pos:y coordinate of horizontal line. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example // Draw a horizontal line between dots (10,20) and (50,20)

SPI Glcd H Line (10, 50, 20, 1);
Notes None.

SPI_Glcd_Rectangle

Prototype procedure SPI Glcd Rectangle(x upper left, y upper left, x bottom right,
y bottom right, color : byte);

Description | Draws a rectangle on Glcd.

Parameters | - x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
- x_bottom right:x coordinate of the lower right rectangle corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts
each dot.

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example // Draw a rectangle between dots (5,5) and (40,40)
SPI Glcd Rectangle(5, 5, 40, 40, 1);

Notes None.
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SPI_Glcd_Rectangle_Round_Edges

Prototype procedure SPI Glcd Rectangle Round Edges (x upper left byte; y upper left
byte; x bottom right byte; y bottom right byte; radius byte; color
byte);
Description | Draws a rounded edge rectangle on Glcd.
Parameters | - x_upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
-x _bottom right:x coordinate of the lower right rectangle corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63
- round_radius: radius of the rounded edge.
- color: color parameter. Valid values: 0..2
Returns Nothing.
Requires Glcd needs to be initialized, see SPI_Glcd_lInit routine.
Example // Draws a rounded edge rectangle between dots (5,5) and (40,40) with
radius
SPI Glcd Rectangle Round Edges (5, 5, 40, 40, 12, 1);

Notes None.

SPI_Glcd_Rectangle Round_Edges_Fill

Prototype |procedure SPI_Glcd Rectangle Round Edges Fill (x_upper_ left : byte; y upper
left byte; x bottom right byte; y bottom right byte; radius byte;
color byte) ;

Description | Draws a filled rounded edge rectangle on Glcd with color.

Parameters | - x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127

-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63

-x bottom right:x coordinate of the lower right rectangle corner. Valid values: 0..127

-y bottom right:y coordinate of the lower right rectangle corner. Valid values: 0..63

- round_radius: radius of the rounded edge

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts
each dot.

Returns Nothing.

Requires Glcd needs to be initialized, see SPI_Glcd_Init routine.

Exan“ﬂe // Draws a filled rounded edge rectangle between dots (5,5) and (40,40) with

the edge radius of 12
SPI Glcd Rectangle Round Edges (5, 5, 40, 40, 12, 1);
Notes None.
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SPI_Glcd_Box

Prototype procedure SPI Glcd Box(x upper left, y upper left, x bottom right, vy
bottom right, color byte) ;

Description | Draws a box on Glcd.

Parameters | - x upper left:x coordinate of the upper left box corner. Valid values: 0..127
-y upper left:y coordinate of the upper left box corner. Valid values: 0..63
- x_bottom right:x coordinate of the lower right box corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2 inverts each dot.

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example // Draw a box between dots (5,15) and (20,40)
SPI_Glcd Box (5, 15, 20, 40, 1);

Notes None.

SPI_Glcd_Circle

Prototype procedure SPI Glcd Circle(x center, y center, radius integer; color
byte);

Description | Draws a circle on Glcd.

Parameters | - x _center: x coordinate of the circle center. Valid values: 0..127

- v _center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size
- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black, and 2 inverts each dot.

Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SP1_Glcd_Init routine.
Example // Draw a circle with center in (50,50) and radius=10
SPI Glcd Circle (50, 50, 10, 1);
Notes None.
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SPI_Glcd_Circle _Flll

Prototype procedure SPI Glcd Circle Fill(x center : integer; y center : integer;
radius : integer; color : byte);
Description | Draws a filled circle on Glcd.
Parameters | - x _center: x coordinate of the circle center. Valid values: 0..127
-y _center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the circle : 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Example // Draw a circle with center in (50,50) and radius=10
SPI Glcd Circle Fill(50, 50, 10, 1);
Notes None.
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SPI_Glcd_Set _Font

Prototype

procedure SPI Glcd Set Font (activeFont: LongInt; aFontWidth, aFontHeight
byte; aFontOffs : word);

Description

Sets font that will be used with SPI_Glcd_Write_Char and SPI_Glcd_Write_Text routines.

Parameters

None.

Returns

- activeFont: font to be set. Needs to be formatted as an array of char

- aFontiWidth: width of the font characters in dots.

- aFontHeight: height of the font characters in dots.

- aFontOf fs: number that represents difference between the mikroPascal PRO for PIC32 character
set and regular ASCII set (eg. if ‘A’ is 65 in ASCII character, and ‘A’ is 45 in the mikroPascal PRO for
PIC32 character set, aFontOffs is 20). Demo fonts supplied with the library have an offset of 32, which
means that they start with space.

The user can use fonts given in the file  Lib GLCDFonts file located in the Uses folder or create
his own fonts.

List of supported fonts:

-Font Glcd System3x5
-Font Glcd Systembx7
-Font Glcd 5x7

-Font Glcd Character8x7

For the sake of the backward compatibility, these fonts are supported also:

- System3x5 (equivalentto Font Glcd System3x5)

- FontSystem5x7 v2 (equivalentto Font Glcd Systemb5x7)
- font5x7 (equivalentto Font Glcd 5x7)

- Character8x7 (equivalentto Font Glcd Character8x7)

Requires

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example

// Use the custom 5x7 font “myfont” which starts with space (32):
SPI Glcd Set Font (myfont, 5, 7, 32);

Notes

None.
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SPI_Glcd_Write_Char

Prototype procedure SPI Glcd Write Char (chrl, x pos, page num, color : byte);
Description | Prints character on Glcd.
Parameters | - chr1: character to be written
- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid values: 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the character: 0 white, 1 black, and 2 inverts each
dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Use the SPI_Glcd_Set_Font to specify the font for display; if no font is specified, then the default
Font Glcd System5x7 font supplied with the library will be used.
Example // Write character 'C’ on the position 10 inside the page 2:
SPI Glcd Write Char(‘C’, 10, 2, 1);
Notes For x axis and page layout explanation see schematic at the bottom of this page.

SPI_Glcd_Write_Text

Prototype procedure SPI Glcd Write Text (var text: array[40] of char; x pos, page num,
color : byte);
Description | Prints text on Glcd.
Parameters | - text: text to be written
- x_pos: text starting position on x-axis.
- page num: the number of the page on which text will be written. Valid values: 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2 inverts each dot.
Returns Nothing.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.
Use the SPI_Glcd_Set_Font to specify the font for display; if no font is specified, then the default
Font Glcd System5x7 font supplied with the library will be used.
Example // Write text “Hello world!” on the position 10 inside the page 2:
SPI Glcd Write Text (“Hello world!”, 10, 2, 1);
Notes For x axis and page layout explanation see schematic at the bottom of this page.
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SPI_Glcd_Image

Prototype procedure SPI Glcd Image (const image: “byte);

Description | Displays bitmap on Glcd.

Parameters | - image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC32 pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example // Draw image myﬁimage on Glcd
SPI Glcd Image (my image);

Notes Use the mikroPascal PRO for PIC32 integrated Glcd Bitmap Editor, Tools > Glcd Bitmap Editor, to
convert image to a constant array suitable for displaying on Glcd.

SPI_Glcd_Partiallmage

Prototype procedure SPI Glcd PartiallImage(x left, y top, width, height, picture
width, picture height : word; const image “byte) ;

Description | Displays a partial area of the image on a desired location.

Parameters | - x _1eft: x coordinate of the desired location (upper left coordinate).
- y_top:y coordinate of the desired location (upper left coordinate).
- width: desired image width.
- height: desired image height.
- picture width: width of the original image.
-picture height: height of the original image.
- image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12). Original image size is 16x32.
SPI Glcd Partiallmage (10, 12, 10, 15, 16, 32, @image);

Notes Use the mikroPascal PRO for PIC32 integrated Glcd Bitmap Editor, Tools > Glcd Bitmap Editor, to
convert image to a constant array suitable for displaying on Glcd.
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Library Example

The example demonstrates how to communicate to KS0108 Glcd via the SPI module, using serial to parallel convertor

MCP23S17.
Copy Code To Clipboard

program SPI_Glecd;

// Port Expander module connections
var SPExpanderRST sbit at LATD8 bit;
SPExpanderCS sbit at LATDY9 bit;

SPExpanderRST Direction
SPExpanderCS Direction
// End Port Expander module

var someText
counter

array[20] of
: byte;

procedure Delay2S;

begin
Delay ms(2000) ;
end;
begin
CHECON := 0x32;
AD1PCFG := OxFFFEF;

// 1If Port Expander Library

// Initialize SPI module used with PortExpander

sbit at TRISD8 bit;
sbit at TRISD9 bit;
connections

char;

uses SPI2 module

SPI2_Init Advanced(_SPI_MASTER,_ SPI_8 BIT,
MIDDLE, SPI _CLK_IDLE . LOW, SPI ACTIVE 2 IDLE)

SPI_Gled_Init(0);
SPI_Glcd Fill (0x00);

while TRUE do
begin

SPI_Glcd Image (@truck_bmp) ;

Delay2s () ; Delay2s();
SPI Glcd f£ill (0x00) ;

SPI:Clcd:?artialImage(0,0,68,30,128,64,@truck_bmp);

Delay ms(500) ;

// Configure AN pins as digital

_SPI_SS_DISABLE, SPI_DATA SAMPLE

//
//

//

//
//

SPI_Glcd PartialImage(24,16,68,30,128,64,@truck bmp) ;

Delay ms (500) ;

SPI_Glcd PartialImage (56,34,68,30,128,64,@truck bmp);

Delay25(), Delay2s() ;
SPI_Glcd Fill (0x00);

SPI_Glcd Box(62,40,124,56,1);
SPI_Glcd Rectangle(5,5,84,35,1);

Delay ms(1000) ;

//

//
//

SPI_Glcd Rectangle Round Edges(2,2,87,38,7,1);

Delay ms (1000) ;

SPI_Glcd Rectangle Round Edges_Fill(8,8,81,32,12,1);

Delay ms (1000) ;
SPI_Glcd Line(0, O,
Delay2s() ;

127,

63, 1);

//

Initialize Glcd via SPI
Clear Glcd

Draw image

Clear GLCD
Partial image

Clear GLCD

Draw box
Draw rectangle

Draw line
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counter := 5;

while (counter <= 59) do
begin
Delay ms (250);
SPI Glcd V Line(2, 54, counter, 1);
SPI Glcd H Line(2, 120, counter, 1);
Counter := counter + 5;
end;

Delay2S();

SPI Glcd Fill(0x00);

SPI Glcd Set Font (@Font Glcd Character8x7, 8,
“Character8x7”

SPI Glcd Write Text(‘mikroE’, 1, 7, 2);

for counter := 1 to 10 do
SPI Glcd Circle(63,32, 3*counter, 1);
Delay2S();

SPI_Glcd_Circle_Fill(63,32, 30, 1);
Delay2S();

SPI Glcd Box (10,20, 70,63, 2);
Delay2s();

SPI Glcd Fill (0xFF);

SPI Glcd Set Font (GFont Glcd Character8x7, 8§,
someText := '‘8x7 Font’;

SPI Glcd Write Text (someText, 5, 0, 2);
Delay2s () ;

SPI Glcd Set Font (GFont Glcd System3x5, 3, 5,
someText := ‘3X5 CAPITALS ONLY';

SPI Glcd Write Text (someText, 60, 2, 2);
Delay2s () ;

SPI Glcd Set Font (GFont Glcd Systembx7, 5, 7,
someText := '‘5x7 Font’;

SPI Glcd Write Text (someText, 5, 4, 2);
Delay2s () ;

SPI_Glcd_Set Font (@Font Gled 5x7, 5, 7, 32);
someText := ‘5x7 Font (v2)’;

SPI Glcd Write Text (someText, 50, 6, 2);
Delay2s () ;

end;
end.

T, 32);

32);

32);

//

7y

//

//

//

//

//

//

//

//

//

//

//

//

//

Clear GLCD
32); // Choose
Write string

Draw circles

Draw circles

Draw box

Fill Glcd
Change font

Write string

Change font

Write string

Change font

Write string

Change font

Write string

// Draw horizontal and vertical lines

font
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HW Connection
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SPI Lcd Library

The mikroPascal PRO for PIC32 provides a library for communication with Lcd (with HD44780 compliant controllers)
in 4-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.
Important:

- When using this library with PIC32 family MCUs be aware of their voltage incompatibility with certain number of
Lcd modules.
So, additional external power supply for these modules may be required.

- Library uses the SPI module for communication. The user must initialize the appropriate SPI module before using
the SPI Lcd Library.

- For MCUs with multiple SPI modules it is possible to initialize all of them and then switch by using the
SPI_Set_Active() routine. See the SPI Library functions.

- This Library is designed to work with the mikroElektronika’s Serial Lcd Adapter Board pinout, see schematic at the
bottom of this page for details.

Library Dependency Tree

—| Port Expander ]
SFI Lcd —
—| Lcd Constants

External dependencies of SPI Lcd Library
The implementation of SPI Lcd Library routines is based on Port Expander Library routines.

External dependencies are the same as Port Expander Library external dependencies.

Library Routines

- SPI_Lcd_Config
- SPI_Lcd_Out

- SPI_Lcd_Out_Cp
- SPI_Lcd_Chr
-SPI_Lcd_Chr_Cp
- SPI_Lcd_Cmd
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SPI_Lcd_Config

Prototype procedure SPI Lcd Config(DeviceAddress byte);
Description | Initializes the Lcd module via SPI interface.
Parameters | - DeviceAddress: SPIl expander hardware address, see schematic at the bottom of this page
Returns Nothing.
Requires Global variables:
- SPExpanderCs: Chip Select line
- SPExpanderRST: Reset line
- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
The SPI module needs to be initialized. See SPTx Init and SPIx Init Advanced routines.
Example // Port Expander module connections
var SPExpanderRST sbit at LATFO bit;
var SPExpanderCS sbit at LATF1 bit;
var SPExpanderRST Direction sbit at TRISFO bit;
var SPExpanderCS Direction sbit at TRISF1 bit;
// End Port Expander module connections
// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with
PortExpander
SPI Lcd Config (0) ; // initialize Lcd over SPI interface
Notes None.
SPI_Lcd_Out
Prototype procedure SPI Lcd Out (row, column byte; var text string) ;
Description | Prints text on the Lcd starting from specified position. Both string variables and literals can be passed
as a text.
Parameters | - row: starting position row number
- column: starting position column number
- text: text to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routine.
Example // Write text “Hello!” on Lcd starting from row 1, column 3:
SPI Lcd Out(l, 3, “Hello!”);
Notes None.
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SPI _Lcd Out Cp

Prototype procedure SPI Lcd Out CP(var text string); // write text at current pos
Description | Prints text on the Lcd at current cursor position. Both string variables and literals can be passed as a
text.
Parameters | - text: text to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routine.
Example // Write text “Here!” at current cursor position:
SPI_Lcd Out CP(“Here!”);
Notes None.
SPI_Lcd _Chr
Prototype procedure SPI Lcd Chr (Row, Column, Out Char byte);
Description | Prints character on Lcd at specified position. Both variables and literals can be passed as character.
Parameters | - Row: writing position row number
- Column: writing position column number
- Out Char: character to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routine.
Example // Write character “i” at row 2, column 3:
SPI Lcd Chr(2, 3, ‘i’);
Notes None.

SPI _Lcd _Chr_Cp

Prototype procedure SPI Lcd Chr CP(Out Char byte);

Description | Prints character on Lcd at current cursor position. Both variables and literals can be passed as
character.

Parameters | - Out Char: character to be written

Returns Nothing.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routine.

Example // Write character “e” at current cursor position:
SPI_Lcd Chr Cp(‘e’);

Notes None.
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SPI Lcd Cmd

Prototype

procedure SPI Lcd Cmd(out char : byte);

Description | Sends command to Lcd.

Parameters | - out char: command to be sent

Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routine.
Example // Clear Lcd display:
SPI Lcd Cmd( LCD_CLEAR) ;
Notes Predefined constants can be passed to the routine, see Available SPI Lcd Commands.

Available SPI| Lcd Commands

SPI Lcd Command

Purpose

_LCD FIRST ROW

Move cursor to the 1st row

_LCD_SECOND_ROW

Move cursor to the 2nd row

_LCD_THIRD ROW

Move cursor to the 3rd row

_LCD FOURTH ROW

Move cursor to the 4th row

_LCD CLEAR

Clear display

_LCD RETURN HOME

Return cursor to home position, returns a shifted display to its
original position. Display data RAM is unaffected.

_LCD_CURSOR_OFF

Turn off cursor

_LCD_UNDERLINE ON

Underline cursor on

_LCD BLINK CURSOR ON

Blink cursor on

_LCD MOVE CURSOR LEFT

Move cursor left without changing display data RAM

_LCD MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

_LCD_TURN_ON

Turn Lcd display on

_LCD_TURN OFF

Turn Lcd display off

_LCD SHIFT LEFT

Shift display left without changing display data RAM

_LCD_SHIFT RIGHT

Shift display right without changing display data RAM

469



mikoPascal PRO for PIC32

Library Example

Default Pin Configuration

Use spI Lcd Init for default pin settings (see the first figure below).

Copy Code To Clipboard
program Spi Lcd;

var text
var counter

array[16] of char;
byte;

// Port Expander module connections

var SPExpanderRST sbit at LATDS8 bit;
SPExpanderCsS sbit at LATDS bit;
SPExpanderRST Direction
SPExpanderCS Direction

// End Port Expander module connections
procedure Move Delay ()
begin
Delay_ms(500);
end;
begin
text := ‘mikroElektronika’;
CHECON := 0x32;
AD1PCFG := OxFFFE;

sbit at TRISD8 bit;
sbit at TRISD9 bit;

// Function used for text moving

// You can change the moving speed here

// Configure AN pins as digital

// If Port Expander Library uses SPI2 module
// Initialize SPI module used with PortExpander

SPI2 Init Advanced( SPI_MASTER, SPI 8 BIT, 4,

_SPI_SS_DISABLE, SPI DATA SAMPLE

MIDDLE, SPI CLK IDLE LOW, SPI ACTIVE 2 IDLE);

Spi Lcd Config(0) ;

Spi Lcd Cmd( LCD CLEAR);

Spi Lcd Cmd( LCD CURSOR OFF) ;
Spi Lcd Out (1,6, ‘mikroE’);
Spi_Led Chr CP(M!7);

Spi Lecd Out (2,1, text);

// Spi_Lcd Out (3,1, 'mikroE’);
// Spi Lcd Out (4,15, ' mikroE’);

Delay ms (2000) ;

// Moving text
for counter :=
begin
Spi_Lcd Cmd( LCD SHIFT RIGHT);
Move Delay () ;
end;

0 to 3 do

!/
!/
//
//
!/
!/

//
//

Initialize LCD over SPI interface
Clear display
Turn cursor off

Print text to LCD, 1lst row, 6th column
Append !’
Print text to LCD, 2nd row, 1lst column

For LCD with more than
For LCD with more than

two rows
two rows

// Move text to the right 4 times
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while TRUE do // Endless loop
begin
for counter := 0 to 6 do // Move text to the left 7 times
begin

Spi Lcd Cmd( LCD_SHIFT LEFT);
Move Delay () ;
end;

for counter := 0 to 6 do // Move text to the right 7 times
begin
Spi_Led Cmd( LCD SHIFT RIGHT);
Move Delay();
end;

end;
end.

MCP23517
K

Contrast
Adjustment

5K

FFFFFFR R RN E

Lcd HW connection by default initialization (using SPI_Lcd_Init)
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SPI Lcd8 (8-bit interface) Library

The mikroPascal PRO for PIC32 provides a library for communication with Lcd (with HD44780 compliant controllers)
in 8-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.
Important:

- When using this library with PIC32 family MCUs be aware of their voltage incompatibility with certain number of
Lcd modules.
So, additional external power supply for these modules may be required.

- Library uses the SPI module for communication. The user must initialize the appropriate SPI module before using
the SPI Lcd8 Library.

- For MCUs with multiple SPI modules it is possible to initialize all of them and then switch by using the
SPI set Active () routine. See the SPI Library functions.

- This Library is designed to work with the mikroElektronika’s Serial Lcd/Glcd Adapter Board pinout, see schematic at
the bottom of this page for details.

Library Dependency Tree

r—| Port Expander ]
Crr——
—| Lcd Constants

External dependencies of SPI Lcd Library
The implementation of SPI Lcd Library routines is based on Port Expander Library routines.

External dependencies are the same as Port Expander Library external dependencies.

Library Routines

- SPI_Lcd8_Config
- SPI_Lcd8_Out

- SPI_Lcd8_Out_Cp
- SPI_Lcd8_Chr

- SPI_Lcd8_Chr_Cp
- SPI_Lcd8_Cmd
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SPI_Lcd8 Config

Prototype procedure SPI Lcd8 Config(DeviceAddress : byte);

Description | Initializes the Lcd module via SPI interface.

Parameters | - DeviceAddress: SPIl expander hardware address, see schematic at the bottom of this page
Returns Nothing.

Requires Global variables:

- SPExpanderCs: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See SPIx_Init and SPIx_Init_Advanced routines.

Example // Port Expander module connections

var SPExpanderRST : sbit at LATF0O bit;

var SPExpanderCS : sbit at LATF1 bit;

var SPExpanderRST Direction : sbit at TRISFO bit;
var SPExpanderCS Direction : sbit at TRISFI1 bit;
// End Port Expander module connections

// If Port Expander Library uses SPI1 module

SPI1 Init(); // Initialize SPI module used
with PortExpander
SPI Lcd8 Config(0) ; // intialize Lcd in 8bit mode
via SPI

Notes None.
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SPI_Lcd8 Out

Prototype procedure SPI Lcd8 Out(row, column: byte; var text: string);

Description | Prints text on Lcd starting from specified position. Both string variables and literals can be passed as
a text.

Parameters | - row: starting position row number
- column: starting position column number
- text: text to be written

Returns Nothing.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routine.

Example // Write text “Hello!” on Lcd starting from row 1, column 3:
SPI Lcd8 out (1, 3, ‘Hello!’);

Notes None.

SPI_Lcd8 Out Cp

Prototype procedure SPI_Lcd8 Out_CP(var text: string);
Description | Prints text on Lcd at current cursor position. Both string variables and literals can be passed as a
text.
Parameters | - text: text to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routine.
Example // Write text “Here!” at current cursor position:
SPI Lcd8 Out Cp(‘Here!’);
Notes None.
SPI_Lcd8_Chr
Prototype procedure SPI Lcd8 Chr(row, column, out char: byte);
Description | Prints character on Lcd at specified position. Both variables and literals can be passed as character.
Parameters | - row: writing position row number
- column: writing position column number
- out char: character to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routine.
Example // Write character “i” at row 2, column 3:
SPI Lcd8 Chr(2, 3, ‘i’);
Notes None.
MikroElektronika
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SPI Lcd8 Chr Cp

Prototype procedure SPI Lcd8 Chr CP(out char: byte);
Description | Prints character on Lcd at current cursor position. Both variables and literals can be passed as
character.
Parameters | - out char: character to be written
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routine.
Example Print “e” at current cursor position:
// Write character “e” at current cursor position:
SPI Lcd8 Chr Cp(‘e’);
Notes None.
SPI _Lcd8 Cmd
Prototype procedure SPI Lcd8 Cmd(out char: byte);
Description | Sends command to Lcd.
Parameters | - out char: command to be sent
Returns Nothing.
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routine.
Example // Clear Lcd display:
SPI Lcd8 Cmd( LCD CLEAR);
Notes Predefined constants can be passed to the routine, see Available SPI Lcd8 Commands.
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Available SPI| Lcd8 Commands

SPI Lcd8 Command

Purpose

_LCD FIRST ROW

Move cursor to the 1st row

_LCD_SECOND ROW

Move cursor to the 2nd row

_1LCD THIRD ROW

Move cursor to the 3rd row

_LCD_FOURTH_ROW

Move cursor to the 4th row

_1CD CLEAR

Clear display

_LCD RETURN HOME

Return cursor to home position, returns a shifted display to its
original position. Display data RAM is unaffected.

_LCD CURSOR_OFF

Turn off cursor

_1LCD UNDERLINE ON

Underline cursor on

LCD BLINK CURSOR ON

Blink cursor on

_1CD MOVE CURSOR LEFT

Move cursor left without changing display data RAM

_LCD MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

_LCD_TURN_ON

Turn Lcd display on

_1LCD TURN OFF

Turn Lcd display off

LCD SHIFT LEFT

Shift display left without changing display data RAM

_1CD SHIFT RIGHT

Shift display right without changing display data RAM

Library Example

This example demonstrates how to communicate Lcd in 8-bit mode via the SPI module, using serial to parallel convertor

MCP23S17.

Copy Code To Clipboard

program SPI Lcd8;

var text : array[l6] of char;

var counter : byte;

// Port Expander module connections
var SPExpanderRST : sbit at LATD8 bit;
SPExpanderCS : sbit at LATDY9 bit;

SPExpanderRST Direction
SPExpanderCS Direction

sbit at TRISD8 bit;
sbit at TRISDY9 bit;

// End Port Expander module connections

procedure Move Delay();

begin
Delay ms (500);
end;

begin
CHECON := 0x32;

AD1PCFG := OxFFFEF;

// Function used for text moving

// You can change the moving speed here

// Configure AN pins as digital

text := ‘mikroElektronika’;
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// If Port Expander Library uses SPI2 module
// Initialize SPI module used with PortExpander
SPI2 Init Advanced( SPI MASTER, SPI 8 BIT, 4, SPI SS DISABLE, SPI DATA SAMPLE
MIDDLE, SPI CLK IDLE LOW, SPI ACTIVE 2 IDLE);

SPI Lcd8 Config (0); // Initialize Lcd over SPI interface

SPI Lcd8 Cmd( LCD CLEAR); // Clear display

SPI Lcd8 Cmd( LCD CURSOR OFF) ; // Turn cursor off

SPI Lcd8 Out(l,6, ‘mikroE’); // Print text to Lcd, 1lst row, 6th column
SPI Lcd8 Chr CP('!7); // Append !

SPI Lcd8 Out(2,1, text); // Print text to Lcd, 2nd row, 1lst column

Delay ms (2000) ;

// Moving text
for counter := 0 to 3 do // Move text to the right 4 times
begin
Spi Lcd8 Cmd( LCD SHIFT RIGHT);
Move Delay();
end;

while TRUE do // Endless loop
begin
for counter := 0 to 6 do // Move text to the left 7 times
begin
Spi Lcd8 Cmd( LCD SHIFT LEFT);
Move Delay () ;
end;

for counter := 0 to 6 do // Move text to the right 7 times
begin
Spi Lcd8 Cmd( LCD SHIFT RIGHT);
Move Delay () ;
end;

end;
end.
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MCP23517

CETILLATOR

Contrast
Adjustment

FEFFFFFFRR RS

SPI Lcd8 HW connection
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SPI T6963C Graphic Lcd Library

The mikroPascal PRO for PIC32 provides a library for working with Glcds based on TOSHIBA T6963C controller via
SPl interface. The Toshiba T6963C is a very popular Lcd controller for the use in small graphics modules. It is capable
of controlling displays with a resolution up to 240x128. Because of its low power and small outline it is most suitable for
mobile applications such as PDAs, MP3 players or mobile measurement equipment. Although this controller is small, it
has a capability of displaying and merging text and graphics and it manages all interfacing signals to the displays Row
and Column drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Important:

- When using this library with PIC32 family MCUs be aware of their voltage incompatibility with certain number
of T6963C based Glcd modules. So, additional external power supply for these modules may be required.

- Glcd size based initialization routines can be found in setup library files located in the Uses folder.

- The user must make sure that used MCU has appropriate ports and pins. If this is not the case the user should
adjust initialization routines.

- The library uses the SPI module for communication. The user must initialize the appropriate SPI module before
using the SP1 T6963C Gilcd Library.

- For MCUs with multiple SPI modules it is possible to initialize both of them and then switch by using the
SPI set Active () routine. See the SPI Library functions.

- This Library is designed to work with mikroElektronika’s Serial Glcd 240x128 and 240x64 Adapter Boards pinout,
see schematic at the bottom of this page for details.

- To use constants located in  Lib SPIT6963C Const.mpas file, user mustinclude it the source file : uses  Lib

SPIT6963C Const;.

Some mikroElektronika’s adapter boards have pinout different from T6369C datasheets. Appropriate relations between
these labels are given in the table below:

Adapter Board T6369C datasheet
RS C/D
R/W /RD
E /WR

Library Dependency Tree

r—*| Port_Expander .
SPI T6963C Gled [—
—*| Trigonometry

External dependencies of SPI T6963C Graphic Lcd Library
The implementation of SPI T6963C Graphic Lcd Library routines is based on Port Expander Library routines.

External dependencies are the same as Port Expander Library external dependencies.
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Library Routines

- SPI_T6963C_config

- SPI_T6963C_writeData

- SPI_T6963C_writeCommand
- SPI_T6963C_setPtr

- SPI_T6963C_waitReady

- SPI_T6963C_fill

- SPI_T6963C_dot

- SPI1_T6963C_write_char

- SPI_T6963C_Write_Text

- SPI_T6963C_line

- SPI_T6963C_rectangle

- SPI_T6963C_rectangle_round_edges
- SPI_T6963C_rectangle_round_edges_fill
- SPI_T6963C_box

- SPI_T6963C_circle

- SPI_T6963C_circle_fill

- SPI_T6963C_image

- SPI_T6963C_Partiallmage

- SPI_T6963C_sprite

- SPI_T6963C_set_cursor

- SP1_T6963C_clearBit

- SPI_T6963C_setBit

- SPI_T6963C_negBit

- SPI_T6963C_displayGrPanel
- SPI_T6963C_displayTxtPanel
- SPI_T6963C_setGrPanel

- SPI_T6963C_setTxtPanel

- SPI_T6963C_panelFill

- SPI_T6963C_grfFill

- SPI_T6963C_txtFill

- SPI_T6963C_cursor_height

- SPI_T6963C_graphics

- SPI_T6963C_text

- SPI1_T6963C_cursor

- SPI_T6963C_cursor_blink
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SPI_T6963C_config

Prototype procedure SPI T6963C config(width, height, fntW : word; DeviceAddress : byte;
wr, rd, cd, rst : byte);

Description | Initializes T6963C Graphic Lcd controller.

Display RAM organization:
The library cuts RAM into panels: a complete panel is one graphics panel followed by a text panel (see
schematic below).

Fo + /\
+ GRAPHICS PANEL #0 +
+ +
+ +
+ +
fomm e + | PANEL O
+ TEXT PANEL #0O +
+ + \/
Fo + /\
+ GRAPHICS PANEL #1 +
+ +
+ +
+ +
fomm e + | PANEL 1
+ TEXT PANEL #1 +
+ +
Fo + \/

Parameters | - width: width of the Glcd panel

- height: height of the Glcd panel

- fntw: font width

- DeviceAddress: SPl expander hardware address, see schematic at the bottom of this page
- wr: write signal pin on Glcd control port

- rd: read signal pin on Glcd control port

- cd: command/data signal pin on Glcd control port

- rst: reset signal pin on Glcd control port

Returns Nothing.

Requires Global variables:

- SPExpanderCs: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCS Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See the SPIx_Init and SPIx_Init_Advanced routines.
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Example // Port Expander module connections
SPExpanderRST : sbit at LATF0 bit;
SPExpanderCS sbit at LATFI1 bit;
SPExpanderRST Direction : sbit at TRISFO bit;
SPExpanderCS Direction sbit at TRISF1 bit;
// End Port Expander module connections
// Initialize SPI module
SPI1 Init();
SPI T6963C config (240, 64, 8, 0, 0, 1, 3, 4);
Notes None.

SPI_T6963C_writeData

Prototype procedure SPI T6963C writeData(data : byte);

Description | Writes data to T6963C controller via SPI interface.

Parameters | - data :data to be written

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C writeData(data );

Notes None.

SPI_T6963C_writeCommand

Prototype procedure SPI T6963C writeCommand(data : byte);
Description | Writes command to T6963C controller via SPI interface.
Parameters |- data : command to be written
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C writeCommand (SPI_T6963C CURSOR POINTER SET) ;
Notes None.
MikroElektronika
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SPI_T6963C_setPtr

Prototype procedure SPI T6963C setPtr(p : word; c : byte);

Description | Sets the memory pointer p for command p.

Parameters | - p: address where command should be written
- c: command to be written

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C setPtr (SPI_T6963C grHomeAddr + start, SPI T6963C ADDRESS
POINTER_SET) ;

Notes None.

SPI_T6963C_waitReady

Prototype procedure SPI T6963C waitReady ()
Description | Pools the status byte, and loops until Toshiba Glcd module is ready.
Parameters | None.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C waitReady();
Notes None.
SPI_T6963C _fill
Prototype procedure SPI T6963C fill(v : byte; start, len : word);
Description | Fills controller memory block with given byte.
Parameters | - v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C fill (0x33, 0x00FF, 0x000F) ;
Notes None.
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SPI_T6963C_dot

Prototype procedure SPI T6963C dot(x, y : integer; color : byte);

Description | Writes a char in the current text panel of Glcd at coordinates (x, v).

Returns - x: dot position on x-axis

- v: dot position on y-axis

- color: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C dot (x0, y0, SPI T6963C BLACK) ;

Notes None.

SPI_T6963C_write _char

Prototype procedure SPI T6963C write char(c, x, y, mode : byte);

Description | Writes a char in the current text panel of Glcd at coordinates (x, y).

Parameters | - c: char to be written

- x: char position on x-axis

- v: char position on y-axis

- mode: mode parameter. Valid values:
SPI_T6963C_ROM_MODE_OR, SPI_T6963C_ROM_MODE_XOR,
SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data is logically “OR-ed”.
This is the most common way of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the logical “exclusive OR”.
This can be useful to display text in negative mode, i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the logical “AND
function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text Attribute values are
stored in the graphic area of display memory.

For more details see the T6963C datasheet.
Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C write char (‘A’,22,23,SPI T6963C ROM MODE AND) ;

Notes None.
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SPI_T6963C_write_text

Prototype |procedure SPI_T6963C_write_text(var str : array[10] of byte; x, y, mode
byte) ;

Description | Writes text in the current text panel of Glcd at coordinates (X, y).

Parameters | - str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode: mode parameter. Valid values: SPI_T6963C_ROM_MODE_OR, SPI_T6963C_ROM_MODE_
XOR, SPI_T6963C_ROM_MODE_AND and SPI_T6963C_ROM_MODE_TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data is logically “OR-ed”.
This is the most common way of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the logical “exclusive OR”.
This can be useful to display text in negative mode, i.e. white text on black background.

-AND-Mode: The text and graphic data shown on the display are combined via the logical “AND
function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text Attribute values are
stored in the graphic area of display memory.

For more details see the T6963C datasheet.
Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI _T6963C write text (‘GLCD LIBRARY DEMO, WELCOME !’, 0, 0, SPI T6963C_ ROM
MODE_XOR) ;
Notes None.
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SPI_T6963C_line

Prototype procedure SPI T6963C line(x0, yO0, x1, vyl integer; pcolor : byte);
Description | Draws a line from (x0, y0) to (x1, y1).
Parameters | - <0: x coordinate of the line start
- v0: y coordinate of the line end
- x1: x coordinate of the line start
- y1:y coordinate of the line end
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C line(0, 0, 239, 127, SPI T6963C WHITE)
Notes None.

SPI_T6963C_rectangle

Prototype procedure SPI T6963C rectangle(x0, yO0, x1, yl integer; pcolor : byte);
Description | Draws a rectangle on Glcd.
Parameters | - x0: x coordinate of the upper left rectangle corner
- v0: y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C rectangle (20, 20, 219, 107, SPI T6963C WHITE);
Notes None.
MikroElektronika
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SPI_T6963C_rectangle _round_edges

Prototype procedure SPI T6963C rectangle round edges (x0 integer; yO0 integer; x1
integer; vyl integer; radius integer; pcolor : byte);
Description | Draws a rounded edge rectangle on Glcd.
Parameters | - x0: x coordinate of the upper left rectangle corner
- y0:y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- round_radius: radius of the rounded edge.
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C rectangle round edges (20, 20, 219, 107, 12, SPI _T6963C WHITE);
Notes None.

SPI_T6963C_rectangle _round_edges fill

Prototype procedure SPI T6963C rectangle round edges fill (x0 integer; yO0 integer;
x1 integer; yl integer; radius integer; pcolor : byte);

Description | Draws a filled rounded edge rectangle on Glcd.

Parameters | - x0: x coordinate of the upper left rectangle corner
- v0: y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- round radius: radius of the rounded edge
- pcolor: color parameter. Valid values: SPT T6963C BLACK and SPT T6963C WHITE

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C rectangle round edges fill (20, 20, 219, 107, 12, SPI T6963C_
WHITE) ;

Notes None.
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SPI_T6963C_box

Prototype procedure SPI_T6963C_box(x0, y0, x1, yl : integer; pcolor : byte);
Description | Draws a box on the Glcd
Parameters | - x0: x coordinate of the upper left box corner
- v0: y coordinate of the upper left box corner
- x1: x coordinate of the lower right box corner
- y1:y coordinate of the lower right box corner
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C box (0, 119, 239, 127, SPI T6963C WHITE);
Notes None.

SPI_T6963C_circle

Prototype procedure SPI T6963C circle(x, y : integer; r longint; pcolor : word);
Description | Draws a circle on the Glcd.
Parameters | - x: x coordinate of the circle center
- v: y coordinate of the circle center
- r: radius size
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and SPI_T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C circle (120, 64, 110, SPI T6963C WHITE);
Notes None.

SPI_T6963C_circle_fill

Prototype procedure SPI T6963C circle fill (x integer; vy integer; r longint;
pcolor : word);
Description | Draws a filled circle on the Glcd.
Parameters | - x: x coordinate of the circle center
- v: y coordinate of the circle center
- r: radius size
- pcolor: color parameter. Valid values: SPT T6963C BLACK and SPI T6963C WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C circle fill(120, 64, 110, SPI _T6963C WHITE);
Notes None.
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SPI_T6963C_image

Prototype procedure SPI T6963C image(pic : ~ const byte);

Description | Displays bitmap on Glcd.

Parameters | - pic:image to be displayed. Bitmap array can be located in both code and RAM memory (due to the
mikroPascal PRO for PIC32 pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C image (my image);

Notes Image dimension must match the display dimension.
Use the integrated Glcd Bitmap Editor (menu option Tools » Glcd Bitmap Editor) to convert image to
a constant array suitable for displaying on Glcd.

SPI_T6963C_Partiallmage

Prototype procedure SPI T6963C Partiallmage (x left, vy top, width, height, picture
width, picture height : word; const image “byte) ;

Description | Displays a partial area of the image on a desired location.

Parameters | - x 1eft:x coordinate of the desired location (upper left coordinate).
- yv_top:y coordinate of the desired location (upper left coordinate).
- width: desired image width.
- height: desired image height.
- picture width: width of the original image.
-picture height: height of the original image.
- image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12). Original image size is 16x32.
SPI T6963C Partiallmage (10, 12, 10, 15, 16, 32, @image);

Notes Use the integrated Glcd Bitmap Editor (menu option Tools » Glcd Bitmap Editor) to convert image to
a constant array suitable for displaying on Glcd.
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SPI_T6963C_sprite

Prototype procedure SPI T6963C sprite(px, py byte; const pic “byte; sx, sy
byte);

Description | Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.

Parameters | - px: x coordinate of the upper left picture corner. Valid values: multiples of the font width
- py: y coordinate of the upper left picture corner
- pic: picture to be displayed
- sx: picture width. Valid values: multiples of the font width
- sy: picture height

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C sprite(76, 4, einstein, 88, 119); // draw a sprite

Notes If px and sx parameters are not multiples of the font width they will be scaled to the nearest lower
number that is a multiple of the font width.

SPI1_T6963C_set _cursor

Prototype procedure SPI T6963C set cursor(x, y : byte);
Description | Sets cursor to row x and column y.
Parameters | - x: cursor position row number
- y: cursor position column number
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C set cursor(cposx, Cposy);
Notes None.

SPI_T6963C clearBit

Prototype procedure SPI T6963C clearBit (b : byte);
Description | Clears control port bit(s).
Parameters | - b: bit mask. The function will clear bit x on control port if bit » in bit mask is set to 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // clear bits 0 and 1 on control port
SPI T6963C clearBit (0x03);
Notes None.
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SPI_T6963C_setBit

Prototype procedure SPI T6963C setBit (b : byte);
Description | Sets control port bit(s).
Parameters | - b: bit mask. The function will set bit < on control port if bit = in bit mask is setto 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // set bits 0 and 1 on control port
SPT_T6963C_setBit (0x03);
Notes None.

SPI_T6963C_negBit

Prototype procedure SPI T6963C negBit (b : byte);
Description | Negates control port bit(s).
Parameters | - b: bit mask. The function will negate bit x on control port if bit = in bit mask is set to 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // negate bits 0 and 1 on control port
SPI T6963C negBit (0x03);
Notes None.

SPI_T6963C_displayGrPanel

Prototype procedure SPI T6963C displayGrPanel(n : word);
Description | Display selected graphic panel.
Parameters | - n: graphic panel number. Valid values: 0 and 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // display graphic panel 1
SPI T6963C displayGrPanel (1) ;
Notes None.
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SPI_T6963C_displayTxtPanel

Prototype procedure SPI T6963C displayTxtPanel(n : word);
Description | Display selected text panel.
Parameters | - n: text panel number. Valid values: 0 and 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // display text panel 1
SPI T6963C displayTxtPanel (1);
Notes None.

SPI_T6963C_setGrPanel

Prototype procedure SPI T6963C setGrPanel(n : word);

Description | Compute start address for selected graphic panel and set appropriate internal pointers. All subsequent
graphic operations will be preformed at this graphic panel.

Parameters | - n: graphic panel number. Valid values: 0 and 1.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example // set graphic panel 1 as current graphic panel.
SPI T6963C setGrPanel (1);

Notes None.

SPI_T6963C_setTxtPanel

Prototype procedure SPI T6963C setTxtPanel (n : word);

Description | Compute start address for selected text panel and set appropriate internal pointers. All subsequent
text operations will be preformed at this text panel.

Parameters | - n: text panel number. Valid values: 0 and 1.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example // set text panel 1 as current text panel.
SPI T6963C setTxtPanel (1) ;

Notes None.
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SPI_T6963C_panelFill

Prototype procedure SPI_T6963C_panelFill(v : word);
Description | Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Parameters | - v: value to fill panel with.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example clear current panel
SPI T6963C panelFill(0);
Notes None.

SPI_T6963C_grFill

Prototype procedure SPI T6963C grFill(v: word);
Description | Fill current graphic panel with appropriate value (0 to clear).
Parameters | - v: value to fill graphic panel with.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // clear current graphic panel
SPI T6963C grFill(0);
Notes None.

SPI_T6963C_txtFill

Prototype procedure SPI T6963C txtFill(v : word);
Description | Fill current text panel with appropriate value (0 to clear).
Parameters | - v: this value increased by 32 will be used to fill text panel.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // clear current text panel
SPI_T6963C_ txtFill (0);
Notes None.
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SPI_T6963C_cursor_height

Prototype procedure SPI T6963C cursor height (n: byte);

Description | Set cursor size.

Parameters | - n: cursor height. Valid values: 0. . 7.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C cursor height (7);

Notes None.

SPI_T6963C_graphics

Prototype procedure SPI T6963C graphics(n : word);

Description | Enable/disable graphic displaying.

Parameters | - n: graphic enable/disable parameter. Valid values: 0 (disable graphic dispaying) and 1 (enable
graphic displaying).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example // enable graphic displaying
SPI T6963C graphics (1) ;

Notes None.

SPI_T6963C_text

Prototype procedure SPI T6963C text(n : word);
Description | Enable/disable text displaying.
Parameters | - n: text enable/disable parameter. Valid values: 0 (disable text dispaying) and 1 (enable text
displaying).
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // enable text displaying
SPI T6963C text (1);
Notes None.
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SPI_T6963C _cursor

Prototype procedure SPI T6963C cursor (n word) ;
Description | Set cursor on/off.
Parameters | - n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // set cursor on
SPI T6963C cursor (1);
Notes None.

SPI_T6963C_cursor_blink

Prototype procedure SPI T6963C cursor blink(n word) ;

Description | Enable/disable cursor blinking.

Parameters | - n: cursor blinking enable/disable parameter. Valid values: 0 (disable cursor blinking) and 1 (enable
cursor blinking).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example // enable cursor blinking
SPI T6963C cursor blink(1l);

Notes None.

Library Example

The following drawing demo tests advanced routines of the SPI T6963C Glcd library. Hardware configurations in this
example are made for the LV-32MX v6 board and PIC32MX460F512L.

Copy Code To Clipboard

program SPI

T6963C 240x128;

uses Lib SPIT6963C Const;

var

// Port Expander module connections

SPExpanderRST : sbit at LATD8 bit; // for writing to output pin always use latch
SPExpanderCS : sbit at LATDY9 bit; // for writing to output pin always use latch
SPExpanderRST Direction : sbit at TRISDS8 bit;
SPExpanderCS Direction : sbit at TRISDY bit;
// End Port Expander module connections
var panel : byte; // current panel
i : word; // general purpose register
curs : byte; // cursor visibility
cposx,
cposy : word; // cursor x-y position
txt, txtl string[29] ;
txt2 : string[21];
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begin

{$DEFINE COMPLETE EXAMPLE}
{$DEFINE LINE DEMO}
{$DEFINE FILL DEMO}

{$DEFINE PARTIAL IMAGE DEMO}

// Uncomment to demonstrate line drawing routines
// Uncomment to demonstrate fill routines

// Uncomment to demonstrate partial image routine

txtl := ' EINSTEIN WOULD HAVE LIKED mE’;

txt := ' GLCD LIBRARY DEMO, WELCOME !’;

txt2 := ' Partial image demo! ‘;

CHECON := 0x32;

ADIPCFG := OxFFFF; // initialize AN pins as digital

TRISB8 bit := 1; // Set RB8 as input

TRISBY bit : 1; // Set RB9 as input

TRISB10 bit := 1; // Set RB10 as input

TRISBI11 bit := 1; // Set RB11 as input

TRISB1Z2 bit := 1; // Set RB12 as input
1

TRISB13 bit

*

bit 2 is
bit 1 is
bit 0 is

P T T A

—~—

N

reverse on,

// Set

8x8 font internaly set in library

RB13 as input

init display for 240 pixel width and 128 pixel height
8 bits character width
data bus on MCP23S17 portB

control bus on MCP23S517 portA
IWR
!RD
I'cD
bit 4 is RST
chip enable,

// If Port Expander Library uses SPI2 module
// Initialize SPI module used with PortExpander
SPI2 Init Advanced(_SPI_MASTER, SPI 8 BIT, 4,
MIDDLE, SPI_CLK IDLE LOW, SPI_ACTIVE 2 IDLE);

{

bit 2 is
bit 1 is
bit 0 is

T

reverse on,

8x8 font internaly set in library

// Initialize SPI Toshiba 240x128
SPI _T6963C Config (240, 128, 8, 0, 2,
//Delay ms (1000) ;

init display for 240 pixel width and 128 pixel height
8 bits character width
data bus on MCP23S17 portB

control bus on MCP23S17 portA
I'WR
!RD
ICD
bit 4 is RST
chip enable,

1, 0, 4);

_SPI_SS DISABLE, SPI DATA SAMPLE
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{*

* Enable both graphics and text display at the same time

*}
SPI T6963C graphics(1);

SPI T6963C text(l);

panel := 0;
i := 0;
curs := 0;
cposx := 0y
cposy := 0;

{*

* Text messages

*}
SPI T6963C write text (txt,
SPI T6963C write text (txtl,

0,
0,

{*

* Cursor

*}

SPI T6963C cursor height (8);
SPI T6963C set cursor(0, 0) ;
SPI T6963C cursor(0) ;

// 8 pixel height
// cursor off

{*
* Draw solid boxes
*}

SPI T6963C box (0,

SPI T6963C box (0,

0, 239,
119,

8, SPI_T6963C WHITE) ;
239, 127, SPI_T6963C_WHITE) ;

{*

* Draw rectangles

*}

{$IFDEF LINE DEMO}
SPI T6963C rectangle(0, 0, 239, 127, SPI T6963C WHITE);
SPI T6963C rectangle (20, 20, 219, 107, SPI T6963C WHITE)
SPI T6963C rectangle (40, 40, 199, 87, SPI T6963C WHITE);
SPI T6963C rectangle (60, 60, 179, 67, SPI T6963C WHITE);
{SENDIF}

{*

* Draw rounded edge rectangle

*}

{SIFDEF LINEiDEMO}
SPI T6963C Rectangle Round Edges (10,
SPI T6963C Rectangle Round Edges (30,
SPI T6963C Rectangle Round Edges (50,

{SENDIF}

10,
30,
50,

2209,
2009,
189,

117,
97,
77,

12,
12,
12,

0, SPI T6963C ROM MODE XOR) ;
15, SPI T6963C_ROM MODE XOR) ;

// move cursor to top left

’

SPI _T6963C WHITE) ;
SPI _T6963C_WHITE) ;
SPI _T6963C_WHITE) ;
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{*

* Draw filled rounded edge rectangle

*}
{SIFDEF FILL DEMO}

SPI_T6963CZRectangle_Round_Edges_Fill(10, 10, 229,
SPI T6963C Rectangle Round Edges Fill (20, 20, 219,
SPI T6963C Rectangle Round Edges Fill (30, 30, 209,
SPI T6963C Rectangle Round Edges Fill (40, 40, 199,
SPI T6963C Rectangle Round Edges Fill (50, 50, 189,

{SENDIF}

{*
* Draw a Ccross
*}
{SIFDEF LINE DEMO}
SPI T6963C line (0, O,

239,

SPI_T6963C_line (0, 127,

{SENDIF}

{*

* Draw circles

*}

{SIFDEF LINE DEMO}
SPI T6963C circle (120,
SPI T6963C circle (120,
SPI T6963C circle (120,
SPI T6963C circle (120,
SPI T6963C circle (120,
SPI T6963C circle (120,
SPI T6963C circle (120,
{SENDIF}

{*

* Draw filled circles
*}

{SIFDEF FILL DEMO}

64,
64,
64,
64,
64,
64,
64,

239,

10, SPI_T6963C WHITE
30, SPI_T6963C WHITE
50, SPI_T6963C WHITE
70, SPI_T6963C WHITE

0,

127, SPI_T6963C WHITE);
SPI _T6963C WHITE);

r

’

’

r

90, SPI_T6963C_WHITE);
SPI_T6963C WHITE) ;
130, SPI_T6963C WHITE) ;

110,

SPI_T6963C circle fill (120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill (120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill (120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C_circle fill (120, 64,
SPI_T6963C circle fill(120, 64,
SPI_T6963C circle fill(120, 64,

{SENDIF}

Delay ms (1000);

SPI T6963C sprite (76, 4,

Delay ms (1000) ;

SPI T6963C setGrPanel (1);

60,
55,
50,
45,
40,
35,
30,
25,
20,
15,
10,
5,

@einstein bmp, 88, 119);

SPI T6963C_WHITE
SPI_T6963C_BLACK
SPI T6963C WHITE

SPI T6963C BLACK) ;

SPI_T6963C WHITE
SPI_T6963C_ BLACK
SPI_T6963C WHITE
SPI T6963C_ BLACK
SPI_T6963C WHITE
SPI T6963C BLACK
SPI T6963C WHITE

117,
107,
97,
87,
77,

)
)
)
)
)
)
)
)
)
)
)

SPI T6963C BLACK) ;

’

’

’

’

’

’

’

’

’

’

12,
12,
12,
12,
12,

SPI_T6963C_WHITE)
SPI_T6963C_BLACK)
SPI_T6963C_WHITE) ;
SPI_T6963C_BLACK) ;
SPI_T6963C_WHITE);

// Draw a sprite

’

’

// Select other graphic panel
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SPI T6963C image (@mikroE 240x128 bmp) ;
SPI_T6963C displayGrPanel (1) ;
Delay ms (1000);
{SIFDEF PART IAL IMAGE DEMO}

SPI _T6963C grFill(0);

SPI T6963C PartiallImage (O, O, 64, 64, 240, 128,

partial image

Delay ms (1000);

SPI T6963C graphics (0);
{SENDIF}
SPI T6963C image (@mikroE 240x128 bmp) ;
SPI T6963C graphics(1);
SPI T6963C displayGrPanel (0);

@mikroE 240x128 bmp); // Display

while (TRUE) do // Endless loop

begin
{*
* If RB8 is pressed, toggle the display between graphic panel 0 and graphic 1
*}
if (RB8 bit <> 0) then
begin
Inc (panel) ;
panel := panel and 1;
SPI T6963C setPtr ((SPI _T6963C grMemSize + SPI T6963C txtMemSize)
SPI T6963C GRAPHIC HOME ADDRESS SET) ;
Delay ms (300);
end

* panel,

{*
* If RB9 is pressed, display only graphic panel
*}
else
if (RBY9 bit <> 0) then
begin
SPI T6963C graphics (1) ;
SPI T6963C text (0) ;
Delay ms (300);
end

{*
* If RB10 is pressed, display only text panel
*}
else
if (RB10 bit <> 0) then
begin
SPI T6963C graphics (0);
SPI_T6963C text(l);
Delay ms (300);
end

{*
* If RB11 is pressed, display text and graphic panels

*}
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else
if (RB11 bit <> 0) then
begin
SPI T6963C graphics(1l);
SPI_T6963C text(l);
Delay ms(300);
end

{*
* If RB12 is pressed, change cursor

*}

else
if (RB12 bit <> 0) then
begin
Inc (curs) ;
if (curs = 3) then
curs := 0;
case curs of
0:
// no cursor
SPI T6963C cursor (0);
1: begin
// blinking cursor
SPI_T6963C_cursor(1l);
SPI T6963C cursor blink(1l);
end;
2: begin
// non blinking cursor
SPI T6963C cursor(1l);
SPI T6963C cursor blink(0);
end;
end;
Delay ms (300);
end

{*

* If RB13 is pressed, perform the “Partial image” demonstration

*}
else
{SIFDEF PART IAL IMAGE DEMO }
if ( RB13 bit = 1) then
begin

SPI T6963C setGrPanel (0);
SPI T6963C setTxtPanel (0);
SPI T6963C txtFill(0);
SPI T6963C setGrPanel(1l);
SPI T6963C setTxtPanel (0);
SPI T6963C graphics(1l);
SPI T6963C text(l);
SPI T6963C displayGrPanel (1);

SPT_T6963C write text(txt2, 5, 15, SPI T6963C ROM MODE XOR);

DelgyilseCT);

SPI T6963C grFill (0);
SPI T6963C PartiallImage (0, 0, 64, 64, 240,
Delay ms (1500);

@mikroE 240x128 bmp) ;
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SPI_T6963C_PartialImage (0, 0, 128, 128, 240, 128, @mikroE 240x128 bmp) ;

Delay ms (1500);

SPI T6963C PartiallImage (0, 0, 240, 128, 240, 128, @mikroE 240x128 bmp) ;

Delay ms (1500);

SPI T6963C txtFill(0);
SPI_T6963C_write text(txt, 0, 0, @mikroE 240x128 bmp) ;
SPI T6963C write text(txtl, 0, 15, @mikroE 240x128 bmp) ;
end;
{SENDIF}
{*
* Move cursor, even if not visible
*
}
Inc (cposx) ;
if (cposx = SPI T6963C txtCols) then
begin
cposx := 0;
Inc (cposy) ;

if (cposy = SPI _T6963C grHeight / SPI_T6963C_CHARACTER HEIGHT) then

cposy := 0;
end;
SPI T6963C set cursor(cposx, Cposy);

Delay ms(100);
end;
end.

HW Connection

MCP23517
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T6963C Graphic Lcd Library

The mikroPascal PRO for PIC32 provides a library for working with Glcds based on TOSHIBA T6963C controller. The
Toshiba T6963C is a very popular Lcd controller for the use in small graphics modules. It is capable of controlling
displays with a resolution up to 240x128. Because of its low power and small outline it is most suitable for mobile
applications such as PDAs, MP3 players or mobile measurement equipment. Although small, this contoller has a
capability of displaying and merging text and graphics and it manages all the interfacing signals to the displays Row
and Column drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Important:

- When using this library with PIC32 family of MCUs be aware of their voltage incompatibility with certain number
of T6963C based Glcd modules. So, additional external power supply for these modules may be required.

- ChipEnable(CE), FontSelect(FS) and Reverse(MD) have to be set to appropriate levels by the user outside of the
T6963C_Init() function. See the Library Example code at the bottom of this page.

- Glcd size based initialization routines can be found in setup library files located in the Uses folder.

- The user must make sure that used MCU has appropriate ports and pins. If this is not the case the user should
adjust initialization routines.

Some mikroElektronika’s adapter boards have pinout different from T6369C datasheets. Appropriate relations between
these labels are given in the table below:

Adapter Board T6369C datasheet

RS C/D
R/W /RD
E /WR

Library Dependency Tree
( T6963C ——+{ Trigonometry |
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External dependencies of T6963C Graphic Lcd Library

The following variables must be
defined in all projects using T6963C
Graphic Lcd library:

Description:

Example:

external;

Reset signal.

LATF4 bit;

ar T6963C_dataPort : d; sfr; ar T6963C_dataPort d at
v _dataPor wor T6963C Data Port. v _dataPor wor
external; PORTB;
var T6963C ctrlwr sbit; sfr; Write signal var T6963C ctrlwr sbit at
external; gnat. LATF2 bit;
var T6963C ctrlrd sbit; sfr; Read sianal var T6963C ctrlrd sbit at
external; gnal. LATF1 bit;
var T6963C ctrlcd sbit; sfr; Command/Data signal var T6963C ctrlcd sbit at
external; ° a ata signal. LATFO bit;
var T6963C ctrlrst sbit; sfr; var T6963C ctrlrst sbit at

var T6963C _ctrlwr Direction
sbit; sfr; external;

Direction of the Write pin.

var T6963C ctrlwr Direction
sbit at TRISF2 bit;

var T6963C ctrlrd Direction
sbit; sfr; external;

Direction of the Read pin.

var T6963C ctrlrd Direction
sbit at TRISF1 bit;

var T6963C ctrlcd Direction
sbit; sfr; external;

Direction of the Command/
Data pin.

var T6963C ctrlcd Direction
sbit at TRISFO bit;

var T6963C ctrlrst Direction
sbit; sfr; external;

Direction of the Reset pin.

var T6963C ctrlrst Direction
sbit at TRISF4 bit;
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Library Routines

- T6963C_init

- T6963C_writeData

- T6963C_writeCommand
- T6963C_setPtr

- T6963C_waitReady

- T6963C_fill

- T6963C_dot

- T6963C_write_char

- T6963C_write_text

- T6963C_line

- T6963C_rectangle

- T6963C_Rectangle_round_edges
- T6963C_Rectangle_round_edges_fill
- T6963C_box

- T6963C_circle

- T6963C_Circle_fill

- T6963C_image

- T6963C_Partiallmage

- T6963C_sprite

- T6963C_set_cursor

- T6963C_displayGrPanel
- T6963C_displayTxtPanel
- T6963C_setGrPanel

- T6963C_setTxtPanel

- T6963C_panelFill

- T6963C_grFill

- T6963C_txtFill

- T6963C_cursor_height

- T6963C_graphics

- T6963C _text

- T6963C_cursor

- T6963C_cursor_blink
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T6963C_init

Prototype procedure T6963C init (width, height, fntW : word);

Description | Initalizes the Graphic Lcd controller.

Display RAM organization:
The library cuts the RAM into panels: a complete panel is one graphics panel followed by a text panel
(see schematic below).

R e L T L L et + /\
+ GRAPHICS PANEL #0 +
+ +
+ +
+ +
e it + | PANEL 0
+ TEXT PANEL #0 +
+ +\/
R e L T L L et + /\
+ GRAPHICS PANEL #1 +
+ +
+ +
+ +
e it + | PANEL 1
+ TEXT PANEL #1 +
+ +
R e L T L L et + \/

Parameters | - width: width of the Glcd panel
- height: height of the Glcd panel
- fntw: font width

Returns Nothing.

Requires Global variables:

-T6963C dataPort: Data Port

-T6963C ctrlwr: Write signal pin

-T6963C ctrlrd: Read signal pin

-T6963C ctrlcd: Command/Data signal pin

-T6963C ctrlrst: Reset signal pin

-T6963C ctrlwr Direction: Direction of Write signal pin

-T6963C ctrlrd Direction: Direction of Read signal pin

-T6963C ctrlcd Direction: Direction of Command/Data signal pin
-T6963C ctrlrst Direction: Direction of Reset signal pin

must be defined before using this function.
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Example // T6963C module connections
var T6963C dataPort : byte at PORTB; // DATA port
var T6963C ctrlwr : sbit at LATF2 bit; // WR write signal
var T6963C ctrlrd : sbit at LATFI1 bit; // RD read signal
var T6963C ctrlcd : sbit at LATF0 bit; // CD command/data signal
var T6963C ctrlrst : sbit at LATF4 bit; // RST reset signal
var T6963C ctrlwr Direction : sbit at TRISF2 bit; // WR write signal
direction
var T6963C ctrlrd Direction : sbit at TRISF1 bit; // RD read signal
direction
var T6963C ctrlcd Direction : sbit at TRISFO bit; // CD command/
data signal direction
var T6963C ctrlrst Direction : sbit at TRISF4 bit; // RST reset signal
direction

// Signals not used by library, they are set in main function

var T6963C ctrlce : sbit at LATF3 bit; // CE signal

var T6963C ctrlfs : sbit at LATF6 bit; // FS signal

var T6963C ctrimd : sbit at LATF5 bit; // MD signal

var T6963C ctrlce Direction : sbit at TRISF3 bit; // CE signal
direction

var T6963C ctrlfs Direction : sbit at TRISF6 bit; // FS signal
direction

var T6963C ctrlmd Direction : sbit at TRISF5 bit; // MD signal
direction

// End T6963C module connections

// init display for 240 pixel width, 128 pixel height and 8 bits character
width
T6963C init (240, 128, 8);

Notes None.

T6963C_writeData

Prototype procedure T6963C writeData (mydata : byte);

Description | Writes data to T6963C controller.
Parameters | - mydata: data to be written

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C writeData (AddrL);

Notes None.
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T6963C_writeCommand

Prototype procedure T6963C writeCommand (mydata : byte);
Description | Writes command to T6963C controller.

Parameters | - mydata: command to be written

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C writeCommand (T6963C CURSOR POINTER SET) ;

Notes None.

T6963C_setPtr

Prototype procedure T6963C setPtr(p : word; c : byte);
Description | Sets the memory pointer p for command p.
Parameters | - p: address where command should be written
- c: command to be written
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C setPtr (T6963C grHomeAddr + start, T6963C ADDRESS POINTER SET);
Notes None.

T6963C_waitReady

Prototype procedure T6963C waitReady ()’

Description | Pools the status byte, and loops until Toshiba Glcd module is ready.
Parameters | None.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C waitReady () ;

Notes None.
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T6963C fill
Prototype procedure T6963C fill(v : byte; start, len : word);
Description | Fills controller memory block with given byte.
Parameters | - v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C fill (0x33,0x00FF, 0x000F) ;
Notes None.
T6963C_dot
Prototype procedure T6963C dot(x, y : integer; color : byte);
Description | Draws a dot in the current graphic panel of Glcd at coordinates (x, y).
Parameters | - x: dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C dot (x0, y0, pcolor);
Notes None.
MikroElektronika
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T6963C_write_char

Prototype

procedure T6963C write char(c, x, y, mode : byte);

Description

Writes a char in the current text panel of Glcd at coordinates (X, y).

Parameters

- c: char to be written

- x: char position on x-axis

- v: char position on y-axis

- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR, T6963C_ROM_MODE_XOR,
T6963C_ROM_MODE_AND and T6963C_ROM_MODE_TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data is logically “OR-ed”. This
is the most common way of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the logical “exclusive OR”.
This can be useful to display text in the negative mode, i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the logical “AND
function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text Attribute values are
stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Returns

Nothing.

Requires

Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example

T6963C write char(‘A’,22,23,T6963C ROM MODE AND) ;

Notes

None.
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T6963C_write_text

Prototype procedure T6963C write text(var str array[10] of byte; x, vy, mode
byte);

Description | Writes text in the current text panel of Glcd at coordinates (X, y).

Parameters | - str: text to be written
- x: text position on x-axis
- v: text position on y-axis
- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR, T6963C_ROM_MODE_XOR,
T6963C_ROM_MODE_AND and T6963C_ROM_MODE_TEXT
Mode parameter explanation:
- OR Mode: In the OR-Mode, text and graphics can be displayed and the data is logically “OR-ed”. This
is the most common way of combining text and graphics for example labels on buttons.
- XOR-Mode: In this mode, the text and graphics data are combined via the logical “exclusive OR”.
This can be useful to display text in the negative mode, i.e. white text on black background.
- AND-Mode: The text and graphic data shown on display are combined via the logical “AND
function”.
- TEXT-Mode: This option is only available when displaying just a text. The Text Attribute values are
stored in the graphic area of display memory.
For more details see the T6963C datasheet.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example T6963C write text ('GLCD LIBRARY DEMO, WELCOME !/, 0, 0, T6963C_ROM MODE
XOR) ;

Notes None.

T6963C _line

Prototype procedure T6963C line(x0, y0, x1, yl integer; pcolor : byte);

Description | Draws a line from (x0, y0) to (x1, y1).

Parameters | - x0: x coordinate of the line start
- y0:y coordinate of the line end
- x1: x coordinate of the line start
- y1:y coordinate of the line end
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example T6963C line (0, 0, 239, 127, T6963C WHITE) ;

Notes None.
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T6963C _rectangle

Prototype procedure T6963C rectangle (x0, y0, x1, vyl integer; pcolor : byte);
Description | Draws a rectangle on Glcd.
Parameters | - x0: x coordinate of the upper left rectangle corner
- y0:y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C rectangle (20, 20, 219, 107, T6963C WHITE);
Notes None.
T6963C_rectangle_round_edges
Prototype procedure T6963C rectangle round edges(x0, y0, x1, yl, radius integer;
pcolor : byte);
Description | Draws a rounded edge rectangle on Glcd.
Parameters | - <0: x coordinate of the upper left rectangle corner
- v0:y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- round_radius: radius of the rounded edge.
- pcolor: color parameter. Valid values: T6963C BLACK and T6963C WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C rectangle round edges (20, 20, 219, 107, 12, T6963C WHITE);
Notes None.
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T6963C_rectangle_round_edges_fill

Prototype procedure T6963C rectangle round edges fill (x0, y0, x1, yl, radius : integer;
pcolor : byte);
Description | Draws a filled rounded edge rectangle on Glcd.
Parameters | - x0: x coordinate of the upper left rectangle corner
- y0:y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- round_radius: radius of the rounded edge
- pcolor: color parameter. Valid values: T6963C BLACK and T6963C WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C rectangle round edges fill (20, 20, 219, 107, 12, T6963C WHITE);
Notes None.
T6963C_box
Prototype procedure T6963C box(x0, y0, x1, yl integer; pcolor : byte);
Description | Draws a box on Glcd
Parameters | - x0: x coordinate of the upper left box corner
- y0:y coordinate of the upper left box corner
- x1: x coordinate of the lower right box corner
- y1:y coordinate of the lower right box corner
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C box (0, 119, 239, 127, T6963C WHITE)
Notes None.
T6963C_circle
Prototype procedure T6963C circle(x, y : integer; r longint; pcolor : word);
Description | Draws a circle on Glcd.
Parameters | - <: x coordinate of the circle center
- y: y coordinate of the circle center
- r: radius size
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C circle (120, 64, 110, T6963C WHITE);
Notes None.
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T6963C _circle_fill

Prototype procedure T6963C Circle fill(x, y : integer; r : longint; pcolor : word);
Description | Draws a filled circle on Glcd.
Parameters | - x: x coordinate of the circle center
- v: y coordinate of the circle center
- r: radius size
- pcolor: color parameter. Valid values: T6963C BLACK and T6963C WHITE
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C circle fill(120, 64, 110, T6963C WHITE);
Notes None.

T6963C_image

Prototype procedure T6963C image (const pic : "“byte);

Description | Displays bitmap on Glcd.

Parameters | - pic:image to be displayed. Bitmap array can be located in both code and RAM memory (due to the
mikroPascal PRO for PIC32 pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C_image (my image);

Notes Image dimension must match the display dimension.
Use the integrated Glcd Bitmap Editor (menu option Tools » Gled Bitmap Editor) to convert image to
a constant array suitable for displaying on Glcd.
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T6963C_Partiallmage

Prototype procedure T6963C PartialImage(x left, y top, width, height, picture width,
picture height : word; const image “byte) ;

Description | Displays a partial area of the image on a desired location.

Parameters | - x _1eft: x coordinate of the desired location (upper left coordinate).
- y_top:y coordinate of the desired location (upper left coordinate).
- width: desired image width.
- height: desired image height.
- picture width: width of the original image.
-picture height: height of the original image.
- image: image to be displayed. Bitmap array can be located in both code and RAM memory (due to
the mikroPascal PRO for PIC pointer to const and pointer to RAM equivalency).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See T6963C_init routine.

Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12). Original image size is 16x32.
T6963C pPartiallImage (10, 12, 10, 15, 16, 32, @image);

Notes Use the integrated Glcd Bitmap Editor (menu option Tools » Glcd Bitmap Editor) to convert image to
a constant array suitable for displaying on Glcd.

T6963C _sprite

Prototype procedure T6963C sprite(px, py : byte; const pic “byte; sx, sy : byte);
Description | Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters | - px: x coordinate of the upper left picture corner. Valid values: multiples of the font width
- py: y coordinate of the upper left picture corner
- pic: picture to be displayed
- sx: picture width. Valid values: multiples of the font width
- sy: picture height
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C sprite(76, 4, einstein, 88, 119); // draw a sprite
Notes If px and sx parameters are not multiples of the font width they will be scaled to the nearest lower
number that is a multiple of the font width.
MikroElektronika
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T6963C_set_cursor

Prototype procedure T6963C set cursor(x, y : byte);
Description | Sets cursor to row x and columny.
Parameters | - x: cursor position row number
- y: cursor position column number
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example T6963C set cursor (cposx, cposy);
Notes None.

T6963C_displayGrPanel

Prototype |procedure T6963C displayGrPanel (n : word);
Description | Display selected graphic panel.
Parameters | - n: graphic panel number. Valid values: 0 and 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example // display graphic panel 1
T6963C displayGrPanel (1) ;
Notes None.

T6963C_displayTxtPanel

Prototype procedure T6963C displayTxtPanel(n : word);
Description | Display selected text panel.
Parameters | - n: text panel number. Valid values: 0 and 1.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // display text panel 1
T6963C displayTxtPanel (1) ;
Notes None.
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T6963C_setGrPanel

Prototype procedure T6963C setGrPanel (n : word);

Description | Compute start address for selected graphic panel and set appropriate internal pointers. All subsequent
graphic operations will be preformed at this graphic panel.

Parameters | - n: graphic panel number. Valid values: 0 and 1.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example // set graphic panel 1 as current graphic panel.
T6963C setGrPanel (1),

Notes None.

T6963C_setTxtPanel

Prototype procedure T6963C setTxtPanel(n : word);

Description | Compute start address for selected text panel and set appropriate internal pointers. All subsequent
text operations will be preformed at this text panel.

Parameters | - n: text panel number. Valid values: 0 and 1.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example // set text panel 1 as current text panel.
T6963C setTxtPanel (1) ;

Notes None.

T6963C_panelFill

Prototype |procedure T6963C panelFill (v : word);
Description | Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Parameters | - v: value to fill panel with.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example clear current panel
T6963C panelFill(0);
Notes None.
MikroElektronika
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T6963C_grFill
Prototype procedure T6963C grFill (v: word);
Description | Fill current graphic panel with appropriate value (0 to clear).
Parameters | - v: value to fill graphic panel with.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.
Example // clear current graphic panel
T6963C grFill(0);
Notes None.

T6963C_txtFill

Prototype procedure T6963C txtFill (v : word);
Description | Fill current text panel with appropriate value (0 to clear).
Parameters | - v: this value increased by 32 will be used to fill text panel.
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // clear current text panel
T6963C txtFill(0);
Notes None.

T6963C_cursor_height

Prototype procedure T6963C cursor height (n: word);

Description | Set cursor size.

Parameters | - n: cursor height. Valid values: 0. . 7.

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C cursor height (7);

Notes None.
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T6963C_graphics

Prototype procedure T6963C graphics(n : word);

Description | Enable/disable graphic displaying.

Parameters | - n: graphic enable/disable parameter. Valid values: 0 (disable graphic dispaying) and 1 (enable
graphic displaying).

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example // enable graphic displaying
T6963C graphics(1);

Notes None.

T6963C _text

Prototype procedure T6963C text(n : word);
Description | Enable/disable text displaying.
Parameters | - n: on/off parameter. Valid values: 0 (disable text displaying) and 1 (enable text displaying).
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // enable text displaying
T6963C text (1) ;
Notes None.

T6963C _cursor

Prototype procedure T6963C cursor(n : word);
Description | Set cursor on/off.
Parameters | - n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Returns Nothing.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // set cursor on
T6963C cursor(1l);
Notes None.
MikroElektronika
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T6963C_cursor_blink

Prototype |procedure T6963C cursor blink(n : word);

Description | Enable/disable cursor blinking.

cursor blinking).

Parameters | - n: cursor blinking enable/disable parameter. Valid values: 0 (disable cursor blinking) and 1 (enable

Returns Nothing.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_init routine.

Example // enable cursor blinking
T6963C cursor blink(1l);

Notes None.

Library Example

The following drawing demo tests advanced routines of the T6963C Glcd library. Hardware configurations in this
example are made for the LV-32MX v6 board and PIC32MX460F512L.

Copy Code To Clipboard
program T6963C 240x128;

uses Lib T6963C Consts;

// T6963C module connections

var T6963C_dataPort : byte at PORTD; //
var T6963C_cntlPort : byte at PORTE; //
var T6963C_ctrlwr : sbit at LATE2 bit; //
var T6963C ctrlrd : sbit at LATEl bit; //
var T6963C_ctrlcd : sbit at LATE(O bit; //

var T6963C ctrlrst : sbit

var T6963C ctrlwr Direction
var T6963C ctrlrd Direction
var T6963C ctrlcd Direction
var T6963C ctrlrst Direction

// Signals not used by library,

at LATE4 bit; //

sbit at TRISE2 bit; //
sbit at TRISEl bit; //

DATA port
DATA port

WR write signal

RD
CD

read signal
command/data signal

RST reset signal
WR write signal direction

RD

read signal direction

sbit at TRISE(O bit; // CD command/data signal direction
sbit at TRISE4 bit; // RST reset signal direction

var T6963C_ctrlce : sbit at LATE3 bit; //
var T6963C_ctrlfs : sbit at LATE6 bit; //
var T6963C_ctrlmd : sbit at LATES bit; //
var T6963C ctrlce Direction sbit at TRISE3 bit; //
var T6963C ctrlfs Direction sbit at TRISE6 bit; //
var T6963C ctrlmd Direction sbit at TRISES bit; //

// End T6963C module connections

var panel : byte;

i : word;

curs : byte;
cposx,

// current panel
// general purpose register
// cursor visibility

they are set in main function

CE
F'S
MD
CE
F'S
MD

signal
signal
signal
signal direction
signal direction
signal direction
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cposy : word; // cursor x-y position
txtcols : byte; // number of text coloms
txt, txtl : string[29];

txt2 : string[21];

begin
{SDEFINE LINE DEMO} // Uncomment to demonstrate line drawing routines
{$DEFINE FILL DEMO} // Uncomment to demonstrate fill routines

{SDEFINE PARTIAL IMAGE DEMO} // Uncomment to demonstrate partial image routine

txtl := ' EINSTEIN WOULD HAVE LIKED mE';

txt := ' GLCD LIBRARY DEMO, WELCOME !';

txt2 := ' Partial image demo! ';

CHECON := 0x32;

AD1IPCFG := OxFFFF;

TRISB8 bit := 1; // Set RB8 as input
TRISB9_bit = 1; // Set RB9 as input
TRISB10 bit := 1; // Set RB10 as input
TRISB11l bit := 1; // Set RB1l as input
TRISB12 bit := 1; // Set RB12 as input
TRISB13 bit := 1; // Set RB13 as input
T6963C ctrlce Direction := 0;

T6963C ctrlce := 0; // Enable T6963C
T6963C ctrlfs Direction := 0;

T6963C ctrlfs := 0; // Font Select 8x8
T6963C ctrlmd Direction := 0;

T6963C ctrlmd := 0; // Column number select
panel := 0;

i = 0;

curs := 0;

cposx := 0;

cposy := 0;

// Initialize T6369C
T6963C init (240, 128, 8);

{*

* Enable both graphics and text display at the same time
*}

T6963C graphics(1);

T6963C text(1);

{*

* Text messages

*}
T6963C write text(txt, 0, 0, T6963C ROM MODE XOR) ;
T6963C write text (txtl, 0, 15, T6963C ROM MODE XOR) ;
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{*

* Cursor

*}
T6963C cursor height (8);
T6963C set cursor (0, 0);
T6963C cursor(0);

{*
* Draw solid boxes
*}

T6963C box (0,

T6963C box (0,

0, 239,
119,

8, T6963C WHITE);
239, 127, T6963C_WHITE);

{*
* Draw rectangles
*}
{SIFDEF LINE DEMO}

// 8 pixel height
// Move cursor to top left
// Cursor off

T6963C rectangle(0, 0, 239, 127, T6963C WHITE);

T6963C rectangle (20, 20, 219, 107, T6963C WHITE);
T6963C rectangle (40, 40, 199, 87, T6963C WHITE);
T6963C rectangle (60, 60, 179, 67, T6963C WHITE);

{SENDIF}

{*

* Draw rounded edge rectangle
*}

{SIFDEF LINE DEMO}

T6963C Rectangle Round Edges (10, 10, 229,
T6963C Rectangle Round Edges (30, 30, 209,
T6963C Rectangle Round Edges (50, 50, 189,

{SENDIF}

{*

* Draw filled rounded edge rectangle

*}

{SIFDEF FILL DEMO}
T6963C Rectangle Round Edges Fill (10, 10,
T6963C Rectangle Round Edges Fill (20, 20,
T6963C Rectangle Round Edges Fill (30, 30,
T6963C Rectangle Round Edges Fill (40, 40,
T6963C Rectangle Round Edges Fill (50, 50,

{SENDIF}

{*
* Draw a Ccross
*}
{SIFDEF LINEiDEMO}
T6963C line (0, 0, 239, 127, T6963C WHITE);
T6963C line(0, 127, 239, 0, T6963C WHITE);
{SENDIF}

117,
97,
77,

12, T6963C WHITE) ;
12, T6963C WHITE) ;
12, T6963C WHITE) ;

229,
219,
209,
199,
189,

117,
107,
97,
87,
77,

12, T6963C WHITE) ;
12, T6963C BLACK) ;
12, T6963C WHITE);
12, T6963C BLACK) ;
12, T6963C WHITE) ;
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{‘k
* Draw circles
*}

{$IFDEF LINE DEMO}
T6963C circle (120,
T6963C circle (120,
T6963C circle (120,
T6963C circle (120,
T6963C circle (120,
T6963C circle (120,
T6963C circle (120,

{SENDIF}

{*

* Draw filled circles
*}

{SIFDEF FILLiDEMO}

64,
64,
64,
64,
64,
64,
64,

T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,

T6963C circle fill
T6963C circle fill

120,
120,

T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,
T6963C circle fill (120,

(
(
(
(
(
(
(
(
(
(
(
(

{SENDIF}
Delay ms (1000);
T6963C sprite(76, 4,
Delay ms (1000);

T6963C setGrPanel (1);

10,
30,
50,
70,
90,
110,
130,

64,
64,
64,
64,
64,
64,
64,
64,
64,
64,
64,
64,

T6963C_WHITE) ;
T6963C_WHITE) ;
T6963C_WHITE) ;
T6963C_WHITE) ;
T6963C_WHITE) ;
T6963C WHITE) ;
T6963C WHITE) ;

60, T6963C_WHITE) ;
55, T6963C_BLACK) ;
50, T6963C_WHITE);
45, T6963C_BLACK) ;
40, T6963C_WHITE);
35, T6963C_BLACK) ;
30, T6963C_WHITE);
25, T6963C_BLACK) ;
20, T6963C_WHITE) ;
15, T6963C_BLACK) ;
10, T6963C_WHITE);
5, T6963C_BLACK) ;

@einstein, 88, 119);

T6963C image (@mikroE 240x128 bmp) ;

T6963C displayGrPanel (1) ;

Delay ms (1000);

{SIFDEF PARTIAL IMAGE DEMO}

T6963C_grFill (0);

// Draw a sprite

// Select other graphic panel

T6963C PartialImage (0, 0, 64, 64, 240, 128, @mikroE 240x128 bmp); // Display partial

image
Delay ms (1000);
T6963C graphics (0);
{SENDIF}

T6963C image (@mikroE 240x128 bmp) ;

T6963C graphics(1);

T6963C displayGrPanel (0);
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while (TRUE) do // Endless loop
begin

{*

* If RB8 1is pressed, toggle the display between graphic panel 0 and graphic 1
*}

if (RB8 bit <> 0) then

begin
Inc (panel) ;
panel := panel and 1;

T6963C setPtr ((T6963C grMemSize + T6963C txtMemSize) * panel, T6963C GRAPHIC
HOME ADDRESS SET) ;
Delay ms(300) ;
end

{*
* If RBY9 is pressed, display only graphic panel
*}

else
if (RB9 bit <> 0) then
begin
T6963C graphics (1) ;
T6963C text (0) ;
Delay ms (300) ;
end

{*
* If RB10 is pressed, display only text panel
*}
else
if (RB10 bit <> 0) then
begin
T6963C graphics(0);
T6963C text (1);
Delay ms (300);
end

{*
* If RB11 is pressed, display text and graphic panels
*}
else
if (RB11 bit <> 0) then
begin
T6963C graphics(1l);
T6963C text (1l);
Delay ms (300);
end

{*
* If RB12 is pressed, change cursor

*}
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else
if (RB12 bit <> 0) then
begin
Inc(curs);
if (curs = 3) then
curs := 0;
case curs of
0:
// no cursor
T6963C cursor (0) ;
1: begin
// blinking cursor
T6963C cursor (1) ;
T6963C_cursor_blink(1);
end;
2: begin
// non blinking cursor
T6963C cursor (1) ;
T6963C_cursor_blink(0);
end;
end;
Delay ms (300);
end

{*

* If RB13 is pressed, perform the “Partial image” demonstration

*}
else
{SIFDEF PART IAL IMAGE DEMO }
if ( RB13 bit = 1) then
begin

T6963C setGrPanel (0);
T6963C setTxtPanel (0);
T6963C txtFill(0);
T6963C setGrPanel(1l);
T6963C setTxtPanel (0);
T6963C graphics (1) ;
T6963C text (1)
T6963C displayGrPanel (1) ;

T6963C write text (txt2, 5, 15, T6963C ROM MODE XOR) ;

Delay lsec();

T6963C grFill (0);

T6963C PartialImage (0, 0, 64, 64, 240, 128, @mikroE 240x128 bmp) ;
Delay ms (1500);

T6963C PartialImage (0, O, 128, 128, 240, 128, @mikroE 240x128 bmp);
Delay ms (1500);

T6963C PartialImage (0, O, 240, 128, 240, 128, @mikroE 240x128 bmp);

Delay ms (1500);
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T6963C txtFill (0);

T6963C write text (txt,

B B 0, 0, T6963C_ROM MODE XOR) ;
T6963C write text(txtl, 0, 15, T6963C_ROM MODE XOR) ;
end;
{SENDIF}
{*
* Move cursor, even if not visible
*}
Inc (cposx) ;
if (cposx = T6963C txtCols) then
begin
cposx := 0;
Inc (cposy) ;
if (cposy = T6963C grHeight div T6963C CHARACTER HEIGHT) then
cposy := 03
end;

T6963C set cursor (cposx, Cposy);

Delay ms (100);
end;
end.
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HW Connection

Teshiba TE963C Graphic LCD (240x128)

Py e e
LR S L N

Dz, ol

Contrast
Adjustment

SPIT6963C Gled HW connection
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TFT Library

Thin film transistor liquid crystal display (TFT-LCD) is a variant of liquid crystal display (LCD) which uses thin-film
transistor (TFT) technology to improve image quality (e.g., addressability, contrast).
TFT LCD is one type of active matrix LCD, though all LCD-screens are based on TFT active matrix addressing.

TFT LCDs are used in television sets, computer monitors, mobile phones, handheld video game systems, personal
digital assistants, navigation systems, projectors, etc.

The mikroPascal PRO for PIC32 provides a library for working with HX8347-D 320x240 TFT Lcd controller.The
HX8347-D is designed to provide a single-chip solution that combines a gate driver, a source driver, power supply
circuit for 262,144 colors to drive a TFT panel with 320x240 dots at maximum.

The HX8347-D is suitable for any small portable battery-driven and long-term driving products, such as small PDAs,
digital cellular phones and bi-directional pagers.

External dependencies of TFT Library

The following variables must be defined in all
projects using TFT library:

Description:

Example:

var
sfr;

TFT DataPort byte; external;

TFT Data Port.

var TFT DataPort

: byte at LATE;

923

var TFT DataPort Direction byte; . . var TFT DataPort Direction : byte

- - 7 Direction of the TFT Data Port. i - v
external; sfr; at TRISE;
var TFT WR : sbit; sfr; external; Write signal. var TFT WR : sbit at LATDI13 bit;
var TFT RD : sbit; sfr; external; Read signal. var TFT RD : sbit at LATDI12 bit;
var TFT CS : sbit; sfr; external; Chip Select signal. var TFT CS : sbit at LATC3 bit;
var TFT RS sbit; sfr; external; gg:zramﬂRegSmrSebct var TFT RS sbit at LATB1S bit;
var TFT_RST : sbit; sfr; external; Reset signal. var TFT_RST : sbit at LATCl bit;
var TFT WR Direction sbit; sfr; Direction of the Write pin var TFT WR Direction sbit at
external; pin. TRISD13 bit;
var TFT RD Direction sbit; sfr; Direction of the Read pin var TFT RD Direction sbit at
external; pin. TRISD12 bit;
var TFT CS Direction sbit; sfr; | Direction of the Chip Select var TFT CS Direction sbit at
external; pin. TRISC3 bit;
var TFT RS Direction sbit; sfr; | Direction of the Register Select | var TFT RS Direction sbit at
external; pin. TRISB13 bit;
var TFT RST Direction sbit; sfr; Direction of the Reset pin var TFT RST Direction sbit at
external; irection of the Reset pin. TRISC1 bit;
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Library Routines

- TFT_Init

- TFT_Set_Index

- TFT_Write_Command
- TFT_Write_Data

- TFT_Set_Active

- TFT_Set_Font

- TFT_Write_Char

- TFT_Write_Text

- TFT_Fill_Screen

- TFT_Set Pen

- TFT_Set_Brush

- TFT_Dot

-TFT_Line
-TFT_H_Line
-TFT_V_Line

- TFT_Rectangle

- TFT_Rectangle_Round_Edges
- TFT_Circle

- TFT_Image

- TFT_Partiallmage

- TFT_Image_Jpeg

- TFT_RGBToColor16bit
- TFT_Color16bitToRGB
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TFT Init

Prototype

procedure TFT Init(display width, display height

word)

’

Returns

Nothing

Description

Initializes TFT display in the 8-bit working mode.
Parameters:

- width: width of the TFT panel
- height: height of the TFT panel

Requires

Global variables :

- TFT DataPort: Data Port

- TET WR: Write signal pin

- TET RD: Read signal pin

- TET Cs: Chip Select signal pin

- TET RS: Register Select signal pin

- TET RST: Reset signal pin

- TFT DataPort Direction: Direction of Data Port

- TFT WR Direction: Direction of Write signal pin

- TFT RD Direction: Direction of Read signal pin

- TEFT CS Direction: Direction of Chip Select signal pin
- TET RS Direction: Direction of Register Select signal pin
- TFT RST Direction: Direction of Reset signal pin

must be defined before using this function.

Example

// TFT display connections

var TFT DataPort : byte at LATE;
var TFT WR : sbit at LATD13 bit;
var TFT RD : sbit at LATD12Z bit;
var TFT CS : sbit at LATC3 bit;
var TFT RS : sbit at LATB15 bit;
var TFT RST : sbit at LATCI bit;

var TFT DataPort Direction : byte at TRISE;
var TFT WR Direction : sbit at TRISDI3 bit;
var TFT RD Direction : sbit at TRISDIZ2 bit;
var TFT CS Direction : sbit at TRISC3 bit;
var TFT RS Direction : sbit at TRISB15 bit;
var TFT RST Direction : sbit at TRISCI bit;
// End of TFT display connections

// Initialize 240x320 TFT display
TFT Init (240, 320);
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TFT_Set Index

Prototype procedure TFT Set Index(index : byte);
Returns Nothing
Description | Accesses register space of the controller and sets the desired register.
Parameters:
- index: desired register number.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example // Access register at the location 0x02
TFT Set Index(0x02);

TFT_Write_Command

Prototype procedure TEFT Write Command(cmd : byte);
Returns Nothing
Description | Accesses data space and writes a command.

Parameters:

- cmd: command to be written.
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example // Write a command

TFT Write Command (0x02);

TFT_Write_Data

Prototype procedure TFT Write Data( data : word);
Returns Nothing
Description | Writes date into display memory.
Parameters:
- data:data to be written.
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example // Send data
TFT Write Data(0x02);
MikroElektronika
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TFT_Set_Active

Prototype |procedure TFT Set Active (Set Index Ptr : "TTFT_Set Index Ptr; Write Command
Ptr : ATTFT_Write_Command_Ptr; Write_Data_Ptr : ATTFT_Write_Data_Ptr);
Returns Nothing
Description | This function sets appropriate pointers to a user-defined basic routines in order to enable multiple
working modes.
Parameters:
- Set Index Ptr:Set_Index handler.
-Write Command Ptr:_Write_Command handler.
-Write Data Ptr:Write_Data handler.
Requires None.
Example // Example of establishing 16-bit communication between TFT display and

PORTD, PORTE of MCU

procedure Set Index(index : byte) {
TFT RS = 0;
Lo (LATD) = index;
TFT WR
TFT WR

0,
1;

procedure Write Command(cmd : byte) {
TFT RS = 1;
Lo (LATD) = cmd;

TFT WR = 0;
TFT WR = 1;
}
procedure Write Data( data : word) {

TFT RS = 1;

Lo (LATE) = Hi( _data);
Lo (LATD) Lo ( data);
TFT WR
TFT WR

0,
1

7

procedure main() {
TRISE = 0;
TRISD = 0;

TFT Set Active(Set Index,Write Command,Write Data);
TFT Init (320, 240);
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TFT_Set Font

font orientation : byte);

Prototype procedure TFT Set Font (activeFont : “const far byte; font color : word;

Returns Nothing

Description | Sets font, its color and font orientation.
Parameters:

- activeFont: desired font. Currently, only TET defaultFont (Tahoma14x16) is supported.
- font color: sets font color:

Value Description
CL_AQUA Aqua color
CL_BLACK Black color
CL BLUE Blue color
CL FUCHSIA Fuchsia color
CL_GRAY Gray color
CL_GREEN Green color
CL LIME Lime color
CL MAROON Maroon color
CL_NAVY Navy color
CL OLIVE Olive color
CL_PURPLE Purple color
CL_RED Red color
CL_SILVER Silver color
CL_TEAL Teal color

CL WHITE White color
CL YELLOW Yellow color

- font orientation: sets font orientation:

Value Description
FO_HORIZONTAL Horizontal orientation
FO_VERTICAL Vertical orientation

Requires TFT module needs to be initialized. See the TFT_Init routine.

Example TFT Set Font (@TFT defaultFont, CL BLACK, FO HORIZONTAL) ;
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TFT_Write_Char

Prototype procedure TFT Write Char(ch, x, y : word);
Returns Nothing.
Description | Writes a char on the TFT at coordinates (x, y).

- c: char to be written.

- x: char position on x-axis.

- v: char position on y-axis.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Write Char(‘A’,22,23,);

TFT_Write Text

Prototype procedure TFT Write Text (var text : string; x, y : word);
Returns Nothing.
Description | Writes text on the TFT at coordinates (x, y).
Parameters:
- text: text to be written.
- x: text position on x-axis.
- v: text position on y-axis.
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT Write Text (‘TFT LIBRARY DEMO, WELCOME !/, 0, 0);
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TFT_Fill_Screen

Prototype procedure TFT Fill Screen(color word) ;
Returns Nothing.
Description | Fills screen memory block with given color.
Parameters:
- color: color to be filled:

Value Description

CL_AQUA Aqua color

CL_BLACK Black color

CL_BLUE Blue color

CL_FUCHSIA Fuchsia color

CL_GRAY Gray color

CL GREEN Green color

CL LIME Lime color

CL_ MAROON Maroon color

CL_NAVY Navy color

CL_OLIVE Olive color

CL_PURPLE Purple color

CL_RED Red color

CL_SILVER Silver color

CL TEAL Teal color

CL_WHITE White color

CL_YELLOW Yellow color
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Fill Screen(CL BLACK);

MikroElektronika
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TFT Dot
Prototype |procedure TFT Dot (x, vy word) ;
Returns Nothing.
Description | Draws a dot on the TFT at coordinates (x, y).
Parameters:
- x: dot position on x-axis.
- v: dot position on y-axis.
- color: color parameter. Valid values:
Value Description
CL_AQUA Aqua color
CL_BLACK Black color
CL_BLUE Blue color
CL FUCHSIA Fuchsia color
CL_GRAY Gray color
CL_GREEN Green color
CL LIME Lime color
CL_MAROON Maroon color
CL_NAVY Navy color
CL_OLIVE Olive color
CL PURPLE Purple color
CL_RED Red color
CL_SILVER Silver color
CL_TEAL Teal color
CL WHITE White color
CL YELLOW Yellow color
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Dot (50, CL_BLACK) ;
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TFT_Set Pen

Prototype procedure TFT Set Pen(pen color : word; pen width : byte);

Returns Nothing.

Description | Sets color and thickness parameter for drawing line, circle and rectangle elements.
Parameters:

-pen color: Sets color.

Value Description
CL_AQUA Aqua color
CL BLACK Black color
CL_BLUE Blue color
CL_FUCHSIA Fuchsia color
CL GRAY Gray color
CL_GREEN Green color
CL LIME Lime color
CL_ MAROON Maroon color
CL_NAVY Navy color
CL OLIVE Olive color
CL_PURPLE Purple color
CL_RED Red color
CL_SILVER Silver color
CL_TEAL Teal color

CL WHITE White color
CL YELLOW Yellow color

- pen_ width: sets thickness.

Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Set Pen(CL BLACK, 10);
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TFT_Set Brush

Prototype |procedure TFT_ Set Brush (brush_enabled : byte; brush color : word; gradient_
enabled, gradient orientation byte; gradient color from, gradient color
to : word);

Returns Nothing.

Description | Sets color and gradient which will be used to fill circles or rectangles.

Parameters:

-brush enabled: enable brush fill.

Value | Description
1 Enable brush fill.
0 Disable brush fill.

-brush color: set brush fill color.

Value Description
CL_AQUA Aqua color
CL BLACK Black color
CL BLUE Blue color
CL_FUCHSIA Fuchsia color
CL_GRAY Gray color
CL_GREEN Green color
CL LIME Lime color
CL_MAROON Maroon color
CL_NAVY Navy color
CL_OLIVE Olive color
CL_PURPLE Purple color
CL RED Red color
CL_SILVER Silver color
CL_TEAL Teal color
CL_WHITE White color
CL_YELLOW Yellow color
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Description | - gradient enabled: enable gradient

Value | Description

1 Enable gradient.

0 Disable gradient.

-gradient orientation: sets gradient orientation :

Value

Description

LEFT TO RIGHT

Left to right gradient orientation

TOP_TO BOTTOM

Top to bottom gradient orientation

-gradient color from:sets the starting gradient color.

Value Description
CL_AQUA Aqua color
CL_BLACK Black color
CL_BLUE Blue color

CL_FUCHSIA

Fuchsia color

CL_GRAY Gray color
CL_GREEN Green color
CL LIME Lime color

CL_MAROON

Maroon color

CL NAVY Navy color
CL_OLIVE Olive color
CL_PURPLE Purple color
CL_RED Red color
CL SILVER Silver color
CL TEAL Teal color
CL WHITE White color
CL_YELLOW Yellow color
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Description | - gradient color to: sets the ending gradient color.
Value Description
CL_AQUA Aqua color
CL_BLACK Black color
CL BLUE Blue color
CL FUCHSIA Fuchsia color
CL_GRAY Gray color
CL_GREEN Green color
CL LIME Lime color
CL MAROON Maroon color
CL NAVY Navy color
CL_OLIVE Olive color
CL_PURPLE Purple color
CL_RED Red color
CL SILVER Silver color
CL TEAL Teal color
CL WHITE White color
CL_YELLOW Yellow color
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example // Enable gradient from black to white color, left-right orientation
TFT Set Brush(0, 0, 1, LEFT TO RIGHT, CL BLACK, CL WHITE);

TFT _Line

Prototype procedure TFT Line(xl, yl, x2, y2 : integer);

Returns Nothing.

Description | Draws a line from (x1, y1) to (x2, y2).
Parameters:

- x1: x coordinate of the line start.
- y1:y coordinate of the line end.
- x2: x coordinate of the line start.
- y2:y coordinate of the line end.

Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT _Line (0, 0, 239, 127);
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TFT_H_Line
Prototype procedure TFT H Line(x start, x end, y pos integer);
Returns Nothing.
Description | Draws a horizontal line on TFT.
Parameters:
- x_start: x coordinate of the line start.
- x_end: x coordinate of the line end.
- yv_pos:y coordinate of horizontal line.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example // Draw a horizontal line between dots (10,20) and (50,20)
TFT H Line (10, 50, 20);
TFT_V_Line
Prototype procedure TFT V Line(y start, y end, x pos integer);
Returns Nothing.
Description | Draws a vertical line on TFT.
Parameters:
-y start:y coordinate of the line start.
- y_end:y coordinate of the line end.
- x_pos: X coordinate of vertical line.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example // Draw a vertical line between dots (10,5) and (10,25)
TFT V Line(5, 25, 10);

TFT_Rectangle

Prototype procedure TFT Rectangle(x upper left, y upper left, x bottom right, vy
bottom right:integer);
Returns Nothing.
Description | Draws a rectangle on TFT.
Parameters:
- x upper left:x coordinate of the upper left rectangle corner.
-y upper left:y coordinate of the upper left rectangle corner.
- x bottom right:x coordinate of the lower right rectangle corner.
-y bottom right:y coordinate of the lower right rectangle corner.
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT Rectangle (20, 20, 219, 107);
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TFT_Rectangle_Round_Edges

Prototype procedure TFT Rectangle Round Edges (x upper left, y upper left, x bottom
right, y bottom right, round radius : word);
Returns Nothing.
Description | Draws a rounded edge rectangle on TFT.
Parameters:
- x_upper left:x coordinate of the upper left rectangle corner.
-y upper left:y coordinate of the upper left rectangle corner.
- x_bottom_ right:x coordinate of the lower right rectangle corner.
-y bottom right:y coordinate of the lower right rectangle corner.
- round_radius: radius of the rounded edge.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Rectangle Round Edges (20, 20, 219, 107, 12);
TFT_Circle
Prototype procedure TFT Circle(x center, y center, radius integer);
Returns Nothing.
Description | Draws a circle on TFT.
Parameters:
- x: x coordinate of the circle center.
- v: y coordinate of the circle center.
- r: radius size.
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT_Circle(lZO, 64, 110);
TFT_Image
Prototype procedure TFT Image (left, top word; image “const far byte; stretch
byte) ;
Returns Nothing.
Description | Displays an image on a desired location.
Parameters:
- left: position of the image’s left edge.
- top:position of the image’s top edge.
- image: image to be displayed. Bitmap array is located in code memory.
- stretch: stretches image by a given factor (if 2, it will double the image.).
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT Image (0, 0, image, 1);
MikroElektronika
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TFT_Partial_Image

Prototype procedure TFT Partial Image(left, top, width, height : word; image : “const
far byte; stretch : byte) ;
Returns Nothing.
Description | Displays a partial area of the image on a desired location.
Parameters:
- left: left coordinate of the image.
- top: top coordinate of the image.
- width: desired image width.
- height: desired image height.
- image: image to be displayed. Bitmap array is located in code memory.
- stretch: stretches image by a given factor (if 2, it will double the image.).
Requires TFT module needs to be initialized. See the TFT_Init routine.
Example // Draws a 10x15 part of the image starting from the upper left corner on
the coordinate (10,12)
TFT PartialImage (10, 12, 10, 15, @image, 1);

TFT_Image_Jpeg

Prototype function TFT Image Jpeg(left, top : word; image : “const far byte): byte;
Returns - 0 - ifimage is loaded and displayed successfully.
- 1 - if error occured.
Description | Displays a JPEG image on a desired location.
Parameters:
- left: left coordinate of the image.
- top: top coordinate of the image.
- image: image to be displayed. Bitmap array is located in code memory.
Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example TFT Image Jpeg (0, 0, image);
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TFT_RGBToColor16bit

Prototype function TFT RGBToColorlébit (rgb red, rgb green, rgb blue : byte) : word;

Returns Returns a color value in the following bit-order : 5 bits red, 6 bits green and 5 bits blue color.

Description | Converts 5:6:5 RGB format into true color format.
Parameters:
- rgb red: red component of the image.

- rgb_green: green component of the image.
- rgb blue: blue component of the image.

Requires TFT module needs to be initialized. See the TFT_lInit routine.
Example colorl6e = TFT Image Jpeg (150, 193, 65);

TFT_Color16bitToRGB

Prototype procedure TFT Colorl6bitToRGB(color : word; rgb red, rgb green, rgb blue
“byte) ;

Returns Nothing.

Description | Converts true color into 5:6:5 RGB format.
Parameters:

- color: true color to be converted.

- rgb red: red component of the input color.

- rgb green: green component of the input color.
- rgb blue: blue component of the input color.

Requires TFT module needs to be initialized. See the TFT_Init routine.
Example TFT Colorl6bitToRGB (start color, (@Qred start, @green start, @blue start);
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HW Connection
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Touch Panel Library

The mikroPascal PRO for PIC32 provides a library for working with Touch Panel.

Library Dependency Tree
| Touch Panel )—PL ADC )

External dependencies of Touch Panel Library

The following variables must be defined in | Description: Example:

all projects using Touch Panel Library:

var DriveA : sbit; sfr; external; | DriveAline. var DriveA : sbit at LATC13 bit;
var DriveB : sbit; sfr; external; | DriveB line. var DriveB : sbit at LATC14 bit;
var DriveA Direction : sbit; sfr; | Direction of the DriveApin. | var DriveA Direction : sbit at
external; TRISC13 bit;

var DriveB Direction : sbit; sfr; | Direction of the DriveB pin. | var DriveB Direction : sbit at
external; TRISC14 bit;

Library Routines

- TP_Init

- TP_Set_ ADC_Threshold

- TP_Press_Detect

- TP_Get_Coordinates

- TP_Calibrate_Bottom_Left
- TP_Calibrate_Upper_Right
- TP_Get_Calibration_Consts
- TP_Set_Calibration_Consts

o1 MikroElektronika



mikoPascal PRO for PIC32

TP_Init
Prototype procedure TP Init (display width : word; display height : word; readX ChNo :
byte; readY ChNo : byte);
Description | Initialize touch panel display. Default touch panel ADC threshold value is set to 3900.
Parameters |- display width: set display width.
-display height: setdisplay height.
- readX ChNo: read X coordinate from desired ADC channel.
- readY ChNo: readY coordinate from desired ADC channel.
Returns Nothing.
Requires Before calling this function initialize ADC module.
Example ADC1 Init(); // Initalize ADC module
TP Init (128, 64, 6, 7); // Initialize touch panel, dimensions 128x64
Notes None.

TP_Set ADC_Threshold

Prototype procedure TP Set ADC Threshold(threshold : word);
Description | Set custom ADC threshold value, call this function after TP_Init.
Parameters | - threshold: custom ADC threshold value.
Returns Nothing.
Requires TP_Init has to be called before using this routine.
Example TP _Set ADC Threshold(3900); // Set touch panel ADC threshold
Notes None.
MikroElektronika
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TP_Press_Detect

Prototype function TP Press Detect() : byte;

Description | Detects if the touch panel has been pressed.

Parameters | None.

Returns - 1 - if touch panel is pressed.
- 0 - otherwise.

Requires Global variables:

- Driven: DriveA.
- DriveB: DriveB.
-DriveA Direction: Direction of DriveA pin.
-DriveB Direction: Direction of DriveB pin.

must be defined before using this function.

Example // Touch Panel module connections
var DriveA : sbit at LATC13 bit;
DriveB : sbit at LATCI14 bit;
DriveA Direction : sbit at TRISCI3 bit;
DriveB Direction : sbit at TRISC14 bit;
// End Touch Panel module connections

if (TP Press Detect () <> 0) then
begin

end;

Notes None.
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TP_Get_Coordinates

Prototype function TP Get Coordinates (x coordinate “word; y coordinate “word)
byte;
Description | Get touch panel coordinates and store them in x coordinate and y coordinate parameters.
Parameters |- x coordinate: x coordinate of the place of touch.
-y coordinate: y coordinate of the place of touch.
Returns - 1 - if reading is within display dimension range.
- 0 - if reading is out of display dimension range.
Requires Nothing.
Example if (TP _Get Coordinates (@x coord, @y coord) = 0) then
begin
end;
Notes None.

TP_Calibrate_Bottom_Left

Prototype procedure TP Calibrate Bottom Left ();

Description | Calibrate bottom left corner of the touch Panel.

Parameters | None.

Returns Nothing.

Requires Nothing.

Example TP Calibrate Bottom Left(); // Calibration of bottom left corner
Notes None.

TP_Calibrate_Upper_Right

Prototype |procedure TP Calibrate Upper Right();
Description | Calibrate upper right corner of the touch panel.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example TP_Calibrate_Upper_ Right(); // Calibration of upper right corner
Notes None.
MikroElektronika
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TP_Get_Calibration_Consts

Prototype procedure TP Get Calibration Consts (x min *word; x max “word; y min
“word; y max “word) ;

Description | Gets calibration constants after calibration is done and stores them in x min, x max, y min and
vy max parameters.

Parameters | - x_min: x coordinate of the bottom left corner of the working area.
- x_max: X coordinate of the upper right corner of the working area.
- y_min:y coordinate of the bottom left corner of the working area.
- y_max:y coordinate of the upper right corner of the working area.

Returns Nothing.

Requires Nothing.

Example TP Get Calibration Consts (@x min, @y min, @x max, @y max); // Get
calibration constants

Notes None.

TP_Set_Calibration_Consts

Prototype procedure TP Set Calibration Consts(x min word; X max word; y min
word; y max : word);

Description | Sets calibration constants.

Parameters | - x min: x coordinate of the bottom left corner of the working area.
- x_max: X coordinate of the upper right corner of the working area.
- y_min:y coordinate of the bottom left corner of the working area.
- v _max:y coordinate of the upper right corner of the working area.

Returns Nothing.

Requires Nothing.

Example TP Set Calibration Consts (148, 3590, 519, 3370); // Set calibration
constants

Notes None.
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Touch Panel TFT Library

The mikroPascal PRO for PIC32 provides a library for working with Touch Panel for TFT.

Library Dependency Tree
—{apc )

| Touch Panel

External dependencies of Touch Panel TFT Library

The following variables must be defined in all

LATB10 bit;

projects using Touch Panel TFT Library: Description: Example:

var DriveX Left : sbit; sfr; external; DriveX_Left line. var DriveX Left sbit at
LATB13 bit;

var DriveX Right : sbit; sfr; external; | DriveX_Rightline. var DriveX Right sbit at
LATBl11l bit;

var DriveY Up : sbit; sfr; external; DriveY_Up line. var DriveY Up sbit at
LATB12 bit;

var DriveY Down : sbit; sfr; external; DriveY_Down line. var DriveY Down sbit at

external;

sbit at TRISB10 bit;

var DriveX Left Direction sbit; sfr; | Direction of the DriveX_Left pin. var DriveX Left Direction
external; sbit at TRISB13 bit;

var DriveX Right Direction sbit; sfr; | Direction of the DriveX_Right pin. | var DriveX Right Direction :
external; sbit at TRISB11l bit;

var DriveY Up Direction sbit; sfr; | Direction of the DriveY_Up pin. var DriveY Up Direction
external; sbit at TRISB12 bit;

var DriveY Down Direction sbit; sfr; | Direction of the DriveY_Down pin. | var DriveY Down Direction

Library Routines

- TP_TFT_lInit

-TP_TFT_Set ADC_Threshold

- TP_TFT_Press_Detect

- TP_TFT_Get_Coordinates

- TP_TFT_Calibrate_Min

- TP_TFT_Calibrate_Max

- TP_TFT_Get_Calibration_Consts
- TP_TFT_Set_Calibration_Consts
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TP_TFT_Init
Prototype procedure TP TFT Init (display width word; display height word; readX
ChNo : byte; readY ChNo : byte);
Description | Initialize TFT touch panel display. Default touch panel ADC threshold value is set to 900.
Parameters |- display width: set display width.
-display height: setdisplay height.
- readX ChNo: read X coordinate from desired ADC channel.
- readY ChNo: readY coordinate from desired ADC channel.
Returns Nothing.
Requires Before calling this function initialize ADC module.
Example ADC1 Init(); // Initalize ADC module
TP _TFT Init (320, 240, 13, 12); // Initialize touch panel
Notes None.
TP_TFT_Set ADC_Threshold
Prototype procedure TP TFT Set ADC Threshold(threshold : word);
Description | Set custom ADC threshold value, call this function after TP_TFT _Init.
Parameters | - threshold: custom ADC threshold value.
Returns Nothing.
Requires TP_TFT_Init has to be called before using this routine.
Example TP _TFT Set ADC Threshold(900); // Set touch panel ADC threshold
Notes None.
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TP_TFT_Press_Detect

Prototype function TP TFT Press Detect () : byte;

Description | Detects if the touch panel has been pressed.

Parameters | None.

Returns - 1 - if touch panel is pressed.
- 0 - otherwise.

Requires Global variables:
- DriveX Left: DriveX_Left pin.
- DriveX Right: DriveX_Right pin.
- DriveY Up: DriveY_Up pin.
- DriveY Down: DriveY_Down pin.
-DriveX Left Direction: Direction of DriveX_Left pin.
- DriveX Right Direction: Direction of DriveX_Right pin.
-DriveY Up Direction: Direction of DriveY_Up pin.
- DriveY Down Direction: Direction of DriveY_Down pin.
must be defined before using this function.

Example // Touch Panel module connections
var DriveX Left : sbit at LATB13 bit;
var DriveX Right : sbit at LATBI11 bit;
var DriveY Up : sbit at LATBI1Z bit;
var DriveY Down : sbit at LATB10 bit;
var DriveX Left Direction : sbit at TRISBI3 bit;
var DriveX Right Direction : sbit at TRISBI11 bit;
var DriveY Up Direction : sbit at TRISB1Z bit;
var DriveY Down Direction : sbit at TRISB10 bit;
// End Touch Panel module connections
if (TP TFT Press Detect() <> 0) then

begin
end;
Notes None.
MikroElektronika
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TP_TFT_Get _Coordinates

Prototype function TP TFT Get Coordinates(x coordinate : “word; y coordinate : “word)
: byte;
Description | Get touch panel coordinates and store them in x _coordinate and y coordinate parameters.
Parameters | - x coordinate: x coordinate of the place of touch.
-y coordinate:y coordinate of the place of touch.
Returns - 1 - if reading is within display dimension range.
- 0 - if reading is out of display dimension range.
Requires Nothing.
Example if (TP _TFT Get Coordinates(@x coord, @y coord) = 0) then
begin
end;
Notes None.

TP_TFT_Calibrate_Min

Prototype procedure TP TFT Calibrate Min();

Description | Calibrate bottom left corner of the touch Panel.

Parameters | None.

Returns Nothing.

Requires Nothing.

Example TP_TFT_Calibrate Min(); // Calibration of bottom left corner
Notes None.

TP_TFT_Calibrate_Max

Prototype procedure TP TFT Calibrate Max();

Description | Calibrate upper right corner of the touch panel.

Parameters | None.

Returns Nothing.

Requires Nothing.

Example TP_TFT_Calibrate Max(); // Calibration of upper right corner
Notes None.
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TP _TFT_Get_Calibration_Consts

Prototype procedure TP TFT Get Calibration Consts(x min : “word; x max : “word; y min
“word; y max “word) ;

Description | Gets calibration constants after calibration is done and stores them in x min, x max, y min and
y max parameters.

Parameters | - x min: x coordinate of the bottom left corner of the working area.
- x_max: X coordinate of the upper right corner of the working area.
- v _min:y coordinate of the bottom left corner of the working area.
- v _max: y coordinate of the upper right corner of the working area.

Returns Nothing.

Requires Nothing.

Example TP _TFT Get Calibration Consts(@x min, @y min, @x max, @y max); // Get
calibration constants

Notes None.

TP_TFT_Set_Calibration_Consts

Prototype procedure TP TFT Set Calibration Consts(x min word; X max word; y min
: word; y max : word);

Description | Sets calibration constants.

Parameters | - x min: x coordinate of the bottom left corner of the working area.
- x_max: X coordinate of the upper right corner of the working area.
- v _min:y coordinate of the bottom left corner of the working area.
- v _max:y coordinate of the upper right corner of the working area.

Returns Nothing.

Requires Nothing.

Example TP_TFT Set Calibration Consts(173, 776, 75, 760); // Set calibration
constants

Notes None.
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HW Connection
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UART Library

The UART hardware module is available with a number of PIC32 MCUs. The mikroPascal PRO for PIC32 UART Library
provides comfortable work with the Asynchronous (full duplex) mode.

Important:

- UART library routines require you to specify the module you want to use. To select the desired UART module,
simply change the letter x in the routine prototype for a number from 1 to 6.

- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate datasheet before utilizing
this library.

- Switching between the UART modules in the UART library is done by the UART_Set_Active function (UART
modules have to be previously initialized).

Library Routines

- UARTx_Init

- UARTx_Init_Advanced
- UARTx_Data_Ready

- UARTx_Tx_Idle

- UARTx_Read

- UARTx_Read_Text

- UARTx_Write

- UARTx_Write_Text

- UART_Set_Active
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UARTx_Init

Prototype

procedure UARTx Init (baud rate : dword);

Description

Configures and initializes the UART module.
The internal UART module module is set to:

- continue operation in IDLE mode

- default Tx and Rx pins

- loopback mode disabled

- 8-bit data, no parity

-1 STOP bit

- transmitter enabled

- generate interrupt on transmission end
- interrupt on reception enabled

- Address Detect mode disabled

Parameters

- baud rate:requested baud rate

Returns

Nothing.

Requires

Routine requires the UART module.

Example

// Initialize hardware UART1 module and establish communication at 2400
bps
UART1 Init (2400);

Notes

- Refer to the device data sheet for baud rates allowed for specific Fosc.

- The compiler will choose for which speed the calculation is to be performed (high or low). This does
not mean that it is the best choice for desired baud rate.
If the baud rate error generated in this way is too big then UARTXx_Init_Advanced routine, which
allows speed select be used.

- UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.

- Switching between the UART modules in the UART library is done by the UART_Set_Active
function (UART modules have to be previously initialized).

- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UARTX_Init_Advanced

Prototype procedure UARTx Init Advanced (baud rate, freq Khz : dword; high low, parity,
stop bits : byte);

Description | Configures and initializes the UART module with user defined settings.

Parameters |- baud rate:requested baud rate
- freg Khz: Peripheral Bus Clock frequency in kHz.
-high low speed: High/low speed selection parameter. Valid values:

High/Low Speed
Description Predefined library const
Low Speed UART _UART LOW_SPEED
Hi Speed UART _UART HI SPEED

- parity: Parity and data selection parameter. Valid values:

Data/Parity Mode
Description Predefined library const
8-bit data, no parity _UART 8BIT NOPARITY
8-bit data, even parity _UART 8BIT EVENPARITY
8-bit data, odd parity UART 8BIT ODDPARITY
9-bit data, no parity ~UART 9BIT NOPARITY

- stop bits: stop bit selection parameter. Valid values:

Stop bits
Description Predefined library const
One stop bit _UART ONE STOPBIT
Two stop bit UART TWO STOPBITS

Returns Nothing.

Requires Routine requires the UART module.

Example

Notes - Refer to the device data sheet for baud rates allowed for specific Fosc.

- UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.

- Switching between the UART modules in the UART library is done by the UART_Set_Active
function (UART modules have to be previously initialized).

- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UARTx_Data_Ready

Prototype function UARTx Data Ready () : word;
Description | The function tests if data in receive buffer is ready for reading.
Parameters | None.
Returns - 1 if data is ready for reading
- 0 if there is no data in the receive register
Requires Routine requires at least one UART module.
Used UART module must be initialized before using this routine. See UARTx_Init and UARTx_Init_
Advanced routines.
Example var receive : word;
// read data if ready
if (UART1 Data Ready() = 1) then
receive := UART1 Read();
Notes - UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.
- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
UARTx_Tx_lIdle
Prototype | function UARTx Tx Idle() : word;
Description | Use the function to test if the transmit shift register is empty or not.
Parameters | None.
Returns - 1 if the data has been transmitted
- 0 otherwise
Requires Routine requires at least one UART module.
Used UART module must be initialized before using this routine. See UARTx_Init and UARTx_Init_
Advanced routines.
Example // If the previous data has been shifted out, send next data:
if (UART1 Tx Idle() = 1) then
UART1 Write( data);
Notes - UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.
- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UARTx_Read
Prototype function UARTx Read() : word;
Description | The function receives a byte via UART. Use the UARTx_Data_Ready function to test if data is ready
first.
Parameters | None.
Returns Received byte.
Requires Routine requires at least one UART module.
Used UART module must be initialized before using this routine. See UARTx_Init and UARTXx_Init_
Advanced routines.
Example var receive : word;
// read data if ready
if (UART1 Data Ready() = 1) then
receive := UART1 Read();
Notes - UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.
- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UARTx_Read_Text

Prounype procedure UARTx Read Text (var output, delimiter : string; Attempts
byte) ;
Description | Reads characters received via UART until the delimiter sequence is detected. The read sequence is
stored in the parameter output; delimiter sequence is stored in the parameter delimiter.
This is a blocking call: the delimiter sequence is expected, otherwise the procedure exits (if the
delimiter is not found).
Parameters | - Output: received text
- Delimiter: sequence of characters that identifies the end of a received string
- Attempts: defines number of received characters in which Delimiter sequence is expected.
If At tempts is set to 255, this routine will continuously try to detect the Delimiter sequence.
Returns Nothing.
Requires Routine requires at least one UART module.
Used UART module must be initialized before using this routine. See UARTx_Init and UARTXx_Init_
Advanced routines.
Example Read text until the sequence “OK” is received, and send back what’s been received:
// Read text until the sequence “OK” is received, and then send it back:
UART1 Init(9600);
delim := ‘OK’;
while TRUE do
begin
if UART1 Data Ready() = 1 then
begin
UART1 Read Text (txt, delim, 10);
UART1 Write Text (txt);
end;
end;
Notes - UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.
- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UARTX_Write

Prototype procedure UARTx Write(data : word);

Description | The function transmits a byte via the UART module.

Parameters | - data: data to be sent

Returns Nothing.

Requires Routine requires at least one UART module.
Used UART module must be initialized before using this routine. See UARTx_Init and UARTx_Init_
Advanced routines.

Example var data : byte;
data := Ox1E;
UART1 Write(data );

Notes - UART library routines require you to specify the module you want to use. To select the desired

UART module, simply change the letter x in the routine prototype for a number from 1 to 6.
- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.

UARTx_Write_Text

Prototype

procedure UARTx Write Text (var uart text string);

Description

Sends text via UART. Text should be zero terminated.

Parameters

- UART text:textto be sent

Returns

Nothing.

Requires

Routine requires at least one UART module.

Used UART module must be initialized before using this routine. See UARTx_Init and UARTx_Init_
Advanced routines.

Example

Read text until the sequence “OK” is received, and send back what’s been received:
// Read text until the sequence “OK” is received, and then send it back:
UART1 Init (9600);
delim := ‘OK’;
while TRUE do
begin
if UART1 Data Ready()
begin
UART1 Read Text (txt, delim,
UART1 Write Text (txt);
end;
end;

= 1 then

10);

Notes

- UART library routines require you to specify the module you want to use. To select the desired
UART module, simply change the letter x in the routine prototype for a number from 1 to 6.

- Number of UART modules per MCU differs from chip to chip. Please, read the appropriate
datasheet before utilizing this library.
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UART_Set Active

Prototype procedure UART Set Active (read ptr : "TUART Rd Ptr; write ptr : "TUART Wr
Ptr; ready ptr : "TUART Rdy Ptr; tx idle ptr : "TUART TX Idle Ptr);

Description | Sets active UART module which will be used by UARTx_Data_Ready, UARTx_Read and UARTx_
Write routines.

Parameters | Parameters:

- read ptr: UARTx_Read handler
-write ptr: UARTx_Write handler

- ready ptr: UARTx_Data_Ready handler
-tx idle ptr:UARTx_Tx_ldle handler

Returns Nothing.

Requires Routine is available only for MCUs with multiple UART modules.

Used UART module must be initialized before using this routine. See UARTx_Init and UARTx_Init_
Advanced routines.

Example UART1 Init(9600); // initialize UART1 module
UART2 Init (9600); // initialize UART2 module
RS485Master Init(); // initialize MCU as Master

UART Set Active (QUART1 Read, @UART1 Write, QUART1 Data Ready, QUART1 Tx
Idle); // set UART1 active
RS485Master Send(dat,1,160); // send message through UART1

UART Set Active (QUART2 Read, @UART2 Write, QUART2 Data Ready, QUART2 Tx
Idle); // set UART2 active
RS485Master Send(dat,1,160); // send through UART2

Notes None.
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Library Example

This example demonstrates simple data exchange via UART. If MCU is connected to the PC, you can test the example
from the mikroPascal PRO for PIC32 USART communication terminal, launch it from the drop-down menu Tools >
USART Terminal or simply click the USART Terminal Icon =l .

Copy Code To Clipboard

program UARTI1;
var uart rd : byte;

begin
CHECON := 0x32;
AD1PCFG := OxFFFF;

UART1 Init(56000);
Delay ms (100);

UART1 Write Text(‘Start’);
UART1 Write (13);
UART1 Write (10);

//

//
//

Configure AN pins as digital I/0

Initialize UART module at 56000 bps
Wait for UART module to stabilize

while (TRUE) do // Endless loop
begin
if (UART1 Data Ready() <> 0) then // If data is received
begin
uart rd := UART1 Read(); // read the received data
UART1 Write (uart rd); // and send data via UART
end;
end;
end.
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HW Connection
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USB Library

Universal Serial Bus (USB) provides a serial bus standard for connecting a wide variety of devices, including computers,
cell phones, game consoles, PDA’s, etc.

USB Library contains HID routines that support HID class devices, and also the generic routines that can be used with
vendor specified drivers.

USB HID Class

The HID class consists primarily of devices that are used by humans to control the operation of computer systems.
Typical examples of HID class devices include:

- Keyboards and pointing devices, for example: standard mouse devices, trackballs, and joysticks.

- Front-panel controls, for example: knobs, switches, buttons, and sliders.

- Controls that might be found on devices such as telephones, VCR remote controls, games or simulation
devices, for example: data gloves, throttles, steering wheels, and rudder pedals.

- Devices that may not require human interaction but provide data in a similar format to HID class devices,
for example, bar-code readers, thermometers, or voltmeters.

Many typical HID class devices include indicators, specialized displays, audio feedback, and force or tactile feedback.
Therefore, the HID class definition includes support for various types of output directed to the end user.

Descriptor File

Each project based on the USB library should include a descriptor source file which contains vendor id and name,
product id and name, report length, and other relevant information. To create a descriptor file, use the integrated USB
HID terminal of mikroPascal PRO for PIC32(Tools » USB HID Terminal). The default name for descriptor file is USBdsc.
mpas, but you may rename it.

Library Routines

- HID_Enable

- HID_Read

- HID_Write

- HID_Disable

- USB_Interrupt_Proc
- USB_Polling_Proc
- Gen_Enable

- Gen_Read

- Gen_Write
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HID Enable

Prototype

procedure HID Enable (readbuff “byte; writebuff : "“byte);

Description

Enables USB HID communication.

Parameters

- readbuf £: Read Buffer.
-writebuff: Write Buffer.

These parameters are used for HID communication.

Returns Nothing.

Requires Nothing

Example HID Enable (&readbuff, &writebuff) ;

Notes This function needs to be called before using other routines of USB HID Library.

HID_Read

Prototype function HID Read() : byte;

Description | Receives message from host and stores it in the Read Buffer.

Parameters | None.

Returns If the data reading has failed, the function returns 0. Otherwise, it returns number of characters
received from the host.

Requires USB HID needs to be enabled before using this function. See HID_Enable.

Example // retry until success
while (HID Read() = 0) do

Notes None.

HID_Write

Prototype function HIDJ/\Trite (writebuff “byte; len : byte) : byte;

Description | Function sends data from Write Buffer writebuff to host.

Parameters | - writebuf £: Write Buffer, same parameter as used in initialization; see HID_Enable.
- len: specifies a length of the data to be transmitted.

Returns If the data transmitting has failed, the function returns 0. Otherwise, it returns number of transmitted
bytes.

Requires USB HID needs to be enabled before using this function. See HID_Enable.

Example // retry until success
while (HID Write (@writebuff,64) = 0) do

Notes Function call needs to be repeated as long as data is not successfuly sent.
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HID_Disable
Prototype procedure HID Disable();
Description | Disables USB HID communication.
Parameters | None.
Returns Nothing.
Requires USB HID needs to be enabled before using this function. See HID_Enable.
Example HID Disable();
Notes None.

USB_Interrupt_Proc

Prototype procedure USB Interrupt Proc();
Description | This routine is used for servicing various USB bus events. Should be called inside USB interrupt
routine.
Parameters | None.
Returns Nothing.
Requires Nothing.
Exan“ﬂe procedure USBlInterrupt(); iv IVT ADDR USB1INTERRUPT;
begin
USB Interrupt Proc();
end;
Notes Do not use this function with USB_Polling_Proc, only one should be used. To enable servicing through
interrupt, UsB_INTERRUPT constant should be set (it is set by default in descriptor file).
MikroElektronika
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USB_Polling_Proc

Prototype procedure USB Polling Proc();
Description | This routine is used for servicing various USB bus events. It should be periodically, preferably every
100 microseconds.
Parameters | None.
Returns Nothing.
Requires Nothing.
Example while TRUE do
begin
USB Polling Proc();
kk := HID Read();
if (kk <> 0) then
begin
for cnt := 0 to 64
writebuff[cnt] := readbufflcnt];
HID Write (@Gwritebuff, 64);
end;
end;
Notes Do not use this functions with USB_Interrupt_Proc. To enable servicing by polling, USB INTERRUPT
constant should be set to O (it is located in descriptor file).
Gen_Enable
Prototype procedure Gen Enable (readbuff “byte; writebuff : “byte);
Description | Initialize the USB module of the MCU.
Parameters | - readbuf £: Read Buffer.
-writebuff: Write Buffer.
Returns Nothing.
Requires USB needs to be enabled before using this function. See HID_Enable.
Exan“ﬂe Gen Enable (&readbuff, &éwritebuff);
Notes None.




mikoPascal PRO for PIC32

Gen_Read
Prototype function Gen Read (readbuff “byte; length : byte; ep : byte) : byte;
Description | Generic routine that receives the specified data from the specified endpoint.
Parameters | - rcadbuf f: Received data.
- length: The length of the data that you wish to receive.
- ep: Endpoint number you want to receive the data into.
Returns Returns the number of received bytes, otherwise 0.
Requires USB needs to be enabled before using this function. See HID_Enable.
Example while (Gen Read(@readbuff,64,1) = 0) do
Notes None.
Gen_Write
Prototype function Gen Write(writebuff : "“byte; length : byte; ep : byte) : byte;
Description | Sends the specified data to the specified endpoint.
Parameters | - writebuff: The data that you want to send.
- length: the length of the data that you wish to send.
- ep: Endpoint number you want to send the data into.
Returns Returns the number of transmitted bytes, otherwise 0.
Requires USB needs to be enabled before using this function. See HID_Enable.
Example while (Gen Write (@writebuff,64,1) = 0) do
Notes None.
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Library Example

This example establishes connection with the HID terminal that is active on the PC. Upon connection establishment,
the HID Device Name will appear in the respective window. After that software will wait for data and it will return
received data back. Examples uses USBdsc .mpas descriptor file, which is in the same folder, and can be created by

the H

Copy

ID Terminal.

Code To Clipboard

program HID Read Write Polling;

var

var
var

begi
CH
AD

of char;

cnt, kk : char;

readbuff : array[64] of char;
writebuff : array[64]

n

ECON := 0x32;

1PCFG := OxFFFE;

HID Enable (Qreadbuff, @writebuff);
while TRUE do

end.

HW

begin
USB_Polling Proc();
kk := HID Read();

if (kk <> 0) then
begin

// Call this routine periodically

for cnt:=0 to 63 do
writebuff[cnt] :=readbuffl[cnt];
HID Write(@writebuff, 64);

end ;
end;

Connection
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Miscellaneous Libraries

- Button Library

- C Type Library

- Conversions Library
- Setjmp Library

- String Library

- Time Library

- Trigon Library

- Trigonometry Library

Button Library

The Button Library provides routines for detecting button presses and debouncing (eliminating the influence of contact
flickering upon pressing a button).

Library Routines

- Button
Button

Prototype function Button(var port: word; pin: byte; time: word; ActiveState: byte)
: word;

Description | The function eliminates the influence of contact flickering upon pressing a button (debouncing). The
Button pin is tested just after the function call and then again after the debouncing period has expired.
If the pin was in the active state in both cases then the function returns 255 (true).

Parameters | - port : button port address
- pin: button pin
- time: debouncing period in milliseconds
-active state: determines what is considered as active state. Valid values: 0 (logical zero)

and 1 (logical one)

Returns - 255 if the pin was in the active state for given period.
- 0 otherwise

Requires Nothing.

Example program Button Test;

var oldstate : bit;

begin

oldstate := 0;

ADPCFG := OxFFFF; // initialize AN pins as
digital

TRISD := OxFFFF; // initialize PORTD as
input

TRISB := 0x0000; // initialize PORTB as
output
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Button
Example while TRUE do
begin
if (Button (PORTD, 0, 1, 1)) then // detect logical
one on RBO pin
oldstate := 1;
if (oldstate and Button (PORTD, 0, 1, 0)) then
begin // detect one-
to-zero transition on RBO pin
LATB := not LATB;
oldstate := 0;
end;
end; // endless loop
end.
Notes None.

C Type Library

The mikroPascal PRO for PIC32 provides a set of library functions for testing and mapping characters.

Library Functions

- isalnum
- isalpha
- iscntrl

- isdigit

- isgraph
- islower

- ispunct
- isspace
- isupper
- isxdigit

- toupper
- tolower

isalnum

Prototype function isalnum(character : byte) : word

Description | Function returns OxFF if the character is alphanumeric (A-Z, a-z, 0-9), otherwise returns zero.

Example res := isalnum(‘o’); // returns O0xFF
res := isalnum(*\r’); // returns O
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isalpha
Prototype function isalpha (character byte) word
Description | Function returns OxFF if the character is alphabetic (A-Z, a-z), otherwise returns zero.
Example res := isalpha(‘A’); // returns OxFF
res := isalpha(‘l’); // returns 0
iscntrl
Prototype function iscntrl (character : byte) word
Description | Function returns OxFF if the character is a control or delete character(decimal 0-31 and 127), otherwise
returns zero.
Example res := iscntrl(*\r’); // returns OxFF
res := iscntrl(‘o’); // returns 0
isdigit
Prototype function isdigit (character : byte) word
Description | Function returns OxFF if the character is a digit (0-9), otherwise returns zero.
Example res := isdigit(‘o’); // returns OxFF
res := isdigit(‘1’); // returns O
isgraph
Prototype function isgraph (character : byte) word
Description | Function returns OxFF if the character is a printable, excluding the space (decimal 32), otherwise
returns zero.
Example res := isgraph(‘o’); // returns OxFF
res := isgraph(‘ '); // returns 0
islower
Prototype function islower (character : byte) word
Description | Function returns OxFF if the character is a lowercase letter (a-z), otherwise returns zero.
Example res := islower (‘0’); // returns OxFF
res := islower (‘A’); // returns 0
MikroElektronika
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ispunct
Prototype function ispunct (character byte) word
Description | Function returns OxFF if the character is a punctuation (decimal 32-47, 58-63, 91-96, 123-126),
otherwise returns zero.
Example res := islower (‘0’); // returns OxFF
res := islower (‘A’); // returns 0
isspace
Prototype function isspace (character byte) word
Description | Function returns OxFF if the character is a white space (space, tab, CR, HT, VT, NL, FF), otherwise
returns zero.
Example res := isspace(‘' '); // returns OxFF
res := isspace(‘l’); // returns 0
isupper
Prototype function isupper (character byte) word
Description | Function returns OxFF if the character is an uppercase letter (A-Z), otherwise returns zero.
Example res := isupper (‘A’); // returns OxFF
res := isupper(‘a’); // returns O
isxdigit
Prototype function isxdigit (character : byte) : word
Description | Function returns OxFF if the character is a hex digit (0-9, A-F, a-f), otherwise returns zero.
Example res := isxdigit (‘A’); // returns O0xFF
res := isxdigit(‘P’); // returns 0
toupper
Prototype function toupper (character byte) byte
Description | If the character is a lowercase letter (a-z), the function returns an uppercase letter. Otherwise, the
function returns an unchanged input parameter.
Example res := toupper(‘a’); // returns A
res := toupper(‘B’); // returns B
tolower
Prototype function tolower (character byte) byte
Description | If the character is an uppercase letter (A-Z), function returns a lowercase letter. Otherwise, function
returns an unchanged input parameter.
Example res := tolower (‘A’); // returns a
res := tolower(‘b’); // returns b

on
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Conversions Library

mikroPascal PRO for PIC32 Conversions Library provides routines for numerals to strings and BCD/decimal
conversions.

Library Dependency Tree
| Conversions )—PL C_String ]

Library Routines
You can get text representation of numerical value by passing it to one of the following routines:

- ByteToStr

- ShortToStr

- WordToStr

- IntToStr

- LongToStr

- LongWordToStr
- FloatToStr

- WordToStrWithZeros

- IntToStrWithZeros

- LongWordToStrWithZeros
- LongIntToStrWithZeros

- ByteToHex

- ShortToHex

- WordToHex

- IntToHex

- LongWordToHex
- LongIntToHex

- StrTolnt
- StrToWord

The following functions convert decimal values to BCD and vice versa:

- Bcd2Dec
- Dec2Bcd
- Bcd2Dec16
- Dec2Bcd16
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ByteToStr
Prototype procedure ByteToStr (input : byte; war output : array[3] of char);
Description | Converts input byte to a string. The output string is right justified and remaining positions on the left (if
any) are filled with blanks.
Parameters | - input : byte to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t : byte;
txt : array[3] of char;
t = 24;
ByteToStr (t, txt); // txt is “ 24” (one blank here)
Notes None.
ShortToStr
Prototype procedure ShortToStr (input short; war output : array[4] of char);
Description | Converts input short (signed byte) number to a string. The output string is right justified and remaining
positions on the left (if any) are filled with blanks.
Parameters | - input: signed short number to be converted
- output: destination string
Returns Nothing.
Requires Destination string should be at least 5 characters in length.
Example var t short;
txt : array[4] of char;
t = -24;
ByteToStr (t, txt); // txt is “ -24” (one blank here)
Notes None.
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WordToStr

Prototype

procedure WordToStr (input : word; war output : array[5] of char);

Description

Converts input word to a string. The output string is right justified and the remaining positions on the
left (if any) are filled with blanks.

Parameters |- input: word to be converted
- output : destination string
Returns Nothing.
Requires Nothing.
Example var t : word;
txt : array[5] of char;
t := 437;
WordToStr (t, txt); // txt is ™ 437” (two blanks here)
Notes None.
IntToStr
Prototype procedure IntToStr (input integer; wvar output : array[6] of char);
Description | Converts input integer number to a string. The output string is right justified and the remaining positions
on the left (if any) are filled with blanks.
Parameters | - input: signed integer number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var input integer;
txt : arrayl[6] of char;
VA
begin
input := -4220;
IntToStr (input, txt); // txt is Y -4220'
Notes None.
MikroElektronika
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LongToStr
Prototype procedure LongintToStr (input : longint; wvar output : array[ll] of char);
Description | Converts input longint number to a string. The output string is right justified and the remaining positions
on the left (if any) are filled with blanks.
Parameters | - input : signed long integer number to be converted
- output : destination string
Returns Nothing.
Requires Nothing.
Example var input : longint;
txt : array[ll] of char;
/e
begin
input := -12345678;
IntToStr (input, txt); // txt is Y -12345678"
Notes None.
LongWordToStr
Prototype procedure LongWordToStr (input : dword; wvar output : array[l10] of char);
Description | Converts input double word number to a string. The output string is right justified and the remaining
positions on the left (if any) are filled with blanks.
Parameters | - input: unsigned long integer number to be converted
- output : destination string
Returns Nothing.
Requires Nothing.
Example var input : longint;
txt : array[l0] of char;
VA
begin
input := 12345678;
IntToStr (input, txt); // txt is Y 12345678’
Notes None.
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FloatToStr
Prokﬁype procedure FloatToStr (fnum : real; wvar str array[23] of char) byte;
Description | Converts a floating point number to a string.
The output string is left justified and null terminated after the last digit.
Parameters | - fnum: floating point number to be converted
- str: destination string
Returns Nothing.
Requires Nothing.
Example var f£fl, ff2, ff3 real;
txt array[10] of char;
£ffl = =-374.2;
ff2 := 123.456789;
f£f3 := 0.000001234;
FloatToStr (ffl, txt); // txt is “-374.20001"
FloatToStr (ff2, txt); // txt is “123.45678”
FloatToStr (ff3, txt); // txt is “0.000000”
Notes Given floating point number will be truncated to 7 most significant digits before conversion.
WordToStrWithZeros
Prototype procedure WordToStrWithZeros (input: word; wvar output: array[5] of char);
Description | Converts input word to a string. The output string is right justified and the remaining positions on the
left (if any) are filled with zeros.
Parameters | - input: unsigned integer to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t : word;
txt array[5] of char;
/)
t = 437;
WordToStrWithZeros (t, txt); // txt is ‘00437’
Notes None.
MikroElektronika
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IntToStrWithZeros

Prototype

procedure IntToStrWithZeros (input: integer; var output: array[6] of char);

Description

Converts input integer to a string. The output string is right justified and the remaining positions on the
left (if any) are filled with zeros.

Parameters | - input: integer number to be converted
- output: destination string

Returns Nothing.

Requires Nothing.

Example var t integer;

txt : array[6] of char;

/e
t -3276;

IntToStrWithZeros (t, txt); // txt is ‘-03276’

Notes

None.

LongWordToStrWithZeros

Prototype procedure LongWordToStrWithZeros (input: dword; var output: array[10] of
char) ;
Description | Converts input dword to a string. The output string is right justified and the remaining positions on the
left (if any) are filled with zeros.
Parameters | - input: unsigned long number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t : dword;
txt : array[l0] of char;
/e
t := 12345678;
LongWordToStrWithZeros (t, txt); // txt is ‘0012345678’
Notes None.
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LongIntToStrWithZeros

Prototype procedure LongIntToStrWithZeros (input: longint; war output: array[ll] of
char) ;
Description | Converts input longint to a string. The output string is right justified and the remaining positions on the
left (if any) are filled with zeros.
Parameters | - input: signed long number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t longint;
txt : array([l1l] of char;
/..
t := -12345678;
LongIntToStrWithZeros (t, txt); // txt is '-0012345678’
Notes None.
ByteToHex
Prototype procedure ByteToHex (input : byte; war output : array[2] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: byte to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t : byte;
txt : array[2] of char;
t = 2;
ByteToHex (t, txt); // txt is “02”
Notes None.
MikroElektronika
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ShortToHex
Prototype procedure ShortToHex (input : short; wvar output : array[2] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: signed short number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t short;
txt : array[2] of char;
t := -100;
ShortToHex (t, txt); // txt is “9C”
Notes None.
WordToHex
Prototype procedure WordToHex (input : word; var output array[4] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: unsigned integer to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var t : word;
txt : array[4] of char;
t o= 1111;
WordToHex (t, txt); // txt is “0457”
Notes None.
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IntToHex
Prototype procedure IntToHex (input integer; wvar output array[64] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: signed integer number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var input integer;
txt string(4];
/e
input := -32768;
IntToHex (input, txt); // txt is Y8000
Notes None.
LongWordToHex
Prototype procedure LongWordToHex (input dword; wvar output array[8] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: unsigned long integer number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var input dword;
txt array[8] of char;
/e
input := 65535;
LongWordToHex (input, txt); // txt is ‘O0000FFFE’
Notes None.
LongIntToHex
Prototype procedure LongIntToHex (input : longint; wvar output : array[8] of char);
Description | Converts input number to a string containing the number’s hexadecimal representation. The output
string is right justified and remaining positions on the left (if any) are filled with zeros.
Parameters | - input: signed long integer number to be converted
- output: destination string
Returns Nothing.
Requires Nothing.
Example var input longint;
txt array[8] of char;
/e
input := -2147483648;
LongIntToHex (input, txt); // txt is Y80000000"
Notes None.
MikroElektronika



mikroPascal PRO for PIC32

StrTolnt
Prototype function StrTolInt (var input: string[6]): integer;
Description | Converts a string to an integer.
Parameters | - input: string to be converted
Returns Integer variable.
Requires Input string is assumed to be the correct representation of a number. The conversion will end with the
first character which is not a decimal digit.
Example var ii: integer;
begin
ii:= StrToInt('-1234");
end.
Notes None.
StrToWord
Prototype function StrToWord(var input: string[5]): word;
Description | Converts a string to word.
Parameters | - input: string to be converted
Returns Word variable.
Requires Input string is assumed to be the correct representation of a number. The conversion will end with the
first character which is not a decimal digit.
Example var ww: word;
begin
ww:= StrToword (‘'65432") ;
end.
Notes None.
Bcd2Dec
Prototype function Bcd2Dec (bcdnum : byte) : byte;
Description | Converts input BCD number to its appropriate decimal representation.
Parameters | - bcdnum: number to be converted
Returns Converted decimal value.
Requires Nothing.
Example var a, b byte;
a i= 22;
b := Bcd2Dec(a); // b equals 34
Notes None.
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Dec2Bcd
Prototype function Dec2Bcd(decnum : byte) : byte;
Description | Converts input unsigned short integer number to its appropriate BCD representation.
Parameters | - decnum: number to be converted
Returns Converted BCD value.
Requires Nothing.
Example var a, b : byte;

a := 22;

b := Dec2Bcd(a); // b equals 34
Notes None
Bcd2Dec16
Prototype function Bcd2Decl6 (bcdnum : word) : word;
Description | Converts unsigned 16-bit decimal value to its BCD equivalent.
Parameters | - bcdnum: 16-bit BCD numeral to be converted
Returns Converted decimal value.
Requires Nothing.
Example var a, b : word;

a := 0x1234; // a equals 4660

b := Bcd2Dbecl6(a); // b equals 1234
Notes None
Dec2Bcd16
Prototype function Dec2Bcdl6 (decnum : word) : word;
Description | Converts decimal value to its BCD equivalent.
Parameters | - decnum decimal number to be converted
Returns Converted decimal value.
Requires Nothing.
Example var a, b : word;

a := 2345;

b := Dec2Bcdl6(a); // b equals 9029
Notes None
MikroElektronika
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Setjmp Library

The Setjmp library contains functions and types definitions for bypassing the normal function call and return

discipline.

Library Routines

- Setjmp
- Longjmp
Setjmp
Prototype function setjmp(var env : array[4] of word) : integer;
Returns - 0 if the return is from direct invocation

-nonzero value if the return is from a call to 1ongjmp (this value will be set by the 1ongjmp
routine)

Description

This function saves calling position for a later use by longjmp.
Parameters :

- env: buffer suitable for holding information needed for restoring calling environment

Requires Nothing.

Example var buf : array[4] of word;
Setjmp (buf) ;

Longjmp

Prototype procedure longjmp (var env : array[4] of word; val : integer);

Returns Nothing.

Description | Restores calling environment saved in the env buffer by the most recent invocation of setjmp. If there
has been no such invocation, or the function containing the invocation of setjmp has terminated in the
interim, the behavior is undefined.

Parameters :
- env: buffer holding the information saved by the corresponding set jmp invocation
- val: value to be returned by the corresponding setjmp function

Requires Invocation of 1ongjmp must occur before return from the function in which setjmp was called
encounters.

Example var buf : array[4] of word;

Longjmp (buf, 2);
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Library Exam

ple

Example demonstrates function cross calling using setjmp and longjmp functions. When called, Setjmp() saves its
calling environment in its buf argument for later use by the Longjmp(). Longjmp(), on the other hand, restores the
environment saved by the most recent invocation of the Setjmp() with the corresponding buf argument.

Copy Code To Clipboard
program Setjmp;
var buf : array([4] of word ; // Note : Program flow diagrams are indexed according
// to the sequence of execution
procedure func33(); /] 2<———————————= |
begin // |
Delay ms(1000) ; // |
// |
nop; // \
longjmp (buf, 2); // B=—mmmmmm——————— >
nop; // | |
// | |
end; // ! |
// | |
procedure func(); /)  1<—=———=—=—= | | |
begin // | | |
PORTB := 3; // | | |
if (setjmp (buf) = 2) then // 3<-———--—----————- |
PORTB := 1 /] A-=>| \ \
else // | | |
func33(); /] 2=—m——————— >
// \ |
/] A<——]| \
end; // 5-———- >
// [
begin // [
ADPCFG := OxFFFF; // |
// [
PORTB := 0; // Lo
TRISB := 0; // Lo
// [
nop; // [
// [
func () ; // l-———— > |
// \
nop; //  5<————- \
Delay ms (1000);
PORTB := OxFFFF;
end.
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Sprint Library

mikroPascal PRO for PIC32 includes a library which automatizes string related tasks.

Library Dependency Tree

Functions

- memchr

- memcmp
- memcpy

- memmove
- memset

- strcat

- strcat2

- strchr

- strcmp

- strcpy

- strlen

- strncat

- strncat2

- strncpy

- strspn

- strncmp

- strstr

- strcspn

- strpbrk

- strrchr

- Itrim

- rtrim

- strappendpre
- strappendsuf
- length
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memchr

Prototype function memchr (p : "“byte; ch : byte; n : word) : word;

Description | The function locates the first occurrence of the word ch in the initial n words of memory area starting
at the address p. The function returns the offset of this occurrence from the memory address p or
0xFEFEF if ch was not found.

For the parameter p you can use either a numerical value (literal/variable/constant) indicating memory
address or a dereferenced value of an object, for example Gmystring or @PORTE.

Example txt := ‘mikroElektronika’;
res := memchr (@txt, ‘e’, 16); // example locates first occurrence of the
letter ‘e’ in the string ‘txt’ in the first 16 characters of the string

memcmp

Prototype function memcmp (pl, p2 : “byte; n : word) : integer;

Description | The function returns a positive, negative, or zero value indicating the relationship of first n words of
memory areas starting at addresses p1 and p2.

This function compares two memory areas starting at addresses p1 and p2 for n words and returns a
value indicating their relationship as follows:

Value Meaning

<0 pl “less than” p2

=0 pl “equal to” p2

> 0 pl “greater than” p2

The value returned by the function is determined by the difference between the values of the first pair
of words that differ in the strings being compared.

For parameters p1 and p2 you can use either a numerical value (literal/variable/constant) indicating
memory address or a dereferenced value of an object, for example ¢mystring or @PORTE.

Example txt := ‘mikroElektronika’;
txt sub ‘mikro’;
res := memcmp (€txt, @txt sub, 16); // returns 69, which is ASCII code of
the first differing character - letter ‘E’
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memcpy

Proknype procedure memcpy (pl, p2 : “byte; nn : word);

Description | The function copies nn words from the memory area starting at the address p2 to the memory area
starting at p1. If these memory buffers overlap, the memcpy function cannot guarantee that words are
copied before being overwritten. If these buffers do overlap, use the memmove function.

For parameters p1 and p2 you can use either a numerical value (literal/variable/constant) indicating
memory address or a dereferenced value of an object, for example Emystring or @PORTE.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
memcpy (@txt+4, @txt sub, 4); // string ‘txt’ will be populated with the first

4 characters of the ‘txt sub’ string, beginning from the 4th character

memmove

Proknype procedure memmove (pl, p2 : “byte; nn : word);

Description | The function copies nn words from the memory area starting at the address p2 to the memory area
starting at p1. If these memory buffers overlap, the Memmove function ensures that the words in p2 are
copied to p1 before being overwritten.

For parameters p1 and p2 you can use either a numerical value (literal/variable/constant) indicating
memory address or a dereferenced value of an object, for example Emystring or @PORTE.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;

memmove (@txt+7, @txt sub, 4); // string ‘txt’ will be populated with first
4 characters of the ‘txt sub’ string, beginning from the 7th character

memset

Prokﬂype procedure memset (p : “byte; character : byte; n : word);

Description | The function fills the first n words in the memory area starting at the address p with the value of word
character.

For parameter p you can use either a numerical value (literal/variable/constant) indicating memory
address or a dereferenced value of an object, for example ¢mystring or @PORTE.

Example txt := ‘mikroElektronika’;

memset (@txt, ‘a’, 2); // routine will copy the character ‘a’ into each of
the first ‘n’ characters of the string ‘txt’,
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strcat
Prototype procedure strcat(var sl, s2 : string);
Description | The function appends the value of string s2 to string s1 and terminates s1 with a null character.
Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
txt[3] := 0;
strcat (txt, ' test’); // routine will append the ' test’ at the place of
the first null character, adding terminating null character to the result
strcat2
Prototype procedure strcat2(var 11, sl, s2 : string);
Description | The procedure adjoins string s2 at the end of the string =1, or at the first null character of the s1, and
places the result string into | string.
Example txt := ‘mikroElektronika’;
txt sub := ' Test’;
11 := string[21];
strcat2 (11, txt, txt sub); // routine will adjoin strings txt and txt sub
and place the result into 1; 1 = mikroElektronika Test
strchr
Prototype function strchr(var s : string; ch : byte) : word;
Description | The function searches the string s for the first occurrence of the character ch. The null character
terminating s is not included in the search.
The function returns the position (index) of the first character ch found in s; if no matching character
was found, the function returns OxFFFF.
Example txt := ‘mikroElektronika’;
res := strchr(txt, ‘E’); // routine will locate the character ‘E’ in the
‘txt’ string, and return the position of the character
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strcmp

Prototype function strcmp(var sl, s2 string) integer;

Description | The function lexicographically compares the contents of the strings s1 and s2 and returns a value
indicating their relationship:

Value Meaning

<0 sl “less than” s2

=0 sl “equal to” s2

> 0 sl “greater than” s2

The value returned by the function is determined by the difference between the values of the first pair
of words that differ in the strings being compared.

Example txt := ‘mikroElektronika’;
res := strchr(txt, ‘E’); // routine will locate the character ‘E’ in the

‘txt’ string, and return the position of the character
strcpy

Prototype procedure strcpy(var sl, s2 string);

Description | The function copies the value of the string s2 to the string s1 and appends a null character to the end
of s1.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
strcpy (txt,txt sub); // copies string ‘txt sub’ to ‘txt’

strlen

Prototype function strlen(var s string) word;

Description | The function returns the length, in words, of the string s. The length does not include the null terminating
character.

Example txt := ‘mikroElektronika’;
res = strlen(txt); // calculates the length of the ‘txt’ string, result = 16

strncat

Prototype procedure strncat (var sl, s2 string; size word) ;

Description | The function appends at most size characters from the string s2 to the string s1 and terminates s1
with a null character. If s2 is shorter than the size characters, s2 is copied up to and including the null
terminating character.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
txt[5] := 0;

strncat (txt,txt sub,4); // routine appends first 4 characters from the string
‘txt sub’ at the place of first null character in the ‘txt’ string
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strncpy

Prototype procedure strncpy(var sl, s2 : string; size : word);

Description | The function copies at most size characters from the string s2 to the string s1. If s2 contains fewer
characters than size, s1 is padded out with null characters up to the total length of the size
characters.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
strncpy (txt, txt sub,4); // copies first 4 characters form the string ‘txt sub’
to ‘txt’

strspn

Prototype function strspn(var sl, s2 : string) : word;

Description | The function searches the string s1 for characters not found in the s2 string.

The function returns the index of first character located in s1 that does not match a character in s2. If
the first character in =1 does not match a character in s2, a value of 0 is returned. If all characters in
s1 are found in s2, the length of s1 is returned (not including the terminating null character).

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
res := strspn(txt,txt sub); // routne returns 4

strncmp

Prototype function strncmp(var sl, s2 : string; len : word) : integer;

Description | The function lexicographically compares the first len characters of the strings s1 and s2 and returns
a value indicating their relationship:

Value Meaning

< 0 sl “less than” s2

=0 sl “equal to” s2

> 0 sl “greater than” s2

The value returned by the function is determined by the difference between the values of the first pair
of words that differ in the strings being compared (within first 1en words).

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
res := strncmp(txt sub, txt,3); // compares the first 3 characters from the
string ‘txt’ with the sting ‘txt sub’ and returns a difference
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strstr

Prototype function strstr(var sl, s2 string) word;

Description | The function locates the first occurrence of the string s2 in the string s1 (excluding the terminating
null character).

The function returns a number indicating the position of the first occurrence of s2 in s1; if no string was
found, the function returns OxFFFF. If s2 is a null string, the function returns 0.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
res := strstr(txt sub,txt);

strcspn

Prototype function strcspn(var sl, s2 string) : word;

Description | The function searches the string s1 for any of the characters in the string s2.

The function returns the index of the first character located in s1 that matches any character in s2. If
the first character in s1 matches a character in s2, a value of 0 is returned. If there are no matching
characters in s1, the length of the string is returned (not including the terminating null character).

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
res := strcspn(txt sub,txt);

strpbrk

Prototype function strpbrk(var sl, s2 string) : word;

Description | The function searches s1 for the first occurrence of any character from the string s2. The null
terminator is not included in the search. The function returns an index of the matching character in s1.
If s1 contains no characters from s2, the function returns 0xFFrF.

Example txt := ‘mikroElektronika’;
txt sub := ‘mikr’;
res := strpbrk(txt sub,txt);

strrchr

Prototype function strrchr (var s string; ch : byte) : word;

Description | The function searches the string s for the last occurrence of the character ch. The null character
terminating s is not included in the search. The function returns an index of the last ch found in s; if no
matching character was found, the function returns 0xFFFT.

Example txt := ‘mikroElektronika’;
res = strrchr(txt,’k’); // returns the index of the ‘k’ character of the ‘txt’
string
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[trim
Prototype procedure ltrim(var astring string) ;
Description | The procedure trims the leading spaces of the string.
Example txt := ' mikroE’;
ltrim(txt); // trims the leading 2 spaces of the ‘txt’ string
rtrim
Prototype procedure rtrim(var astring string) ;
Description | The procedure trims the trailing spaces of the string.
Example txt := ‘mikroE ‘;
rtrim(txt); // trims the trailing 2 spaces of the ‘txt’ string and adds
terminating null character to the result
strappendpre
Prototype procedure strappendpre (letter: char; wvar sl string);
Description | The procedure appends character at the beginning of the string.
Example txt := ‘ikroE’;
strappendpre (‘m’, txt) ; // adds letter ‘m’ at the beginning of the ‘txt’
string
strappendsuf
Prototype procedure strappendsuf (var sl string; letter char) ;
Description | The procedure appends character at the end of the string.
Example txt := ‘mikro’;
strappendsuf (‘E’,txt); // adds letter ‘E’ at the end of the ‘txt’ string
length
Prototype function length(var s: string) word;
Description | The function returns length of passed string.
Example txt := ‘mikroE’;
res = length(txt); // calculates and returns the length of the ‘txt’ string
MikroElektronika
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Time Library

The Time Library contains functions and type definitions for time calculations in the UNIX time format which counts the
number of seconds since the “epoch”. This is very convenient for programs that work with time intervals: the difference
between two UNIX time values is a real-time difference measured in seconds.

What is the epoch?
Originally it was defined as the beginning of 1970 GMT. (January 1, 1970 Julian day) GMT, Greenwich Mean Time, is
a traditional term for the time zone in England.

The TimeStruct type is a structure type suitable for time and date storage.

Library Routines

- Time_dateToEpoch
- Time_epochToDate
- Time_dateDiff

Time_dateToEpoch

Prototype function Time_dateToEpoch(var ts : TimeStruct) : longint;
Description | This function returns the UNIX time : number of seconds since January 1, 1970 0hOOmnQO0s.
Parameters | - ts: time and date value for calculating UNIX time.
Returns Number of seconds since January 1, 1970 0hOOmnOO0s.
Requires Nothing.
Example var tsl : TimeStruct;
Epoch : longint;

}}.what is the epoch of the date in ts ?

epoch := Time dateToEpoch (@tsl) ;
Notes None.
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Time_epochToDate

Prototype procedure Time epochToDate (e longint; wvar ts TimeStruct) ;
Description | Converts the UNIX time to time and date.
Parameters | - = : UNIX time (seconds since UNIX epoch)
- ts: time and date structure for storing conversion output
Returns Nothing.
Requires Nothing.
Example var ts2 TimeStruct;
epoch longint;
//what date is epoch 1234567890 2
epoch := 1234567890 ;
Time epochToDate (epoch, ts2);
Notes None.
Time_dateDiff
Prokﬂype function Time_dateDiff(var tl, t2 TimeStruct) longint ;
Description | This function compares two dates and returns time difference in seconds as a signed long. Result is
positive if t1 is before 2, result is null if t 1 is the same as t2 and result is negative if t 1 is after t 2.
Parameters | - ©1:time and date structure (the first comparison parameter)
- t2:time and date structure (the second comparison parameter)
Parameters | None.
Returns Time difference in seconds as a signed long.
Requires Nothing.
Example var tsl, ts2 TimeStruct;
diff longint;
//how many seconds between these two dates contained in tsl and ts?2
buffers?
diff := Time dateDiff (tsl, ts2);
Notes None.

Library Example

Demonstration of Time library routines usage for time calculations in UNIX time format.

Copy Code To Clipboard

program Time Demo;

{*

* simple time structure

*}

type TimeStruct =

record

ss byte ; // seconds
mn byte ; // minutes
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hh : byte ; // hours
md : byte ; // day in month, from 1 to 31
wd : byte ; // day in week, monday=0, tuesday=1, .... sunday=6
mo : byte ; // month number, from 1 to 12 (and not from 0 to 11 as with unix C
time !)
yy : word ; // year Y2K compliant, from 1892 to 2038
end;
var tsl, ts2 : TimeStruct;
buf : array[256] of byte ;
epoch, diff : longint ;
begin
tsl.ss = 0 ;
tsl.mn := 7 ;
tsl.hh := 17 ;
tsl.md := 23 ;
tsl.mo := 5 ;

tsl.yy := 2006 ;

{*

* what is the epoch of the date in ts ?

*}
epoch := Time dateToEpoch (@tsl) ; // epoch = 1148404020
{*

* what date is epoch 1234567890 *?

*}

epoch := 1234567890 ;

Time epochToDate (epoch, @ts2) ; // ts2.ss := 30 ;
// ts2.mn := 31 ;
// ts2.hh := 23 ;
// ts2.md := 13 ;
// ts2.wd := 4 ;
// ts2.mo := 2

// ts2.yy := 2009 ;
{*
* how much seconds between this two dates *?
*}
diff := Time dateDiff (€tsl, @ts2) ; // diff = 86163870

end.

TimeStruct type definition

type TimeStruct = record

ss : byte ; // seconds
mn : byte ; // minutes
hh : byte ; // hours
md : byte ; // day in month, from 1 to 31
wd : byte ; // day in week, monday=0, tuesday=1, .... sunday=6
mo : byte ; // month number, from 1 to 12 (and not from 0 to 11 as with unix C
time !)
yy : word ; // year Y2K compliant, from 1892 to 2038
end;
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Trigon Library

The mikroPascal PRO for PIC32 provides a set of library functions for floating point math handling. See also Predefined
Globals and Constants for the list of predefined math constants.

Library Functions

- acos
- asin
- atan
- atan2
- ceil

- cos

- cosh
- eval_poly
- exp

- fabs
- floor
- frexp
- ldexp
- log
-log10
- modf
- pow
- sin

- sinh

- sqrt

- tan

- tanh

acos

Prototype function acos(x : real) : real;

Description | Function returns the arc cosine of parameter x; that is, the value whose cosine is <. The input parameter
= must be between -1 and 1 (inclusive). The return value is in radians, between 0 and 1 (inclusive).

Example res := acos(0.5); // res := 1.047198
asin
Prototype function asin(x : real) : real;

Description | Function returns the arc sine of parameter x; that is, the value whose sine is x. The input parameter
% must be between -1 and 1 (inclusive). The return value is in radians, between -I1/2 and I1/2

(inclusive).
Example res := asin(0.5); // res := 5.235987e-1
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atan

Prototype function atan(arg real) real;

Description | Function computes the arc tangent of parameter f; that is, the value whose tangent is ©. The return
value is in radians, between -1/2 and /2 (inclusive).

Example res := atan(1.0); // res := 7.853982e-1

atan2

Prototype function atan2(y : real; x real) real;

Description | This is the two-argument arc tangent function. It is similar to computing the arc tangent of v/ x, except
that the signs of both arguments are used to determine the quadrant of the result and x is permitted to
be zero. The return value is in radians, between -1 and 1 (inclusive).

Example res := atan2(2., 1.); // res := 4.636475e-1

ceil

Prototype function ceil (x real) real;

Description | Function returns value of parameter x rounded up to the next whole number.

Example res := ceil(0.5); // res := 1.000000

Ccos

Prototype function cos(arg : real) real;

Description | Function returns the cosine of f in radians. The return value is from -1 to 1.

Example res := cos(PI/3.); // res := 0.500008

cosh

Prototype function cosh (x real) real;

Description | Function returns the hyperbolic cosine of =, defined mathematically as (e*+e™*) /2. If the value of x
is too large (if overflow occurs), the function fails.

Example res := cosh(PI/3.); // res := 1.600286

eval_poly
Prototype function eval poly(x : real; var d : array([10] of real; n : byte) real;
Description | Function Calculates polynom for number x, with coefficients stored in d [ ], for degree n.
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exp

Prototype function exp(x : real) real;

Description | Function returns the value of e — the base of natural logarithms — raised to the power = (i.e. e*).

Example res := exp(0.5); // res := 1.648721

fabs

Prototype function fabs(d : real) real;

Description | Function returns the absolute (i.e. positive) value of d.

Example res := fabs(-1.3); // res := 1.3

floor

Prototype function floor (x real) real;

Description | Function returns the value of parameter x rounded down to the nearest integer.

Example res := floor(15.258); // res := 15.000000

frexp

Prototype function frexp (value real; wvar eptr integer) real;

Description | The function splits a floating-point value vz 1ue into a normalized fraction and an integral power of 2.
The return value is a normalized fraction and the integer exponent is stored in the object pointed to
by eptr.

Idexp

Prototype function ldexp (value real; newexp integer) real;

Description | Function returns the result of multiplying the floating-point number num by 2 raised to the power n (i.e.
returns x * 20).

Example res := ldexp(2.5, 2); // res := 10

log

Prototype function log(x real) real;

Description | Function returns the natural logarithm of x (i.e. 1oge (x)).

Example res := log(10); // res := 2.302585E

log10

Prototype function 1loglO (x real) real;

Description | Function returns the base-10 logarithm of x (i.e. 1og (x)).

Example res := 1ogl0(100.); // res := 2.000000
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modf
Prototype function modf (val real; wvar iptr real) real;
Description | Returns argument val split to the fractional part (function return val) and integer part (in number iptr).
Example res := modf (6.25, iptr); // res := 0.25, iptr = 6.00
pow
Prototype function pow (x real; y : real) real;
Description | Function returns the value of x raised to the power y (i.e. xY). If x is negative, the function will
automatically cast y into unsigned long.
Example res := pow(1l0.,5.); // res := 9.999984e+4
sin
Prototype function sin(arg : real) real;
Description | Function returns the sine of £ in radians. The return value is from -1 to 1.
Example res := sin(PI/2.); // res := 1.000000
sinh
Prototype function sinh (x real) real;
Description | Function returns the hyperbolic sine of x, defined mathematically as (e*-e~%) /2. If the value of x is
too large (if overflow occurs), the function fails.
Example res := sinh(PI/2.); // res := 2.301296
sqrt
Prototype function sqgrt (x real) real;
Description | Function returns the non negative square root of x.
Example res := sqrt(10000.); // res := 100.0000
tan
Prototype function tan(x : real) real;
Description | Function returns the tangent of x in radians. The return value spans the allowed range of floating point
in the mikroPascal PRO for PIC32.
Example res := tan(PI/4.); // res := 0.999998
tanh
Prototype function tanh (x real) real;
Description | Function returns the hyperbolic tangent of x, defined mathematically as sinh (x) /cosh (x) .
Example res := tanh (-PI/4.); // res := -0.655793
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Trigonometry Library

The mikroPascal PRO for PIC32 implements fundamental trigonometry functions. These functions are implemented as
look-up tables. Trigonometry functions are implemented in integer format in order to save memory.

Library Routines

- sinE3
- cosE3
sinE3
Prototype function sinE3(angle _deg : word): integer;
Description | The function calculates sine multiplied by 1000 and rounded to the nearest integer:
result = round(sin (angle deg) *1000)
Parameters | - angle deg:input angle in degrees
Returns The function returns the sine of input parameter multiplied by 1000.
Requires Nothing.
Example var res : integer;
res := sinE3(45); // result is 707
Notes Return value range: -1000..1000.
cosE3
Prototype function cosE3 (angle deg : word): integer;
Description | The function calculates cosine multiplied by 1000 and rounded to the nearest integer:
result = round(cos(angle deg)*1000)
Parameters | - angle deg:input angle in degrees
Returns The function returns the cosine of input parameter multiplied by 1000.
Requires Nothing.
Example var res: integer;
res := cosE3(196); // result is -193
Notes Return value range: -1000..1000.
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CHAPTER 10

Tutorials

Managing Project

Projects

The mikroPascal PRO for PIC32 organizes applications into projects, consisting of a single project file (extension
.mpp32) and one or more source files (extension .mpas). mikroPascal PRO for PIC32 IDE allows you to manage
multiple projects (see Project Manager). Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- binary files (*.emcl),

- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does, see Add/Remove Files from
Project.
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New Project

The easiest way to create a project is by means of the New Project Wizard, drop-down menu Project » New Project or
by clicking the New Project Icon |35_.| from Project Toolbar.

New Project Wizard Steps

Start creating your New project, by clicking Next button:

New Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

Create a new project

Select the device for your project
Setup device clock

add project files

Click Mext to continue

New Project Wizard

Step 176

Select the device you want to use.

Device Mame: | P32MX460FS12L v

4 Back Cancel
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Step Two - Enter the oscillator frequency value:

New Project Wizard

Step 2/6

Setup the clock, for example 11,0592 MHz.

Device Clock: 10,000000 | MHz

Cancel

New Project Wizard

Project File Nanme:

|C:'|,He||0 WworldiHello World.mpp32

Specify where your project will be saved.

4 Back Next 5 Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can always add project files later using
Project Manager:

New Project Wizard

Step 476
add project files if they are available at this point.
vou can always add project files later using the Project Manager in IDE.
Add File To Project:
Ci\ProjectsiHella Warld.mpas Add
File Mame
CiiProjectsiHello World, mpas
Remove
Remove All
4@ Back Next 3 Cancel

Step Five - Select inital Library Manager state:

New Project Wizard

Step 576

Select initial Library Manager state.

Include Libraries
& Inchude Al (Default)
" Inchude Mone (Advanced)

Selecting all libraries is recommended for beginners.

Selecking libraries manually using Library Manager

(recommended Far advanced users) results in Faster compilation. Libary Manager Help

4@ Back Next 5 Cancel
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Step Six - Click Finish button to create your New Project:

New Project Wizard

Step 6/6

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

e

Open Edit Project window to sek Configuration bits

Cancel

Related topics: Project Manager, Project Settings
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Customizing Projects

You can change basic project settings in the Project Settings window. You can change chip and oscillator frequency.
Any change in the Project Setting Window affects currently active project only, so in case more than one project is open,
you have to ensure that exactly the desired project is set as active one in the Project Manager.

Also, you can change configuration bits of the selected chip in the Edit Project window.

Managing Project Group

mikroPascal PRO for PIC32 IDE provides convenient option which enables several projects to be open simultaneously.
If you have several projects being connected in some way, you can create a project group.

The project group may be saved by clicking the Save Project Group lcon % from the Project Manager window. The
project group may be reopened by clicking the Open Project Group Icon % . All relevant data about the project group

is stored in the project group file (extension .mpdsgroup)

Add/Remove Files from Project
The project can contain the following file types:

- .mpas source files

- .emc1 binary files

- .pld project level defines files

- image files

- .ihex EEPROM files

- .hex, .asmand . 1st files, see output files. These files can not be added or removed from project.
- other files

Project Manager [1,1] 3]
EAESEE L I E Y S
58y
=1 sources
Ej Teos3C_240x128 mpas
] einstein_bmp.mpas
% mikroe_brp. mpas
E1-IC7) Binaties
TE963C_240x128.mel
I Project level defines
E1-C7) Image Files
mikroE_240x128.bmp
=177 EEPRGOM Files
TEIEIC_240:x128 thex
[T Active Comments Files
2157 Qutput Files
TE9E3C_240x128 . hex
TE963C_240x1 25, as5m
einstein_brmp. asm
mikroe_brp.asm
TEI63C_240x128.Isk
2107 Other Files
DataShest_70138b.pdf
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The list of relevant files is stored in the project file (extension .mpp32).

To add a file to the project, click the Add File to Project Icon @ or press Insert button on your keyboard. Each added

source file must be self-contained, i.e. it must have all necessary definitions after preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon [1—.,‘]{ or press Delete button on your
keyboard.

Project Level Defines:

Project Level Defines (. p1d) files can also be added to project. Project level define files enable you to have defines that
are visible in all source files in the project. A file must contain one definition per line in the following form:

ANALOG

DEBUG

TEST

For example, lets make a project level define named p1d test. First of all, create a new file with the . p1d extension,
pld test file.pld.

Next, open it, and write something like this :

PLD TEST

Once you have done this, save the file. In the Project Manager, add pld test file.pld file by right-clicking the
Project Level Defines node.

In the source code write the following :
{SIFDEF PLD TEST}
{SENDIF}

There are a number of predefined project level defines. See predefined project level defines

Related topics: Project Manager, Project Settings, Edit Project
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Source Files

Source files containing source code should have the extension . mpas. The list of source files relevant to the application
is stored in project file with extension .mppav, along with other project information. You can compile source files only
if they are part of the project.

Managing Source Files

Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click the New File Icon |j from the File
Toolbar.
2. A new tab will be opened. This is a new source file. Select File » Save from the drop-down menu, or press Ctrl+S, or

click the Save File Icon H from the File Toolbar and name it as you want.
If you use the New Project Wizard, an empty source file, named after the project with extension . mpas, will be created

automatically. The mikroPascal PRO for PIC32 does not require you to have a source file named the same as the
project, it's just a matter of convenience.

Opening an existing file

1. Select File » Open from the drop-down menu, or press Ctrl+0O, or click the Open File Icon @ ~+ from the File

Toolbar. In Open Dialog browse to the location of the file that you want to open, select it and click the Open button.
2. The selected file is displayed in its own tab. If the selected file is already open, its current Editor tab will become
active.

Printing an open file

1. Make sure that the window containing the file that you want to print is the active window.

2. Select File » Print from the drop-down menu, or press Ctrl+P.

3. In the Print Preview Window, set a desired layout of the document and click the OK button. The file will be printed
on the selected printer.

Saving file

1. Make sure that the window containing the file that you want to save is the active window.

2. Select File » Save from the drop-down menu, or press Ctrl+S, or click the Save File Icon H from the File
Toolbar.
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Saving file under a different name

1. Make sure that the window containing the file that you want to save is the active window.

2. Select File » Save As from the drop-down menu. The New File Name dialog will be displayed.
3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.

Closing file

1. Make sure that the tab containing the file that you want to close is the active tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file that you want to close and select Close
option from the context menu.

3. If the file has been changed since it was last saved, you will be prompted to save your changes.

Search Paths

You can specify your own custom search paths: select Project » Edit Search Paths... option from the drop-down
menu:

Search Paths (5]

ﬂﬂ 6 Q& Source Files

Path

Ci\Program Files\Mikroelekbronikalmikr oP ascal PRO For PIC32\defs)

Ci\Program Files\Mikroelekbronikaimikr oP ascal PRO For PIC32\uses)

C:\Program Files\Mikroelekbronikalmikr oP ascal PRO For PIC32\ExamplesiDeveloprment SystemsiLy32ME vailcD, .,

0K Apply Restors
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Following options are available:

Icon Description

ﬁ Add Search Path.

E Remove Search Path.

LT Purge Invalid Paths.

Paths for Source Files (.mpas)

You can specify either absolute or relative path to the source file. If you specify a relative path, mikroPascal PRO for

PIC32 will ook for the file in following locations, in this particular order:
1. the project folder (folder which contains the project file .mpp32),

2. your custom search paths,
3. mikroPascal PRO for PIC32 installation folder > Uses folder.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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Edit Project

Edit Project gives you option to change MCU you wish to use, change its oscillator frequency and build type. Also, Edit
Project enables you to alter specific configuration bits of the selected device.

As you alter these bits, appropriate register values will be updated also. This can be viewed in the Configuration
Registers pane.

When you have finished configuring your device, you can save bit configuration as a scheme, using | save scheme
button.

In case you need this scheme in another project, you can load it using Load scheme | button.

There is also a Default button which lets you select default configuration bit settings for the selected device.

Edit Project

P e
PLL Input Divider — MU and Oscillator
|2x Divider v |
PLL Multiplier TMCL Name |P32M><460F512|_ “ |
|20x Multiplier |

Oscillator Frequency [MHz] 3.000000

USE PLL Input Divider
|12 Divider |

Inkerrupt Control:
() Single Wector Base Address

|Disabled and Bypassed b | EBASE: 0x| 9FC0 1000

System PLL Output Clock Divider
(%) Multi Yeckar

|PLL Divide by 1 |
Weckor Spacing (¥a):

USB PLL Enable

SRS Priority Level:

Oscillator Selection Bits

|Primary ©se (x7,HS,EC) |
Secondary Dscillator Enable Ld Load Schema
EBuild Tvpe Heap
Enabled b - .
| | '@ Release ' ICD Debug Use Size Save Scheme
Internal /External Switch Over
|Enabled b | Configuration Registers
Primary Dscillator Configuration DEVCFGZ  :$1FCOZFF4 : Ox0D0008751 Default
|><T st mode v| DEVCFGL  :$1FCOZFFS : Ox00148542
DEVCFGO :#1FCOZFFC : 0Ox110FFOOE
CLKO Output Signal Active on the 0SCO Pin
|Enabled v | o
Peripheral Clock Divisor Cancel

General Qutput Settings ...

|Pb_Clkis Sys_clkj1 v|

Related topics: Project Settings, Customizing Projects
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Clean Project Folder

This menu gives you option to choose which files from your current project you want to delete.
Files marked in bold can be easily recreated by building a project. Other files should be marked for deletion only with a
great care, because IDE cannot recover them.

lean Project Folder 3]
Below is the list of all files in the project folder. Files in bold are those
generated by the compiler and they can be easily recreated when the
project is rebuilt.

Select which files you want to remove from the project folder, Please note
that selected files will be permanently deleted from your disk if you click

[ coG.xml
LCD.asm
[ Lco.efg

[ Le.emd

[JLcD.hex

[Lco.log

LCD.Ist

[ Lco.mpas

[ Lco.mpp32
LCD.mpp32_callertable.txt
[ Lc.user dic

Clean Cancel

C:\Program FilesiMikroelektronikaimikroPascal PRO For PIC32\ExamplesiDevelopment Sy

Related topics: Customizing Projects
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Compilation

When you have created the project and written the source code, it's time to compile it. Select Project » Build from the
drop-down menu, or click the Build Icon {.‘, from the Build Toolbar. If more more than one project is open you

can compile all open projects by selecting Project » Build All Projects from the drop-down menu, or click the Build All

Projects Icon i:, from the Build Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are some errors, you will be notified in the
Messages Window. If no errors are encountered, the mikroPascal PRO for PIC32 will generate output files.

Output Files

Upon successful compilation, the mikroPascal PRO for PIC32 will generate output files in the project folder (folder

which contains the project file .mpp32). Output files are summarized in the table below:

addresses, registers, routines and labels.

Format Description File Type
Intel HEX Intel style hex records. Use this file to program MCU. hex
Binary Extended mikro Compiled Library. Binary distribution of | .emcl
application that can be included in other projects.
List File Overview of MCU memory allotment: instruction st

Assembler File

Human readable assembly with symbolic names,
extracted from the List File.

.asm

Assembly View

After compiling the program in mikroPascal PRO for PIC32, you can click the View Assembly icon ﬂ

or select Project » View Assembly from the drop-down menu to review the generated assembly code (. asm file) in a

new tab window.

Assembly is human-readable with symbolic names.

Related topics: Build Menu, Build Toolbar, Messages Window, Project Manager, Project Settings
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Creating New Library

mikroPascal PRO for PIC32 allows you to create your own libraries. In order to create a library in mikroPascal PRO for
PIC32 follow the steps bellow:

1. Create a new source file, see Managing Source Files
2. Save the file in one of the subfolders of the compiler’s Uses folder:
DriveName:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Uses\
3. Write a code for your library and save it.
4.Add 1Lib Example file in some project, see Project Manager. Recompile the project.
If you wish to use this library for all MCUs, then you should go to Tools » Options > Output settings, and check
Build all files as library box.
This will build libraries in a common form which will work with all MCUs. If this box is not checked, then library
will be built for selected MCU.
Bear in mind that compiler will report an error if a library built for specific MCU is used for another one.
. Compiled file Lib Example.emcl should appearin ...\mikroPascal PRO for PIC32\Uses\ folder.
. Open the definition file for the MCU that you want to use. This file is placed in the compiler’s Defs folder:
DriveName:\Program Files\Mikroelektronika\mikroPascal PRO for PIC32\Defs\
and it is named MCU NAME .m1k, for example P32MxX460F512L . m1k
7. Add the the following segment of code to <1.TBRARTES> node of the definition file (definition file is in XML format):
<LIB>
<ALIAS>Example Library</ALIAS>
<FILE> Lib Example</FILE>
<TYPE>REGULAR</TYPE>
</LIB>
8. Add Library to mik file for each MCU that you want to use with your library.
9. Click Refresh button in Library Manager
10. Example Library should appear in the Library manager window.

(e3¢}

Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .emcl file. For example UART library for
PIC32MX460F512L is different from UART library for PIC32MX675F512L MCU. Therefore, two different UART Library
versions were made, see mlk files for these two MCUs. Note that these two libraries have the same Library Alias
(UART) in both m1k files. This approach enables you to have identical representation of UART library for both MCUs
in Library Manager.

Related topics: Library Manager, Project Manager, Managing Source Files
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Frequently Asked Questions

This is a list of frequently asked questions about using mikroElektronika compilers.
If your question is not answered on this page, please contact mikroElektronika Support Desk.

Can | use your compilers and programmer on Windows Vista (Windows 7) ?

Our compilers and programmer software are developed to work on and tested on Windows 98, Windows 2000, Windows
ME, Windows XP (32 and 64 bit), Windows Vista (32 and 64 bit) and Windows 7 (32 and 64 bit) and they work fine on
these operating systems.

You can find the latest drivers on our website.

| am getting “Access is denied” error in Vista, how to solve this problem ?

Please turn off User Account Control (UAC). This should make your software fully functional. To do this, follow the path
in your Windows Vista (logged in as administrator) Control Panel » User Accounts > Turn User Account Control on
or off, uncheck Use User Account Control (UAC) and click OK.

What are differences between mikroC PRO, mikroPascal PRO and mikroBasic PRO
compilers ? Why do they have different prices ?

Basically, there is little differences between these compilers. mikroC PRO is standardized with ANSI C, and it is much
more complex and it is far more difficult to write the compiler for it. We used a lot more resources for making it than what
we used for mikroPascal and mikroBasic. We also worked on some very complex topics such as floating point, typedef,
union, a completely new debugger and many other. Because of that there is difference in price.

Why do your PIC compilers don’t support 12F508 and some similar chips ?

Unfortunately our PIC compilers don’t support 12F508 and similar chips because these chips are designed to use 12-bit
wide instructions. Our compiler support MCUs which use 14-bit or wider instructions.

What are limitations of demo versions of mikroElektronika’s compilers ?

The only limitation of the free demo version is that it cannot generate hex output over 2K of program words. Although it
may sound restrictive, this margin allows you to develop practical, working applications without ever thinking of demo
limit. If you intend to develop really complex projects in one of our compilers, you should consider purchasing the
license key.

Why do | still get demo limit error when | purchased and installed license key ?

If you are first time installing and registering compiler, you need to follow instructions exactly as described in registration
procedure. License is valid only for the computer from which request is made, so license requested from one computer
won’t work on another computer. You can find on our site manual and video describing in detail how to get your license.
If you previously had an older version of our compiler and have working license key for it but it doesn’t work with new
compiler, you have to repeat registration procedure from the new compiler and you will get a new license.
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| have bought license for the older version, do | have to pay license for the new version
of the compiler ?

No, once you pay for the license key you get a lifetime license. When we release a new major release of the compiler,
you might need to repeat registration procedure from your new compiler and you will get new license free of charge.

Do your compilers work on Windows Vista (Windows 7) ?

Yes!

What does this function/procedure/routine do ?

Please see your compiler’s Help where all of the functions are explained in detail.

| try to compile one of the provided examples and nothing happens, what is the
problem?

You need to open project, not file. When you want to open an example, go to Project » Open Project, then browse
through projects and choose project file. Now you will be able to compile and program with success.

Can | get your library sources ? | need to provide all sources with my project.

It is our company’s policy not to share our source code.

Can | use code | developed in your compilers in commercial purposes ? Are there some
limitations ?
Regarding your code, there are no limitations. Your application is your own property and you can do whatever you like

with it. If you want to include some of code we provide with our compilers or on our site, you may include them in your
project, however, you are not allowed to charge your users for these.

Why does an example provided with your compilers doesn’t work ?

All of the examples provided with our compilers are tested and work fine. You need to read commented header of the
example and be sure that you have used the same MCU example is written for and that you have hardware connections
(DIP switches, jumpers etc.) set as described.

Your example works if | use the same MCU you did, but how to make it work for another
MCU ?

You should read your MCU’s datasheet. Different MCUs can have different pin assignments and may require different
settings. If you need help regarding this, you can find free online books on our website and recommend you starting
there. You can also ask for help on our forum.

MikroElektronika 616



mikroPascal PRO for PIC32

| need this project finished, can you help me ?

We currently do not do custom projects, however, we can give you some directions when you start working on your
project and come to a problem. Also, our forum is very active community and as you can find there experts in different
fields, we encourage you to look for help there.

Do you have some discount on your compilers/development systems for students/
professors ?

Since large percentage of our customers are schools, laboratories and students, our prices are already scaled for these
kinds of users. If you plan ordering more than one of our products, see special offers page on our website. Also, you
can contact our Sales Department and see if you are eligible for some additional discount.

| have a question about your compilers which is not listed here. Where can | find an
answer ?

Firstly, look for it in your compiler’s Help. If you don’t find an answer there, please create a support ticket on our
website.
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